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GIRIŞ 

 

Kompýuter tehnologiýasy – iň ýaş ugurlaryň biridir. Kompýuter 

tehnologiýasynyň ösüş taryhy beýlekilere garaňda kän bir uly döwri alýan däldir – 40-

50 ýyl. Kompýuter tehnologiýasy, tehnikasy diýen adalgalar bolsa ondan hem ýaşdyr. 

Bilişimiz ýaly, ilkibaşda elektron-hasaplaýyş maşyn, hasaplaýyş tehnikasy diýen 

adalgalar ulanylardy. 20 ýyldan bäri bolsa EHM diýlen adalga ýuwaş-ýuwaşdan ýitip 

kompýuter adalga öz örnuny berdi, tehnika bolsa öňküler ýaly hasaplaýyş dälde 

kompýuter tehnikasy diýlip atlandyrylýar. 

Kompýuter tehnologiýasy ýaş bolmak bilen, dünýäde öňdebaryjy ugurlaryň 

biri bolup durýar. Häzirki wagtda habarlar-aragatnaşyk tehnologiýalaryň ýokary 

depginde ösýändigi barada aýdylýar. Öýjükli telefon aragatnaşygyň, maglumat 

tehnologiýalaryň ösmegi muňa subut bolup durýar. Şol tehnologiýalaryň düzümine 

çuňlaýyn seredilen mahalynda olaryň kompýuter ugruna esaslanýandygyna göz 

ýetirmek bolýar. 

Öz gezeginde, kompýuterler öz düzüminde tehnikanyň başga ugurlarynyň 

soňky derejelerini jemländir. Bu bolsa onuň bilen işlemegi diňe ýeňilletmän, 

eýsem  amatly edip goýýar. 

Türkmenistan dünýä ösüşiniň gapdalynda durman, kompýuter 

tehnologiýalaryň soňky gazananlaryny ulanmaklyga ymtylýar. Ýurdumyzda 

öňdebaryjy tehnologiýalary öwrenmeklik boýunça uly işler alnyp barylýar. Şol işlerde  

Hormatly Prezidentimiziň ýardam bermegi olaryň tiz depginde amala aşmagyny 

üpjün edýär. Ýurdumyzyň Baştutany öz gymmatly wagtyny tygşytlaman dünýäniň 

ösüşindäki ymtylyşlara üns berýär we olaryň has netijelilerini döwletimizde gerekli 

ugurlarda ornaşdyrylmagyna ýardam berýär. 

Täze galkynyşlar zamanasynda ýurdumyzyň islendik pudagyň öňünde täze 

meseleler goýuldy. Şol meseleleri üstünlikli çözmek üçin diňe bir tehnologiýalar 

ýeterlikli däl. Şol tehnologiýalary ulanyp biljek ýokary derejeli hünärmenler zerur. 

Türkmen politehniki instituty öz içinde öhümçilikde ulanylýan birnäçe 

hünärleri jemländir. Olaryň arasynda gurluşyk we binagärlik, himiýa, nebit we gaz 

pudagyna degişli hünärler, ykdysadyýeti dolandyryş, mehanika we energetika bilen 

bagly hünärler, hem-de kompýuter tehnologiýasy. 

Kompýuter tehnologiýalary öz düzümine birnäçe ugurlary we dersleri alýar. 

Olara  umuman aýdanyňda maksatnama düzme, multimediýa tilsimatlary, grafika 

we bezeg işleri, tory dolandyrma, amallar ulgamy we maksatnama üpjünçiligi, 

kompýuteriň içki gurluşy we ş.m. degişli etmek bolýar. 

Kompýuterler bir wagtyň içinde birnäçe amallary ýerine ýetirýärler. Mysal 

üçin şol bir wagtyň içinde ol çylşyrymly hasap işleri, çap etmegi, ses çykarmagy, 

faýllar bilen işlemekligi we ş.m. amala aşyryp bilýär. 

Häzirki wagtda kompýuterler önümçiligiň islendik pudagynda giňden 

ýaýrandyr. Şonuň üçin hem hasaplaýyş tehnikasy bilen tanyşlyk talyplaryň haýsy 

hünär boýunça bilim alýanlygyna garamazdan öwrenilýär. 
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Ýokarda aýdyşymyz ýaly Täze Galkynyş zamanasy täze talaplary bildirýär. 

Her bir hünäriň öz aýratynlygy bar hem bolsa, onuň kompýuter tehnikasy bilen iş 

salyşýan meseleleri hökman bardyr. 

Binagärlik hünärini alyp görsek. Çylşyrymly çyzgylar takyklygy, dogrulygy, 

bezegi, köplenç köp mukdarda bolmagy talap edýär. Häzirki wagtda kompýuterde 

ulanylýan maksatnamalaryň arasynda inženerçilik-çyzgy maksatnamalar köp 

ulanyşa eýe bolup durýar. Olaryň hataryna AutoCAD, 3DMAX, ArhiCAD we b. 

maksatnamalar. Olar çyzgylary tiz depginde, ýokary takyklyk bilen, ýokary 

derejeli bezegli we göze ýakymly edip taýýarlamagy mümkin edýär. Eldeki 

çyzgydan tapawutlykda, ýörite çap ediş gurluş arkaly islendik mukdarda çap 

etmegi mümkin edýär, şeýle hem ýalňyşlyklar ýüze çykanda tiz we arassa 

düzetmegi mümkin edýär.  

Gurluşygyň ugurlary üçin hem bu maksatnamalar peýdaly bolýar, sebäbi 

diňe çyzgylary amala aşyrmakdan tapawutlykda, olar ölçegleri goýmagy, 

çyzgydaky desga materialy ulanmak bilen onuň mukdaryny kesgitlemegi üpjün 

edýär. 

Kompýuter ugry ykdysadyýetdäki çylşyrymly hasapçylyk işlerini amala 

aşyrmagy hem mümkin edýär. Bu ýere diňe, her kişä belli bolan Microsoft Excel 

maksatnamasyny goşman, birnäçe hasapçylyk işlerini ýerine ýetirmek üçin ýörite 

düzülen maksatnamalary goşmak bolýar. 

Himiýanyň önümçilik proseslerini hasaplama işlerinde hem kompýuteriň 

ulanylýandygyny bellemek bolýar.  

Nebit we gaz ugry öz içine dürli hünärleri alýan hem bolsa, olaryň 

hemmesiniň  alyp barýan işlerinde  kompýuter serişdeleri ulanylýar. Meselem, 

geologiýa işleriniň netijelerini işläp bejermekde GeoFrame toplumy giňden 

peýdalanylýar.  

Görüşimiz ýaly kompýuter tehnologiýasy pudaklaryň ählisine özleşdirilipdir 

hem-de adaty teskt redaktorlary ulanmak bilen çäklenmän, öz gönümel ugurlary  

we alyp barýan işleri boýunça zerur kompýuter maksatnamalaryny ulanýarlar. 

Bu bolsa ýene bir gezek, Hormatly Prezidentimiziň, dürli ugurdaky 

hünärmenleriň Täze galkynyş zamanasynda kompýuter tehnikasy bilen giňden iş 

salyşmagyny gazanmak baradaky tabşyryklarynyň onuň öňden görüjilik 

syýasatynyň aýrylmaz bölegidigini görkezýär. 

Beýleki hünärleriň kompýuter tehnikasy bilen işlemegini öwretmegiň esasy 

ugurlary barada gysgaça gürrüň edildi. Öz hünärimiziň – gönümel kompýuter 

tehnologiýasynyň esasy öwrenýän talyplar bilen işlenende aýry usulyýet gerek 

bolýar. 

Eger beýleki hünärler kompýuter tehnologiýalary bilen ulanyjylyk ýagdaýda 

öwredilýän bolsa, kompýuter ugrundaky hünärler has ýöriteleşdirilen, dolandyryjy 

we sazlaýjy wezipeleri ýerine ýetirmeklige gönükdirilen ugur bilen öwredilýär. 

Tekst redaktorlary bilen işlenende ýa-da beýleki bir ulanyjy maksatnamalar 

ulanylanda kompýuter bilen işlemekligiň ussatlygy dürli ulanyjylarda 

tapawutlandyrmaýar. Emma şol maksatnamalaryň işini sazlamakda, 

häsiýetnamalaryny goýmakda ýa-da umuma kompýuteriň işini düzetme işlerinde 

tapawut bildirip durmaly. Mundan başga hem, biz öz hünärimiz boýunça 
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talyplarymyza maksatnamalary düzmekligi, maksatnamanyň döredijisi bolmaklygy 

öwredýäris. 

Başgaça aýdanyňda, beýleki hünärli talyplar öz ugrundaky meseleleri 

işlerinde kompýuteri netijeli peýdalanmaga öwredilýän bolsa, kompýuter ugrunda 

kompýuteriň özi bir şol meseläniň biri bolup durýar, sebäbi talyplara kompýuteri 

bejermek, sazlamak, gurnamak, onuň üçin maksatnamalary ýüklemek, 

kompýuterleri torda sazlamak, kompýuterde maksatnama düzmek we ş.m. 

Emma ýokarda agzalan işleriň ýöriteleşdirilen kompýuter ugrundan işleýän 

hünärmenler üçin gönükdirilen hem bolsa, olar kompýuteriň islendik ulanyjysy 

tarapyndan özleşdirilmegi mümkin. 

Bu kitap kompýuter tehnologiýasynyň ýaş ugurlarynyň biri bolan kompýuter 

grafikasynyň işleýiş düzgünlerini öwretmeklige gönükdirilen. Kompýuter 

grafikasynyň amala aşyrylmagy adaty çeperçilik grafikasynyň çekilmegine 

garanyňda düýpli tapawutlyklara eýe bolup durýar. Bu diňe bir amala aşyryş 

serişdeleriň aýratynlyklaryna bagly bolup durman, eýsem çyzgylary we suratlary 

kim tarapyndan ýerine ýetirilýän meselesinde hem tapawutlanýar. Kompýuter 

grafikasynda çyzgyny taýýarlaýan adam hökmany suratkeş ýa-da binagärçi bolman 

hem bilýär. Bu aýratynlyk kompýuter grafikasyny öndürijilik boýunça has netijeli 

edýär. Kompýuter grafikasynda esasy orny onuň haýsy kompýuter programmasy 

arkaly ýerine ýetirilýändigi tutýar. 

Bu kitapda kompýuter grafikasy ugrunda iň meşhur programmalar bolan – 

Adobe Photoshop, Corel Draw, AutoCad ulgamynda işlemegiň düzgünleri we 

grafiki şekilleri taýýarlamagyň usullary barada gürrüň gidýär. Kitap öz düzüminde 

diňe maglumat beriji bölümleri saklaman, eýsem tejribe taýdan peýdaly 

görkezmeleri we maslahatlary ädimleýin düzgünde saklaýar. 

Bilişimiz ýaly kompýuter tehnologiýasy gün-günden ösýär. Onuň ösüşi diňe 

bir kompýuter tehnikasynyň we onuň bilen bagly bolan gurluşlaryň kämilleşmegi 

bilen bagly bolman, eýsem kompýuter programmalaryň wagtal-wagtal 

täzelenmegi, öňki görnüşlerine görä kämilleşmegi bilen hem bagly bolup durýar. 

Bu kitabymda men, ýokarda agzalan programmalaryň işleýiş düzgünini 

uniwersal ýagdaýda, ýagny programmalaryň täzelenmegine bagly etmän beýan 

etmegi niýet edindim. Kitap arkaly öwrenilen tilsimler grafiki programmalaryň 

soňky çykan görnüşlerinde hem öz ähmiýetini ýitirmeýändir. Şol sebäpli, kitabyň 

dersi talyplara okatmakda ýeterlikçe derejede ýardam berip biljekdigi aýdyňdyr. 

Kitapda üns bermeli zatlaryň biri – bu grafiki programmalaryň iki dilinde 

hem – iňlis hem-de rus dillerindäki görnüşlerinde işlemeklige gönükdirilendigidir. 

Kitabyň ýazgysynyň köp ýerlerinde programmanyň iňlis dilinde görkezilýän 

buýruklarynyň, menýularyň gapdalynda rus dilindäki programmalardaky 

buýruklaryň, menýularyň ýazgylary ýaýyň içinde rus dilinde getirilendir. 

Kitap kompýuter tehnologiýasy ugrunda işleýänler we okaýanlar üçin hem 

niýetlenen bolsa, ondan başga höwesjeň adamlar hem peýdalanyp bilner. 
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GRAFIKA BARADA DÜŞÜNJE 
 

Kompýuter tilsimatynyň 90-njy ýyllarda giňden ýaýramagy kompýuterde 

ulanylýan programma üpjünçiligine ägirt uly itergi berdi. Şol ýyllarda penjireli 

operasion ulgamlaryň giňden ulanyp başlanylýar. Kompýuteriň tehniki taýdan 

düzüminde uly üýtgemeler bolup geçýär. Kompýuter ondan oňki döwürler diňe 

hasaplama maksady bilen ulanylan bolsa 1490-njy ýyllaryň dowamynda onuň 

niýetlenilişinde düýpgöter özgeriş bolup geçýär. 

Ol özgermeler ilkibaşda kompýuterde grafikanyň, wideo, ses we 

animasiýanyň (hereketlendirilen şekil görnüşleriň) giňden ulanylmagy bilen bagly. 

Grafika kompýuterde alnyp barylýan işleriň arasynda iň göwrümlileriň biri 

bolup durýar. 

Kompýuterde düzülen grafikanyň kagyz ýüzüne çap ediji gurallar (printerler, 

plotterler) arkaly çykarylmagy bu babatdaky işleri has öndümli edýär. 

Windows operasion ulgamynda soňky ýyllarda DirectX programmasy uly 

ähmiýete eýe boldy. Bu programma operasion ulgamyň soňky wersiýalary bilen 

bilelikde hem gurnalýar. Ol ulgamda wideo, grafika, ses, torlar we b. babatda belli 

bir işler ulgamlaýyn işi alyp barýar. Onuň üsti bilen köp nusagalaýyn näsazlyklary 

üýtgedip bolýar, ses gurallaryň ölçeglerini barlap, üýtgedip hem bolýar. 

Kompýuterde grafika bilen işlemek üçin esasan wideoadapteriň hem-de 

operatiw huşuň parametrleri ýokary bolmaly. Sebäbi ýokarda aýdyşymyz ýaly 

grafika maglumaty kompýuterden iň köp resurslary talap edýär. 

Kompýuterleşdirmegiň ägirt uly mümkinçiliklerine düşünmek üçin binagärlik 

çyzgylaryň kompýuter grafikasyny adaty eldeki çyzmaklyk bilen deňeşdirmeklik 

ýeterlikdir: 

- çyzgylaryň kompýuter grafikasy tiz amala aşyrylýar, ýeterlikçe çylşyrymly 

çyzgylary AutoCad programmasy arkaly 2-3 sagatda amala aşyrmak mümkin, 

eldeki çyzmak arkaly bolsa 2-3 gün sarp edilmegi mümkin; 

- kompýuter grafikasy tiz we arassa redaktirlenýär, şol wagtda bolsa ekldeki 

çyzgyny bozguç we galam arkaly redaktirlemek gerek, özem kompýuter grafikasy 

çyzgynyň öňki ýagdaýyny üýtgetmezden öň ýatda saklamagy mümkin edýär, 

sebäbi şol çyzgy soňra gerek bolmagy ähtimal, eldeki çyzgyda bolsa öňki ýagdaýa 

çyzgyny getirmek üçin ýene-de bozguç we galam bilen işlemek gerek bolar; 

- kompýuter grafikasy adamyň özi bolmazdan şol bir suratyň ägirt köp sanly 

nusgasyny çap ediji gurluşlar arkaly tiz wagtda çap etmegi mümkin edýär, şol 

wagtda bolsa eldeki çyzmada bu wagtyň örän köp mukdaryny we adamlaryň köp 

sanyny (nusganyň sanyna deň bolmagy mümkin) talap etmegi mümkin, özem 

kompýuter grafikasynda hemme nusgalaryň hili deň bolar, eldeki çyzgylaryňky 

bolsa olary çyzan adama abgly bolar; 

- kompýuter grafikasynyň çyzgylary köp mukdarda ykjam göterijilerde 

(disklerde, fleş-huşda, gaty disklerde) saklanylýar, eldeki çyzgylaryň şol 

mukdaryny saklamak üçin bolsa aýry otaglar, binalar gerk bolmagy mümkin. 
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Häzirki wagtda grafika boýunça kompýuterde birnäçe programmalar 

niýetlenen. 

Olar: Photoshop, Cotrel Draw, AutoCAD we b. Bu programmalryň hemmesi  

belli bir derejede biri-birini gaýtalaýar, emma olaryň öz spesifiki niýetlenilişi hem 

bar. 

Kompýuterde grafiki obýektleri döretmek we saklamak iki usul arkaly 

mümkindir – rastr ýa-da wektor şekil görnüşinde. Her şekiliň kysymy üçin öz 

kodirleme usuly bar. 

Rastr şekili – ony monitoryň ekranynda görkezmek üçin ulanylýan 

nokatlaryň toplumyna aýdylýar. Rstr şekiliň ölçegi nokatlaryň mukdarynyň bir 

nokadyň maglumat göwrümine köpeltmek arkaly kesgitlenýär, ol maglumat 

göwrümi bolsa mümkin bolan reňkleriň sanyna baglydyr. Gara-ak şekil üçin 

nokadyň maglumat göwrümi 1 bite deň. sebäbi ol ýa gara, ýa-da ak bolup biler, 

ony bolsa iki san bilen kodirlemek bolar – 0 we 1. 

Reňkli nokady görkezmek üçin näçe bit gerek bolmagy mümkin 8 reňk üçin 

– 3 bit, 16 reňk üçin – 4 bit, 256 reňk üçin – 8 bit (1 baýt). Aşaky jetwelde 16 

reňkden ybarat bolan reňk palitrasynyň kodirlenmegi görkezilen. Dürli reňkler we 

olaryň öwüşgini üç esasy reňkiň (gyzyl, gök, ýaşyl) ýoklugynyň ýa-da bolmagynyň 

we olaryň ýagtylygynyň hasabyna emele gelýär. Ekrandaky her bir nokat  4 bit 

arkaly kodirlenýär. 

 

Reňk Ýagtylyk Gyzyl Ýaşyl Gök 

Gara 0 0 0 0 

Gök 0 0 0 1 

Ýaşyl 0 0 1 0 

Mawy 0 0 1 1 

Gyzyl 0 1 0 1 

Benewşe 0 1 0 0 

Goňur 0 1 1 1 

Ak 0 1 1 0 

Çal 1 0 0 1 

Açyk gök 1 0 0 0 

Açyk ýaşyl 1 0 1 1 

Açyk mawy 1 0 1 0 

Açyk gyzyl 1 1 0 1 

Açyk benewşe 1 1 0 0 

Sary 1 1 1 1 

Ýiti ak 1 1 1 0 

 

Wektor şekili elementar kesimlerden we ýaý halkalardan düzülen grafiki 

obýekt görnüşinde bolýar. 

Şol elementar obýektleriň ýerleşişi nokatlaryň koordinatlary we radiusyň 

uzynlygy bilen kesgitlenýär. Her bir çyzyk üçin  onuň kysymy (tutuş, punktir, 
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ştrih-punktirli), galyňlygy we reňki. Wektor şekili baradaky maglumat adaty harp-

san  görnçüşinde kodirlenýär we ýörite programmalar arkaly işlenip bejerilýär. 

Soňky wagt fraktal grafika diýen düşünje emele gelip başlady. Ol edil 

wektor grafikasy ýaly matematiki hasaplamalarda esaslanan. Emma fraktal 

grafikanyň binýan parçasy hökmünde  matematiki formulanyň özi bolup durýar, 

ýagny kompýuteriň huşunda hiç hili obýekt saklanylmaýar we şekil diňe 

deňlemeler arkaly gurulýar. Şeýle usul arkaly hemä ýönekeý wagtal-wagtal 

düzümleri, hem-de tebigy landşaftlary we üçölçegli obýektlere meňzetme döredýän 

çylşyrymly suratlary gurýarlar. 

Umumy reňk barada gürrüň edilende fizika gaýdyp gelmeli. Hemme reňkler 

ýagtylygyň görünýän spektrinde ýerleşendir (nm). 

Benewşe 400-450, gök 450-480, mawy 480-510, ýaşyl 510-550, sary-ýaşyl 

550-575, sary 575-585, narynç 585-620, gyzyl 620-700. 

Kompýuter grafiksasynda reňk ygtyýary (beýleki reňki çuňlugy) düşünjesini 

girizýärler, Ol reňk maglumatyny kodirlemeginiň usulyny kesgitleýär. Gara-ak 

şekili görkezmek üçin bir bit ýeterli, Sekizrazrýadly kodirleme  reňkli tonuň 256 

gradasiýasyny görkezmegi mümkin edýär. İkı baýt (16 bit) 65536 öwüşgini 

kesgitleýär (bu düzgüni High Color). 24 razrýadly kodirleme usulynda 16,5 mln 

reňkleri kesgitlemek mümkin (True Color). 

Tejribe taýdan  monitoryň reňk ygtyýaryna reňk tutumy diýen düşünje 

golaý. Oňa ol ýa-da başga çykyş gural arkaly (monitor,  printer, cap maşyny we b.) 

çykaryp boljak reňkleriň çägine düşünilýär. Şekili additiw we subtraktiw usullar 

arkaly döretmegiň düzgünlerine laýyklykda  reňk öwüşgini düzüm komponentlere 

bölmekligiň usullary işlenip düzüldi, oalar reňk modeller diýip aýdylýar. 

Şu ýerde biz reňk modelleri barada aýdyp geçeliň 

CIE Lab modeli 

1920-nji ýylda CIE Lab giňişlik modeli döredildi (Communications 

Internationale de l’ Eclairage – yşyklandyryş boýunça halkara iş topary. L, a,b – bu 

ulgamda koordinatalary belligi). Ulgam apparata taýdan garaşsyz bolup durýarwe 

şol sebäpli gurallaryň arasynda maglumatlar geçirilende ulanylýar. Bu modelde 

islendik reňk ýagtylygy (L) we hromatiki düzüm bölekler bilen kesgitlenýär: 

a parametri – ýaşyldan  gyzyla çenli çäkde üýtgeýär, b – gökden sara çenli. 

CIE Lab modeliniň reňk tutumy  monitorlaryň we çap ediji gurallaryň 

mümkinçiliklerinden ep-esli ýokary gemçýär, şol sebäpli ony çykarmazdan öň 

özgertmeli bolýar. Bu model reňk fotohimiki proseslerini poligrafiýa prosesleri 

bilen ylalaşdyrmak üçin döredildi. Häzirki wagtda ola Adobe Photoshop 

programmasy üçin deslapdan alynan standart hökmünde çykyş edýär. 

RGB modeli 

RGB modeli additiw bolýar, ýagny islendik reňk özi bilen esasy üç reňkiň 

gyzyl (Red), ýaşyl (Green) we gök (Blue) reňkleriň dürli derejedäki utgaşygy 

bolup durýar. Ol elektron taýdan görkezilmek üçin (monitorda, telewizorda) 

niýetlenen kompýuter grafikasy döredilende we işlenende esas bolup durýar. Esasy 

reňkiň bir komponenti  beýlekiň üstüne düşende jemi şöhlelenmegiň ýagtylygy 

güýçlenýär. Üç komponentiň utgaşmagy ahromatiki çal reňki berýär, onuň 
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ýagtylygy  ýokarlanda ak reňke golaýlaýar. 256 gradasiýa derejesinde gara reňke 

nol ähmiýetler, ak reňke bolsa 255 ähmoiýetler degişli. 

 

HSB modeli 

HSB reňk modeli adam tarapyndan reňki duýgurlamagyň aýratynlyklaryny 

iň ýokary derejede hasaba almak bilen işlenip döredildi. Reňk üç komponent bilen 

teswirlenýär: öwüşgini (Hue), doýgunlygy (Saturation), we ýagtylygy (Brightness). 

Reňkiň ähmiýeti  tegelegiň merkezinden çykýan wektor hökmünde saýlanýar. 

Merkezdäki nokat ak reňke gabat gelýär. tegelegiň perimetrindäki nokatlar bolsa 

arassa spektral reňklere. Wektoryň ugry gradusda berilýär we reňk öwüşgini 

kesgitleýär. Wektoryň uzynlygy doýgunnlygy kesgitleýär. Ahromatiki diýlip 

atlandyrylýan aýry okda ýagtylyk bellenilýär, özem nol nokady gara reňke gabat 

gelýär. HSB modeliniň reňk tutumy hakyky reňkleriň hemme ähmiýetlerini ýapýar. 

HSB modeli suratkeşleriň işini meňzetme bilen kompýuterde döreilýän 

şekillerde ulanmaklyk amatly. Şekil döredilenden soň ony çap etmegiň usulyna 

baglylykda başga reňk modeline özgertmeklik maslahat berilýär. 

CMYK reňk modeli 

CMYK modeli subtraktiw bolup durýar we ony publikasiýalar çapa 

taýýarlannada ulanýarlar. Modeliň reňk komponentleri bolup ak reňkden esasy 

reňkleriň aýrylmagy esasynda alnan reňkler bolýar: 

mawy (cyan) = ak – gyzyl = ýaşyl + gök 

gyrmyzy (magenta) = ak – ýaşyl = gyzyl + gök 

sary (ýellow) = ak – gök = gyzyl + ýaşyl 

Mawy, gyrymzy we sary reňkleri goşmaça bolup atlandyrylýarlar, sebäbi 

olar esasy reňkleri ak reňke çenli goşdurýarlar. Şu ýerden CMY modeliniň esasy 

kynçylygy  - goşmaça reňkleriň biri-biriniň üstüne düşmegi tejribede arassa gara 

reňki bermeýär. Şol sebäpli reňk modeline arassa gara reňkiň komponenti goşuldy. 

Abrewiaturada 4-nji harp emele geldi CMYK (Cyan, Magenta, Yellow, blacK). 

 

Tejribe işleri 

 

1) Ekranyň rugsadyny 1024x768 derejä goýmak 

2) Reňk ibermegiň ýagdaýyny 32 bit etmek 

3) Ekranyň rugsadyny 800x600 derejä goýmak 

4) Reňk ibermegiň ýagdaýyny 16 bit etmek 

5) Ekranyň çalyşmagynyň ýygylygyny 75 Gh edip goýmak 

6) Iş meýdanynyňsuratyny çalyşmak 

7) Iş meýdanynyň dynç alyş zastawkasyny çalşyrmak 

8) Ekranyň çalyşmagynyň ýygylygyny 60 Gh edip goýmak 

9) Iş meýdanyň bezegini çalşyrmak 

Ekranyň çalyşmagynyň ýygylygyny 85 Gh edip goýmak 
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PHOTOSHOP PROGRAMMASYNA GIRIŞ. 
 

Photoshop maksatnamasy çyzgy redaktory bolmak bilen ol, esasan, çyzgy 

elementleriň, suratlaryň, çyzgylaryň üstünde işlemeklige niýetlenendir. Bu 

maksatnama arkaly surat çekmekligiň esasy tilsimlerine, suratlary sazlamaklygyň 

ýollaryna, suratlara reňk bermekligiň elementlerine seretmek maksada laýykdyr. 

Şeýle hem maksatnama arkaly suratlardan bölüp almak serişdelerine, konturara 

kanallara, gatlaklara, süzgüçlere we suratlaryň üstünde geçirilýän amallara 

seretmeli. 

Her bir çyzgy redaktoryň özüne degişli işçi meýdany bolýar. Photoshop 

maksatnamasynyň işçi meýdany Windows operasion ulgamynyň beýleki 

programmalarynyň penjirelerine meňzeşdir. 

Penjiräniň adyny we ulgamlaýyn üç nokat ýerleşýän zolagyň aşagynda 

menýu setiri ýerleşýär. 

Menýu setiri adatça şu bölümlerden ybarat: 

File (Файл) -  umuman faýllary açmak, täzesini döretmek, ýatda saklamak, 

ýerleşdirmek, ýapmak, skanirlemek, importirlemek ýa-da eksportirlemek, çap 

etmek, faýly tor boýunça ibermek, käbir amallary awtomatlaşdyrmak, goşmaça 

programmalar geçmek we Photoshop programmasyndan çykmak üçin ulanylýar. 

Edit (Правка) – menýuda şekili redaktirlemek üçin – göçürip almak, 

göçürilen zady goýmak, transformirlemek, şekiliň reňklerini gaýtadan 

kesgitlemegiň, şeýle hem dürli bezegleri we figuralary döretmek üçin buýruklar 

ýerleşen. Fade (Сглаживание) kömekçi menýunyň buýrugy köp ammalarynyň 

netijesini peseltmäge mümkinçilik berýär (meselem, soňky ulanylan filtriň, belli 

bir gural bilen redaktirlemegiň we çekmegiň buýruklarynyň netijelerini. Purge 

(Очистить) kömekçi menýusynyň buýruklary huşy boşadýar. Photoshop 

programmasy köp ýagdaýda operatiw huşy ulanman emeli döredilen wirtula huşy 

ulanýar. Şol sebäpli programmada köp ýerine ýetirilen amallar ýatda saklanylýar, 

buferde göçürilen zatlar saklanylýar, ýörite döredilen taryhy amallar ýatda 

saklanylýar. Şol kömekçi menýusy şu üç parametri boşadýar. Şeýle hem Edit 

menýusy arkaly Color Settings (Цветовые установки), Preset Manager 

(Инициализация Менеджера) we Preferences (Предпочтения) buýruklaryny 

goýberip bolýar. Has esasy bolup Preferens buýrugy bolup durýar. Ol arkaly taryhy 

amallaryň möçberini, gurallara bolan kömekçi düşündirmeleri, faýllar açylanda, 

ýatda saklanylanda we ýapylanda käbir düşündirmeleri, displeýiň we kursorlaryň 

görnüşlerini, fonuň açyklygyny we gammasyny, ölçeg birlikleri we çyzgyçlary, 

ugrukdyryjylary we torlary we bşgalary dolandyryp we sazlamak bolýar. 

Edit menýusynda käbir buýruklary klawiaturdan goýbermek üçin we olara 

düwmejikleriň utgaşygyny bellemek üçin hem kömekçi menýu bar (Горячие 

клавиши). 

Image (Изображение) - Mode (Режим) kömekçi menýu arkaly şekil 

islendik 8 sany görkezilişe  (şol sanda 4 sany reňk modeline, gara reňk görnüşine 
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we b.) geçirmek mümkin. Adjustments (Регулировки) kömekçi menýunyň 

buýruklary reňkiň tonuny, doýgunlygyny, ýagtylygyny kontrastlygyny üýtgetmäge 

mümkinçilik berýär. Image Size (Размер изображения) menýunyň kömegi arkaly 

faýlyň, şekiliň ölçegini ýa-da rugsadyny üýtgetmek mümkin. Canvas Size (Размер 

холста) gepleşik penjiresi şekiliň ýerleşýän iş meýdanyny üýtgetmeli bolsa 

ulanylýar. Mundan başga hem Image menýusy arkaly holsty islendik tarapa 

islendik burça öwürmek mümkin. 

Layer (Слой) menýusynda ýerleşen buýruklar gatlaklary goşmagy, 

göçürmegi, üýtgetmegi, toparlaşdyrylmagy, birleşdirmegi, baglanana gatlaglaryň 

özara ýerleşişini dolandyrmagy, şekili bir ýeke gatlaga öwürmegi mümkin edýär. 

Bu menýunyň buýruklaryň has çalt ulanylmagyny Layers (Слои). palitrasynyň 

üsti bilen gazanmak mümkin. Gatlak – bu şekilde ýerleşýän özbaşdak işlenilýän, 

üýtgedilmegi beýleki gatlaklara we fona degmeýän we gatlak öçürilenden soňra 

hemme üýtgemeleri ýitýän grafiki bölek. Kä halatlarda gatlak özüni şekil ýaly alyp 

barýar emma gatlagyň üstündäki geometriki amallary transformirlemek buýrugy 

arkaly ýerine ýetirmek gerek. 

Select (Выделить) menýusy belleme amallary ýerine ýetirýär - All (Все) 

buýrugy tutuş gatlagy belläp alýar. Deselect (Снять выделение) öň bellenilen 

hemme gatlaklardan bellemegi aýyrýar. Reselect (Восстановить выделение) 

buýrugy iň soňky gezek Deselect buýrugy ulanylan töweregi gaýtadan belläp alýar. 

Color Range (Цветовой ряд) buýrugy aýratyn penjiräni açyp üýtgeýän ölçege 

görä reňki hasaba almak bilen bellemegi amala aşyrýar. Şol ölçeg 0-dan 200-e 

çenli üýtgeýär. Ölçegiň iň pes ýagdaýynda saýlanylýan reňk sany az, ulaldygyça  

has golaý reňkleriň köp sany bellenip alynýar. Beýleki buýruklar bellenilen çäkleri 

giňeldärler, gysýarlar, uladýarlar, çäkleriniň güýjüni peseldärler şeýle hem 

bellenilen töwerekleri kanallarda saklaýarlar. 

Filter menýusy – bu menýu Photoshop programmasynyň aýratynlygyny has 

doly görkezýär. Bu menýunyň buýruklary arkaly berlen şekili ýa-da onuň 

bellenilen töweregi islendik ýagdaýda çeperçilik, ýagtylyk, plast, tolkun şekiliň 

detallaryny birsydyrgyn üýtgemegi amala aşyrýar. 

View (Вид) menýusynyň Gamut Warning (Предупреждение о гамме) 

buýrugy 4 reňkli çapda çap edilmejek reňkleri görkezýär. Proof Setup 

(Установки пробного отпечатка) kömekçi menýusynyň buýrugy şekil dürli 

düzgünlerde (modellerde) nähili görünjekdigini görkezýär. Beýleki buýruklar 

şekiliň masştabyny dolandyrýar, şeýle hem ekrana çyzgyçlary, koordinata toruny 

çykarýar, kömekçi çyzyklary çykarýar. 

Window menýusy – ekrandaky palitralaryň görkezilişini, şeýle hem açylan 

faýllardan biri-birine geçmekligi amala aşyrýar. 

Photoshop programmasynda belli bir işleri alyp barmakda gurallar paneli uly 

rol oýnaýar. 

Panelde islendik öz çagyryş klawişasy bar. Eger guralyň belgisiniň ýüzünde 

kiçi gara üçburçlyk bar bolsa, onda şol gurallar birnäçe görnüşi bar. Her görnüşi 

klawiaturadan saýlamak üçin Shift dümejik bilen bilelikde guralyň çagyryş 

klawişasyny basmaly. 
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Geometriýa görnüşli töweregi saýlamak üçin gural palitrasy (M) – tegelek 

we göniburçly bellemek guraly. 

Islendik görnüşli töweregi saýlamak üçin palitra (L) – Lasso, Poligonal 

Lasso, Magnetik Lasso, 1-nji belleýän töweregi galam bilen çyzylan ýaly alýar, 2-

nji syçanyň basmagy arkaly nokatlaýyn belleýär, 3-nji şekiliň reňk kontrastlygy 

has köp üýtgeýän bolsa özbaşdak şol töwerekleri aýrybaşgalap belleýär. 

Şekiliň kemçiliklerini düzetmek palitrasy (J) 

Klonlamak gurallaryň palitrasy (S) – çekiji gural arkaly saýlanan töweregiň 

göürmesini çuzup gidýär. 

Pozmak gurallaryň palitrasy (E) (Pozmakdan galan reňk fonuň reňkine görä 

alynýar, fonuň reňki gural panelinde iki reňkli gönübrçuň aşakysynda saýlanylýar, 

gönüburçuň ýokarkysy üýtgetme gurallaryň reňki). 

Şekiliň çäkleriniň dürslüligini sazlaýan gurallaryň palitrasy (R)  

Gönümel saýlap almak gurallaryň palitrasy (A) 

Sudurlar bilen işlemek gurallaryň palitrasy (P) 

Bellikleri döretmek üçin gurallaryň palitrasy (N) – Ýazgy belligi we owaz 

belligi 

Bölekler bilen işlemek gurallaryň palitrasy ( K) 

Surat çekmek gurallaryň palitrasy (B) 

Şekiliň döreýiş taryhy bilen işleýiş palitra (Y) – şekilde rastr taýdan üýtgeme 

bolan töwerekleri faýlyň açylan ýagdaýyndaky görnüşe getirýär 

Reňk doldurma gurallaryň palitrasy (G) – Şekili gradiýent ýa-da islendik bir 

reňk bilen doldurýar 

Şekilleri ýagtylandyrmak we garamtyl etmek gurallaryň palitrasy (O) 

Tekst bilen işlemek gurallaryň palitrasy (T) – keseleýin we dikleýin tekst 

ýazmak üçin, tekst maskalaryny döretmek üçin 

Çekmegiň wektor gurallaryň paneli (U) – çyzyk, dörtburçluk, tegelek, ellips, 

köpburçluklary we islendik görnüşli figuralar.  

Reňk, burçlar we aralyklar bilen işleýiş paneli (I) – şekiliň töweregindäki 

islendik reňki saýlap almak, birnäçe reňkleri belläp goýmak we şekilde burçlary 

we aralyklary ölçemek gurallary. 

 

Tejribe işleri 

Faýllary bir formatdan başga geçirmek üçin File menýusyndan Save As 

bendi saýlamaly we faýlyň adynyň aşagynda duran setirde şekiliň degişli 

formadyny kesgitlemeli. Soňra şekiliň hilini görkezmeli we her formata degişli 

parametrleri sazlamaly. 

Ýumuşlar: 

1) BMP formaty JPG formata geçirmek 

2) JPG formaty TIFF formata geçirmek 

3) TIFF formaty PSD formata geçirmek 

4) JPG formaty BMP formata geçirmek 

5) TIFF formaty BMP formata geçirmek 

6) BMP formaty TIFF formata geçirmek 

7) BMP formaty PSD formata geçirmek 
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8) PSD formaty TIFF formata geçirmek 

9) JPG formaty PSD formata geçirmek 

PSD formaty JPG formata geçirmek 

 

ŞEKİLLER WE İŞ MEÝDANY BİLEN İŞLEMEK. 
 

Photoshop programmasynyň iş meýdany menýudan we guralar panelinden 

başga şekiller bilen işlemek üçin palitralar we gurallaryň opsiýalarynyň panelleri 

bar. Soňkusy ol ýa-da başga gural saýlanyp alynanda üýtgeýär. Mysal üçin (Brush) 

kist saýlanyp alynanda kistiň ölçegi, görnüşi, garyşyk düzgüni, açyk däldigi we 

akymlygy görkezilýär. 

Düzgün opsiýasy köp gurallarda duş gelýär ol şulardan ybarat: 

Normal (Норма) – hemme baza reňkler üýtgedilýär. 

Dissolve (Растворение) – hek ýaly, gury tekstura döredilýär, surat çekiş 

ýa-da garyşma reňke eýe bolýar. Açyk däldigiň we akymyň ölçegleri näçe ýokary 

bolsa şonça hem kistiň mazogy gaty bolýar. 

Behind (Задний) – gatlaklar üçin elýeterli däl. Diňe açyk töwerekler 

üýtgediler.Edil arassa asetat matanyň ters tarapynda surat çekilen ýaly bolýar. 

Emma ony fon üçin ulanmak bolmaýar. 

Clear (Очистка) – Gatlaklar üçin elýeterli däl. Ştrihler ýerleşen ýerine baza 

reňki açyk bolýar. Bu düzgüni Paint Bucket (Ведро с краской), Line (Линия) 

Fill Region (Залить область) basylan bolsa ýa-da Fill (Залить), Stroke 

(Очертить), Fill Path (Залить контур) we Stroke Path (Очертить контур) 

buýruklary ulanylanda diňe köp gatlakly şekile ulanmak mümkin. Bu düzgüni fona 

ulanyp bolmaýar 

Darken (Темнее) – surat çekiş ýa-da garyşyk gatlagyň reňkinden açyk baza 

reňkler üýtgär, beýleki reňkler üýtgemez. Eger surat çekiş reňki üýtgetjek bolýan 

reňkinde garamtyl bolsa ulanyp bilersiňiz. 

Multiply (Умножение) – Surat çekiş ýa-da garyşyk gatlagyň garamtyl 

reňki baza reňkiň has açyk töwereklerini garamtylamak netijesini bermek üçin 

çalşyrýar. Surat çekiş ýa-da garyşyk gatlagyň açyk reňki hem baza reňkini 

garamtylaýar, ýöne kän güýçli däl. Ýarym açyk kölegeleri döretmek üçin örän 

peýdaly düzgün. 

Color Burn (Затемнение цвета) - Surat çekiş ýa-da garyşyk gatlagyň 

garamtyl reňki baza reňkini garamtylaýar, eger ol açyk bolsa onda baza reňki 

birnäçe ýagtylandyrylar. 

Linear Burn (Линейное горение) -  çyzyklaýyn şekili garamtylaýar. 

Lighten (Светлее) - surat çekiş ýa-da garyşyk gatlagyň reňkinden garamtyl 

baza reňkler üýtgär, beýleki reňkler üýtgemez. Eger surat çekiş reňki üýtgetjek 

bolýan reňkinden açyk bolsa ulanyp bilersiňiz. 

Screen (Экран) - Surat çekiş ýa-da garyşyk gatlagyň açyk reňki baza reňkiň 

has garamtyl töwereklerini çalşyrýar, şeýlelik bilen has açyk, reňksizlenen baza 

reňki emele gelýär. Surat çekiş ýa-da garyşyk gatlagyň garamtyl reňki hem baza 

reňkini ýagtyladýar, ýöne kän güýçli däl. 
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Color Dodge (Остветление цвета) - Surat çekiş ýa-da garyşyk gatlagyň 

açyk reňki baza reňkini ýagtyladýar, eger ol garamtyl bolsa onda baza reňki 

birnäçe ýagtylandyrylar. 

Linear Dodge (Линейный сдвиг) - çyzyklaýyn şekili ýagtylandyrýar. 

Overlay (Перекрытие) – baza reňkiň garamtyl töwerekleri ýagtylanýar we 

açyk ýerleri garamtylanýar. Gara we ak reňkleri üýtgemeýär, şonuň üçin şekilde 

hemme detallar saklanylýar. 

Soft Light (Мягкий цвет) – Eger surat çekiş ýa-da garyşyk gatlagyň reňki 

açyk bolsa baza reňki ýagtylanýar, eger garamtyl bolsa baza reňki garamtylanýar. 

Şonda baza reňkiniň ýagtylyk ölçegleri saklanylýar. Bu düzgün ulanylanda 

ýumşak, çala bildirýän ýagtylandyryş netijesi amala aşyrylýar. 

Hard light (Жесткий цвет) – Eger surat çekiş ýa-da garyşyk gatlagyň 

reňki açyk bolsa baza reňki reňsizlenýär we eger garamtyl bolsa baza reňki 

garalanýar. Baza reňkiň we gatlagyň arasynda kontrast artýar. Blikler we 

ylşyrymly effektler döredilende örän gowy gural. 

Vivid light (Яркий цвет) – şekili reňke görä ýagtylan ýerleri belleýär 

Linear light (Линейный цвет) – çyzyklaýyn reňke görä baza reňki 

üýtgedýär 

Pin light (Точечный цвет) – baza reňkiň reňkine surat çekiş ýa-da 

garyşyk gatlagyň reňkini goşýar. 

Difference (Разница) – baza reňki üçin negatiw effektini döredýär. Eger 

surat çekiş ýa-da garyşyk gatlagyň reňki açyk bolsa, onda negatiw effekti has 

anykly bolar 

Exclusion (Исключение) - surat çekiş ýa-da garyşyk gatlagyň reňki 

garamtyl bolan ýerlerde baza reňki çal bolýar, reňkler açyk bolan ýerlerde bolsa 

baza reňki inwertirlenýär. 

Hue (Оттенок) – reňkiň tony garyşyk gatlagyndan alynýar. Baza reňkiniň 

ýagtylygy we doýgunlygy şonda üýtgemeýär. 

Saturation (Насыщение) – reňkiň doýgunlygy garyşyk gatlagyndan 

alynýar. Şonda baza reňkiniň tony we ýagtylygy üýtgemeýär.  

Color (Цвет) – garyşyk gatlagyň tony we doýgunlygy ulanylýar. Baza 

reňkiniň ýagtylygy üýtgemeýär. Şekili ýeňil reňklemek üçin amatly düzgün. 

Luminosity (Яркость) – Baza reňkiniň ýagtylygynyň ähmiýeti surat çekiş 

ýa-da garyşyk gatlagyň reňkiniň ýagtylygynyň ähmiýetleri bilen çalşyrylýar. Şonda 

baza reňkiniň tony we doýgunlygy üýtgemeýär. 

 

Photoshop programmasynda ýerine ýetirilýän amallaryň köpüsi palitralar 

arkaly ýerine ýetirilýär. 

Color (Цвет) palitrasy reňkleri garmak we saýlamak üçin ulanylýar. 

Gurallar panelinde ýerleşen esasy we fon reňkiniň inedördüline basyp Color 

Picker (Выбор цвета) panelini çykaryp bolýar. Bu ýerde reňkiň giň spektri 

modeller e baglylykda ýerleşen. 

Swatches (Образцы) – taýyn nusgalar saýlanylan bolanda ulanylýar. 

Styles (Стили) öň kesgitlenen we ýatda saklanylan effektleri we olaryň 

utgaşmasyny peýdalanmak üçin ulanylýar. 
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Navigator (Навигация) – şekiliň görünýän parçasyny saýlap şol parçanyň 

masştabyny üýtgedip bolýar. 

Info (Информация) palitrasynda kursoryň görkezýän pikseliň reňk 

komponentleri görkezilýär. Mundan başga hem bu ýerde kursoryň x we y 

koordinatalary görkezilen. Bu ýerde başga maglumatlar hem görkezilip bilner, 

belleýiş ýa-da Measure (Измеритель) guraly ulanylanda, transformasiýada. Şol 

parametrler üçin birlik ölçeglerini şol palitranyň ýokarsynyň sag tarapynda gök 

üçburçluga basyp goýmak mümkin. Şol üçburçluk beýleki palitralarda hem bar we 

käbir sazlamalary elýeterli etmegi mümkin edýär. 

Eger reňkiň ýanynda ýüzlenme belgisi duran bolsa onda ol CMYK 

modeliniň daşyna çykýar we çapda öz öwüşgini üýtgeder. 

Layers (Слой) – fonuň üstünde ýerleşen gatlaklary döretmegi, aýyrmagy, 

goşmagy, görkezmegi/bukmagy, göçürmegi, toparlaşdyrmagy, baglaşdyrmagy we 

ýerleşmeginiň yzygiderligini üýtgetmegi mümkin edýär. Her gatlaga öz garyşyk 

düzgüni we açyklyk derejesi degişli bolup biler. Standart gatlakdan başga 

Photoshop programmasynda: düzediji gatlagy (adjustment layer) we tekst gatlagy 

döredip bolýar. 

Channels (Каналы) palitrasynda şekili düzýän bir ýa-da birnäçe kanallar 

görkezilýär, mundan başga hem bu palitra arkaly bellenilen töwerekleri ýatda 

saklamak üçin alfa-kanallary döredip bolýar. 

Paths (Контуры) palitrasy ulanylan sudurlar bilen işlemekligi üpjün edýär. 

History (История) palitrasy arkaly saýlap bir ýa-da birnäçe amallary 

ýatyrmak bolýar. Eger şu palitranyň sazlanýan ýerine çyzykly däl ölçege rugsat 

berilmedik bolsa onda has irki amal ýatyrylandan soň ondan soňky amallar 

awtomatiki aýrylýar, eger rugsat berilen bolsa onda ýitmeýär we diňe şol amal 

ýatyrylýar. Bu sazlama History Options (Опции палитры History) penjiresinde 

Allow Non-Linear History (Разрешить нелинейность событий) baýdajygyň 

bolmagy ýa-da aýrylmagy arkaly amala aşyrylýar. 

Bu palitra goşmaça bolup History brush (Кисть историческая) gabat gelýär. 

Palitrada şu guralyň belgisi şekiliň açylan ýagdaýynyň gapdalynda durýar. Şol 

sebäpli kist bilen işlenende onuň degen ýerleri şekili açylan wagtynyň ýagdaýyna 

getirýär. Eger şol belgini haýsy-da bolsa bir ýerine ýetirilen amalyň gapdalynda 

goýulsa onda kist şol amalyň ýagdaýyna görä hemme zady yza gaýtarar. Art 

History Brush (Художественная восстанавливающая кисть) edil şol hereketleri 

gaýtalaýar emma belli bir çeperçilik stili ulanyp ýerine ýetirýär. 

Actions (Действия) palitrasynyň esasy wezipesi bolup şekilleri işläp 

bejermegiň awtomatlaşdyrylmagy bolup durýar. Buýruklaryň yzygiderligini ýazyp, 

ony bir şekile ýa-da şekilleriň toparyna ulanmak mümkin, şeýle hem Actions 

palitrasy belli bir hereket etmek üçin “tiz” klawişalary elýeterligi belläp we alyp 

bilýär. 

Character (Шрифт) -  palitrasy teksti ýazmagyň düzgünini belleýär, şriftiň 

häsiýetnamalaryny mundan başga hem gurallar paneliniň Туре (Текст) guralynyň 

opsiýalar paneli arkaly hem belläp bolar. 

Paragraph (Абзац) palitrasy tekstiň abzaslaryna kesgitli häsiýetnamalary 

we b ulandyryp bilýär. 
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Photoshop programmasynda iş meýdanyny amatly etmek maksady bilen 

palitralary we panelleri wagtlaýyn aýyrmak we yzyna getirmek ýola goýlan. Tab 

düwmejigi arkaly ekranda menýudan we şekilden başga zady aýyryp bolýar. Shift 

we Tab düwmejikleriň utgaşykda basylmagy mundan başga hem gurallar panelini 

ekranda saklap galýar. 

Palitralaryň we panelleriň depesinde gök zolaga syçanjyk bilen basylanda 

şol gök zolaklaryndan başga töweregi ýitýär, şol zolaga ýene bir gezek basyp 

paneli gaýtaryp bolýar. 

Eger palitralar doly aýrylan bolsa olary Window menýusy arkaly gaýtaryp 

bolýar. 

Programmada birnäçe şekil açylan ýagdaýynda biri-birinden geçmek üçin 

CTRL we Tab düwmejikleri ulanmak gerek. 

Photoshop programmasynda şekil ilkibaşda açylanda (täze faýl döredilende) 

gepleşik penjiresi çykýar. Ol ýerde dörediljek şekiliň ölçegleri bellenilýär. 

Ölçegleriň gapdalynda birlikleri saýlap bolýar. Şol penjire arkaly şekiliň ulanjak 

modelini, rugsadyny, her kanala bolan bit ölçenilen huşy, fonuň reňkini we bň 

belläp bolar. 

Şekil bilen işlemekde uly orny Image menýusy oýnaýar. Bu menýu arkaly 

şekiliň ölçeglerini, şekiliň oturan holstunyň ölçeglerini goýmak mümkin. Holstuň 

ölçegleri goýulanda Canvas Size (Размер холста) gepleşik penjiresinde her 

tarapyna üçly çyzyklar goýberilen inedördüliň çyzgysy bar. Syçanjyk bilen bilen 

haýsy-da bolsa üçly çyzyga basylanda ol ýitýär we holstuň artmagyny ýa-da 

kiçelmegini garşyky tarap ugrunda bolmagyny belleýär. Soňra ini we beýikligi 

parametrinde olaryň ähmiýetleri üýtgedilýär. Meselem beýikligi 26sm we ini 5 sm 

şekiliň holstunyň ölçegini üýtgetmek maksady bilen Siz şol gepleşik penjiresini 

açsaňyz we ýokarky üçly çyzyga basyp beýikligiň 26 sm bolan ähmiýetini 30 edip 

ýazsaňyz, onda netijede şekiliň aşagydan 4 sm boş ýer goşular. Onuň fonunyň 

reňki gurallar panelinde öň belenilen fon reňkine gabat geler. 

Şekiliň ölçegi üýtgedilende şekiliň eger prporsiýalar saklanylmaly baýdajyk 

goýlan bolsa, onda iniň ýa-da beýikligiň üýtgedilmegi beýleki ölçegiň awtomatiki 

üýtgedilmegine getirer, mundan başga hem rugsady hem üýtgedip bolýar. Şekil 

çap üçin ulanylanda 300 dpi has amatly bolýar, sebäbi ol adaty çapyň rugsady. 

Şekili öwürip hem bolýar. Eger ony 90 we ol esseleýin burça dälde başga 

islendik burça öwürmek gerek bolsa, onda şol ýerde islendik burça öwürmek 

buýruga basyp, sagat ugry (CW) ýa-da sagat ugruna garşy (CCW) baýdajyklary 

saýlap burçuň ähmiýetini girizýäris.  

Mundan başga hem şekiliň eýýam goýlan reňk düzgüni üýtgedip bolýar we 

reňk häsiýetnamalaryny belläp bolar. 

Islendik şekili Photoshop-da 12-den gowrak formatlarda döredip, açyp, 

redaktirläp we ýatda saklap bolýar. Ýöne adatça diňe birnäçe formatlar ulanylýar: 

TIFF, GIF, JPEG, EPS we Photoshop programmasynyň öz formaty. 

Photoshop programmasynyň şonça formatlary işläp bilýändigi sebäpli onuň 

üçin şekili islendik çeşmeden: skanerden, grafiki redaktordan, kompakt-diskden, 
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fotosuratdan, wideoşekilden eýsem beýleki operasion ulgamlaryndan. Şeýle hem 

şekil doly Photoshop programmasynyň özünde döredilip bilner. 

 

Programmada skanirlemek File > Import > Twain_32 (Файл > Импорт > 

Twain_32) ýol arkaly amala aşyrylýar. 

Skanirlemekde esasy meselesi bolup şekiliň reňk görnüşi. Eger gara-ak, 

ýarym ton we reňkli şekil gerek bolsa bu ölçegler Skaner gepleşik penjiresinde 

görkezilýär. Skaneriň rugsady düýma bolan pikselde ölçenýär (dpi) Resolution 

(Разрешение) parametri bilen kesgitlenýär – rugsat näçe ýokary bolsa, şonça hem 

nokatlaryň sany köp. Faýlyň göwrümi bu ýagdaýda hem uly bolar.  

Tejribe suratlary skanirlemek üçin amatly bolup 200-300 dpi, poligrafiýa 

nusgalar üçin — 600 dpi.  

Şekilleriň ölçegleri saýlanan reňk düzgüne baglylykda hem üýtgeýär. 

Meselem her reňk modeliň kanallary bar. Her kanala 8 ýa-da 16 bit goýberilýär. 

Näçe kanal sany köp bolsa şonça hem şekiliň faýlynyň ölçegi uly bolýar. Meselem 

4 kanaly bolan CMYK düzügünli faýl iň uly bolýar. Gara-ak reňkli şekiliň 

göwrümi pes bolýar. RGB modeliň 3 kanaly bar, CIE Lab we HSB modelleriň hem 

3 kanaly bar. 

Her şekilde belli bir effektler bellenilýär. Photoshop, Advanced TIFF we 

Photoshop PDF – aşakdaky elementler saklanylýan ýeke-täk formatlar:  

 birnäçe gatlaklar we gatlagyň açyklygy;  

 düzediji gatlaklar;  

 redaktirlenýän tekst gatlaklary;  

 gatlagyň effektleri;  

 torlar we ugrukdyryjy çyzyklar;  

 reňki dolandyryş ulgamynyň ICC-profilleri (PICT, JPEG, DCS we EPS 

formatlarda hem profiller saklanylýar);  

 Lab şekiliň düzgüni (EPS we DCS formatlarda hem bu düzgün saklanylýar). 

 

Şekiller skanirlenenden soň öz asyl nusgalaryna garanyňda örän pes hil bilen 

tapawutlanýar. Bu näsazlyklary düzetmek üçin Photoshop programmasy Image 

(Изображение) menýusynyň Adjustments (Регулировки) kömekçi menýusynyň 

Регулировки, Баланс цветов we Яркость контраст atly gepleşik penjireleri 

arkaly ol kemçilikleri düzetmegi mümkin edýär. 

Skanirlenen materialyň däneliligini peseltmek üçin Filter > Blur > 

Gaussian Blur (Фильтр > Размытие > Размытие по Гауссу) menýunyň 

buýrugyny uly bolmadyk rugsat bilen (1-den pes) ulanyň soňra 1 ýa-da 2 gezek 

Filter > Sharpen > Sharpen Edges (Фильтр > Резкость > Резкость контуров) 

buýrugyny peýdalanyň. 

 

Serediş masştabyny üýtgetmek üçin “tiz” düwmejigi 
    

 Amal  «Tiz» düwmejikler  

 Ulaltmak (penjiräniň ölçeglerini 

üýtgetmezden)  

Сtrl+«+»   
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 Kiçeltmek (penjiräniň ölçeglerini 

üýtgetmezden)   

Сtrl+«-»   

 Ulaltmak (penjiräniň ölçeglerini 

üýtgedip)   

Ctrl+Alt+«+»   

 Kiçeltmek (penjiräniň ölçeglerini 

üýtgedip)   

Сtrl+АН+«-»   

 Actual pixels / 100% masştab Ctrl+Alt+О (nol)   

 Ekranyň ölçegi boýunça getirmek  Ctrl+О (nol)  

 Başga gural ulanan wagty ulatmak Ctrl+ “probel”  

 Başga gural ulanan wagty ulatmak Alt+ “probel”  

 

Rastr şekilleri 

Ekrana çykarylanda şekiliň ölçeglerini pikselde üýtgetmek  

1. Image > Image Size (Изображение > Размер изображения) menýunyň 

buýrugyny saýlaň.  

2. Resample Image (Отслеживать изменения) baýdajyk durandygyna göz 

ýetiriňустановлен.  

3. Iniň we beýikligiň özara gatnaşygyny saklamak üçin Constrain Proportions 

(Сохранять пропорции) baýdajygy aýyrmaň.  

4. 72 ppi rugsady deň edip goýuň.  

5. Pixel Dimensions (Размеры в пикселах) toparynyň : Width (Ширина) 

we/ýa-da Height (Высота) parametrleriniň täze ähmiýetlerini girizmeli.  

6. ОК düwmejigine basyň. 

 

Çapa çykarylanda şekiliň ölçeglerini üýtgetmek 

1. Image > Image Size (Изображение > Размер изображения) menýunyň 

buýrugyny saýlamaly 

2. Document Size (Размер документа) böleginde ýerleşen Width (Ширина) 

we Height (Высота) meýdanlarynyň özi çykýan menýulardan, ölçeg 

birlikleri saýlamaly.  
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3. Width (Ширина) we Height (Высота) meýdanlaryna täze ähmiýetleri 

giriziň. Resample Image (Отслеживать изменения) baýdajyk goýulmadyk 

bolsa, rugsat üýtgemez.  

4. ОК düwmejigine basmaly. 

 

Rugsady üýtgetmek üçin şol penjiräniň Resolution (Разрешение) 

meýdanynda täze ähmiýeti girizmeli. Näçe rugsat ulaldylsa, şonça hem şekiliň 

ýitiligi peselýär. Ony düzetmek üçin Filter (Фильтр) menýunyň Unsharp Mask 

(Нечеткая маска) buýrugy ulanmaly. 

Filtriň şeýle parametrlerini görkezmek mümkin: ýitiligiň derejesini Amount 

(Количество) parametri arkaly ýokarlandyrmaklyk; kontrasty ulalýan her bir 

nokadyň töwereginde  üýtgeýän gurşawa alýan pikselleriň sany (Radius (Радиус) 

parametri); şeýle hem filtriň haýsy nokatlary täsuir etjekdigini we etmejekdigini 

bar bolan kontrastyň iň pes derejesini görkezmek bilen kesgitlemek (Threshold 

(kesgitlemek) 

Radiusyň ähmiýeti näçe ýokary bolsa, şonça hem Amount parametriň 

ähmiýeti pes bolup biler we tersine. Eger Threshold (Порог) ähmiýeti artdyrylsa,  

Amount (Количество)  we Radius (Радиус) parametrleri ýokarlandyryp bolýar. 

Fit Image (Подогнать изображение) buýrugy şekiliň rugsadyna täsir 

etmeýär, diňe onuň fiziki ölçeglerine. Eger şekili kiçeltjek bolsaňyz bu buýrukdan 

peýdalanyň.  

1. File > Automate > Fit Image (Файл > Автоматически > Подогнать 

изображение) buýrugy saýlaň.  

 



 18 

2. Iniň we beýikligiň ähmiýetlerini pikselde giriziň. Beýleki meýdan OK 

düwmejigine basylandan soň awtomatiki düzediler.  

3. ОК düwmejigine basyň. 

 

Kendiriň ölçeglerini üýtgetmek 

Canvas Size (Размер холста) buýrugy redaktirlemeklige ýol berýän şekiliň 

töweregini üýtgedýär. 

1. Eger şekiliň fony bar bolsa, fon reňkini saýlaň.  

2. Image > Canvas Size (Изображение > Размер холста) dialog penjiresini 

açyň 

3. Width (Ширина) we/ýa-da Height (Высота) meýdanyna täze ähmiýeti 

giriziň. Bir ululugyň üýtgedilmegi beýlekisine täsir etmeýär.  

4. Şekili täze kendire göräleýin geçirmek üçin Anchor (Якорь) inerdüle basyň. 

Ýagty element şekiliň şol wagtky ýerleşişini görkezýär.  

5. ОК düwmejigine basyň. Hemme goşmaça meýdan şol wagtky fon reňki 

bilen doldurylar. 

 

Şekil Crop (Кадрировать) guraly, Crop (Кадрировать) buýrugy ýa-da Trim 

(Подрезать) buýrugy arkaly kesilip bilner.  

1. Crop (Кадрировать) guraly saýlaň ýa-da С klawişasyna basyň.  

2. Ýatda saklajak bolýan töweregiň daşynda gönüburçlugy belläň. 

3. Bu guralyň Shield cropped area (Прикрыть область кадрирования) 

opsiýasy arkaly saýlanmadyk bölegi garaldyp bolýar, eger saýlanan bölek 

bilen aratapawudy güýçlendirmek üçin. Color (Цвет) nusgastna basyň, eger 

garalanan töweregiň reňkini üýtgetjek bolsaňyz we bu reňk üçin Opacity 

(Непрозрачность) parametriň ähmiýetini saýlaň. Eger gatlagy kadrirleýän 

bolsaňyz, Cropped Area (Отсекаемая область) pereklýuçateli Delete 

(Удалить) ýagdaýa goýmaly çägiň içine düşmedik töweregi ýok etmek üçin 

ýa-da Hide (Спрятать) ýagdaýa – töweregi faýl bilen ýatda saklamak üçin 

hem-de ol şekiliň çäginden daşarda ýerleşdirer ýaly .  

4. Bu guralyň çägi bilen edil beýleçäkler bilen işläp bolýar – uladyp, öwürip, 

kiçeldip, eger proporsionla üýtgetmek gerek bolsa onda Shift düwmejigi 

bilelikde basmaly ýa-da Alt düwmejigi (merekeze göräleýin)  

 

Bu guralyň Width (Ширина) we/ýa-da Height (Высота) opsiýalaryna 

ähmiuýeti girizip  şekili kesmek mümkin. 

Köplenç çäk şekiliň araçäklerine berkilýär, munuň öňüni almak üçin çägi 

şekiliň gyrasynda çyzaňyzda Ctrl+Shift düwmejiklerini basyp saklap çyzmaly. 

Eger bir şekili beýleki şekiliň çäklerinde ýerleşer ýaly edip kesmek gerek 

bolsa iki şekili açmaly, maksatly şekili aktiwirläň, Crop guraly saýlap,  onuň 

opsiýalarynyň panelinde Front Image (Внешнее изображение) düwmejigine 

basyň, kesilmeli şekili aktiwirläň we punktir çägi çyzyň. Kesilenden soň, Shift 

düwmejigi basyp, gatlagy maksatly şekile geçiriň ýa-da göçüriň. Rugsat 

awtomatiki düzediler. 
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Eger kesmegi ölçegi şekilden uly bolan çäk arkaly ýerine ýetirsek şekiliň 

kendiriniň ölçegi hem ulalar.  

 Crop (Кадрировать) buýrugy Crop guralyň opsiýalaryny ulanmagyň 

zerurlygy ýok bolanda peýdaly. Ony ulanmak üçin belleýiş çägi deretmeli.  

1. Rectangular Marquee (Прямоугольная область) guraly saýlap ýatda 

saklanylmaly töweregi ol arkaly belläň.  

2. Image > Crop (Изображение > Кадрировать) buýrugy saýlaň. 
 

Şekiliň daş töweregindäki artyk bolan açyk we reňkli töwerekleri tiz 

aýyrmak üçin Trim (Подрезать) buýrugy peýdalanyň. 

 

Rotate Canvas > Flip Horizontal и Flip Vertical (Повернуть холст > 

Перевернуть вдоль горизонтали и Перевернуть вдоль вертикали) buýruklary 

şekiliň hemme gatlaklaryny degişlekde çepden saga we tersine hem-de ýokardan 

aşak we tersine geçirýär. Eger diňe bir gatlagy üýtgetmeklik gerek bolsa onda Edit 

> Transform > Flip Horizontal или Flip Vertical (Правка > 

Трансформировать > Перевернуть вдоль горизонтали или Перевернуть вдоль 

вертикали) buýruklardan peýdalanyň. 

Rotate Canvas toparynyň buýruklary şekiliň hemme gatlaklaryny 

öwürýärler. Eger diňe bir gatlagy öwürmek gerek bolsa Edit > Transform 

(Правка > Трансформировать) kömekçi menýunyň öwüriş buýrugyndan 

peýdalanyň.  

Eger şekili belli bir burça öwürmek gerek bolsa onda Image > Rotate 

Canvas > 180°, 90° CW или 90° CCW (Изображение > Повернуть холст > На 

180°, 90° по часовой стрелке или на 90° против часовой стрелки) buýruklary 

saýlaň.  

Egerde şekili islendik burça öwürmek gerek bolsa aşakdaky amallary ýerine 

ýetiriň.  

1. Image > Rotate Canvas > Arbitrary (Изображение > Повернуть холст > 

Произвольно) buýrugy ýerine ýetiriň.  

2. Angle (Угол) meýdanynda -359.99°-den  359.99° çenli islendik sany 

giriziň.  

 
 

 

Belleýiş amallary 

 

Eger şekilde saýlanyp bellenen aktiw töwerek bar bolsa, onda diňe ony 

redaktirlemek mümkin, şekiliň galan bölegi goranylan. Bellemek üçin şeýle 

gurallar bar: Rectangular Marquee (Прямоугольная область), Elliptical 

Marquee (Овальная область), Lasso (Лассо), Polygonal Lasso (Полигональное 

лассо), Magic Wand (Волшебная палочка) we Magnetic Lasso (Магнитное 
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лассо), şeýle hem Color Range (Диапазон цветов) we Extract (Извлечь) 

buýruklary. 

Turuş gatlagy belläp almak. 

Gatlagy saýlaň, Select О All (Выделить > Все) menýunyň buýrugyny 

ulanyň ýa-da Ctrl+A düwmejikleriň utgaşmasyna basyň. Çäk tutuş gatlagy gurşap 

alar.  

Diňe gatlagyň açyk däl pikseller belläp almak üçin, Ctrl düwmejigine 

basyň Layers (Слои) palitrasyndaky gatlagyň adyna syçanjyk bilen basyň. Ýa-da 

gatlagyň nusgasyna syçanjygyň sag düwmejigi bilen basyp kontekst menýudan 

Select Layer Transparency (Выделить прозрачные пикселы слоя) elementi 

saýlaň. 

Göniburçlyk we elliptikal töweregi belläp almak. 

1. Şekiliň gatlagyny saýlaň  

2. Rectangular Marquee (Прямоугольная область) ýa-da Elliptical 

Marquee (Овальная область) guraly, М ýa-da Shift+M düwmejiklerine 

basyp işlediň.  

3. Eger Rectangular Marquee (Прямоугольная область) ýa-da Elliptical 

Marquee (Овальная область) gural saýlanylsa, onda bellenilen töweregiň 

takyk ölçeglerini kesgitlemek üçin opsiýalar panelinde ýerleşen Style 

(Стиль) özi açylýan menýudan Fixed Size (Фиксированный размер) bendi 

saýlaň, soňra iniň we beýikligiň bahasyny giriziň.  

4. Bellenilen töweregiň araçäklerini gowşatmak üçin, opsiýalar panelinde 

bellemegi döretmekden öň Feather (Растуше-вывание) parametriň 

bahasyny 0-dan ýokary edip girizmeli. Elliptical Marquee (Овальная 

область) guraly üçin  Anti-aliased (Сглаживание) baýdajygy aýrymak 

mümkin.  

5. Eger bellenilen töweregiň fiksirlenen ölçegi görkezilen bolsa (ýa-da Single 

Row Marquee (Строка пикселов) ýa-da Single Column Marquee 

(Столбец пикселов) gurallary saýlanylan bolsa) şekile syçanjyk bilen 

basyň.  

 

Islendik görnüşle bellenilen töweregi döretmek 

Eger bellejek bolýan figura has çylşyrymly bolsa onuň araçägini Реn (Перо) 

ýa-da Freeform Pen (Свободное перо) guraly bilen Lasso (Лассо) guralyň 

deregine çyzyň soňra sudury bellenişeň özgerdiň. Netije has takyk bolar. Hem-de 

bu amaly tersine ýerine ýetirip bolýar. 

 Lasso arkaly bellenilen töweregiň araçäklerini gowşatmak üçin Select > 

Feather (Выделить > Растушевать) buýrugy ulanyň ýa-da Ctrl+Alt+D 

düwmejiklerine basyň. Eger Lasso (Лассо) guraly bilen işlenende göni çyzygyň 

keseimini çyzmak gerek bolsa, onda syçanjygyň düwmejigini goýbermän Alt 

düwmejigine basyň we burçlary döretmek üçin syçanjyga basyp duruň. Kursory 

geçiriň soňra klawişany goýberiň we islendik görnüşli belleýişi çyzmagy dowam 

edibermeli. 

Köp burçluk görnüşle bellenilen töweregi döretmek 

Bu maksatlar üçin Polygon Lasso (Полигональное лассо) guraly ulanylýar. 
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Alt düwmejigini basyp poligonal belleýiş döredilýän mahaly egri çyzykly 

segmenti çyamak bolýar.  

Shift düwmejigine basyp 45° burça bölünýän burç bilen göniçyzykly 

belleýiş çyzyklary gurmak bolýar.  

Delete düwmejigine basyp iň soňky döredilen burçy ýok edip bolýar, bu 

düwmejigi goýbermän birnäçe burçlary ýok etmek mümkin.  

 Reňke görä bellemeklik 

Eger haýsy-da bolsa bir piksele Magic Wand (Волшебная палочка) guraly 

bilen basylsa, bir öwüşginiň ýa-da açyklygyň bir derejeli goňşy pikselleri 

belleniler. Soňra alynan töwerege goňşy däl, reňk boýunça meňzeş pikselleri 

Similar (Похожие) biuýrugy arkaly ýa-da beýleki reňkiň piksellerini Shift 

klawişasyna basmak arkaly goşup bolar.  

Eger opsiýalar panelinde Contiguous (Смежные) baýdajyk goýulan bolsa, 

onda bellenilen töwerege birinji piksel bilen “bagly” bolan pikseller girer. Goňşy 

däl töwereklerden pikseller aýyrmak üçin bu baýdajygy aýyrmaly. 

 Bu guralyň opsiýalar panelinde Tolerance (Чувстивительность) meýdanyna 

belli bir san girizilse onda saýlanylan piksele goşmaça ondan şonça sana garamtyl 

we ýagtyrak reňkler hem goşular. 

Magnetic Lasso (Магнитное лассо) guraly kursor hereket edilende 

awtomatiki belleinlen töweregi döredýär. Töweregiň araçägi figuranyň araçägini 

kesgitleýän golaý reňkiň ýa-da kölegäň öwüşgine “ýelmeşýär”. 

Eger Magnetic Lasso (Магнитное лассо) guraly bilen işlenende 

wagtlaýynça Polygon Lasso (Полигональное лассо) ulanmaklyk zerur bolsa, 

onda Alt klawişasyny basyp saklap şekile syçanjyk bilen basyň.  

Belleýiş çyzygy bellenilmeli däl töwerege ýelmeşýän bolsa, onda syçanjyk 

bilen belejek bolýan töweregiň gyrasyna basyň we aralykdaky nokady dörediň. 

Bu guralyň opsiýalar paneliniň Feather (Растушевывание) parametriň 

bahasy bellenilen töweregiň araçäginiň goiwşalma derejesini kesgitleýär. parametri 

Width (Ширина) 1-den 255-a çenli üýtgeýär we guralyň işleýän töweregiň 

pikseldäki ölçegini görkezýär. Ýokary kontrastly we takyk araçakli şekil üçin uly 

ähmiýeti saýlaň Kontrastlygyň üýtgeýänligi kän bir bildirmeýän we biri birinden 

golaý ýerleşen figuraly şekil üçin uly bahany goýmaly däl. 

Eger Edit > Preferences > Display&Cursors (Правка > Установки > 

Отображение&курсоры) penjirede Other Cursors (Другие курсоры) toparynda 

Precise (Точно) görnüşi saýlanylsa, onda kursor ortasy kesişme bolan we diametri 

Width parametriniň bahasyna deň bolan tegelegiň görnüşine eýe bolar. Precise 

düzgünine wagtlaýyn geçmek üçin CapsLock düwmejigine basyň.  

Töweregi belläňizde Width parametriň bahasyny 1 piksele kiçeltmek üçin [ 

klawişasyna, ulaltmak üçin bolsa ] klawişasyna basmaly.  

Edge Contrast (Контраст границ) parametri 1-den 100-e çenli üýtgeýär  

we figuranyň araçägini kesgitlemek üçin zerur bolan kontrastlylygyň derejesini 

görkezýär. Pes kontrastly şekiller üçin pes bahany saýlaň. 

Iniň uly ýa-da kiçi ähmiýeti girizilen bolsa onda şol ýalyny hem araçäkleriň 

kontrasty üçin girizmeli.  
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 Frequency (Частота) parametri 0-dan 100-e çenli üýtgeýär we bellenilen 

töwerek döredilen aralyk nokatlaryň goýulmagynyň ýygylygyny kesgitleýär. Näçe 

ýygylygy pes bolsa şonça hem nokatlaryň sany az. Nädogry görnüşli figuranyň 

suduryny bellemek üçin uly bahany saýlaň. 

 Color Range (Диапазон цветов) buýrugy arkaly töweregi şekiliň reňkine 

baglylykda ýa-da ýagtylygyň ýa-da tonyň çägini berip bellemek bolýar.  

 
Saýlanylýan öwüşginleriň çägini giňeltmek üçin Fuzziness (Размытость) 

polzunogy saga, azaltmak üçin bolsa çepe süýşüriň. 

Sampled Colors (Выбранные цвета) opsiýasy Select parametrinde 

saýlanylsa, bellenilen töwerege köp öwüşginleri goşmak üçin onda Shift klawişany 

basyp, şekiliň peniresinde ýa-da deslapdan seretmegiň penjiresinde syçanjyk bilen 

basyň. Alt klawişany basmak bilen we syçanjyk bilen basyp, bellenilýän 

töwerekden öwüşgini ýok etmek mümkin. Mundan başgada şol maksatlar üçin plus 

ýa-da minus belgili pipetkalary ulanmak mümkin.  

 Eger bellenilen töweregi zolak hökmünde ýerine ýetirmeli bolsa, onda birinji 

bellemegi islendik usul bilen geçirip, soňra Alt klawişasyny basyp, ikinji çägi 

çyzýarys. Birinji we ikinji çägiň arasyndaky belleýiş töwerek bellenilen bolup 

galar. 

 Bellenişden aýyrmak üçin Select > Deselect (Выделить > Снять 

выделение) buýrugy saýlamaly ýa-da Ctrl+D düwmejikleri basmaly. 

 Iň soňky bellenilen töweregi gaýtadan bellemek üçin Select > Reselect 

(Выделить > Снова выделить) buýrugy ýerine ýetirmeli ýa-da Ctrl+Shift+D 

düwmejiklerine basmaly. 

Bellenilen we bellenilmedik töwerekleriň ýerini çalyşmak üçin Select > 

Inverse (Выделить > Инвертировать) buýruklary saýlamaly ýa-da Ctrl+Shift+I 

düwmejikleri basmaly. 

Mundan başga hem belleýiş gurallary saýlanylanda olaryň opsiýalar 

panelinde 4 sany düwmejik bar. Eger eýýam bellenilen töwerege täze töwerekleri 

goşmaklygy we aýyrmaklygy (Alt), iki belenilen töweregiň kesişmesini almagy 

(Alt+Shift) we öňkiň deregine täze belllemegi döretmegi amala aşyrýar. 
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 Bellemek arkaly winýetirlemegi amala aşyrmak mümkin, munuň üçin 

belleýden öň opsiýalar panelinde  Feather (Растушевывание) parametrine belli 

bir sany goýmaly (meselem), soňra bir töweregi belläp, bellemegi inwertitlrmrli we 

bellenilen ýeri Delete klawişasy aýyrmaly, bu amalyň netijesinde töwerek doly 

aýrylmaz, ol kem-kemden öçýän ýaly görnüşe geler. Mundan başga hem ony 

belleýişden soň hem goýup bolýar - Select > Feather (Выделить > Растушевать) 

buýrugy arkaly. 

Bellemegiň ýene bir usuly Filter > Extract (Фильтр > Вычитание) buýrugy. 

 

Utgaşdyrma 

Photoshopda utgaşdyrma alyş-çalşyk buferiň birnäçe usullary: Cut 

(Вырезать), Сору (Копировать), Paste (Вставить) we Paste Into (Вставить в)) 

usullary, geçiriliş, klonlama we nusgalary ulanma arkaly amala aşyrylýar. Mundan 

başga bu ýere şekiliň elementleriniň takyk ýerleşmeginiň we deňlenmeginiň, şeýle 

hem olaryň arasyndaky sepleriň düzlenmeginiň usullaryny degişle edip bolar. 

Eger şekiliň ýa-da onuň haýsy-da bolsa bir gatlagynyň bir töweregi çäk bilen 

bellenilip Move (Перемещение) guraly bilen (V klawişasy) ýa-da Ctrl klawişasy 

bilen bile basylyp süýşürilenede onda çäk bilen bilelikde şol töweregiň pikselleri 

hem süýşüriler. 

Eger bellenilen töwerek Move (Перемещение) guraly ýa-da Ctrl düwmejigi 

basylyp, goşmaça Alt düwmejigine basyp geçirilse onda onuň göçürilmesi 

süýşüriler. Eger Alt düwmejigi basylyp strelkaly klawişalar basylsa, göçürme 1 

piksele süýşer, eger Alt-Shift bilen şol klawişalar basylsa onda 10 piksele. Emma 

şunda täze gatlak döremez, hemme göçürilen töwerek şol bir gatlagyň içinde bolar. 

Göçürme amallary amala aşyrylanda bir zady ýatdan çykarmaly däl. Her 

şekiliň öz rugsady bar, şol sebäpli bir şekiliň töweregi başga şekile göçürilmeli 

bolsa, onda göçürilýän töweregiň ölçeglerini saklajak bolsak, iki şekiliň rugsadyny 

Image > Image Size (Изображение > Размер изображения) buýruk arkaly deň 

etmeli. 

Eger bellenilen töweregi gatalag öwürmek gerek bolsa onda Layer > New > 

Layer Via Сору (Слой > Новый > Посредством копирования) или Layer Via 

Cut (Посредством вырезания) buýrygy ýa-da degişlikde Ctrl+J we Shift+Ctrl+J 

klawişalara basmaly. 

Eger bir şekilden başga şekile alyş-çalyş bufere degmän geçirmeklik gerek 

bolsa, onda iki penjiräni açyp ikisem görüner ýaly edip, bir şekilde töweregi belläp 

ony Move guralyny basyp syçanjyk bilen beýleki şekiliň penjiresine tarap eltmeli 

we getirip syçanjygy goýbermeli. Eger geçirilýän töweregi beýleki şekiliň 

merkezine goýmak gerek bolsa onda syçanjygy goýbermezden Shift düwmejigi 

basmaly. 

Köplenç bellenilen töweregi başga bellenilen töwerege goýmaklyk (maska 

döretmek) gerek bolsa, onda göçürme amalyny goýmaklyk bilen tamamlanyňyzda 

Edit > Paste Into (Правка > Вставить в) buýrugy peýdalanmaly ýa-da 

Ctrl+Shift+V klawişalary basmaly. 

Magic Wand (Волшебная палочка), Smudge (Палец), Sharpen 

(Резкость), Blur (Размытие) ýa-da Clone Stamp (Клонирующий штамп) 
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gurallary ulanylanda olaryň opsiýalar panelinde Use All Layers (Использовать 

все слои) baýdajygy aýrylan bolsa onda bu gurallaryň täsiri diňe ulanylýan gatlaga 

täsir eder şeikiliň hemme gatlaklaryna täsir etmeklik gerek bolsa onda bu 

baýdajygy goýmaly. 

Tor, çyzgyçlar we ugrukdyryjylar obýektleri takyk ýerleşdirmek üçin gerek. 

Çyzgyçlar ekranda görüner we görünmez ýaly View > Rulers (Вид > Линейки) 

menýuny saýlamaly ýa-da Ctrl+R düwmejikleri basmaly. Çyzgyçlaryň 

häsiýetlerini (ölçeg birliklerini we b.) üýtgetmek üçin we Preferences 

(Установки) gepleşik penjiresiniň Units&Rulers (Единицы измерения и 

линейки) menýusyna tiz girmek üçin islendik çyzgyça iki gezek syçanjyk bilen 

basmaly. 

Şekildäki obýektleri ýerleşdirmegi tertipleşdirmek üçin tor ulanylyp biler. 

Tory goýmak üçin View > Show > Grid (Вид > Показать > Сетка) menýuny 

çagyrmaly ýa-daCtrl+Alt+ ' klawişalara basmaly. View > Snap To > Grid (Вид > 

Прикрепить к > Сетка) buýruk işledilenden soň her obýektiň ýerleşişini  

kesgitlämizde ol toruň çyzyklaryna baglaşdyrylar. Meselem biz 8 piksele haýsy-da 

bolsa toruň çyzygyna golaýlaşdyrsak, onda ol obýekt göni şol çyzyga awtomatiki 

geler. 

Ugrukdyryjylary döretmek üçin çyzgyçlardan syçanjyk arkaly kursory çekip 

geliň, Alt düwmejigine yzygiderli basyp kese ýa-da dik ugrukdyryjyny döretmek 

mümkin. Eger döredilen ugrukdyryjylary Move guraly süýşürmez ýaly etmek 

gerek bolsa onda View > Lock Guides (Вид > Блокировать направляющие 

линии) buýrugy ýerine ýetirmeli ýa-da Ctrl+Alt+; klawişalaryna basmaly. 

Measure (Измеритель) guraly çagyrmak üçin I ýa-da Shift+I düwmejigini 

basyň ýa-da ony gurallar panelinden işlediň; Çyzylan çyzygyň eňňitlik burçy (А) 

we uzynlygy (D) Info (Информация) görkeziler. Eger çyzyk çyzylanda Shift 

klawişasy basylyp dursa, eňňitlik burçy 45° bölünijilikli bolar. Measure 

(Измеритель) guraly arkaly çyzyk çyzylan soň,  Alt düwmejigini basyň we 

kursory çyzygyň bir ujyndan burçy gurmak üçin çekiň. 
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Clone Stamp (Клонирующий штамп) guraly obýektiň klonuny şol bir köp 

gatly şekiliň çäginde bir gatlakdan başgasyna we bir şekilden beýlekisine geçirmek 

üçin ulanylýar.  

Clone Stamp (Клонирующий штамп) guraly panelden hem-de S ýa-da 

Shift+S klawişalaryny basyp çagyrmak mümkin.  

Eger başlangyç nokat bilen bagly bolan bir üznüksiz klon gerek bolsa onda 

bu guralyň opsiýalar panelinde Aligned (Выровненный) baýdajygy goýmaly, eger 

şol bir başlangyç nokada gabat gelýän birnäçe klonlary döretmek üçin şol 

baýdajygy aýyrmaly..  

Başlangyç nokady döredip töweregi klonlamak üçin Alt düwmejigi basyp 

şol töwerege basyň.  

Öz nagyşyňyzy döretmek üçin (pattern) Rectangular Marquee 

(Прямоугольная область) guraly işlediň we şekiliň bir töweregini belläň, soňra 

Edit > Define Pattern (Правка > Определить узор) buýrugy saýlap, bir ady 

giriziň we ОК düwmejigine basyň.  

Pattern Stamp (Штамп узора) guraly işlediň.  
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Pattern (Узор) meýdanyň strelkasyna basyň we sanawyň içinde iň soňky 

duran kesgitlenen şekili saýlaň.  

 

Healing Brush guraly şekiliň kemçiliklerini aýyrmak üçin niýetlenen «zen-

zele», tozanyň yzy we ş.m. Ol arkaly az güýçler bilen saç örtügiň şekiliniň 

zaýalanan böleklerini dikeltmek we hallary, menekleri we b. ýok etmek mümkin. 

Bu gural panelden ýa-da J we Shift+J klawişalar arkaly çagyrylýar.  

  Bu guralyň işlemeginiň iki düzgüni bar: Sampled (По образцу) we Pattern 

(Текстурное). Birinji ýagdaýda has “akylly” gural alynýar, ikinji ýagdaýda - 

Pattern Stamp guralynyň gowulandyrylan warianty. 

Şekili gyralaryny rastuşewka etmek üçin Select > Feather (Выделить > 

Растушевать) buýrugyny Ctrl+Alt+D klawişalary basyp çagyrmaly. Radius 

(Радиус) meýdanynda 250-den ýokary geçmeýän sany girizmeli. Töweregiň täsir 

edilýn ini şekiliň rugsadyna bagly, rugsat näçe uly bolsa, şonça hem raduisy uly 

edip görkezmeli. Radius 5 piksel edilip girizilse, onda täsir edilýän meýdanyň ini 

10 piksele deň bolýar. 

 

 



 27 

Gatlagyň piksellerini goýmakdan we süýşürilmeginden galan görünýän 

sepleri aýyrmak üçin Defringe (Удалить бахрому) buýrugy ulanmaly. Bu buýruk 

bellenilýän töweregiň araçäginde pikselleri töweregiň içinde belli bir aralykda 

ýerleşen pikselleriň reňkine laýyklykda gaýtadan reňkleýär.  

Eger geçirilen we goýlan bölek gara fonda ýerleşen bolsa we tekizlenen 

bolsa Layer > Matting > Remove Black Matte (Слой > Кайма > Удалить 

черную кайму) buýrugy peýdalanmak mümkin. Remove White Matte (Удалить 

белую кайму) buýrugy saýlaň, eger bölek ak fonda ýerleşen bolsa.  

Şekiliň bölegigoýlan gatlagy saýlamaly we Layer > Matting > Defringe 

(Слой > Кайма > Удалить бахрому) buýrugy goýbermeli. 

 

Tejribe işleri 

1) A4 formatda boş surat döretmek 

2) Ini 220 mm, beýikligi 114 mm boş suraty döretmek 

3) Rugsady 150 dpi bolan boş surat döretmek 

4) Ini 800 pi, beýikligi 600 pi boş suraty döretmek 

5) Fony reňkli boş suraty döretmek 

6) Fony açyk bolan boş suraty dşretmek 

7) Reňk düzgüni gara/ak boş suraty döretmek 

8) Reňk düzgüni gyzyl-gök-ýaşyl boş suraty döretmek 

9) Düzgüni 16 bit bolan boş suraty döretmek 

10) A3 formatda boş surat döretmek 
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GATLAKLAR 
 

Gatlaklar bilen işlemek 

Her gatlak üçin açyk däligiň öz derejesini beläp bolýar. Bir wagtda birnäçe 

gatlaklary redaktirlemek mümkin däl: şekiliň bölegi üýtgedilse beýleki gatlaklara 

bu täsir etmeýär. 

Eger File > New (Файл > Новый) buýrugy ýerine ýetirilinden soň açylan 

gepleşik penjiresinde täze şekil döredilende Contents (Содержание) parametri 

White (Белый) ýa-da Background Color (Фоновый цвет) ýagdaýa goýulsa, 

şekiliň iň yzda duran bölegi fon bolar. ýagny ol gatlak bolmaz Transparent 

(Прозрачный) saýlanylsa, ol gatlak bolar.  

Layers (Слои) palitrasynda gatlaklaryň sanawynda gatlaklaryň ady 

ýerleşdirilen. Elbetde Background (Фон) sanawyň iň soňunda ýerleşer. Palitrada 

şol wagt bellenilen gatlak aktiw bolup durýar. Aktiw gatlagyň ady (ýa-da 

Background sözi) şekiliň penjiresiniň sözbaşysynda ýerleşýär. 

 

Eger şekili Photoshop (.psd) ýa-da Advanced TIFF (.tif) formatdan başga 

islendik formatda ýatda saklasaňyz, hemme gatlaklar birleşer, şekiliň düzgüniniň 

üýtgedilmegi babatda bolsa (meselem, RGB düzgünden CMYK özgerme), eger 

gatlaklary saklajak bolsaňaz Don't Flatten (He объединять) ýa-da Don't Merge 

(He сливать) baýdajygy goýmaly. 

100% açyk däl täze gatlagy döretmek üçin Layers (Слои) palitrasynyny 

aşagyndaky Create New Layer (Создать новый слой) düwmejigine basmaly.  

 
Eger täze gatlagy käbir parametrleri goýup döretmek gerek bolsa, onda 

Layers (Слои) palitrasynyň menýusyndan New Layer (Новый слой) buýrugy 

saýlamaly ýa-da Alt klawişasyny basmak bilen Create New Layer düwmejigine 

syçanjyk bilen basmaly, aşaky penjire çykar. 
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Işlenmeýän gatlagy wagtlaýynça bukmagyň azyndan iki sebäbi bar. Bırınjısı 

– olary ünsüňi çekýär, ikinji olarsyz programmanyň işewürligi ýokarlanýar. 

Layers (Слои) palitrasynda bukjak bolýan gatlagyň gabadyndaky göz 

şekilindäki inedördüle basyň, eger ony görmek üçin ýene şoňa bir gezek basmaly. 

Eger bir gatlakdan başgasyny bukmak üçin, onda Alt klawişasyny basyp şol 

gatlagyň göz şekilli inerdördüline basmaly, beýleki gatlaklary gaýtadan görünýän 

etmk üçin bu amaly gaýtalamaly.   

 Islendik gatlak bilen transformasiýa amallaryny ýerine ýetirmek üçin Edit > 

Transform > (Правка > Трансформировать >) ýa-da Edit > Free Transform > 

(Правка > Свободная Трансформация >) menýunyň buýruklaryny ýerine 

ýetirmeli - Scale (Масштаб), Rotate (Поворот), Skew (Скос), Distort 

(Искажение) или Perspective (Перспектива). Gatlagyň töwereginde çäk emele 

geler we ol arkaly degişli üýtgetmeleri ýerine ýetirmek mümkin. 

Gatlagy ýok etmek üçin Layers (Слои) palitrasynda ýok edilmeli gatlagyň 

adyna basmaly. Soňra palitranyň Trash (Корзина) düwmejigine basyň.  

Gatlagy ýok etmegiň ýene bir usuly gatlagyň adyny belläp syçanjyk bilen 

kontekst menýudan Delete Layer (Удалить слой) bendi saýlamaly. 

Köplenç transformasiýa amallaryny Free Transform (Произвольная 

трансформация) guraly arkaly hem ýerine ýetirmek mümkin, esasan hem 

özgermeleriň birnäçesini ýerine ýetirmek gerek bolsa. Munuň üçin Edit > Free 

Transform (Правка > Произвольная трансформация) buýrugyny çagyrmaly ýa-

da Ctrl+T klawişalary basmaly.  

Mundan başga hem Move (Перемещение) guralyny işledip we opsiýalar 

panelinde Show Bounding Box (Показать габаритную рамку) baýdajygy 

goýmaly. Bu buýruk ýerine ýetirilende şeýle tiz klawişalary ulanmak mümkin: 

o Skew buýrugy ýerine ýetirmek üçin klawişalary basmaly Ctrl+Shift;  

o Distort – Ctrl klawişalary basmaly; 

o Perspective - Ctrl+Alt+Shift klawişalary basmaly. 

Measure (Измеритель) guralyny işledip gerek burçy kesgitläp, soňra guraly 

çalyşman, Edit > Transform > Rotate (Правка > Трансформация > Поворот) 

buýrugy saýlanylsa. gatlak görkezilen burça awtomatiki öwrenilen. 

Gatlaklaryň ýerini Layers (Слои) palitrasynda çalşyryp olaryň ekranda 

görkezilmegini sazlap bolýar. Aktiw gatlagyň beýleki gatlaklaryna görä ýerleşişini 

beýleki usullar arkaly hem mümkin: Layer > Arrange > Bring to Front (Слой > 

Расположить > Поверх остальных), Bring Forward (Перенести вверх), Send 
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Backward (Перенести вниз) ýa-da Send to Back (Ниже остальных) buýruklary 

arkaly mümkin, degişlikde: 

Ýokary geçirmek  Ctrl+]  

Beýlekileriň üstünden  Ctrl+Shift+]  

Aşak geçirmek  Ctrl+[  

Beýlekileriň aşagynda  Ctrl+Shift+[  

Şekiliň fonuny gatlak we gatlagy fon etmek mümkin. Birinji amaly ýerine 

ýetiremk üçin Layers (Слои) palitrasynda fonuň adyna iki gezek basyp täze 

gatlagyň döredilýän ölçeglerini girizmek gerek. Ters amaly ýerine ýetirmek üçin 

Layer > New > Background From Layer (Слой > Новый > Фон из слоя) 

buýrukdan peýdalanmaly. 

Gatlagy tiz saýlamak üçin Auto Select Layer (Автовыделение слоя) 

baýdajygy goýmaly, bu ýagdaýda syçanjyk bilen gatlak bellenilse ol aktiw bolar, 

bu amaly şeýle hem ol baýdajygy aýyryp Ctrl klawişasyny basyp syçanjyk bien 

aktiwirläp bolýar. Mundan başga hem syçanjygyň sag düwmejigine basyp kontekst 

menýuny çagyryp bu ýerde şol pikselde duran gatlaklaryň adyny görmek bolar. 

Gatlaklar bilen işlemekligi aňsatlaşdyrmak üçin olary toplumlara salmak 

amatly. Düzediji gatlaklar we garyşyk düzgünleri diňe bu topluma girýän 

gatlaklara degişli bolup bilýär. Toplumy döretmek üçin Layers (Слои) 

palitrasynyň aşagynda Create new set (Создать новый набор) düwmejigine 

basmaly. Şeýle hem Layer > New > Layer Set (Слой > Новый > Набор слоев) 

buýrugy çagyrmak mümkin. Gatlagy toplumdan çykarmak üçin palitrada onuň 

adyny toplumyň adynda ýokary ýa-da toplumyň iň aşaky gatlagyndan aşak 

çykaryp amala aşyrmak mümkin. 

Lock (Блокировка) opsiýasy şekiliň tötänleýin üýtgedilmeginiň öňüni alýar.  

1. Layers (Слои) palitrasynda blokirlenmeli gatlagy saýlamaly.  

2. Gatlagyň ýerleşişini blokirlemek üçin Lock position (Блокировать 

положение) baýdajygy goýmaly. Şunda gatlagy süýşürip bolmaýar, emma 

ony redaktirlemek mümkin 

Eger Lock all (Заблокировать все) baýdajyk goýulsa, gatlak hemme redaktirleme 

amallaryndan goranylar. 

Layers (Слои) palitrasynda Lock transparent pixels (Блокировать 

прозрачные точки) baýdajygy goýlan bolsa, onda gatlagyň diňe görünýän 

nokatlaryny redaktirlemäge ýol berilýär. 

Lock transparent pixels (Блокировать прозрачные точки) opsiýasy 

elmydama renderinge degişli bolmadyk tekst gatlagy üçin işledilen. 

 

 Bu ýerde bir zady bellemek gerek gatlagyň açyk däldigi 60% bolanda we 

onuň piksellerini redaktirlenýän guralyň açyk däldigi 100% (Brush guraly) bolanda 

onda gural 60% açyk dällik bilen redaktirlär, eger guralyň açyk däldigi 100%-den 

pes bolsa onda ýokarkydan hem pes bolar. 

Photoshop programmasynda käbir amallar ýerine ýetirilende gatlaklar 

birleşdirilip ýa-da üýtgäp bilner. Olary aýry faýlda ýatda saklamak üçin Layers 

(Слои) palitrasynda menýudan Duplicate Layer (Дублировать слой) buýrugy 
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saýlap açylan penjirede Destination (Целевой) toparynda Document (Документ) 

meýdanynda New (Новый) ähmiýeti saýlamaly. As (Как) meýdanynda gatlagyň 

adyny girizmeli, Destination (Целевой) toparynda Name (Имя) meýdanynda täze 

döredilmeli faýlyň girizmeli. 

Iki gatlagy birleşdirmek üçin palitrada iki bile ýerleşen gatlaklaryň 

ýokarkysyny aktiw etmeli. Eger gatlaklaryň toplumy saýlanylsa onuň düzümine 

girýän hemme gatlaklar bir gatlaga birikdiriler.  

Layers (Слои) palitrasynyň menýusyndan Merge Down (Слить с нижним) 

buýrugyny saýlamaly ýa-da Ctrl+E klawişalaryna basmaly. Aktiw gatlak ondan 

aşakysy bilen birleşdiriler. Gatlaklaryň toplumyny birleşdirmek üçin Merge Layer 

Set (Слить набор.слоев) buýrugyny saýlamaly. 

Merge Visible (Слить видимые) buýrugy şol wagt hemme görünýän 

gatlaklary birleşdirýär, şonda görünmeýän gatlaklar üýtgemeýär. Munuň üçin 

Layers (Слои) palitrasyndan Merge Visible (Слить видимые) buýrugy saýlamaly 

ýa-da Ctrl+Shift+E klawişalary basmaly. 

Flatten Image (Плоское изображение) buýrugy şol wagt görünýän 

gatlaklary birleşdirýär we görünmeýänleri ýok edýär. Munuň üçin Layers (Слои) 

palitrasyndan Flatten Image (Плоское изображение) buýrugy saýlamaly. 

 

Hadysalar 

3-nji sapakda hadysalar bilen işlemek boýunça gysgaça maglumatlar 

berilipdi. Allow Non-Linear History (Разрешить нелинейность событий) 

opsiýasy işledilmedik bolsa, onda bir hadysa gaýtarylyp ondan soň täze amal 

ýerine ýetirilse ýa-da şol hadysa ýok edilse, onda ondan soňky beýleki amallar ýok 

ediler, eger işledilen bolsa onda ondan soňky amalla ýitmez. 

Deslapdan History (История) palitrasynda 20 amal ýatda saklanylýar. Eger 

bu sany azaltmaly ýa-da artdyrmaly bolsa onda Edit > Preferences > General 

(Правка > Установки > Общие) buýrugy çagyryp şol penjirede History States 

(Состояния) meýdanynda 1-den 100-e çenli san girizimeli. 

 Eger amallary huşdan boşatmak gerek bolsa Edit > Purge > Histories 

(Правка > Очистить > Истории) buýrugyny ýerine ýetirmeli. Eger palitrany diňe 

aktiw resminama üçin arassalamak gerek bolsa, onda palitranyň menýusyndan 

Clear History (Очистить историю) buýrugyny çagyrmaly. Purge (Очистить) 

buýrugyny ýatyryp bolmaýar, History (Очистить историю) buýrugyny bolsa 

mümkin. 

Hadysany ýok etmek üçin hadysany syçanjyk bilen History (История) 

palitrasynda ýerleşen Delete current state (текущего состояния) düwmejiginiň 

üstüne getiriň, eger şol hadysadan öňki hadysalary yzygiderli ýok etmek gerek 

bolsa onda bu amala ýerine ýetirilendse Alt klawişasyny basyp durmaly. 

Снимок (snapshot) – hadysanyň göçürmesi ýaly, emma hadysadan 

tapawutlykda ony döreden palitradaky element ýok edilen bolsa hem snimok 

palitrada galar. Şol sebäpli belli bir amallar ýerine ýetirilenden soň, amallaryň 

beýleki yzygiderligini ýerine ýetirmezden soň snimogy döretmek maksda laýyk. 

Şekil ýapylandan soň hemme snimoklar ýok edilýär. 
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Snimogyň esasy boljak hadysanyň üstüne basyň. Create new snapshot 

(Создать новый снимок) düwmejigine basmaly. Mundan başga hem palitranyň 

menýusyndan New Snapshot (Новый снимок) bendi saýlamaly ýa-da Alt 

klawişany basyp Create new snapshot (Создать новый снимок) düwmejigini 

syçanjyk bilen bilelikde basmaly.  

 

 

 
 

Açylan penjirede From (Из) meýdanynda eger şekiliň hemme gatlaklarynyň 

suratyny almak üçin Full Document (Весь документ) warianty saýlamaly, ýa-da 

Merged Layers (Слитые слои) wariantyny gatlaklaryň birleşen ýagdaýyndaky 

suraty almak üçin saýlamaly hem-de Current Layer (Текущий слой) warianty 

diňe şol wagt aktiw gatlagyň suratyny almak üçin saýlamaly.  

Snimogy ýa-da hadysany resminama özgerdilse onda Siz özüňizi işiň 

togtadylmagynyň netijelerinden özňüizi gorap bilersiňiz. Munuň üçin gerekli 

snimogy ýa-da hadysany belläp Create new document from current state 

(Создать новый документ из текущего состояния) düwmejigine basmaly. 

Netijede şol ýagdaýdaky ikinji şekiliň penjiresi açylar. Palitradan islendik 

hadysany syçanjyk bilen alyp ikinji penjirä geçirilende şol penjiredäki şekil şol 

geçirilen hadysanyň ýagdaýyna geler.  

History Brush (Восстанавливающая кисть) guralyny umumy pikselleriň 

sany açylandan soň üýtgedilen (meselem şekiliň düzgüni ýa-da kendiri 

üýtgedilenden, kesilenden soň) ulanmak mümkin däl. 

 

Düzetme buýruklary 

Aşakda düzediş buýruklaryny ulanmak boýunça hödürlemeler getirilen: 

 redaktirlemegi amatly etmek üçin düzediş gatlaklary ulanmaly;  

 gatlagyň bellenilen töweregine buýrugy ulanmazdan öň ilkibaşda töweregi 

bellemeli;  
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 gepleşik penjiresinde parametrleri dikeltmek üçin Alt klawişasyny basyp 

Reset (Восстановить) düwmejigine syçanjyk bilen basmaly;  

 ulanyljak parametrleriň täsirini öňünden görmek üçin Adjustments 

(Корректировки) kömekçi menýusynyň gepleşik penjirelerinde Preview 

(Предварительный просмотр) opsiýany ulanmaly. Bu opsiýa işledilenden 

CMYK düzgüninde reňkler has takyk görkezilýär;  

 buýrugyň ulanylmagynyň täsirini kem-kemden peseltmek üçin Edit > Fade 

(Правка > Ослабить) buýrugyny ulanmaly ýa-da Ctrl+Shift+F 

klawişalaryna basmaly;  

 Gepleşik penjiresini standart  parametrleri bilen dälde soňky goýlan 

parametrler bilen gaýtadan açmak üçin Alt klawişany bilelikde basyp 

durmaly. 

Düzediş buýruklaryny ulanmagyň iki usuly bar. Olar şol wagtdaky 

ulanylýan gatlaga ulanylyp bilner ýa-da düzediş gatlagy arkaly şekile. Adaty 

gatlaklardan tapawutlykda düzediş gatlaklary diňe şol wagtky ulanylýana dälde,  

eýsem onuň aşagyndaky hemme görünýän gatlaklara täsir edýär. Emma onuň 

aýratyn amatly tarapy ol aşagyndaky gatlak bilen birleşdirilýänçä hiç pikseli 

üýtgetmeýär. Düzediş gatlaklary – reňki düzetmegiň netijesine deslapdan baha 

bermegiň amatly usuly. 

Üstünde düzediji gatlaklar ýerleşmeli gatlagy saýlamaly. Layers (Слои) 

palitrasynyň aşagynda ýerleşen Create new fill or adjustment layer (Создать 

новый слой заливки или корректирующий слой) düwmejigine basylandan soň 

çykýan menýudan düzediş buýrugyny çagyrmaly.  
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Şeýle hem Layer > New Adjustment Layer (Слой > Новый 

корректирующий слой) kömekçi menýudan buýrugy hem çagyrmak bolar. 

Düzediji gatlagyň şekili düzediji buýrugyň piktogrammasyny saklar we bu 

buýrugy redaktirlemegi we üýtgetmegi mümkindigi barada ýatladýan polzunokly 

bolar. 

Düzediji gatlagy üýtgetmek üçin Layer > Layer Content Options (Слой > 

Опции содержимого слоя) buýrugy çagyrmaly. 

Layer Style (Стиль слоя) gepleşik penjiresi arkaly düzediji gatlagyň onuň 

aşagyndaky agtlaklar bilen garyşýandygyny dolandyrmak mümkin. 

Aşaky gatlaklar bilen garyşanda haýsy kanallary aýyrjak bolsaňyz  olardan 

Channels (Каналы) baýdajygy aýyrmaly. Her kanala üçin garyşmagyň 

diapazonyny goýmak üçin, Blend If (Смешивать если) menýudan haýsy-da bolsa 

bir kanaly çagyrmaly; bir wagtda hemme kanallar bilen işlemek üçin Gray 

(Серый) ähmiýetini galdyrmaly.  

This Layer (Этот слой) meýdanynyň çep polzunogyny saga süýşürmeli - 

aktiw gatlagyň garamtyl töwereklerini ýok etmek üçin we sag polzunogy çepe 

süýşürmeli – eger aktiw gatlakdan açyk reňkli töwerekleri ýok etmeli bolsa.  

Underlying Layer (Нижележащий слой) meýdanynyň çep polzunogyny 

saga süýşürmeli – aktiw gatlagyň aşagyndaky gatlaklaryň garamtyl töwerekleri 

görüner ýaly we  sag polzunogy çepe süýşürmeli - aktiw gatlagyň aşagyndaky 

gatlaklaryň açyk reňkli töwerekleri görüner ýaly. 

Düzediji gatlagy beýleki düzediji gatlak bilen birleşdimek mümkin däl, 

sebäbi olaryň pikselleri ýok, emma olary başga gatlak bilen birleşdirmek bolýar. 
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Düzediji gatlagyň düzediş buýrugyny üýtgetmek üçin Layer > Change 

Layer Content (Слой > Изменить содержимое слоя) kömekçi menýudan bar 

bolan buýrugy çalşyrjak buýrugy çagyrmaly. 

Düzediji gatlagyň ondan aşakysy bilen birleşmeginiň esasynda hemme 

üýtgetmeler hemişelik bolar, şol sebäpli üýtgetmeleriň doly we dogry 

geçirilendiginie göz ýetiriň. 

Image > Adjustments (Изображение > Корректировки) kömekçi 

menýunyň buýruklary düzediş buýruklaryň arasynda aýratyn orunlary tutýar.  Olar 

gatlaklara gönümel ýa-da düzediş gatlagyň üsti bilen ulanylyp bilner. Ilkibaşda 

buýruklary ýarym tonly şekillere, soňra bolsa reňkli şekillere ulanmaly. 

Auto Contrast (Автоконтраст) ýönekeý buýrugy iň açyk pikselleri aklara, 

iň garamtyllary – garalara öwürýär hem-de olaryň arasynda çallaryň derejelerini 

tertipleşdirýär. Munuň üçin Image > Adjustments > Auto Contrast 

(Изображение > Корректировки > Автоконтраст) menýudan buýrugy 

çagyrmaly ýa-da Ctrl+Alt+Shift+L klawişalaryna basmaly. 

Equalize (Выровнять) buýrugy aktiw gatlagyň ýagtylygyny tertipleşdirip 

paýlaýar. Ol kontrastlyk ýetmeýän ýa-da örän garamtyl bolan şekili gowulandyryp 

biler. Munuň üçin Image > Adjustments > Equalize (Изображение > 

Корректировки > Выровнять) buýrugyny çagyrmaly. Buýrugyň täsiriniň 

töweregini çäklendirmek üçin ilkibaşda şol töweregi belläň soňra Equalize 

(Выровнять) gepleşik penjiresinde Equalize selected area only (Выровнять 

яркость только выделенной области) baýdajygyny goýuň. Tutuş gatlagy 

bellenilen töweregiň iň açyk we garamtyl reňkini hasaba almak bilen düzetmek 

üçin Equalize entire image based on selected area (Выровнять все 

изображение на основе выделенной области) goýmaly. 

Gatlak ýa-da fon negatiw ýaly görüner ýaly Invert (Инвертировать) 

buýrugyny ulanmaly. Bu buýruk arkaly negatiwi pozitiwe öwürmek bolýar. 

Gatlagy saýlap Image > Adjustments > Invert (Изображение > 

Корректировки > Инвертировать) buýrugyny saýlamaly ýa-da Ctrl+I 

klawişalaryna basmaly.  

Düzediji gatlagyň üsti bilen aşaky gatlaklaryň inwertirlenmegini ýerine 

ýetirmek üçin Layers (Слои) palitrasynyň aşagynda ýerleşen Create new fill or 

adjustment layer (Создать новый слой заливки или корректирующий слой) 

düwmejige basylandan soň çykýan menýudan Invert (Инвертировать) buýrugy 

saýlamaly. 

Threshold (Порог) gepleşik penjiresi arkaly ulanylýan gatlagyň ýa-da 

fonyň kontrastyny reňkli ýa-da çal pikselleri gara ýa-da ak piksellere öwürmek 

arkaly ýokarlandyrmak mümkin. 

Häzirki gatlakda ýa-da fonda reňkleriň ýa-da derejeleriň mukdaryny 

azaltmak üçin Posterize (Превратить в плакат) buýrugyny peýdalanmaly. Munuň 

üçin gatlagy saýlaň we Image > Adjustments > Posterize (Изображение > 

Корректировки > Превратить в плакат) buýrugy çagyrmaly. Preview 

(Предварительный просмотр) baýdajygyny goýuň, we Levels (Уровни) 

meýdanyna 2-den 255-e çenli san girizmeli. Trafaret çapyň ýa-da plakat stiliň  

netijesini goýmak üçin 4 we 8 sanyň çägindäki ululygy girizmeli. 
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Eger reňki düzetmek üçin Levels (Уровни) buýrugy saýlanylsa, 

aýratynlykda we has takyk açyk, orta we garamtyl tonlary sazlamak mümkin, 

emma has aňsat Brightness/Contrast (Яркость/Контраст) buýrugyny 

ulanmaklyk. 

Levels (Уровни) gepleşik penjiresi arkaly şekilleriň köp mukdaryny 

bejermek mümkin. 

Gatlagy saýlap Image > Adjustments > Levels (Изображение > 

Корректировки > Уровни) buýrugyny çagyrmaly ýa-da Ctrl+L klawişalaryna 

basmaly. 

 açyk tonlaryň ýagtylygyny we kontrasty ýokarlandyrmak üçin Input Levels 

(Входные уровни) ak polzunogy çepe süýşürmeli. Orta tonlaryň polzunogy 

hem süýşüriler;  

 garamtyl tonlary ondan hem garamtyl etmek üçin Input Levels (Входные 

уровни) gara polzunogy saga süýşürmeli. orta tonlaryň polzunogy hem 

süýşüriler;  

 orta tonlary garaşsyz sazlamak üçin Input Levels (Входные уровни) çal 

polzunogy süýşürmeli;  

 kontrasty peseltmek üçin we şekili ýagtylandyrmak üçin Output Levels 

(Выходные уровни) gara polzunogy saga süýşürmeli;  

 kontrasty peseltmek üçin we şekili garamtyllamak üçin Output Levels 

(Выход ные уровни) ak polzunogy çepe süýşürmeli. 

 

Derejeleri awtomatiki sazlamak üçin Image > Adjustments > Auto Levels 

(Изображение > Корректировки > Автоуровни) buýrugy çagyrmaly ýa-da 

Ctrl+Shitt+L klawişalaryna basmaly ýa-da Levels (Уровни) gepleşik penjiresinde 

Auto (Авто) düwmejigine basmaly. 

Şekiliň kontrastlygyny ýokarlandyrmak üçin Input Levels (Входные 

уровни) gara we ak polzunoklary mümkindigiçe biri-birine golaý süýşürmeli. 

Auto Color buýrugy foto surata alyş emeli yşyklandyryşda emele gelýän 

şekilleriň sary we mawy ýagty düşmegini ýok etmek üçin gulluk edýär. Ol we 
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beýleki ýagdaýda RGB şekiliň gök kanalyň ýagtylygyny we kontrastlygyny 

üýtgetmeklik ýeterlikdir.  

Şol öwüşgini ýok etmek üçin Image > Adjustments > Auto Color 

(Изображение > Корректировки > Автоцвет) buýrugy ýerine ýetirmeli ýa-da 

Shift+Ctrl+B klawişalaryna basmaly. 

 

Reňki saýlamaklyk 

 

 

 

  

 

 

 

 

Haýsy da bolsa bir gural ulanylanda, tekst döredilende ýa-da Stroke 

(Обводка) buýrugy ulanylanda häzirki esasy reňk ulanylýar (fore-groundcolor).  

Eraser (Ластик) guraly ulanylanda, kendiriň ölçegi ulaldylanda ýa-da fonda 

ýerleşen bellenilen Move (Перемещение) guraly bilen töwerek 

hereketlendirilende açylan meýdança häzirki fon reňki bilen doldurylýar 

(background color). Gradient (Градиент) guraly dürli reňkleri, şol sanda esasy we 

fon reňkini garyşdyrýar.  

Esasy we fon reňkini saýlamagyň birnäçe usullary bar:  

 kesgitlenen meýdançalarra ähmiýetleri girizmeli ýa-da reňkleri saýlamagyň 

panelinde uly reňk inedördüline basyň;  

 Custom Colors (Цвета по выбору пользователя) gepleşik penjiresinde 

reňkleriň ulgamyny saýlamaly;  

 sanly meýdançalary ähmiýetleri girizmeli ýa-da Color (Цвет) palitrasynda 

polzunoklary süýşürmeli;  

 Swatches (Образцы) palitrasynda reňk nusgasyna basyň;  

 Eyedropper (Пипетка) guraly arkaly şekilde reňki saýlamaly. 

 

Eger aktiw däl inerdördüliň reňkini saýlamak üçin onda Ctrl klawişasyny 

basyp saýlamaly. 

Swatches (Образцы) palitrasyna täze reňki goşmak üçin reňk nusgalaryň 

tamamlanýan ýerinde onuň boş ýerine syçanjyk bilen basmaly - şol wagt ulanylýan 

reňk awtomatiki goşular. Eger bar bolan nusgany çalşyrmak üçin onda Shift 

EEssaassyy  rreeňňkk  FFoonn  rreeňňkkii  
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klawişasyna basyp şol çalşyrylmaly nusgasyna basmaly. Palitradan reňki ýok 

etmek üçin Alt klawişasyna basmaly we şol reňk nusgasyna basmaly. 

Eyedropper (Пипетка) guraly reňki saýlaýan töweregi üýtgetmek üçin, 

opsiýalar panelinde Sample Size (Размер пробы) parametriň şu bahalaryny 

görkezmeli: Point Sample (Точка) – siz tarapyndan syçanjyk bilen basýan piksel, 

3 by 3 Average ýa-da 5 by 5 Average - 3x3 ýa-da 5x5 pikselli töweregiň 

çägindäki reňkiň ortaça ähmiýeti. Eyedropper (Пипетка) guraly işletsek и we 

şekiliň penjiresinde syjanjgyň sag düwmejigi bilen basylsa bu opsiýalary kontekst 

menýudan saýlamak mümkin. 

 
Eyedropper (Пипетка) guraly işledilende esasyň reňkiniň inedördüli 

işlenende fon reňki saýlamak üçin we ters ýagdaýda Alt klawişasyna basyp 

syçanjyk bilen reňk saýlamaly. 

 

Tejribe işleri 

1) Reňkli suraty gara/ak düzgüne geçirmek kontrastlygyny gowulandyrmak we 

arassalamak 

2) Garamtyl suraty agartmaly we hilini gowulandyrmaly 

3) Ak/gara düzgündäki suraty reňkli etmeli 

4) Fotosuratyň reňklerini doldurmaly we gowulandyrmaly 

5) Suratyň ýitiligini ýokarlandyrmaly 

6) Suratyň fonunyň reňkini dürli edip üýtgetmeli 

7) Suratyň fonuny gradiýent bilen doldurmaly 

8) Reňkleriň basyşyny üýtgetmeli 

9) Täze stili döretmeli 

10) Täze nusga döretmeli 
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SURAT ÇEKMEK 
 

Reňklemek 

Image > Adjustments (Изображение > Корректировки) gepleşik 

penjireleri açylanda Ctrl+probel ýa-da Alt+probel düwmejikleri basyp we şekile 

syçanjyk bilen basylsa ol şekiliň masştaby degişlikde ulaldylar ýa-da kiçeldiler. 

Eger diňe probele basylsa onda şekili penjirede süýşürmek mümkin. 

Bu gepleşik penjireleriň parametrlerini öňki deslapky derejelerine getirmek 

üçin Alt klawişasyny basyp saklap Reset (Сброс) düwmejigine basmaly. 

 

Esasy ýa-da fon reňki bilen bir tonly reňkleýiş üçin Color (Цвет) ýa-da 

Swatches (Образцы) palitrasynda reňki saýlamaly.  

Gaýtalanýan nagyş üçin gerek bolan nusgany saýlamaly. Öz nusgany 

döretmegi isleseňiz, Rectangular Marquee (Прямоугольная область) guraly 

arkaly gatlagyň haýsy-da bolsa bölegini belläň, Edit > Define Pattern (Правка > 

Определить узор) buýrugy çagyryň, Deselect (Снять выделение) buýrukdan 

peýdalanmaly ýa-da Ctrl+D klawişalaryna basmaly.  

  

    

 Amallar «Tiz» klawişalar  

 Esasy reük bilen doldurmak, 100% açyk 

dällilik 

Alt+Backspace   

 Fon reňki bilen doldurmak, 100% açyk 

dällilik  

Ctrl+Backspace   

 Görünýän pikselleri esasy reňk bilen 

doldurmak (açyk däl töwerekleri)  

Alt+Shift+Backspace   

 Görünýän pikselleri fon reňki bilen 

doldurmak (açyk däl töwerekleri) 

Ctrl+Shift+Backspace   

Gatlagy dolulykda reňk bilen doldurmak üçin ony saýlap Layers (Спои) 

palitrasynda Lock transparent pixels (Блокировать прозрачные точки) 

baýdajygy aýyrmaly; Amalyň täsirini çäklendirmek üçin bellenilen töweregi 

döretmeli. Edit > Fill (Правка > Залить) buýrugy ýerine ýetirmeli ýa-da 

Shift+Backspace klawişalaryna basmaly.  

Use (Используя) выберите açylýan menýudan gatlagy ýa-da bellenilen 

töweregi näme bilen doldurmagy saýlamaly: Foreground Color (Основной 

цвет), Background Color (Фоновый цвет), Black (Черный), 50% Gray (50% 

серый) ýa-da White (Белый). Pattern (Узор) wariant saýlanylsa, Custom 

Pattern (Узор по выбору пользователя) meýdanyň strelkasyna basmaly we 

açylýan panelde nusgany saýlamaly. Blending (Смешивание) bölüminde Mode 

(Режим) we Opacity (Непрозрачность) parametrleri bellemeli. Eger Layers 

(Слои) palitrasynda Lock transparent pixels (Блокировать прозрачные точки) 

baýdajygy goýmak ýatdan çykarylan bolsa, onda onuň deregine bu ýerde Preserve 

Transparency (Сохранять прозрачность) baýdajygy goýmak mümkin. 
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Gatlagyň suduryny çyzmak üçin Edit > Stroke (Правка > Очертить) 

buýrugyny çagyrmaly. Width (Ширина) meýdanynda 1-den  16-a çenli bahany 

girizip çyzygyň ini bellemeli. Reňki saýlamak üçin Color (Цвет) meýdanyndaky 

reňke basmaly Color Picker penjireden reňki saýlamaly. Şeýle hem bu amaly 

Layer Style (Стиль слоя) penjiresinde Stroke (Очертить) opsiýasyny bellemeli. 

Hue/Saturation buýrugy arkaly şekili işläp bejermek. 

1.  Gatlagy ýa-da onuň bellenilen töweregini saýlamaly.  

2. Image > Hue/Saturation (Изображение > Тон/Насыщенность) buýrugy 

ýerine ýetirmeli (Ctrl+U (Windows) klawişalar).  

3. Şekiliň hemme reňklerini sazlamak üçin Edit (Правка) döreýän menýudan 

Master (Мастер) warianty saýlamaly, ýa-da deslapdan döredilen diapazony 

bellemeli diňe onuň bilen işlemek üçin.  

Reňki reňkler paneliniň býleki töweregine süýşürmek üçin Hue (Тон) 

polzunogy çepe ýa-da saga süýşüriň  

Saturation (Насыщенность) polzunogy doýgunlygy peseltmek üçin çepe, 

ýa-da artdyrmak üçin saga süýşürmeli.  

Şekili ýagtylandyrmak üçin Lightness (Яркость) polzunogy saga, 

garamtylamak üçin bolsa çepe süýşürmeli.  

Eger Edit (Правка) menýudan öň saýlanylan reňk diapazony alynsa, onda 

düzediş polzunogy we reňki bellemek üçin pipetkalar elýeterli bolýar. Düzediş 

polzunogy Hue (Тон), Saturation (Насыщенность) we Lightness (Яркость) 

opsiýalaryň täsir etjek diapazony daraltmak ýa-da giňeltmek üçin ulanmak 

mümkin.  
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Deslapdan düzediş polzunogy reňk tekeriň 90° ýapýar: çepden we sagdan çal 

töwerekler  - 30° her biri we garamtyl-çal töwerek (reňkleriň diapazony) 30°.  

  

 
 

Reňkiň çalşyrylmagy  

1. Deslapdan saýlaman şekiliň reňklerini üýtgetmek üçin Replace Color 

(Заменить цвет) buýrugyny ulanmaly. Munuň üçin gatlagy ýa-da bellenilen 

töweregi saýlamaly. Image > Adjustments > Replace Color 

(Изображение > Корректировки > Заменить цвет) buýrugy ýerine 

ýetirmeli.  

2. Çalşyrylmaly reňke basmaly, ýa-da Replace Color (Заменить цвет) 

gepleşik penjiresiniň serediliş böleginde reňki saýlamaly.  

3. Fuz-ziness (Размытость) polzunogy, saýlanan reňk bilen bagly bolan 

reňkleri goşmak üçin saga süýşürmeli, ýa-da beýleki reňk töwerekleri 

goşmak üçin Shift klawişasyny basyp deslapky seretmegiň penjiresine 

syçanjyk bilen basmaly. Şeýle hem Shift klawişasyny basman Eyedropper+ 

(Пипетка+) guraly ulanmak mümkin.  

Alt klawişasyny basyp we deslapky seretmegiň penjiresine syçanjyk 

bilen basyp, reňkli töwerekleri aýyrmak mümkin. Ýa-da Alt klawişasynyň 

deregine Eyedropper- (Пипетка-) guraly işletmeli.  



 42 

 
 

4. Saýlanan reňkleri üýtgetmek üçin Hue (Тон), Saturation (Насыщенность) 

we Lightness (Яркость) polzunoklary süýşürmeli, (ýarym ton şekili üçin 

diňe Lightness (Яркость) polzunogy el ýeterli bolar). Nusga Sample 

(Проба) penjiresinde polzunoklar süýşürilende üýtgär.  

Gatlagy ýa-da fony ýarym ton görnüşe özgertmek  

Gatlakdan reňki aýyrmak, düzgüni çalşyrman üçin (ony ýarym tona geçirmek üçin) 

Desaturate (Обесцветить) buýrugy saýlamaly.  

1. Image > Adjustments > Desaturate (Изображение > Корректировки > 

Обесцветить) buýrugy saýlamaly ýa-da Ctrl+ Shift+U klawişalary 

basmaly.  

Color Balance buýrugy 

Gatlagyň açyk, orta ýa-da garamtyl tonuny düzetmek üçin ýa-da haýsy-da 

bolsa ýyly ýa-da sowyk öwüşgini girizmek üçin Color Balance (Баланс цвета) 

gepleşik penjiresini ulanmaly.  

1. Image > Adjustments > Color Balance (Изображение > Корректировки 

> Баланс цвета) buýrugy saýlamaly (Ctrl+B).  

2. Gepleşik penjiresiniň aşagynda düzedilmeli diapazony bellemeli: Shadows 

(Темные тона), Midtones (Средние тона) ýa-da Highlights (Светлые 

тона).  

3. Islendik polzunogy goşjak bolýan reňke tarap süýşürmeli. Ýyly we sowuk 

tonlar biri biri bilen jübütde ýerleşen. Meselem, polzunoklaryň Cyan we 

Blue taraplaryna süýşürilmegi sowuk öwüşgini emele getirer.  
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Variations gepleşik penjiresinde reňki düzediş 

Variations (Вариации) gepleşik penjiresi şekiliň reňkleriň dürli sazlamalary 

bilen görkezilişini amala aşyrýar. Şekiliň penjiresinde has tajyk düzedişleri we 

üýtgetmeleri geçirmek üçin Color Balance (Баланс цвета) ýa-da Levels (Уровни) 

gepleşik penjirelerini ulanmaly.  

Variations (Вариации) buýrugyny Indexed Color düzgündäki şekil üçin 

ulanmak mümkin däl.  

1. Image > Adjustments > Variations (Изображение > Корректировки > 

Вариации) buýrugyny ýerine ýetirmeli.  

2. Gepleşik penjiresiniň ýokarsynda pereklýuçateli Shadows (Темные тона), 

Midtones (Средние тона) ýa-da Highlights (Светлые тона) düzgünine 

diňe şol töwerekleri üýtgetmek üçin goýmaly, ýa-da Saturation 

(Насыщенность) bendi reňkiň diňe bu häsiýetini bellemeli.  

3. Fine/Coarse (Тонкий/Грубый) polzunogy güýçli düzedişi geçirmek üçin 

saga, ýa-da uly bolmadyk üýtgemeler üçin çepe süýşürmeli. 

4. More... (Больше...) ýazgyly miniatýura basyp, şol reňki gatlaga köp 

mukdarda goşmak üçin. Eger haýsy-da bolsa bir reňki azaltmak üçin 

diagonalyň garşyky ahyrynda ýerleşen reňke basmaly.  

Özi bilen üýtgedilen gatlagy bolup durýan Current Pick (Текущий выбор) 

miniatýurany Original (Исходное изображение) miniatýura bilen deňeşdirip 

görmeli. Düzedişi ýatyrmak üçin başdaky şekile basmaly.  

6. Lighter (Светлее) ýa-da Darker (Темнее) miniatýura, tona degmän 

ýagtylygy üýtgetmek üçmin basmaly.  
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Surat çekmek 

Brush guraly 

Brush (Кисть) (В klawişasy) guraly işledip, esasy reňki saýlamaly. Opsiýalar 

panelinde kistiň tipini saýlamak üçin Brush (Кисть) strelkasyna basmaly. 

Piktogrammanyň aşagyndaky san kistiň pikselde bolan inini kesgitleýär. 

Gönı çyzykly ştrihi döretmek üçin syçanjyk bilen bir gezek basyp ştrihi 

başyny bellemeli, we Shift düwmejigini basyp başga ýere syçanjyk bilen ştrihi 

tamamlamaly.  

Alt klawişasyny basyp şekiliň islendik ýerine basyp gural işläp duran wagty 

reňkiň nusgasyny almak mümkin.  
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Bar bolan kisti üýtgetmek 

Photoshop programmasy bilen bilelikde kistleriň bibliotekasy goşulýar we olaryň 

islendigini modofosorläp mümkin.  

1. Opsiýalar panelinde Brushes (Кисть) düwmejigine basyň we Brush Tip 

Shape menýusyna geçmeli.  

2. Diameter (Диаметр) polzunogy süýşüriň ýa-da ştrihiň diametrini (inini) 

girizmeli (1-den 999-a çenli).  

3. Hardness (Жесткость) polzunogy süýşürmeli ýa-da kistiň açyk däl yzyny 

kesgitleýän sany girizmeli –ştrihiň diametrinden göteromde (0-100%).  

4. Spacing (Интервал) süýşürmeli ýa-da şol parametriň ululygyny girizmeli 

(0-999%). Ol näçe ýokary bolsa, şonça hem daşlykda kistiň yzlary ýerleşer.  

Deslapdan gurnalan kistleriň köpüsi üçin üýtgedip boljak ýeke-täk opsiýalar - bu 

Spacing we Diameter.  

5.  Angle (Угол) meýdanyna belli bir bahany girizmeli (-180°-dan +180°-a 

çenli).  

6. Roundness (Округлость) parametriň ähmiýetini girizmeli (0-100%) ýa-da 

iki sany gara nokadyň birini tegelegiň daşyna ýa-da içene çekmeli. Ähmiýet 

näçe ýokary bolsa, şonça hem kistiň görnüşi tegelege golaý.  

 
7. Kistiň üýtgedilen häsiýetnamalary olary kistiň täze ekzemplýary hökmünde 

ýatda saklaýançaňyz wagtlaýyn bolar.  

8. Penjiräni ýapmak üçin gaýtadan Brushes (Кисти) düwmejigine basmaly.  

Bar bolan kist üýtgedilende onuň özi dälde onuň wagtlaýyn nusgasy 

modifisirlener. 
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Täze kisti döretmek 

1. Brush (Кисть) meýdanynda strelka basmaly we saýlama paneliniň 

menýusyndan New Brush (Создать кисть) buýrugyny saýlamaly.  

2. Kistiň üýtgedilen görnüşini ýatda saklajak bolsaňyz Create New Brush 

(Создать новую кисть) düwmejigine basmaly (emma täze nusa hiç bir 

biblioteka girmez.). Täze kistiň piktogrammasy saýlama paneliniň iň 

soňunda ýerleşer.  

Kisti ýok etmek  

1. Kisti saýlama paneli açmaly.  

2. Birinji usul: Alt klawişasyny basyp we ýok edilmeli kiste syçanjyk bilen 

basmaly. Bu amaly ýatyryp bolmaýar.  

ikinji usul: ýok edilmeli kisti görkezip, açylýan menýudan Delete Brush (Удалить 

кисть) buýrugy saýlamaly 

 

 

Dry Media Brushes bibliotekasy 

 

 

 

 

 

Special Effects Brushes bibliotekasy 

 

 

Thick Heavy Brushes bibliotekasy 
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Wet Media Brushes bibliotekasy 

Şekiliň esasynda kisti döretmek 

1. Rectangular Marquee (Прямоугольная область) guraly işletmeli.  

2. Şekiliň belli bir töweregini çäk bilen bellemeli (aňryçäk 1000x1000 piksel).   

3. Edit > Define Brush (Правка > Определить кисть) buýrugy saýlamaly.  

4. Вtäze kistiň adyny girizmeli we ОК düwmejigine basmaly. Täze kistiň 

piktogrammasy saýlama panelinde iň soňky bolar. Bu kist bilen Brush 

(Кисть) guraly bilen işlenende peýdalanmak mümkin. Redaktirleme 

palitrada Spacing (Интервал) parametrini sazlamaly. 

Kisti täze bibliotekada ýatda saklamak 

Täze kistleri bibliotekada ýayda saklamak üçin aşakdakylary ýerine ýetirmeli:  

1. Kisti saýlama paneliniň menýusynda Save Brushes (Сохранить кисти) 

buýrugy saýlamaly.  

2. Bibliotekanyň adyny girizmeli. (.abr).  

3. Bibliotekanyň saklanyljak bukjasyny saýlamaly we Save (Сохранить) 

düwmejigine basmaly.  

Töweregi Paint Bucket guraly bilen doldurmak. 

Paint Bucket (Ведро с краской) guraly pikseller esasy reňk ýa-da nagyş 

bilen çalşyrýar.  

Paint Bucket (Ведро с краской) guraly Bitmap düzgündäki şekile ulanmak 

mümkin däl. 
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Gural saýlanylandan soň panelde Fill (Залить) meýdanynda Foreground 

(Основной цвет) bahany we Mode (Режим смешивания) meýdanynyň bahasyny 

goýmaly. Shift-plýus» ýa-da Shift+«minus» klawişalary yzygiderli düzügünden 

düzgüne geçmek üçin ulanmaly. Maslahat. Multiply (Умножение), Soft Light 

(Мягкий свет) ýa-da Color Burn (Форсирование цвета) düzgünleri ulanyp 

görüň.  

  Opacity (Непрозрачность) parametriň bahasyny göterimde we Tolerance 

dopuskyň ululygyny (0-255) girizmeli. Şol ululyk näçe ýokary bolsa, şomça hem 

guralyň çalşyrjak reňkleriň çägi ýokary bolar. Ilkibaşda uly bolmadyk dopusky 

goýmaly we doldurylýan töweregiň araçägini tekizlemek üçin Anti-aliased 

(Сглаживание) baýdajygy goýmaly hem-de syçanjyk bilen basylýan töwerege 

diňe galtaşýan töwerekleri reňk bilen doldurmak üçin Contiguous (Смежные) 

baýdajygy goýmaly.  

Background Eraser (Ластик для фона) guraly 

Bu gural üstünden kursor geçirilýän töwerekleri açyk edýär ýa-da ony fon 

reňki bilen doldurýar.  

1. Bu guraly saýlamaly. 

2. Opsiýalar panelinde Limits (Границы) menýudan şekiliň nirede 

pozuljakdygyny saýlamaly:  

1. Discontiguous (Несмежные), nokatlaryň galtaşýanlygyna 

garamazdan dopusk bilen kesgitlenýän çäkdäki hemme nokatlary 

pozmak üçin. Eger bu opsiýa saýlanylsa onda mundan beýläk 

Sampling (Взятие образца) menýudan Once (Один раз) parametri 

saýlamaly;  

2. Contiguous (Непрерывно), diňe, Tolerance (Допуск) parametri 

bilen kesgitlenýän çäkdäki galtaşýan, ilkinji syçanjyk bilen basylan 

piksleiň reňkine gabat gelýän nokatlary pozmak üçin;  

3. Find Edges (Найти края), diňe goňşy nokatlary ýok etmek üçin, 

emme obýektiň araçäklerini saklamak (ýokary kontrastly araçäklerer 

degişlikde).  

3. Tolerance (Допуск) parametriň bahasyny saýlamaly. Ol näçe ýokary bolsa, 

şonça hem, syçanjyk bilen basylan ilkinji pikseliň reňkine meňzeş reňkleriň 

çägi giň.  

4. Sampling (Взятие образца) menýudan saýlamaly:  

o Continuous (Непрерывно), dopusk bilen kesgitlenýän çäkdäki, 

üstünde kursor geçirilýän hemme pikselleri açyk etmek üçin; 

o Once (Один раз), diňe, üstünden kursor geçirilen ilkinji piksele takyk 

gabat gelýän pikselleri açyk etmek üçin. Diňe bir reňki pozmak üçin 

bu opsiýany saýlamaly we  dopusky 1% deň etmeli;  

o Background Swatch (Фоновый цвет), diňe, reňki fon bilen gabat 

gelýän pikselleri pozmak üçin. Bu opsiýasu ulanylandan dopuskyň 

kiçi bahasyny goýmaly. 
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6. Pozmakdan belli bir reňki goramak üçin Protect Foreground Color 

(Защитить основной цвет) baýdajygy goýmaly we Sampling (Взятие 

образца) menýusynda Once (Один раз) opsiýanyň saýlanylandygyna göz 

ýetirmeli. Color (Цвет) palitrasynda esasy reňkiň inedördülini işletmeli we 

Alt klawişany basyp ony goýbermän şekiliň goranyljak pikseline basmaly.  

7. Pozulmaly gatlagy, nokatlary saýlamaly.  

8. Kursoryň işjeň bölegi bu kesişýä çyzyklar. 

Magic Eraser (Волшебный ластик) guraly 

Bu gural kursory geçirmän, syçanjygyň ýönekeý basylmagy pikselleri 

pozmagy mümkin edýär. Ol, berlen dopusky hasaba almak bilen reňki syçanjyk 

bilen basylan piksele gabat gelýän nokatlary pozýar. Bu gural edil Paint Bucket 

(Ведро с краской) ýaly işleýär, emma tapawutlykda ol pikselleri goşmaýarda – 

ýok edýär. Eger açyk dälligi 100%-den pes edilse, onda Magic Eraser guraly 

arkaly gatlagyň maksatly töwereklerini bölekleýin açyk edip bolýar.  

 

 Awtomatiki pozmagyň düzgüni 

Awto pozmagyň düzgüninde (hakykatdan Auto Erase (Автоластик) 

opsiýasy goýlan Pencil (Карандаш) guraly bilen işlenilende) esasy reňkiň 

pikselleriň üstünden kursor geçirilende fon reňki bilen surat çekiliş bolup geçýär. 

Eger kursory beýleki reňkiň pikselleriniň üstünden geçirilse, onda gural esasy reňk 

bilen çyzyp başlar. 

Reňkleri çyrşama  

1. Gatlagy saýlamaly.  

2. Smudge (Палец) guraly R ýa-da Shift+R  klawişalary basyp işletmeli. 

Opsiýalar panelinde Brush (Кисть) meýdanynda strelka basmaly we kistiň 

tipini saýlamaly.  

3. Pressure (Давление) polzunogy 100%-den pes baha geçirmeli.  

4. Çyrşdyrmagy esasy reňkden başlamak üçin, opsiýalar panelinde Finger 

Painting (Рисование пальцем) opsiýasyny goýmaly. Eger ol opsiýa 

öçürilen bolsa, çyrşaşdyrma, ştrihiň başlanýan nokadyndan başlanar. 

Strength (Давление) parametriň bahasy näçe ýokary bolsa, şonça hem 

esasy reňk köp derejede ulanylar.  

 

Gradiýent 

Gradiýent reňklenmesi özi bilen iki ýa-da köp reňkleriň arasynda kem-

kemden biri-birine geçmeklik bolup durýar. Programma gradiýenti ulanmagyň iki 

usulyny hödürleýär. Birinji - Gradient (Градиент) guralyny ulanmaklyk, ol 

gradiýenti gönümel gatlagyň düzümine ulanmagy mümkin edýär.  

Ikinji usul – doldurmagyň täze gatlagyny gradiýent bilen ulanmaklyk 

(gradient fill layer), bu ýagdaýda gradiýent öz gatlagynda ýerleşýär. Gradiýentiň 

bu görnüşini redaktirlemek aňsat. 

Gradiýenti doldurma gatlagy hökmünde ulanmaklyk 
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1. Gatlagy saýlamaly. Gradient (Градиент) guraly Bitmap ýa-da Indexed 

Color düzgündäki şekillere ulanmaklyk mümkin däl.  

2. Gradient (Градиент) bendi Create new fill or adjustment layer (Создать 

новый слой заливки или корректирующий слой) düwmejigi bilen 

çagyrylýan menýudan çagyrmaly.  

3. Gepleşik penjiresiniň ýokarsynda Gradient (Градиент) meýdanyndaky 

strelka basmaly we reňkleýşiň nusgasyny saýlamaly.  

4. Style (Стиль) meýdanyndaky bahany saýlamaly: Linear (Линейный), 

Radial (Радиальный), Reflected (Отраженный), Angular (Угловой) ýa-

da Diamond (Ромбовидный).  

Gradiýentiň çykýan burçuny üýtgetmek üçin Angle (Угол) parametriň 

bahasyny bermeli.  

Scale (Масштаб) polzunogy, gradiýentiň gatlaga görä masştabyny sazlamak 

üçin üýtgetmeli. Onuň bahasy näçe ýokary bolsa, şonça hem gradiýentiň 

reňkleriniň arasyndaky geçiş birsydyrgyn bolar. 

 

 

 

 

 

Reverse (Обратить) baýdajygy gradiýentäki reňkleriň geçmeginiň ters 

tertibine çalşyrmak üçin goýmaly/aýyrmaly.  
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Dither (Размыть) baýdajygy gradiýente zolaklaryň emele gelmeginiň 

mümkinligini iň pes ýagdaýa getirmek üçin goýmaly.  

Align with layer (Выровнять со слоем) baýdajygy gradiýent doldurmagyň 

uzynlygy gatlagyň çäginiň ölçeglerini hasaba almak bilen hasaplanar ýaly 

goýmaly. 

Gradient guralyny ulanmaklyk 

Gradient (Градиент) gural arkaly şekili ýöne kursory süýşürip reňklemek 

mümkin. Her gezek kursor süýşürilende gatlaga täze gradiýent ulanylar. Gradiýent 

doldurmagyň gatlagyndan tapawutlykda şu hili döredilen gradiýenti redaktirlemek 

kyn.  

1. Gradient Tool (Градиент) guraly işletmeli  (G или Shift+G).  

2. opsiýalar panelinde birinji meýdanyň strelkasyna basyp reňkleýişiň 

nusgasyny saýlamaly.  

Gradiýentiň burçy 45° bölünijilikli bolar ýaly Shift klawişasyna basyp 

kursory süýşürmeli. 

Gradiýentiň nusgasyny döretmek we redaktirlemek 

Gradiýentiň nusgasy üýtgedilse we ýok edilse, hakyky gradiýent 

gradiýentleriň şol wagtky ulanylýan bibliotekasynda üýtgedilmez;.  

1. Gradient (Градиент) guralyny işletmeli, soňra opsiýalar panelinde 

gradiýentiň nusgasyna basyp, Gradient Editor (Правка градиента) 

penjiresini açmaly.  

2. Gradient Editor (Правка градиента) gepleşik penjiresinde üýtgetjek 

bolýan gradiýentiň nusgasyna basmaly.  

3. Başlangyç reňki saýlamak üçin gradiýentiň paneliniň aşagynda ýerleşen 

öwüşginiň başlangyç markerine basmaly.  

4. Swatches (Образцы) palitrasynda haýsy-da bolsa bir reňke basmaly, ýa-da 

Color (Цвет) palitranyň aşaky böleginde ýerleşen spwektriň paneline 

basmaly.  

5. Ahyrky reňki saýlamak üçin ahyrky öwüşginiň markerine basmaly.  

Gradiýente aralykdaky reňki goşmak üçin gradiýentiň paneliniň aşagyna 

syçanjyk bilen basmaly we mareker döretmeli hem-de onuň üçin reňk saýlamaly.  

Reňkleriň biri-birine geçmeginiň ýitiligne gözegçilik etmek üçin romb 

görnüşindäki markeri süýşürip durmaly.  

Reňki ýok etmek üçin onuň markerini panelden aşak süýşürmeli. Soňky 

amaly ýatyrjak bolsaňyz Ctrl+Z tiz klawişalardan peýdalanmaly.  

 Gradiýentiň reňkleriniň açyk dälliginiň derejesini üýtgetmek  

1. Gradient Editor (Правка градиента) gepleşik penjiresini açmaly we 

nusgany saýlamaly.  

2. gradiýentiň paneliniň ýokarsynda ýerleşen açyk dälligiň markerine basmaly.  

3. Açyk dälligiň derejesini saýlamaly.  

Açyk dälligiň goşmaça markerlerini goşmak üçin gradiýentiň paneliniň 

ýokarsyna basmaly we her marker üçin açyk dälligiň koeffisientini girizmeli. 
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Gatlaklar barada goşmaşa maglumat 

 

Gatlagyň açyk dälligini üýtgetmek 

Layers (Слои) palitrasynda gatlagyň açyk dälliginiň derejesini bellemek 

mümkin. Programmada açyk dälligiň hem esasy derejesini (Opacity meýdany), 

hem-de içerki derejesini (Fill meýdany) üýtgetmek mümkin. Şol bahalar näçe pes 

bolsa, şonça hem aktiw gatlagyň aşagynda köp pikseller görüner. Fpnuň açyk 

dälligini üýtgedip bolmaýar. 

Effektler  

Gatlaga şular ýaly ýörite effektleri ulanmak mümkin: Drop Shadow 

(Отбросить тень), Inner Shadow (Внутренняя тень), Outer Glow (Внешнее 

свечение), Inner Glow (Внутреннее свечение), Bevel and Emboss (Скос и 

рельеф), Satin (Атлас), Color Overlay (Наложение цвета), Gradient Overlay 

(Наложение градиента), Pattern Overlay (Наложение узора) we Stroke 

(Кайма).  

Stiller bilen effektleri çalşyrmaly däl. Stil – gatlagyň bir ýa-da birnäçe 

effektleriň utgaşmasy.  

Effektler Layer Style (Стиль слоя) gepleşik penjiresi ýa-da Add layer style 

(Добавить стиль слоя) bendi arkaly döredilýär we redaktirlenýär. Gatlagyň 

effektini şekiliň fonuna ulanmak mümkin däl. 

Effektleri bir gatlakdan beýlekä göçürip bolýar, munuň üçin oalry belläp 

syçanjyk bilen gerekli gatlagyň üstüne getirip goýmaly, olary edil gatlaklary ýaly 

bukup bolýar, wagtlaýynça hemme effektleri bukup programmanyň tiz 

hereketliligini ýoakrlandyrmak üçin Layer > Layer Style > Hide All Effects 

(Слой > Стиль слоя > Спрятать все эффекты) buýrugy saýlamaly. Olary 

görkezmek üçin Show All Effects (Показать все эффекты) buýrugy çagyrmaly; 
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Drop Shadow we Inner Shadow effektleriň ulanylmagy 

1. Gatlagy saýlamaly.  

2. Drop Shadow (Отбросить тень) effektiň adyna basmaly.  

Blend Mode (Режим смешивания) menýudan garyşma düzgüni saýlamaly. 

Kölege üçin başga reňk saýlamak üçin reňkiň nusgasyna basmaly.  

Kölegäniň açyk dälligiň derejesini saýlamaly.  

Angle (Угол) parametriň bahasyny saýlamaly, ol başlangyç gatlagyň 

fuguralaryna görä kölegäniň burçuny kesgitleýär. Use Global Light 

(Использовать глобальное освещение) baýdajyk goýlan bolsa, onda 

Layer > Layer Style > Global Light (Слой > Стиль слоя > Глобальный 

свет) gepleşik penjiresinde girizilen burç ulanylar. Şol effekt üçin aýratyn 

burçy ulanmak üçin şol baýdajygy aýyrmaly.  

Bellik 
Eger Use Global Light (Использовать глобальное освещение) baýdajyk goýlan 

ýagdaýynda aýry effekt üçin burç üýtgedilse, onda bu opsiýany ulanýan hemme 

effektler üçin burç hem üýtgediler.  
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Distance (Расстояние) parametriň bahasyny saýlamaly, ol kölegeden 

başlangyç gatlagyň figurasyna çenli aralygy (pokselde) ýa-da içki kölegäniň inini 

kesgitleýär.  

 
Spread (Распространение) parametri kölegäniň gyralarynyň goýulygynyň 

derejesini kesgitleýär. Inner Shadow (Внутренняя тень) effekti üçin kölegäni 

inçeldýän Choke (Уменьшение) parametriň bahasyny saýlamaly.  

Kölegäniň ölçegini Size (Размер) polzunogy arkaly bellemeli. Quality 

(Качество) parametrleriň toparynda kölegäniň araçäkleri üçin sudury ýörite 

panelde saýlamak üçin Contour (Контур) strelkasyna basmaly. 

 

Outer Glow we Inner Glow effektleriň ulanylmagy 

1. Swatches (Образцы) palitrasyny açmaly.  

2. Gatlagyň adyna iki gezek syçanjyk bilen basmaly.  

3. Outer Glow (Внешнее свечение) ýa-da Inner Glow (Внутреннее 

свечение) effektleriň atlaryn basmaly.  

4. Structure (Структура) bölüminde parametrleriň bahalaryny bermeli.  

Yşyklyklygyň reňkini üýtgetmek üçin reňkiň nusgasyna basmaly we açylýan 

panelden reňki saýlamaly. Fonuň reňki bilen kontrastlaşýan reňki saýlamaly, 

sebäbi daşky yşyklanmanyň açyk reňkini açyk fonda görmek örän kyn. 

5. Noise (Шум) parametriň bahasyny goýmaly, ol yşyklanmagyň 

garjaşyklygynyň derejesini kesgitleýär. 

Elements (Элементы) bölüminde parametrleriň bahalaryny saýlamaly.  

Technique (Техника) açylýan menýudan Softer (Мягче) ýa-da Precise 

(Точно) warianty saýlamaly – maskanyň töweregiň suduryna näçe takyk 

laýyk gelýändigine gözegçilik etmek üçin.  
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Inner Glow (Внутреннее свечение) effekti üçin pereklýuçateli Center 

(Центр) ýagdaýyna goýmaly – gatlagyň merkezi piksellerinde yşyklanmany 

döretmek üçin. Eger pereklýuçatel Edge (Граница) ýagdaýyna goýlan 

bolsa, onda yşyklanma obýektiň çäklerinden onuň içine gidýän edilip 

dörediler.  

Outer Glow (Внешнее свечение) effektiň ýagdaýynda Spread 

(Распространение) parametriň ululygyny yşyklanmanyň inini kesgitlemek 

üçin bellemeli.  

Inner Glow (Внутреннее свечение) effekti üçin Choke (Уменьшение) 

parametriň ululygyny düzetmeli, ol yşyklanmanyň inini kesgitlekligi amala 

aşyrýar.  

Yşyklanmanyň ölçegini Size (Размер) ölçegi arkaly bellemeli. 

 

6. Quality (Качество) bölüminde parametrleriň bahalaryny goýmaly.  

Yşyklanmanyň araçäginiň profili üçin suduryň nusgasyny saýlamak üçin 

Contour (Контур) meýdanynda strelka basmaly.  

Yşyklanmanyň içinde suduryň effektiniň ýerleşmegine gözegçilik etmek 

üçin Range (Диапазон) parametriň bahasyny saýlamaly.  

7. Eger ýşyklanma gradiýenti saklaýan bolsa Jitting (Дрожание) parametri 

gradiýentde reňkleri tötänleýin ýerleşdirmek üçin ulanmaly. 

 

Bevel we Emboss effektlerini ulanmaklyk. 

Bevel and Emboss (Скос и рельеф) effekti gatlagyň figuralaryna yşygy we 

gölegäni goşup göwrümiň hyýalyny döredýär.  

1. Swatches (Образцы) palitrasyny açmaly.  

2. Layers (Слои) palitrasynda gatlagyň adyna iki gezek syçanjyk bilen 

basmaly.  



 56 

3. Bevel and Emboss (Скос и рельеф) effektiň adyna basmaly.  

4. Structure (Структура) bölüminde parametrleriň bahalaryny saýlamaly.  

Style (Стиль) menýusynda şulardan bir warianty saýlamaly: Outer Bevel 

(Внешний скос), Inner Bevel (Внутренний скос), Emboss (Рельеф), Pillow 

Emboss (Выпуклый рельеф) ýa-da Stroke Emboss (Рельефная кайма).  

Technique (Техника) açylýan menýudan Smooth (Гладко), Chisel Hard 

(Твердый резец) ýa-da Chisel Soft (Мягкий резец) wariantlary saýlamaly.  

Gatlagyň figurasyndan açyk meýdançalaryň we kölegäniň süýşmeginiň 

derejesini görkezmek üçin Depth (Глубина) parametriň bahasyny girizmeli.  

Up (Вверх) we Down (Вниз) pereklýuçatelleri yşygyň we kölegäniň 

ýerlerini çalyşmagy mümkin edýärler.  

Effekt üçin Size (Размер) parametriň bahasyny saýlamaly.  

Figuranyň takyk araçäklerini ýumşatmak üçin we şeýleik bilen effekti 

ýumşatmak üçin Soften (Смягчить) parametriň bahasyny artdyrmaly.  

5. Shading (Затенение) bölüminde parametrleriň bahalaryny saýlamaly.  

Angle (Угол) we Altitude (Высота) parametrler yşygyň çeşmesiniň 

ýerleşişini kesgitleýär, bu bolsa bliklere we kölegelere täsir edýär. Gloss Contour 

(Контур блеска) strelkasyna basmaly we açylýan panelde nusgany saýlamaly.  

6. Highlight Mode (Режим света) we Opacity (Непрозрачность) ýa-da 

Shadow Mode (Режим - тени) we Opacity (Непрозрачность) parametrleriň 

bahalaryny degişlikde şekiliň açyk we garamtyl töwerekleri üçin goýmaly.  

Açyk we garamtyl tonlaryň reňkini üýtgetmek üçin reňkiň islendik 

nusgasyna basmaly we Color Picker panelinde täze tony saýlamaly.  

6. Bevel and Emboss (Скос и рельеф) effektine yşyklanmanyň araçäklerine 

täsir edýän belli bir sudury goşmak üçin Bevel and Emboss (Скос и 

рельеф) adyň aşagynda ýerleşen Contour (Контур) ýazga basmaly. 

Contour (Контур) meýdanyndaky strelka basmaly we nusgany saýlamaly.  

Yşyklanmanyň içinde suduryň effektiniň ýerleşmegine gözegçilik etmek 

üçin Range (Диапазон) parametriň bahasyny saýlamaly. Bu opsiýa Emboss 

(Рельеф) effektine hiç-hili täsir etmeýär.  

7. Effekte teksturany goşmak üçin Texture (Текстура) ýazga basmaly, soňra 

Texture (Текстура) meýdanyň strelkasyna basyp açylýan panelde suraty 

saýlamaly.  

Suratyň masştabyny Scale (Масштаб) polzunogy arkaly redaktirlemeli.  

Depth (Глубина) parametri suratyň açyk we garamtyl reňkleriniň 

kontrastyny düzetmek üçin üýtgetmeli.  

Tekstura we gatlak sinhron hereket eder ýaly Link with Layer (Связать со 

слоем) baýdajygy goýmaly. Şekiliň penjiresinde kursor bilen teksturanyň 

şekilini gerek ýagdaýda ýerleşdirmeli.  
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Suduryň profiliniň üýtgedilmegi 

Effektiň suduryny üýtgetmek üçin aşakdaky hereketleri ýerine ýetirmeli.  

1. Bevel and Emboss (Скос и рельеф) effektiň ýagdaýynda Contour 

(Контур) ýazga basmaly.  

2. Suduryň miniatýurasyna basmaly.  

3. Contour Editor (Правка контура) gepleşik penjiresinde Preset (Образец) 

açylan menýuda sudury saýlamaly.  

4. Täze nokatlary goşmak üçin çyzga basmaly. Nokatlary süýşürip çyzgyny 

üýtgetmeli.  

5. Şol wagtda bellenilen nokady burçdaka özgertmek üçin Corner (Угол) 

baýdajygy goýmaly.  

Profilleriň miniatýuralary araçäkleriň dürli stillerini görkezýär. Çal 

töwerekler özi bilen açyk däl pikseller bolup durýar, aklar bolsa - açyk. 
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Satin effektiniň ulanylmagy 

1. Satin (Атлас) effektine basmaly.  

Blend Mode (Режим смешивания) meýdanyň bahasyny üýtgedip görmeli.  

Rweňki üýtgetmek üçin reňkiň nusgasyna basmaly.  

Angle (Угол) parametriň bahasyny üýtgetmeli. Ol burç Global Light 

(Глобальное освещение) parametriň bahasyna bagly däl.  

Distanсе (Расстояние) we Size (Размер) parametrleriň bahalaryny 

goýmaly. Contour (Контур) meýdanynda strelka basyp effektiň araçäginiň 

profilini saýlaň.  

2. Açyk we garamtyl töwerekleriň ýerini çalşyrmak üçin Invert 

(Инвертировать) baýdajygy goýmaly. 
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Color Overlay effektiň ulanylmagy 

1. Bir gatlagy saýlap oňa iki gezek basmaly.  

2. Color Overlay (Наложение цвета) effektiň adyna basmaly.  

Blend Mode (Режим смешивания) parametriň bahasyny saýlamaly.  

Öňküň üstünden goýmak üçin täze başga reňki saýlamaly.  

3. Opacity (Непрозрачность) parametriň bahasyny düzetmeli. 
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Gradient Overlay effektiň ulanylmagy 

1. Gatlagyň adyna iki gezek basmaly.  

2. Gradient Overlay (Наложение градиента) effektiň adyna basmaly.  

Blend Mode (Режим смешивания) parametriň bahasyny saýlamaly.  

Opacity (Непрозрачность) parametriň bahasyny düzetmeli.  

Gradient (Градиент) meýdanynda strelka basmaly, we gradiýenti 

saýlamaly. Gradiýentiň ugruny üýtgetmek üçin Reverse (Обратить) 

baýdajygy goýmaly.  

Style (Стиль) meýdanynda şu bahalardan saýlamaly: Linear (Линейный), 

Radial (Радиальный), Angle (Угловой), Reflected (Отраженный) ýa-da 

Diamond (Ромбовидный). 

Gradiýenti gatlagyň figuralaryna görä deňleşdirmek üçin Align with Layer 

(Выровнять со слоем) baýdajygy goýmaly.  

gradiýent üçin Angle (Угол) parametriň bahasyny goýmaly.  

3. Scale (Масштаб) parametriň bahasyny goýmaly. 

 

Pattern Overlay effektiň ulanylmagy 

1. Gatlagyň adyna iki gezek basmaly.  

2. Pattern Overlay (Наложение узора) effektiň adyna basmaly.  

Blend Mode (Режим смешивания) parametriň bahasyny saýlamaly.  

Opacity (Непрозрачность) parametriň bahasyny düzetmeli.  

Pattern (Узор) meýdanynda strelka basyp islendik nusgany saýlamaly.  
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Nagyş üçin Scale (Масштаб) parametriň bahasyny saýlamaly.  

Nagyşy gatlak bilen baglaşdyrmak üçin Link with Layer (Связать со слоем) 

baýdajygy goýmaly. 

 

Stroke effektiniň ulanylmagy 

1. Gatlagyň adyna iki gezek basmaly.  

2. Stroke (Кайма) effektiň adyna basmaly.  

Size (Размер) parametriň bahasyny saýlamaly. Position (Положение) 

açylýan menýudan gaýmanyň fuguranyň araçäklerine görä ýerleşişini 

saýlamaly: Outside (Снаружи), Inside (Внутри) ýa-da Centered (По 

центру).  

Blend Mode (Режим смешивания) parametriň bahasyny saýlamaly.  

Opacity (Непрозрачность) parametriň bahasyny düzetmeli.  

Fill Type (Тип заливки) menýuda gerek bolan görnüşi saýlamaly: Color 

(Цвет), Gradient (Градиент) ýa-da Pattern (Узор). 
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Gatlaklary baglaşdyrma we olary bir bitewi edip süýşürmek 

1. Layers (Слои) palitrasynda baglaşmaly gatlaklaryň birine basmaly.  

2. Birinji ädimde saýlanylan gatlak bilen baglaşmaly gatlagyň ýanyndaky ikinji 

sütüniň inedördüline basmaly. Baglaşylýan gatlaklar hökmany yzygiderli 

ýerleşmeli däldir. Baglaşma nyşany aktiw däl baglaşylan gatalagyň ýanynda 

emele geler.  

Iki we köp baglaşylan gatlaklary deňleşdirmek 

Align Layers (Выровнять слои) buýrugy baglaşylan gatlaklaryň 

araçäklerini deňleşdirmek üçin ulanylýar.  

1. Iki we ondan köp gatlaklar bilen baglaşylan gatlagy saýlamaly, şoňa görä 

beýleki gatlaklar deňleşdiriler.  

2. Layer > Align Linked > Top Edges (Слой > Выровнять связанные > 

Верхние границы), Vertical Center (Положение центра по вертикали), 

Bottom Edges (Нижние границы), Horizontal Center (Положение 

центра по горизонтали), Left (Левый край) ýa-da Right (Правый край) 

buýruklary saýlamaly.  
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Bellenilen töwerek boýunça gatlagyň araçägini deňleşdirmek 

1. Bellenilen töweregi döretmeli.  

2. Şol töwerek boýunça deňleşdirilen gatlagy saýlamaly.  

3. Layer > Align to Selection (Слой > Выровнять по выделенной области) 

kömekçi menýudan buýrugy saýlamaly.  

Saýlanylan gatlak bilen bagly bolan islendik gatlaklar hem deňleşerler. 

 

Üç we ondan köp baglaşan gatlaklaryň tertipleşdirilmegi 

Baglaşylan gatlaklarda şekilleri bellenilen tertipde Distribute Linked 

(Распределить связанные) buýrugy arkaly tertipleşdirmek mümkin.  

1. Iki we ondan köp gatlaklar bilen baglaşan gatlagy saýlamaly.  

2. Şol gatlagyň bir töweregini saýlamaly, şol töwerek boýunça beýleki 

gatlaklar deňleşdirilmeli.  

3. Layer > Distribute Linked > Top Edges (Слой > Распределить 

связанные > Верхние границы), Vertical Center (Положение центра по 

вертикали), Bottom Edges (Нижние границы), Horizontal Center 

(Положение центра по горизонтали), Left (Левый край) ýa-da Right 

(Правый край) buýruklary saýlamaly. 

Gatlaklaryň şekilleri biri-biriinde has uzakda ýerleşen iki sany gatlagyň 

arasynda birölçegli ýerleşdirilerler. 

 

Tejribe işleri 

 

 

1) Çekilen suratda birnäçe gatlaklary döretmek 

2) Gatlaklary birleşdirmek 

3) Tekst gatlagyny döretmek 

4) Ýazylan tekstiň transformasiýalaryny üýtgetmek 
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5) Ýazylan tekstiň kölegesini emele getirmek 

6) Ýazylan tekstiň ýylpyldysyny döretmek 

7) Teksti altyn şekilinde ýazmak 

8) Dürli gatlaklary ulanyp kompozisiýa döretmek 

9) Jaýlaryň utgaşygyny döretmek 

10) Tekst maskasyny almak 
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GOŞMAÇA MÜMKINÇILIKLER. 

 

Maskalar 

Bellenilen töweregiň formasyny ýatda saklamagyň we üýtgetmegiň ýörite iki 

sany usuly bar: alfa-kanallar we Quick Mask (Быстрая маска) düzgüni.  

Eger bellenilen töwerek alfa-kanal diýlip atlandyrylýan ýörite döredilen 

ýarym ton kanalda saklanylsa, ony islendik ýagdaýda şekile ýüklemek mümkin. 

Faýlda 24 sany kanala çenli saklanylyp bilner, her kanal faýlyň göwrümini 

ulaldýar.  

Alfa-kanallary el-ýeterligi Channels (Каналы) palitrasy arkaly almak 

mümkin, olary ýatda saklamagy ýa-da ýüklemegi bolsa Select (Выделить) 

menýusynyň ýa-da Channels (Каналы) palitrasynyň buýruklary arkaly amala 

aşyrmak mümkin. 

Quick Mask (Быстрая маска) düzgüni arkaly Photoshop programmasynda 

şekiliň bellenilen we bellenilmedik töwerekleriň üsti ýarym açyk reňkli maska 

bilen ýapylyp biler, soňkularyň formasynysurat çekiş ýa-da redaktirleýiş gural 

arkaly üýtgedilip bilner. Maskalanan töwerekler üýtgemelerden goranylan. Alfa-

kanallardan tapawutlykda tiz maskany ýatda saklama mümkin däl, emma 

Standard (Стандартный) düzgünine gaýdylanda maska ýatda saklanylyp biljek 

bellenilen töwerege özgerdiler. 

 Quick Mask (Быстрая маска) düzgüni gurallar panelinden (Q klawişasy) 

çagyryp, gatlagyň belli bir bölegini bellesek, ýarym açyk tonirlenen maska 

bellenilmedik töwerekleriň üstüni alar, bellenilen töwerek bolsa görüner. 

Maskanyň formasyny Pencil (Карандаш) ýa-da Brush (Кисть) gurallar arkaly 

üýtgetmek mümkin. Bellenilen töwerek boýunça gara reňk bilen çyzylsa 

maskalanan (goranylan) töwerek ulalar, ak bilen çyzylsa kesilip alnan 

(maskalanmadyk töwerek) ulalar. 

Aşakdaky görkezmeler ýerine ýetirilende maskany bellenilen töweregi 

ulanman döretmek mümkin.  

1. Pencil (Карандаш) ýa-da Brush (Кисть) guraly işletmeli.  

2. Gurallar panelindäki Quick Mask (Быстрая маска) düwmejige iki gezek 

basmaly.  

3. Color Indicates (Цвет означает) pereklýuçateli Selected Areas 

(Выделенные области) ýagdaýa goýup ОК düwmejige basmaly.  

4. Gatlaga gara ştrihleri çyzmaly. Bellenilen töwerekler maska bilen ýapylar, 

we çyzylan ýerler bolsa bellenilen töwerege öwrüler. Soňra standart düzgüne 

gaýtmak üçin Q klawişasyna basmaly.  

 

Sudurlar 

Aşakda suratlary görkezilen Реn (Перо) toparynyň gurallary we figuralary 

gurmagyň gurallary arkaly sudur (path) diýlip atlandyrylýan  wektor obýektleri 

döretmek mümkin.  

Sudurlar düwün nokatlardan (anchor point) durýarlar, şol nokatlar biri-biri 

bilen egri we göni çyzyklaryň segmentleri bilen birleşdirilen. Suduryň formasyny 



 66 

üýtgetmek üçin düwün nokady süýşürmeli, goşmaly ýa-da ýok etmeli ýa-da 

swgmenti süýşürmeli.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Реn (Перо) ýa-da Freeform Pen (Свободное перо) gurallary arkaly 

döredilen sudurlary Paths (Контуры) palitrany ulanmakly bilen görkezilýär, 

açylýar, ýapylýar, ýatda saklanylýar we ýok edilýär. 

Bellenilen töweregi sudura özgertmek üçin aşakdaky amallary ýerine 

ýetirmeli .  

1. Şekiliň bölegini saýlamaly.  

2. Alt klawişasyna basmaly we ony goýbermän Paths palitrasynyň aşaky 

bölegindäki Make work path from selection (Создать рабочий контур из 

выделенной области) düwmejige basmaly ýa-da Paths palitrasynyň 

menýusynda Make work path buýrugy saýlamaly.  

3. Tolerance (Допуск) parametriň bahasyny 0,5-den 10-a çenli girizmeli (şol 

baha näçe kiçi bolsa şonça düwün nokatlary kän bolýar we sudur has takyk 

bolar).  

Bellenilen töwerek sudura özgerdilen soň programma amallary diňe sudur 

bilen alyp barar. 

Täze iş suduryň ady Paths palitrasynda emele geler. Programma tarapyndan 

hödürlenen ady hökmany üýtgetmelidir, munuň üçin oňa iki gezek basmaly we 

täze at girizmeli. 

Sudury Реn guraly arkaly gurmaklyk 

1. Munuň üçin Pen Tool guraly saýlamaly (Р ýa-da Shift+P klawişasy).  
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2. Göni çyzykly segmentleri almak üçin syçanjyk bilen şekiliň ýerlerine basyp 

durmaly iki nokadyň arasy awtomatiki göni çyzyk bilen birleşiler. Indiki 

kesimi 45° bölünijikli burç bilen çyzmaly bolsa Shift klawişasyny basyp 

syçanjygy basmaly.  

Eger egri çyzykly segmenti gurmak gerek bolsa, syçanjygyň çep 

düwmejigini basyp ony süýşürmeli. Ugrukdyryjy çyzyklar emele geler.  

Soňky düwün nokadynda öwrümi döretmek üçin Alt klawişasyny basyp, 

syçanjygy gerekli ugra süýşürmeli.  

Soňky döredilen düwün nokadyny ýok etmek üçin Delete klawişasyny 

basmaly, tutş sudury ýok etmek üçin bolsa şol klawişany iki gezek basmaly. 

 

 
 

3. Sudury ýapman onuň bilen işi tamamlamak üçin Ctrl klawişasyny basmaly 

we syçanjyk bilen sudurdan daşary ýa-da beýleki guralyň piktogrammasyna 

basmaly. Nobatdaky sudury gurmazdan öň ondan öňki sudur aktiw däl 

ýagdaýa geçirilmedik bolsa, onda hemme goşmaça sudurlar şol bir at bilen 

ýatda saklanylar.  

Sudury ýapmak üçin birinji düwün nokadyna basmaly. 

 

 Sudurlary süýşürmek üçin Path Selection Tool (Инструмент выбора 

контура) guraly (А ýa-da Shift+A klawişalary) peýdalanmaly. 

Sudurlaryň üstünden transformasiýa buýruklaryny ýerine ýetirmek hem 

mümkin. 

Suduryň aýratyn bir nokadyna hem transformasiýanyň birnäçe buýruklaryny 

ulanmak mümkin. Munuň üçin Direct Selection Tool (Инструмент прямого 

выделения) guraly А klawişasyna basyp saýlamaly we gerekli nokady bellemeli. 

Sudurlaryň göçürmesiniň birnäçe usullary bar. Olaryň biri Path Selection 

Tool guraly işledip Alt klawişasyny basyp saklap suçanjyk bilen sudury 

süýşürmek Ý-da palitrada susury adyny belläp ony Alt klawişasyny basyp saklap 

palitranyň Create new path düwmejigine getirmeli. 

Sudury wagtlaýyn görkezmezlik/görkezmek üçin palitrada onuň adyna Shift 

klawişasyny basyp syçanjyk bilen basmaly. 

Suduryň düwün nokatlaryny bellemek üçin iki usul bar. Birinji usulda 

suduryň adyny palitrada saýlap, Path Selection Tool guraly işletmeli we syçanjyk 

bilen sudury şekilde saýlamaly ýa-da onuň daşyndan punktirli çägi döretmeli. 

Netijede onuň hemme düwün nokatlary bellenilip galar. 
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Ikinji usul - Direct Selection Tool guraly işletmeli. Sudury ýa-da onuň 

bölegini saýlap, soňra onuň bir düwün nokadyny bellemeli. Shift düwmejigini 

basyp saklap, suduryň beýleki düwün nokatlaryny hem bellemek mümkin. 

Sudurda hemme düwün nokatlary bellemek üçin Alt klawişasyny basmaly 

we sudury bellemeli. 

Pen guraly bilen işlenende Direct Selection Tool guraly wagtlaýyn işletmek 

üçin Ctrl klawişasyny basmaly. 

Sudurlaryň formalaryny üýtgetmek üçin onuň düwün nokatlarynyň 

ýerleşişini üýtgetmek ýa-da segmenti süýşürmek ýeterlik. Egri segmentiň 

formasyny ugrukdyryş çyzygy süýşürip ýa-da ony degişli düwün nokadyň 

daşyndan aýlap üýtgetmek mümkin. 

Sudurlaryň düwün nokatlaryny aýyrmak we goşmaklyk gurallar panelinden 

Pen guralyň goşmak we aýyrmak nyşanly görnüşlerini ulanmaklyk arkaly mümkin. 

Eger opsiýalar panelinde AutoAdd/Delete (Автоматическое 

добавление/удаление) baýdajyk goýlan bolsa Pen guraly görkeziji segmente 

getirilende Add Anchor Point Tool gurala öwrülýär, ýa-da görkeziji düwün 

nokatda bolsa Delete Anchor Point Tool (Удалить узловую точку) gurala 

öwrülýär. Bu düzgüni wagtlaýyn aýyrmak üçin Shift klawişasyny basyp 

saklamaly. 

Eger ugrudyş çyzygyň manipulýatory iki segmentiň düz seplenmeginiň 

nokadynda süýşürilse, onda iki segment hem süýşüriler. Eger ugrukdyryş çyzygy 

suduryň döwülme noakdynda süýşürseňiz onda diňe bir segment süýşüriler. 

Düz seplenmeginiň nokadyny döwülmä özgertmek üçin Convert Point Tool 

(Преобразовать узел) guraly işletmeli.  

Eger amaly tersine ýerine ýetirmek üçin gaýtadan Convert Point Tool 

guraly saýlamaly.  

Ugrukdyryş çyzygyň bir bölegine beýlekä garaşsyz öwürmek üçin Convert 

Point Tool gural bilen peýdalanmak mümkin. 

Sudurlary Path palitranyň degişli düwmejikleri arkaly ýok etmek mümkin. 

Sudury belleýişe öwürmek üçin Path palitrasynda sudury saýlap kontekst 

menýudan Make Selection bendi saýlamaly. 

Amallar «Tiz» klawişalar 

Sudury belläp almak Ctrl klawişasy basylan mahaly suduryň adyna syçanjyk 

bilen basmaklyk  

Sudury belleýişe goşmak Ctrl+Shift klawişalary basylan mahaly suduryň adyna 

syçanjyk bilen basmaklyk 

Sudury belleýişden 

aýyrmak 

Ctrt+Alt klawişalary basylan mahaly suduryň adyna 

syçanjyk bilen basmaklyk 

Sudury belleýiş bilen 

kesişdirmek 

Ctrl+Alt+Shift klawişalary basylan mahaly suduryň 

adyna syçanjyk bilen basmaklyk 

Fill Path (Заливка контура) buýrugy sudury belli bir reňk, gaýtalanýan 

nagyş ýa-da beýleki şekilen bilen doldurmagy amala aşyrýar.  

1. Paths palitrasynda sudury aktiw etmeli.  

2. Layers palitrasynda reňklenen suduryň ýerleşjek gatlagyny saýlamaly.  
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3. Sudury akdan ýa-da garadan tapawutly reňk bilen doldurmak üçin, 

Foreground color parametriň ähmiýetini bellemeli. 

4. Alt düwmejigini basyp Paths palitrasynyň aşaky bölegindäki Fill path with 

foreground color (Заливка контура основным цветом) düwmejigine 

basmaly. Contents (Содержимое заливки) böleginde Use (Использовать) 

açylýan sanawyndan doldurmagyň degişli düzgünini saýlamaly 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figuralar 

Figura (shape) geometriýa obýekti ýa-da belli bir görnüşli töwerek 

bolup durýar.Figura bir tonly ýa-da gradiýentli reňke eýe bolup biler, ýa-

da gaýtalanýan nagyş bilen doldurylyp bilner, özem her figura öz gatlagy 

gabat gelýär. 

Figura çyzylanda Shift düwmejikleri basylanda inedördül 

(göniburçlugyň deregine), tegelek (ellipsiň deregine) we 45° bölünijilikli 

burç boýunça ýerleşen çyzyk çyzylar. 
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1. Islendik figuralary saýlamagyň paneline täze elementi goşmak üçin täze 

döreden figuranyň adyny Layers palitrasynda saýlamaly.  

2. Edit > Define Custom Shape (Правка > Определить заказную форму) 

buýrugy ýerine ýetirmeli, Custom Shape guralyň panelinde täze element 

emele geler.  

 
 Figuranyň reňk doldurmasynyň üýtgetmek üçin  (gradiýente ýa-da 

gaýtalanýan nagyşly edip) Layer > Change Layer Contents (Слой > Изменить 

содержимое слоя) buýrugy ýerine ýetirmeli.  

Figuranyň reňk doldurmasy islendik mahal üýtgedilip bilner.  

1. Layers palitrasynda shape görnüşli elementiň adyna syçanjyk bilen iki 

gezek basmaly.  

2. Reňk palitrasyndan täze reňki saýlamaly. 

Shape görnüşli gatlagy rastr formadyna özgertmek 

Shape görnüşli gatlakda pikselleriň üstünden dürli amallary ýerine ýetirmek 

üçin, meselem, surat çekmek ýa-da filtrlemek üçin, ilikibaşda gatlagy rastr formada 

geçirmek gerek.  

1. Shape görnüşli gatlagy saýlamaly 

o Layer > Rasterize (Слой > Преобразовать в растровый формат) 

buýrugy goýbermeli  ýa-da ol buýrugy Layers palitrasynda gerek 

bolan gatlagy saýlap kontekst menýudan çagyrmaly. 

 

Tekst bilen işlemek 

Photoshop programmasynda tekst wektorly bolup durýar. 

Туре (Текст) guraly arkaly tekst döredilenden soň ol awtomatiki öz 

gatlagynda emele gelýär. Islendik wagtda oniň atributlaryny üýtgetmek mümkin: 

şrifti, stili, kegl, reňki, kerningi1 , trekingi 2 , setirara aralygy, deňleşmegini, baza 

çyzygyna görä ýeleşişini. Mundan başga dürli atributlar bir tekst gatlakdaky dürli 

harplara hem berlip bilner. 

Şeýle hem, tekstiň düzümini, oňa gatlagyň dürli effektlerini ulanmaga, 

garyşma düzgünini we açyk däl derejesini üýtgetmege ýol berilýär. Redaktirlenýän 

tekst gatlagyna filtrleri ulanmak mümkin, teksti çyzyp ýa-da ony gradiýent we 

surat bilen doldurmak mümkin. Bu amallary amala aşyrmak üçin tekst gatlagyny 

rastr formadyna Layer palitrasynda tekst gatlagy belläp kontekst menýudan 

Растеризация слоя bendi arkaly geçirmek gerek. 

Bitmap, Indexed Color we Multichannel düzgünlerinde döredilen tekst 

fonda emele gelip, gatlakda emele gelmez; bu teksti redaktirlemek mümkin däl.  
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Tekst rastr formadyna özgerdilenden soň, onuň tipografiýa atributlaryny 

(meselem, şrift ýa-da stil) üýtgetmek mümkin däl.  

Tekstiň islendik tipleri (redaktirlenýän we b.) Туре (Текст) guraly, Layer 

(Слои) menýusy, Character (Шрифт) palitrasy, Paragraph (Абзац) palitrasy we 

opsiýalar paneli arkaly döredilip bilner.  

 
 

 
Redaktirlenýän tekst gatlagyny döretmek  

1. Ilkibaşda Туре (Текст) guraly işletmeli Т (klawişasy).  

2. Setirleýin giriziş düzgüninde tekstiň başlangyç nokadyny goýmak üçin 

penjirä basmaly. Tekst bloguny girizmek üçin punktirli sudury çyzmaly, şonuň 

bilen tekstiň araçäklerini kesgitlener.  

3. Opsiýalar panelinde aşakdaky amallary ýerine ýetirmeli:  

o Tekstiň ugrukdyrylmagyny (keselik/diklik) üýtgetmek üçin Туре 

guralynyň opsiýalar panelinde Туре düwmejige basmaly;  

o Şriftleriň toparyny, şriftiň stilini we keglini saýlamaly;  

Şeýle hem Anti-aliased (Сглаживание) meýdanynda literleri/ araçäklerini 

düzlemegiň usulynyň birini saýlamaly: Sharp (Резкое) Crisp (Жесткое),-Strong 

(Сильное), ýa-da Smooth (Гладкое).  

 
Tekstiň elementlerini belläp almak  
 

Amal  Ýerine ýetirmegiň usuly  

Setiriň bölegini 

bellemek  

Syçanjygyň düwmejigine basmaly we kursory 

süýşürip almaly. Ýa-da setirň başynyň bölegine 

basmaly, soňra Shift klawişasyny basyp saklap, 

onuň ahyryna basmaly 
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Sözi bellemek  Oňa iki gezek syçanjyk bilen basmaly 

Setiri bellemek  Üç gezek syçanjyk bilen basmaly  

Abzasy bellemek  4 gezek syçanjyk bilen basmaly 

Tutuş teksti 

bellemek 

Ctrl+A klawişalaryny basyp tekstiň içinde dört 

gezek basmaly ýa-da Layers (Слои) palitrasynda 

onuň nyşanyna iki gezek basmaly 

Teksti masştablamak  

Horizontal Scale (Масштаб по горизонтали) we Vertical Scale (Масштаб 

по вертикали) buýruklary diňe harplary ýoýmak (uzaltmak ýa-da gysgaltmak) 

üçin ulanmaly. Literleri deň ölçegli masştablamak üçin aşakda getirilen 

görkezmelerden gollanmaly, ýa-da gerek bolan simwollary bellemeli we 

Character (Шрифт) palitrasynda kegli üýtgetmeli. 

iSaýlanan simwollary masştablamak 

1. Layers (Слои) palitrasynda teksti saklaýan gatlagy saýlamaly.  

2. Character (Шрифт) palitrasynda açmaly.  

3. Horizontal Scale (Масштаб по горизонтали) we/ýa-da Vertical Scale 

(Масштаб по вертикали) meýdanlarda masştabyň bahalaryny üýtgetmeli. 

  

 
Gatlakdaky tutuş teksti masştablamak 

1. Move (Перемещение) guralyny işletmeli.  

2. Guralyň opsiýa panelinde Show Bounding Box (Показать габаритную 

рамку) baýdajygy goýmaly.  

3. Layers (Слои) palitrasynda gatlagyň adyna basmaly.  

4. Gabarit çägi onuň burçy boýunça çekip şol bir wagtda masştaby diklik we 

keselik boýunça üýtgetmeli, eger ululyklaryň birini üýtgetmeklik üçin çägiň 

gyraky manipulýatoryny süýşürmeli. Tekstiň proporsiýalaryny saklamak 

üçin amallary Shift klawişasy basylyp duran ýagdaýynda ýerine ýetirmeli.  

 

 

Diklik boýunça masştab 

Keselik boýunça masştab 
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Goňşy simwollar üçin simwolara aralyklary goýmak 

1. Layers (Слои) palitrasynda tekst gatlagy saýlamaly.  

2. Character palitrasynda Kerning (Kepнинг) menýuda Metrics (Метрика) 

bendi saýlamaly.  

3. Туре (Т klawişasy) guraly işletdip üýtgedilmeli teksti bellemeli.  

4. Kerning (Кернинг) menýuda gerek bolan ululygy girizmeli. Simwollary 

biri-birine golaý etmek üçin otrisatel sany girizmeli.Simwollaryň arasyndaky 

aralygy Alt klawişasyna basyp saga we çepe ugrukdyrylan strelkaly 

klawişalaryna basmaly.  

 
Keselik tekst üçin setirara aralygy goýmaklyk 

Setirara aralyk (interlinýaž) – bu kursoryň duran setirden gönümel onuň aşagynda 

duran setire çenli dik aralyk. Her simwolda öz setirara aralygy bolup biler; olardan 

has uly baha şol setir üçin setirara aralygy kesgitlär.  

 

   Kerning 

        Treking 

Interlinýaž 
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Bellenilen simwollary baza çyzyga göräleýin gyşartma 

1. Layers (Слои) palitrasynda gerekli gatlagy saýlamaly.  

2. Character (Шрифт) palitrasyny açmaly.  

3. Baza çyzygyna gşräleýin gyşarmagyň meýdanyna bahany girizmeli –

simwolalr baza çyzykda ýokarda ýerleşer ýaly položitel sany girizmeliž 

ondan pesde ýerleşdirer ýaly  - otrisatel bahalary girizmeli. 

 

Simwollary goýy, gyşardyp, aşagyny çyzyp, özüni çyzyp, aşaky we ýokarky 

indeksde çyzyp ýazmak üçin Character (Шрифт) palitrasynda T harpyň degişli 

nyşanly düwmejiklerine basmaly. 

Layer > Туре > Vertical (Слой > Текст > Вертикально) ýa-da Horizontal 

(Горизонтально) buýruklary arkaly tekstiň ýerleşişini dik ýa-da kese boýunça 

üýtgetmek mümkin. 

Paragraph (Абзац) palitrasy arkaly tekstiň ýerleşişiniň deňleşmesini sazlap 

bolýar. 
 

 
Free Transform (Произвольная трансформация) we transformasiýanyň 

beýleki buýruklary arkaly teksti ýörite transformirlemek mümkin. 

Tekst ýazylanda adatça onuň daşynda gabarit çägi emele gelýär. Teksti 

gabarit çägi bilen bile ulaltmak ýa-da kiçeltmek üçin Tekst gatlagyny Layer 

palitrasynda belläp Type guralyny saýlap Ctrl klawuşasyny basyp gabarit çäginiň 

manipulýatorlaryndan çekip üýtgetmeli. Eger Teksti üýtgetmän gabarit çägi 

üýtgetmek gerek bolsa onda Ctrl klawişasyny basman üýtgetmeli. 

Redaktirlenýän gatlakda tekstiň deformasiýasy 

Photoshop programmasynda Warp Text (Деформировать текст) görnüşli 

birnäçe funksiýalar bar, olar gabarit çägi we onuň içindäki teksti gyşartmagy 

mümkin edýär. Şonda defoormirlenen tekst rdaktirlenýän bolup galar.  

Baza çyzygyna görä gyşartma 
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1. Layers (Слои) palitrasynda deformirlenmeli teksti saýlamaly.  

2. Warp Text (Деформировать текст) gepleşik penjiresini açmak üçin Layer 

> Type > Warp Text (Слои > Текст > Деформировать текст) buýrugy 

çagyrmaly ýa-da Туре (Текст) guraly işledip opsiýalar panelinde Warp 

Text düwmejigine basmaly. 

3. Style (Стиль) açylýan menýuda tekstiň stilini saýlamaly.  

4. Pereklýuçateli Vertical (По вертикали) ýa-da Horizontal (По 

горизонтали) ýagdaýa goýup, tekstiň deformirlenmeginiň amaly üçin esasy 

ugry bellemeli.  

5. Bend (Изгиб), Horizontal Distortion (Горизонтальное искажение) 

we/ýa-da Vertical Distortion (Вертикальное искажение) polzunoklary 

süýşürmeli.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Teksti edil wektorly figuralary we sudurlary ýaly rastr formadyna geçirip 

bolýar. Ondan soň onuň bilen islendik rastr amallary ýerine ýetirmek mümkin. 

Teksti Paste Into bnuýrugy arkaly şekil bilen doldurmak 

1. Tekst gatlagy döretmeli.  

2. Gerekli şekili saklaýan gatlagy işletmeli.  

3. командой меню Selection > All 

(Выделить > Все) buýrugyny 

peýdalanmaly ýa-da belleýişi syçanjyk 

bilen döretmeli.  

4. Edit (Правка) menýusynda Сору 

(Копировать) buýrugyny ýerine 
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ýetirmeli, oňa Ctrl+C düwmejikleri gabat gelýär.  

5. Tekst gatlagy saklaýan şekili bellemeli, soňra Ctrl düwmejigi basyp şol 

gatlagyň adyna basmaly.  

6. Edit (Правка) menýusynda Paste Into (Вставить в) buýrugy ýerine 

ýetirmeli ýa-da Ctrl+Shift+V  klawişalaryň utgaşmasyna basmaly..  

Kem-kemden ýitýän teksti döretmek  

1. Teskti döretmeli we onuň gatlagyny aktiw edip goýmaly.  

2. Layers (Слои) palitrasynyň aşagynda Add a mask (Добавить маску) 

düwmejige basmaly.  Gatlagyň adynyň ýanynda maskanyň miniatýurasy 

emele geler.  

3. Gradient (Градиент) guraly saýlamaly.  

4. Opsiýalar panelinde Gradient meýdanynda üçburçly strelkaly düwmejige 

basyp araçäkdäki reňkleri saýlamaly. Linear gradient (Линейный 

градиент) düwmejige basmaly, Normal (Нормальный) düzgüni saýlamaly 

100% deň bolan açyk dälligiň bahasyny girizmeli.  

5. Syçanjyk düwmejigini basyp saklap kursory şekiliň penjiresinde ýokardan-

aşaga ýa-da sagdan çepe süýşürmeli. Tekst gatlagyň maskasy akdan-gara 

çenli gradiýent bilen doldurylar. Tekst gara reňkiň bar ýerinde bukulan 

bolar.  

 
 

 Redaktirlenýän tekst gatlaklaryna Layer Style (Стиль слоя) penjiredäki 

effektleri ulanmak mümkin. Olar bilen işlemek edil Gatlaklar bilen goşmaça 

işlemek bölümdäki ýaly bolup geçýär. 

 

Filtrler 

Photoshop programmasynda filtrler arkaly effektleriň sansyz mukdaryny 

almak mümkin. Meselem, Color Halftone (Цветной растр), Find Edges 

(Выделение краев), Emboss (Рельеф) ýa-da Wind (Ветер) filtrleri – has 

görünýän effektler üçin ulanmak mümkin; Artistic (Художественный), Brush 

Strokes (Мазки кисти), Sketch (Эскиз) ýa-da Texture (Текстура) – elde 

“çekilen” şekili döretmek üçin; Lighting Effects (Эффекты освещения) – şekili 

yşyklandyrmak üçin ulanmak mümkin.  

Hemme filtrler 13 dereje boýunça Filter (Фильтр) menýuda toparlara 

bölünen. 

Filtri tutş gatlaga hem-de onuň bellenilen töweregine hem ulanyp bolýar  
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Käbir filtrleri gönümel ulanyp bolýar (degişli buýrugy 

kömekçi menýudan saýlamak bilen). Beýleki 

filtrleri bolsa gepleşik penjirelerinde degişli 

parametleri goýup ulanmak mümkin. Filter > 

Last Filter (Фильтр > Последний фильтр) 

(Ctrl+F) buýrugy saýlap soňky ulanylan filtri şol 

öňki parametrler bilen gaýtalamak mümkin.  

RGB we Multichannel düzgüninde hemme filtrler; 

CMYK, Grayscale we Lab Color düzgünlerinde 

bolsa olaryň käbiri elýeterli. Filtrler Bitmap we 

Indexed Color düzgünlerinde we her kanala 16 bit 

bolan düzgünlerinde ulanylyp bilmeýär.  

Filtrleriň gepleşik penjireleri 

Köp filtrleriň gepleşik penjireleri deslapdan görmegiň penjirejiklere eýe. 

 

Şonda şekiliň ölçegini dolandyrmak üçin 

(ulaltmak we kiçeltmek üçin) “plýus” we “minus” 

şekilleri bolan düwmejiklere basmaly. 

Edit > Fade (Правка > Ослабить) 

(Ctrl+Shift+F) buýrugy arkaly islendik filtriň ýerine 

ýetiren netijesini peseltmek mümkin. 

Onuň üçin açylan gepleşik penjirede açyk dälligiň 

derejesini peseltmeli. 

 

 

 

 

 

 

 

Ýagtylygyň we kontrastyň bahalarynyň artdyrylmagy filtrasiýanyň effektiniň 

güýçlenmegine getirer. Image > Adjustments > Levels (Изображение > 

Корректировки > Уровни) buýrugy saýlamaly we emele gelen Levels (Уровни) 

penjirede Input (Ввод) ara polzunogy saga, Output (Вывод) ak polzunogy bolsa 

– biraz çepe süýşürmeli.  

Käbir reňki ýok eden filtrler gatalaga ulanylandan soň gatlagyň reňkini 

üýtgetmek üçin (meselem Charcoal (Уголь) filtri ulanylanda), Image > 

Adjustments > Hue/Saturation (Изображение > Корректировки > 

Тон/Насыщенность) buýrugyndan peýdalanmaly we Colorize (Тонировать) 

baýdajygy goýmaly.  

Sketch (Эскиз) kömekçi menýunyň Water Paper (Мокрая бумага) 

başgasyndan bolan filtrler, gatlagyň reňkini ak reňke we surat çekilýän reňke 

öwürýär, şol sebäpli Foreground color (Основной цвет) parametri öňünde 

saýlap, ondan soň şol filtrleri ulanmak gerek.  
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Filtrler arkaly teksturany goýmak 

Käbir filtrler üçin (meselem, Conte Crayon (Волшебный карандаш), 

Displace (Смещение), Glass (Стекло), Lighting Effects (Эффекты освещения), 

Rough Pastels (Пастель), Texture Fill (Текстурная заливка) ýa-da Texturizer 

(Тексту-ризатор)) tekstura döretmek üçin standart nagyşyň deregine, başga şekili 

ýükläp ony nagyş hökmünde ulanmak mümkin. Şekiliň açyk we garamtyl 

töwerekleri teksturada galýan we çökýän ýerleri döreder. Texture (Текстура) 

açylýan menýuny saklaýan filtriň gepleşik penjiresinde, Load Texture (Загрузить 

текстуру) opsiýasyny işletmeli, gara we reňkli şekili Photoshop formadyna 

özgertmeli we ОК düwmejigine basmaly. 

Hemme filtrler 

Artistic kömekçi menýunyň filtrleri

 
Başlangyç şekil  

 
Colored Pencil (Цветной карандаш)  

 
Cutout (Аппликация)  

 
Dry Brush (Сухая кисть)  

 
Film Grain (Зернистость 

фотопленки)  

 
Fresco (Фреска)  
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Neon Glow (Неоновый вет)  

 
Paint Daubs (Масляная живопись)  

 
Palette Knife (Шпатель) 

 
Plastic Wrap (Целлофановая 

упаковка)  

 
Poster Edges (Плакатные края)  

 
Rough Pastels (Пастель)  

 
Smudge Stick (Растушевка)  

 
Sponge (Губка)  

 
Watercolor (Акварель)  
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Underpaying (Грунтовка)  

Blur kömekçi menýunyň filtrleri

 
Blur More (Размытие плюс)  

 
Gaussian Blur (Размытие по 

Гауссу)  

 
Motion Blur (Размытие в 

движении)  

 
Radial Blur (Радиальное размытие)  

 
Smart Blur (Умное размытие), 

режим Normal (Нормальный)  

 
Smart Blur (Умное размытие), 

режим Edges Only (Только 

контуры)  
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Smart Blur (Умное размытие), 

режим Overlay Edge (Режим 

наложения)

Brush Strokes kömekçi menýusynyň filtrleri

 
Accented Edges (Подчеркнутые 

края)  

 
Angled Strokes (Наклонные 

штрихи)  

 
Crosshatch (Перекрестные штрихи)  

 
Dark Strokes (Темные штрихи)  

 
Ink Outlines (Обводка тушью)  

 
Spatter (Разбрызгивание)  
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Sprayed Strokes (Аэрограф)  

 
Sumi-e (Японская роспись) 

 

Distort kömekçi menýusynyň filtrleri 

 
Diffuse Glow (Рассеянный свет)  

 
Displace (Смещение)  

 
Glass (Стекло)  

 
Ocean Ripple (Океанские волны)  

 
Pinch (Дисторсия)  

 
Polar Coordinates (Полярные 

координаты)  
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Ripple (Рябь)  

 
Shear (Искривление) 

 
Spherize (Сферизация)  

 
Twirl (Скручивание)  

Wave (Волна), тип Square 

(Квадрат)  

 
Wave (Волна), тип Sine 

(Синусоида)  

 
ZigZag (Зигзаг) 
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Noise kömekçi menýunyň filtrleri 

 
Add noise (Добавить шум)  

 
Median (Медиана) 

Pixelate kömekçi menýunyň filtrleri 

 
Color Halftone (Цветной растр)  

 
Crystallize (Кристаллизация)  

 
Facet (Грань)  

 
Fragment (Фрагмент)  

 
Mezzotint (Меццо-тинто), режим 

Short Strokes (Короткие штрихи)  

 
Mezzotint (Меццо-тинто), режим 

Medium Dots (Средние точки)  
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Mosaic (Мозаика)  

 
Pointillize (Пуантилизм) 

 

Render kömekçi menýunyň filtrleri 

 
Clouds (Облака)  

Difference Clouds (Облака с 

разностью)  

 
Lens Flare (Блик) 

Sharpen kömekçi menýunyň filtrleri 

 
Sharpen Edges (Резкость на краях)  

 
Sharpen More (Резкость плюс)  
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Unsharp Mask (Нерезкое 

маскирование) 

Sketch kömekçi menýusynyň filtrleri 

 
Bas Relief (Барельеф)  

 
Chalk&Charcoal (Мел и уголь)  

 
Charcoal (Уголь)  

 
Chrome (Хром)  

 
Conte Crayon (Волшебный 

карандаш)  

 
Graphic Pen (Тушь)  
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Halftone Pattern (Полутоновый 

узор), стиль узора Circle (Круг)  

 
Halftone Pattern (Полутоновый 

узор), стиль узора Dot (Точка) 

 
Note Paper (Почтовая бумага)  

 
Photocopy (Ксерокопия)  

 
Plaster (Гипс)  

 
Reticulation (Ретикуляция)  

 
Stamp (Штамп)  

 
Torn Edges (Рваные края)  
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Water Paper (Мокрая бумага) 

 
 

 

 

 
 

 
 

 
 

 
 

Stylize kömekçi menýusynyň filtrleri 

 
Diffuse (Диффузия)  

 
Emboss (Рельеф)  

 
Extrude (Экструзия)  

 
Find Edges (Выделение краев)  

 
Glowing Edges (Свечение краев)  

 
Solarize (Соляризация)  
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Tiles (Плитки)  

 
Результат применения фильтра 

Tiles (Плитки), затем команды Fade 

(Ослабить) в режиме Overlay 

(Перекрытие)

 
Trace Contour (Трассировка 

контуров)  

 

 
Wind (Ветер) 

 

Фильтры подменю Texture 

 
Craquelure (Кракелюры)  

 
Grain (Зерно), режим Horizontal 

(Горизонтально)  

 
Mosaic Tiles (Мозаичные плитки)  

 
Patchwork (Цветная плитка)  
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Stained Glass (Витраж)  

 
Texturizer (Текстуризатор 

 

Epin-epin kagyzyň görnüşine meňzeş bolan teksturany döretmek üçin ak 

gyralary bolan gatlaga Ripple (Рябь), Twirl (Скручивание) ýa-da Zigzag 

(Зигзаг) filtrleri ulanmaly. 

1. Fon reňki hökmünde ak reňki saýlamaly.  

2. Okantowka goşmak üçin Image (Изображение) menýusyndan Canvas Size 

(Размер холста) buýrugy ulanmaly (bir gatly şekili ulanmaly).  

3. Rectangular Marquee (Прямоугольная область) guraly saýlamaly (М ýa-

da Shift+M klawişalary).  

4. Şol guralyň opsiýalar panelinde Feather (Растушевка) meýdanyna 8 

bahany girizmeli.  

5. Şekiliň dörtden üç bölek töwereginiň daşyndan punktirli çägi çyzmaly.  

6. Select (Выделение) menýudan Inverse (Инвертировать) buýrugy 

saýlamaly (Ctrl+Shift+I). Indi bellenilen töwerek goşulan okantowkadan 

we şekiliň böleginden durýar.  

7. Filter > Distort > Ripple (Фильтр > Деформация > Рябь), Filter > Brush 

Strokes > Spatter (Фильтр > Мазки кисти > Разбрызгивание) buýruklary 

ýerine ýetirmeli ýa-da olaryň utgaşmasyndan peýdalanmaly.  

Fotosuraty surata öwürmek  

1. Şekili açmaly, Layers (Слои) palitranyň menýusynda Duplicate Layer 

(Дублировать слой) buýrugy saýlamaly.  

2. Filter > Stylize > Find Edges (Фильтр > Стилизация > Выделение краев) 

buýrugy ýerine ýetirmeli.  

3. Gatlagyň aktiw dublikatynda Add a mask (Добавить маску) düwmejige 

basmaly.  

4. Gatlagyň maskasyny açyk dälligiň derejesi 100%-den az bolan ýagdaýda 

gara reňk bilen reňklemeli – aşakda ýerleşen gatlagyň käbir töwereklerini 

görkezmek üçin.  

5. Gara fonda has güýçli reňk effektini almak üçin gatlagyň miniatýurasyna 

basyp Image & Adjustments > Invert (Изображение > Корректировки > 

Обратить) buýrugy peýdalanmaly (Ctrl+I).  

Galamly suraty almak üçin 2-nji ädimi ýerine ýetirmän Trace Contour 

(Трассировка контуров) filtri soňra bolsa Other (Другие) kömekçi bendinde 

Minimum (Минимум) filtri radiusyň bahasyny 1 ýa-da 2 edip girizip ulanmaly. 
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Akwarel filtri 

Fotosurady akwarel surata öwürmek üçin Other (Другие) kömekçi 

menýudan Minimum (Минимум) we Noise (Шум) kömekçi menýudan Median 

(Медиана) filtrleri ulanmaly. Olary Watercolor (Акварель) filtr bilen 

deňeşdirmeli. Aşakda birnäçe filtrleriň bir şekile ulanmagyň nusgasy getirilen:  

1. Gatlagyň dublikatyny döretmeli.  

2. Gatlagyň dublikaty işletmeli we Filter > Noise > Median (Фильтр > Шум 

> Медиана) buýrugy ýerine ýetirmeli.  

3. Radius (Радиус) parametriň polzunogy 2 we 8 sanlaryň arasyna geçirmeli.   

4. Filter > Others > Minimum (Фильтр > Другие > Минимум) buýrugy 

ýerine ýetirmeli.  

5. Radius (Радиус) parametriň polzunogy 1, 2 we 3 bellikde.  

6. Filter > Sharpen > Sharpen More (Фильтр > Резкость > Резкость плюс) 

buýrugy ýerine ýetirmeli. 

Mosaic filtriň ulanylmagy 

Aşakdaky ammalaryň netijesinde Mosaic (Мозаика) filtri birnäçe 

göniburçly bellenilen töwereklere ulanylýar we mozaikanyň bölekleriniň bir 

wagtda ulanylmagy bolup geçýär. Gatlagyň maskasynda gradiýentiň ulanylmagy  

Mosaic giltriň amlynyň effektini peselder emma onuň elementleriniň ölçegini 

üýtgetmez.  

1. Gatlagy bellemeli.  



 92 

2. Rectangular Marquee (Прямоугольная область) guraly saýlamaly.  

3. mozaikanyň başlanýan ýerinden şekiliň dörtden we bäşden bir böleginiň 

daşyny aýlamaly.  

4. Pixelate (Объединение пикселов) kömekçi bendinden Mosaic (Мозаика) 

filtri saýlamaly.  

5. Mosaic (Мозаика) gepleşik penjiresinde Cell Size (Размер ячейки) 

meýdanynda 6 bahany girizmeli. Görülýän bahany kem-kemden ulaltmak 

üçin bu amaly birnäçe gezek ýerine ýetirmeli.  

6. Bellenilen töweregi we Rectangular Marquee (Прямоугольная область) 

guraly aktiw edip saklap, Shift klawişasyny basyp punktirli sudury ýanaşýan 

ýere süýşürmeli, we filtri ulanmaly we m.b.  

7. 4-6 ädimleri şekili doly işlenip bejerilýänçä Cell Size (Размер ячейки) 

meýdanyna degişlikde 12, 24 we 30 bahalary girizip ulanmaly. 

 

 

 

 

 

 

 

 

 

 

 

 

Hereketiň illýuziýasyny döretmek 

Hereketiň illýuziýasyny döretmek üçin hereketsiz durmaly obýekti belläp ony täze 

gatlaga göçürmeli, soňra, soňra fon şekiline Motion Blur (Размытие в движении) 

filtri ulanmaly.  

1. Üýtgedilmän galmaly şekiliň bölegini bellemeli.  

2. Select (Выделение) menýudan Feather (Растушевка) buýrugyny 

çagyrmaly (Ctrl+Alt+D).  

3. Feather Radius (Радиус растушевки) meýdanyna 5 bahany girizmeli. 

4. Bellenilen töweregi täze gatlaga göçürmek üçin Ctrl+J klawişalaryny 

basmaly. 

5. Fony saklaýan başlangyç şekili bellemeli.  

6. Filter > Blur > Motion Blur (Фильтр> Размытие > Размытие в 

движении) buýrugy ýerine ýetirmeli.  

7. Eňňitligiň burçunyň bahasyny Angle (Угол) -360°-dan 360°-a çenli 

girizmeli. -17° baha girizilen.  

8. Distance (Расстояние) bahany 1-den 999-a çenli girizmeli. Biz 50 girizdik  
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Şekile ýagtylygy goşmak 

Lighting Effects (Эффекты освещения) filtri ýagtylygyň sansyz effektini 

döretmegi mümkin edýär. Şekilde 16-a çenli ýagtylyk çeşmesini goýmak mümkin 

we her çeşme üçin öz reňkini, ýagtylygyň depginliligini we şöhleleriniň ugruny 

goýmak mümkin.  

1. Şekil RGB reňk düzgüninde bolmaly.  

2. Gatlagy ýa-da onuň bölegini belläp saýlamaly.  

3. Filter > Render > Lighting Effects (Фильтр > Освещение> Эффекты 

освещения) buýrugy ýerine ýetirmeli.  

4. Style (Стиль) meýdanyndaky açylýan sanawdan Default (По умолчанию) 

görnüşi ýa-da ýagtylygyň taýyn efektini saýlamaly.  

5. Light Type (Тип освещения) bölüminde şeýle amallary ýerine ýetirmeli:  

o effekti deslapky seretmegiň penjiresinde görmek üçin On 

(Включить) baýdajygy goýmaly;  

o Light Type (Тип освещения) meýdanyndaky açylýan sanawdan 

ýagtylygyň degişli görnüşini saýlamaly: Spotlight (Прожектор) – 

eger ýagtylygyň toplumy deslapdan inçe, konus görnüşli we elliptiki 

görnüşi berer ýaly; 
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o    Intensity (Интенсивность) polzunogy ýagtylygyň güýjüni üýtgetmek 

üçin üýtgetmeli. Full (Полностью) iň ýagty yşygy kesgitleýär, Negative 

(Отрицательно) bolsa – iň garamtyly;  

o    Spotlight (Прожектор) yşyklandyryşyň görnüşi üçin Focus (Фокус), 

polzunogy süýşürip ellipsiň içindäki yşygy sazlamak mümkin. Eger 

polzunok Wide Focus (Широкий фокус) ýagdaýa goýulsa onda, onda 

yşyk ellipsiň araçäklerine golaýlaşanda has ýagty bolýar (рис. 18.138а). 

o Yşygyň reňkini üýtgetmek üçin reňkiň nusgasynyň meýdanyna basmaly 

we palitrada gerek reňki saýlamaly.  
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6. Properties (Свойства) bölümindäki polzunoklary obýektiň üstüniň şeýle 

häsiýetlerini sazlamak üçin süýşürmeli:  

o Gloss (Фактура) yşygyň düşýän üstden serpikmegiň güýjüni 

kesgitleýär;  

o Material (Материал) şekil yşyk çeşmesiniň reňkini nähili 

serpikdirýändigini kesgitleýär: Plastic (Пластик) – yşygyň reňki 

serpikýär, Metall (Металл) – obýektiň özüniň reňki serpikýär;  

o Exposure (Экспозиция) şekiliň tutuş gatlagyny ýagtyladýar ýa-da 

garamtylaýar;  

o Ambience (Подсветка) yşyk çeşmesiniň we tutuş şekiliň 

yşyklandyrmasynyň arasyndaky balansa gözegçilik edýär.  

o Yşygyň ýene bir çeşmesini goşmak üçin, ýanyp duran çyra 

görnüşindäki belgini deslapdan görmegiň penjiresine getirmeli. 

o yşyk çeşmesini ýok etmek üçin, onuň merkezi nokadyny korzina 

görnüşindäki düwmejige getirmeli;  

o yşyk çeşmesiniň göçürmesini döretmek üçin Alt klawişasyny basyp 

onuň merkezi nokadyny gerekli ýere getirmeli. 
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Yşygyň teksturalaýyn effektini döretmek üçin Texture Channel (Текстурный 

канал) bölüminde açylýan sanawdan teksturany saklaýan alfa kanaly saýlamaly. Height 

(Высота) polzunogy süýşürip teksturanyň beýikligini sazlamaly. Bu funksiýa Spotlight 

(Прожектор) yşyk düzgünine has gabat gelýär.  

Omni (Лампа) görnüşli ýagtylyk sferalyk ýagtylyk töweregini döredýär we 

fonaryň ýagtylygyna meňzeş.  

Shift klawişasyny basyp we ellipsiň araçäk manipulýatoryny süýşürip, onuň 

ölçegini üýtgetmek mümkin (şonda burç üýtgemeýär). Ellipsiň ölçeglerini üýtgetmän 

burçy ýa-da ýagtylygyň ugruny üýtgetmek üçin Ctrl  klawişasyny basyp radiusy 

süýşürmeli.  

Eger şekiliň fony Lighting Effects (Эффекты освещения) filtriň ulanylmagy 

sebäpli has garamtylan bolsa, onda ony ýene bir gezek garamatyl töweregi ýagtylandyrmak 

üçin ulanmaly. Properties (Свойства) bölüminde Exposure (Экспозиция) we Ambience 

(Подсветка) polzunoklary biraz saga süýşürmeli. 

Liquify  buýrugy 

Liquify (Исказить) buýrugy şekiliň gatlagyny towlap, egip, süýnürip we 

beýleki usullar bilen dewormirläp bilýär.  

Şekili deformirlemegi kist arkaly mümkin, ol kistiň ölçegleri we täsir ediş 

derejesi sazlanylýar. Mundan başga hem Freeze (Заморозить) guralyny 

peýdalanyp bolýar – ol aýry töwerekleriň üýtgedilmeginiň öňüni alýar. Eger 

üýtgedilen şekili doly ýa-da bölekleýin yzyna gaýtarjak bolsaňyz onda 

Reconstruct (Реконструировать) guralyndan peýdalanmaly. Üýtgetmeler 

buýrugyň penjiresinden çykylan ýagdaýynda hemişelik bolup galar.  
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1. Ýoýulmaly gatlagy saýlamaly. Backdrop baýdajygy işledilende Liquify guralyň 

täsirini birnäçr gatlagyň diňe birine degişli edip bolýar. Liquify (Исказить) 

buýrugy diňe rastr şekili bilen işleýär.  

2. Liquify buýrugy Filter (Фильтр) menýudan saýlamaly (Ctrl+Shift+X).  

3. Berlen şekili deformirlemek üçin Liquify gepleşik penjiresini gurallaryndan 

peýdalanmaly. Ilkibaşda Tool Options (Опции инструмента) bölüminde kistiň 

ölçegini (Brush Size) 1-den 600 piksele çenli goýmaly, şeýle hem kistiň 

basyşynyň ululygyny (Brush Pressure) 1-den 100%-e çenli goýmaly we zen-

zeläniň üýtgemeginiň ululygyny (Turbulent Jitter) - şekiliň ýoýmagy nähili bolup 

geljekdigini kesgitlemek üçin bellemeli.  

 

 

 

 

 

 

4. Freeze (Заморозить) guraly işletmeli (F klawişasy), ol ýoýulmaly 

däl töwerekleri maskalamak üçin ulanylýar. Soňra View Options 

(Режимы просмотра) bölüminde Freeze Color (Цвет маски) 

açylýan sanawdan reňki saýlamaly. Deslapdan gyzyl reňk goýlan. Şol 

wagtky ýagdaýda üýtgemän galmaly töwerekleri reňklemeli.  

5. Eger maskalanan töwereklerden goragy aýyrmak üçin Thaw 

(Разморозить) guraly işletmeli (Т klawişasy) we ol arkaly 

reňklemeli.  

6. Aşakdaky amallaryň islendigini saýlamaly:  
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o maskany inwertirlemek üçin Freeze Area (Область маски) 

bölüminde Invert (Инвертировать) düwmejige basmaly;  

o şekilden hemme maskany aýyrmak üçin Thaw All (Разморозить все) 

düwmejige basmaly;  

o Freeze (Заморозить) guraly arkaly döredilen maskany bukmak üçin 

View Options (Режимы просмотра) bölüminde Show Frozen Areas 

(Показать маскированные области) baýdajygy aýyrmaly.  

7. Ýoýmagyň bir guraly işletmeli:  

o Warp (Деформация) guraly W (klawişasy) — kistiň hereketiniň 

ugrunda nokatlary süýşürýär. 

o Turbulence (Волнение) (А klawişasy) – kistiň hereketiniň ugrunda 

nokatlary süýşürip aýyrýar. Kistiň işlän ýerinde şekil suw bilen täsir 

edilen ýaly görünýär;  

o Twirl Clockwise (Закрутка по часовой стрелке) (R klawişasy) we 

Twirl Counterclockwise (Закрутка против часовой стрелки) (L 

klawişasy); - syçanjygyň düwmejigi basylyp durka ýa-da şekil çekilip 

durka piksellere öwürýär. Brush Pressure (Нажим кисти) 

parametriň ululygy näçe ýokary bolsa şonça hem öwürme tiz bolup 

geçýär. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Warp       Turbulence 
 

o Pucker (Складка) (Р klawişasy) ýa-da Bloat (Раздувание) 

piktogrammasy (B klawişasy) – syçanjygyň düwmejigi basylyp durka 

ýa-da şekil çekilip durka nokatlary kistiň merkezine ýa-da garşy 

tarapa süýşürýär. Brush Pressure (Нажим кисти) parametriň bahasy 

näçe ýokary bolsa,şonça hem nokatlar tiz hereket edýär;  

o Shift Pixels (Сдвиг пикселов) (S guraly) – kistiň hereketiniň  ugry 

boýunça pikselleri süýşürýärler. Deslapdan pikseller kistiň hereketiniň 
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ugrundan çepe süýşürilýär. Alt klawişasyny basyp plara saga süýşürip 

bolýar;  

o Reflection (Отражение) (М klawişasy) – kistiň hereketiniň ugrunyň 

çepindäki nokatlary göçürip alýar we olary serpiken görnüşde şu 

guralyň täsir edýän zolagyna süýşürýär.  

 

 

 

 

 

 
 

 

 
Pucker    Reflection 

Şekili rekonstruirlemek 

Şekil ýoýlan soň ony Reconstruction (Реконструкция) bölümiň serişdeleri 

we Reconstruct (Реконструировать) guraly bilen doly ýa-da bölekleýin öňki 

ýagdaýa getirip bolýar.  

Reconstruction (Реконструкция) bölüminde Revert (Восстановить) 

düwmejige basmaly. Şekil penjire açylan ýagdaýyndaky ýagdaýa geler.  

 

 
 

Reconstruct (Реконструировать) gural bilen dikeltmäge degişli bolan 

töwerekleri reňklemeli. 

 

Çap 

Diňe görünýän gatlaklar we kanallar çapda görkeziler. 
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1. File > Print with Preview (Файл > Печать с предварительным 

просмотром) buýrugyny ýerine ýetirmeli ýa-da Ctrl+Alt+P klawişalaryny 

basmaly.  

2. Source Space (Исходное пространство источника) bölüminde gerek 

bolan düzgüni goýmaly.  

 

 
3. Print (Печать) gepleşik penjiresinde Print to File (Печать в файл) 

baýdajyk aýrylan bolmalydyr.  

Şekiliň bölegini çap etmek üçin şol töweregi Rectangular Marquee 

(Прямоугольная область) guraly bilen bellemeli. Soňra Print (Печать) gepleşik 

penjiresiniň Print Range (Диапазон страниц) bölüminde pereklýuçateli Selection 

(Выделенная область) ýagdaýa goýmaly.  

Artyk rugsat 

Eger şekiliň rugsady ekranyň rugsadyndan 2,5 esse ýokary bolsa, onda şekil 

çapa iberilende duýduryş beriler. bu ýagdaýda şekili Image > Image Size 

(Изображение > Размер изображения) buýruk arkaly kiçeltmeli. 

Print with Preview gepleşik penjiresi  

1. Şekili sahypanyň merkezinde ýerleşdirmek üçin Center Image 

(Изображение в центре) baýdajygy goýmaly, ýa-da ony aýyryp şekili 

sahypada ýerleşdirmek üçin sahypanyň ýokarsyndan we çep gyrasyndan 

bolan aralyklary girizmeli.  

2. Scaled Print Size (Масштабирование при печати) bölüminde Scale 

(Масштаб) meýdanynda ululygy üýtgetmeli ýa-da Height (Высота) we 
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Width (Ширина) meýdanlaryna bahalary girizip şekiliň çap üçin ölçeglerini 

üýtgetmeli.  

Scale, Height we Width parametrleri biri-biri bilen bagly we olaryň biriniň 

üýtgemegi beýlekilere täsir eder.  

3. Scale to Fit Media (Масштабировать с подгонкой по размерам 

страницы) baýdajygy goýmaly. Şonda şekil şekil kagyzyň ölçegine gabat 

geler ýaly ölçegini üýtgeder. Şol kagyzyň ölçegi File > Page Setup (Файл > 

Параметры страницы) buýrugy arkaly saýlanylýar.  

4. Show Bounding Box (Показать габаритную рамку) baýdajygy goýmaly 

we şekiliň daşyna punktirli çyzyk aýlanylar. Şekiliň ölçeglerini çap üçin 

üýtgetmek üçin şol çyzygyň araçäklerini syçanjyk bilen çekip üýtgedip 

bolýar.  

 
Şekiliň birnäçe göçürmesiniň bir sahypada çap edilmegi 

1. File > Automate > Picture Package (Файл > Автоматизация > Пакет 

рисунков), 

2. Use meýdanynda çeşme saýlanylmaly:  

o Frontmost Document – aktiw penjiräniň şekili;  

o File – islendik grafiki format (Photoshop bilen goldanylýan);  

o Folder – bir bukjada ýerleşen birnäçe faýllar.  

3. Page Size meýdanynda kagyzyň formatyny saýlamaly.  

4. Layout meýdanynda göçürmeleriň sanyny saýlamaly (1-20).  

5. File çeşme diýlip saýlanylanda her penjirede grafiki faýly görkezmeli.  

6. Resolution meýdanynda rugsady görkezmeli.  

7. Mode meýdanynda reňk modelini bellemeli.  
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Tejribe işleri 

 

1) Şekile renderiň etmek 

2) Şekile Sketch filtrini ulanmak 

3) Şekile pikselleme filtrini ulanmak 

4) Gausyň çalmagyny ulanyp altyn görnüşdäki obýekt döretmek 

5) Şekile stilleşdirme filtrini ulanmak 

6) Şekilde ýitilik filtrini ulanmak 

7) Şekili süýündirmek 

8) Şekiliň aýry böleklerini ulaltmak 

9) Şekiliň aýry böleklerini kiçeltmek 

10) Çeperçilik filtrlerini ulanmak 
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COREL DRAW PROGRAMMASY BARADA 

 

Mesele - Esaslar, şekilleriň düzümi, çyzyklar, tekst, obýektler 

Corel Draw programasy grafika bilen işlemek babatda dünýäniň öňdebaryjy 

programmalarynyň biri bolup durýar. Ol esasan wektor grafikanyň üstünde alnyp 

barylýan amallary ýerine ýetirmegi mümkin edýär. Öz işinde ol diňe grafiki 

obýektleri bilen işlemek bilen çäklenmän, eýsem ol tekst bilen işlemekde hem 

amatly mümkinçilikleri hödürleýär. 

CorelDRAW programmasy illýustratiw grafika bilen işlemek üçin 

programmalaryň obýektl-integrirlenen toplumy bolup durýar.  

«Integrirlenen toplum» sözleri hökmünde CorelDRAW programmanyň diňe 

bir anyk meseläni çözmek üçin aýry programma dälde, meseleleriň birnäçesini 

çözmek üçin niýetlenen programmalaryň utgaşmasy bolup durýar. Toplumyň 

integrirlenmegi, oňa girýän programmalaryň özara maglumatlar bilen aňsat alyş-

çaşlyp bilýändigini aňladýar. Şeýleik bilen, toplumyň köp funksiýalylygy 

gazanylýar, dürli programmalaryň mümkinçilikleri bolsa öz bölekleriniň jeminden 

uly bolan bir bitewi zada birleşýär. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Esaslar 

 

Iş meýdany we ulanyjynyň interfeýsi 

Programmanyň ulanylýan faýllaryny goýbermek üçin şu giňişlikleri 

gözlemeli - .CDR, .CMX, .WMF.  

Program goýberilenden soň suratda görkezilen CorelDRAW 

programmasynyň ulanyjy interfeýsiniň esasy elementlerini saklaýan penjiresi 

açylýar.  

Wektor grafikasy Rastr grafikasy 
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Windowsyň standartlaryna laýyklykda penjiräniň adynyň aşagynda menýu 

setiri ýerleşdirilen. CorelDRAW programmasynda menýu örän çylyşyrymly, 

kömekçi menýularyň we buýruklaryň köp mukdary bilen. Edil beýleki 

programmalarda ýaly menýu CorelDraw programmasynyň köp funksiýalaryna 

elýeterligi üpjün edýär, emma köp amallar onsuz hem ýerine ýetirilip bilner.  

Iş meýdanyň çep böleginde Corel firmasynyň önümleri üçin spesifiki bolan 

gurallar toplumy (toolbox) ýerleşdirilen. Ol iş düzügünini saýlamak üçin 

niýetlenen. Düzgüniň saýlanylmagy gurallar toplumynyň düwmejikleriniň birine 

syçanjyk bilen basma arkaly amala aşyrylýar.  

Gurallaryň düwmejikleriniň käbiri aşaky sag burçundan üçburçluk bilen 

ýerine ýetirilen, bu şol düwmejigiň ýeke däl-de birnäçe gurallar bilen 

baglaşandygyny görkezýär. Olaryň hemmesini görmek üçin syçanjygyň 

düwmejigini tiz basmagyň deregine ony basyp durmaly (1-2 sekundan soň 

goýbermeli) – ekranda anyk guralyň paneli açylar. 

Menýu setiriniň aşagynda ýerleşen standart gurallar panelinde (toolbar) has 

köp ulanylýan buýruklara gabat gelýän dolandyryş elementler ýerleşdirilen: 

faýllary açmak, ýapmak we ýatda saklamak, alyş-çalşygyň buferi bilen işlemek, 

suratlary görmegiň düzgünlerine we masştabyna.  

Standart paneliniň aşagynda atributlar paneli (property bar) ýerleşdirilýär. Ol 

saýlanylan iş düzgünine laýyklykda hemişe üýtgeýär, ol ulanyjynyň esasy iş guraly 

bolup durýar. 

Sag araçägiň ugry boýunça ekran reňk palitrasy ýerleşen (color palette). Ol 

reňk doldurmanyň we obýektleriň sudurynyň reňkini bellemek üçin ulanylýar.  

Menýu setiri 

Gurallar toplumy 

Çap sahypasy 

Gurallaryň standart paneli Atributlar 

paneli 

Iş stoly 

Ýanaşdyrylan 

penjireler 

Reňkleriň ekran 

palitrasy 
Ýagdaý setiri 

Sahypalar geçmek boýunça 

dolandyryş elementler 
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CorelDRAW penjiresiniň aşaky gyraňynda ýagdaý setiri ýerleşen (status 

bar). Onda bellenilen obýekt barada maglumatlar we programmanyň iş düzgüni 

barada köp peýdaly maglumatlar görkezilýär. 

Iş giňişligini esasy bölegi resminamalaryň penjirelerini (drawing windows) 

ýerleşdirmek üçin niýetlenen. Resminama döredilenden soň, ekranda surat 

ýerleşdirilmeli çap sahypanyň görnüşi bolar. Sahypanyň araçäkleri kölegeli ramka 

görnüşinde görkezilen, emma olar şekiliň elementi bolup durmaýar. Şekili düzjek 

obýektler şol araçäkleriň içinde ýerleşdirilmelidir. Şekiliň penjiresiniň beýleki 

giňişligi iş stoly diýlip atlandyrylyp obýektleriň wagtlaýyn saklawjysy hökmünde 

ulanylýar.  

Resminamanyň çepki we ýokarky gyraňlarynda obýektleriň 

koordinatalaryny ölçemek we ugrukdyryjylary ýerleşdirmek üçin gulluk edýän 

koordinata çyzgyçlary (rulers) bar.  

CorelDRAW interfeýsinde ýanaşdyrylýan penjireler (dockers) uly rol 

oýnaýar. 

Täze resminamany döretmek 

Deslapdan programma goýberilenden soň hemişe resminmama açylýar. Eger 

işiň dowamynda ýene bir resminama açmak zerurlygy ýüze çyksa, onda File 

(Файл) menýusynda New (Новый документ) bendi saýlamaly ýa-da gurallaryň 

standart paneliniň çep gyrasynda ýerleşen New (Новый документ) düwmejige 

basmaly.  

Resminamalary açmak we ýapmak 

CorelDRAW-da öň döredilen resminamalar Windows üçin standart usuly 

bilen açylýar: CorelDRAW bilen asssiirlenen faýlyň üstüne syçanjyk bilen 

basylandan soň programma goýberilende; File > Open (Файл > Открыть) buýrugy 

ýa-da standart panelinde ýerleşen Open (Открыть) düwmejigi arkaly.  

Açylan gepleşik penjiresinde Windowsyň islendik programmasyndaky ýaly 

hemme standart elementler bar. Ondan başga, faýllaryň sanawyndan çepde, 

deslapky götmegiň töweregi bar, Preview (Предварительный просмотр) 

baýdajygy goýlan ýagdaýynda şol töwerekde faýlyň içinde saklanylýan şekiliň 

kiçeldilen görnüşi görkezilýär. CorelDRAW resminamalary ýatda saklanylanda 

esasy sözler ýa-da bellikler bellenilen bolsa, onda olar Keywords (Ключевые 

слова) we Notes (Замечания) meýdanlarynda görkezilýär.  

Şekiliň kiçeldilen nusgalary faýl ýatda saklanylanda oňa goşulman hem 

bilýär, bu ýagdaýda Preview (Предварительный просмотр) baýdajyk goýulan 

hem bolsa deslapky görmegiň töwereginde hiç zat görünmez.  

Ulanylýan resminamany ýapmak üçin File > Close (Файл > Закрыть) 

buýrugy ulanmaly ýa-da şol penjiräniň sag ýokarky burçunda ýerleşen 

düwmejigine basmaly.  

 Resminamalary ýatda saklamak 

CorelDRAW resminamasynyň ýatda saklanylmagy File > Save (Файл > 

Сохранить) buýrugyň saýlanylmagy ýa-da gurallaryň standart panelindäki Save 

(Сохранить) düwmejigine basmak arkaly amala aşyrylýar. Eger bu resminama öň 
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ýatda saklanylman bolsa, onda ýörite Save Drawing (Сохранить документ) 

penjiresi açylýar.  

Eger resminamany programmanyň öňki ir wersiýalarynda ýatda saklamaklyk 

gerek bolsa, onda bu penjiredäki Version (Версия) açylýan sanawa üns bermeli we 

bu sanawda gerekli wersiýany saýlamaly.  

Eger faýl öň ýatda saklanylan bolsa, diske gaýtalanyş ýazgy Save Drawing 

(Сохранить документ) penjires açylmazdan bolup geçer.  

Eger faýlyň göçürmesini döretmek üçin File > Save As (Файл > Сохранить 

как) buýrugyndan peýdalanmaly. 

Sahypanyň parametrlerini üýtgetmek 

Täze resminama döredilenden soň käwagt deslapdan kabul edilen çap 

sahypanyň ölçeglerini üýtgetmek gerek bolýar. Bu amal aşakdaky panel arkaly 

sahypada hiç obýekt saýlanylman wagty ýerine ýetirilip bilner. 

 
Çap sahypalaryň ölçegi Paper Type/Size (Тип/формат бумаги) sanaw 

arkaly saýlanylýar, ol atributlar paneliniň iň çepinde ýerleşýär. Çap sahypanyň 

ölçegi hökman kagyzyň formatyna laýyk gelmän hem bilýär. Ol listiň 

ölçeglerinden kiçi bolsa ýeterlik.. Eger çap sahypanyň ölçegi listiňkiden kiçi bolsa, 

şekiliň gyrasynda arassa meýdan bolýar. 

 

Şekilleriň düzümi 
Öň bellenilşi ýaly, CorelDRAW-da şekiller bilen işlemekde esas bolup 

obýektler bolýar. Hemme grafiki obýektleri iki derejä bölmek bolýar — çyzyklara 

we primitiwlere. Soňkulara şulary degişli etmek mümkin: 

 Göniburçluklar  

 Ellipsler 

 Köpburçluklar we ýyldyzlar 

 Halkaçlar  

 Torlar 

 Standart figuralar 

Göniburçluklar  

 
Görkezilen obýektleriň iň pepdäkisi — «klassik» göniburçluk. Hut şeýle 

görnüşde göniburçluklar döredilende görünýär. Ikinji obýekt 45° burça öwrülen. 

Üçünji obýektde 4 burçdan üçüsi tegeleklenen. iň sagdaky bolsa egrilen. Görnüşi 

ýaly gönibrçlugy beýleki obýektlerden tapawutlandyrmak kän bir aňsat hem däl, 

emma ygtybarly usul - obýekti saýlap, ýagdaý setire seretmeklik. Eger ol ýerde 

kagyzyň formaty listiň ölçegi listiň ugrukdyrylmagy 
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Rectangle on Layer 1 (Прямоугольник на слое 1) habar emele gelse – şol obýekt 

göniburçlukdyr.  

CorelDRAW-da hemme primitiwler degişli gurallar arkaly gurulýar. 

Göniburçluklar döretmek üçin Rectangle (Прямоугольник) düwmejigi ulanmaly. 

Syçanjygyň görkezijisi gönüburçluk bilen kesişmäniň görnüşini alar.  

Rectangle (Прямоугольник) guraly başga usul hem arkaly işletmek 

mümkin, munuň üçin sahypanyň boş ýerinde syçanjygyň sag düwmejigine 

basmaly we kontekst menýuda Create Object > Rectangle (Создать объект > 

Прямоугольник) menýuny saýlamaly ýa-da F6 klawişasyna basmaly.  

Gönuburçlugy çyzmak üçin Rectangle (Прямоугольник) guralynyň 

görkezijisini döredilýän obýektiň diagonaly boýunça süýşürmeli. Syçanjygyň 

görkezijisi süýşürilýän mahaly ýagdaý setirde göniburçlugyň beýikliginiň we 

ininiň şol wagtky bahalary görkezilýär, ekranda bolsa, onuň hemişe üýtgeýän 

abrisi görkezilýär. Syçanjygyň düwmejikleri goýberilen mahaly ekranda 

göniburçluk emele geler, onuň daşynda ramka we markerler we içinde marker 

bolar, ýagdaý setirinde bolsa göniburçluklaryň toparyna degişli bolan obýekt 

döredilendigi barada habar bolar. 

 
 

Klawişa-modifikatorlaryň ulanylmagy 

1. Göniburçluk çyzylanda Ctrl klawişasy basylanda inedördül çyzylar.  

Ctrl klawişasy beýleki funksiýlary hem ýerine ýetirip bilýär. Meselem eger 

obýektiň öwrülmegi Ctrl klawişasynyň basylan ýagdaýynda amala aşyrylsa, onda 

obýekt birsydyrgyn öwrülmeginiň deregine 15° burç bilen bökme bilen öwrüler.  

2. Göniburçluk çyzylanda Shift klawişasy basylanda syçanjygyň 

görkezijisiniň süýşürilmeginiň başlanmagynyň nokadynda burçdaky marker dälde, 

merkeziň markeri bolýar. Bu usul, göniburçlugyň merkeziniň ýerleşmeginiň ýeri 

belli bolan mahaly amatly.  

 

 

 

 

 

 

 

 

Belleniş çägiň markerleri 

Obýektiň 

bellenilmeginiň 

markerleri 

Obýektiň düwünleri 

markerleri 

Rectangle guraly üçin syçanjygyň görkezijisi 
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Iki modifikatory bilelikde ulanmak mümkin.  

 
 

Indi bolsa göniburçluklaryň atributlarynyň paneline göz ýetireliň. Atributlar 

panelinde obýektiň modeliniň parametrini kesgitleýän dolandyryş elementleri we 

şol toparyň obýektleriniň üstünden standart amallary ýerine ýetirmegi mümkin 

edýän düwmejikler ýerleşdirilen.  

 Object(s) Position (Координаты середины). Koordinat ulgamynda (adatça 

sahypanyň çepki aşaky burçy bilen bagly bolan) göniburçlugyň ortasynyň 

koordinatlarynyň takyk bahalaryny saklaýan iki meýdan. Bu meýdanlara 

täze bahalary girizmek bilen göniburçlugy süýşürmek mümkin.  

 Object(s) Size (Высота и ширина). Bu meýdanlardaky bahalar 

göniburçluklaryň ölçeglerini dolandyrýar.  

Takyk aýdylanda bu meýdanlarda obýektleriň ölçegleri dälde, onuň gabaralary, 

ýagny ony belleýiş çägiň ölçegleri görkezilýär. Tapawut şol çägiň taraplarynyň 

koordinata oklaryna elmydama parallel bolmagyndan ybarat. Şol sebäpli, 45° 

burça öwrülen inedördül üçin iniň we beýikligiň bahalary onuň diagonalyna deň 

bolar.  

 Scale Factor (Коэффициенты масштабирования). Bu iki meýdanda 

çyzyklaýyn süýnmegiň we gysylmagynyň koeffisientleri saklanylýar. Olary 

üýtgedip, obýektiň degişli özgerdilmegini amala aşyrmak mümkin.  

 Nonproportional Scaling/Sizing Ratio (Блокировка раздельного 

масштабирования). Eger bu düwmejik basylan bolsa obýektiň bir 

tarapynyň ugry boýunça süýnmegi ýa-da gysylmagy ikinji tarap boýunça 

proporsionla süýnmege we gysylmaga getirer.  

 Angle of Rotation (Угол поворота). Bu meýdanda obýektiň öwrüliş 

amalynyň dolandyryş parametriniň bahasy saklanylýar.  

 Rectangle Corner Roundness (Коэффициенты закругления углов). Bu 

meýdanda göniburçlugyň her burçunyň tegelenmekliginiň radiusynyň 

otnositel bahalary saklanylýar. Bahalar göterimde ölçenilýär, 100 % 

hökmünde göniburçlugyň iň kiçi tarapynyň uzynlygynyň ýartysy kabul 

edilen.  

 Round Corners Together (Блокировка раздельного закругления углов). 

Eger bu düwmejik basylan bolsa, tegeleniş koeffisientleriniň dördüsinden 

islendik biriniň üýtgedilmegi beýleki koeffisientleriň şol bir ululyga 

awtomatiki üýtgedilmegine getirer. 

Göniburçlugyň burçlaryny tegelemek  

Gurallar toplumynda Shape (Форма) guraly saýlamaly, onuň görkezijisini 

göniburçlugyň burçunda ýerleşen islendik düwüne süýşürmeli we ony 

göniburçlugyň islendik tarapynyň ugry boýunça geçirmeli. Syçanjygyň 

görkezijisiniň göniburçlugyň burçundan daşlaşmagy boýunça hemme dört burç 

Masştablamagyň koeffisienti 

Ini 

Beýikligi 

Aýratyn 

masştablamagy 

blokirlemek 

Serpikdiriş 

koeffisienti 

Egrilere 

geçirmek 

Öwrüliş 

burçy 

Burçlaryň aýratyn 

tegelenmekligini blokirlemek 

Burçlaryň  

tegelenmekliginiň 

koeffisientleri 

Ortalaryň 

koordinatalary 
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tegelenip başlanýar, özem görkeziji näçe uzak süýşürilse, şonça hem tegelenmegiň 

radiusy uly bolýar.  

 
 

Göniburçlugyň diňe bir burçuny tegelemeklik üçin görkezijini gerek bolan 

burça getirmeli we syçanjyk bilen basmaly we soň görkezijini çekmeli. Diňe şol 

burç tegeleklener. 

Eger üns berilse, görkeziji çekilende düwünden emele gelen iki täze düwün 

biri biri bilen deň hereketlenýär we olaryň süýşürilmegi olaryň biriniň 

göniburçlugyň tarapynyň ortasyna ýetýänçä dowam edýär. Göniburçlugyň 

burçunyň maksimal tegeleniş radiusy (100%) onuň iň kiçi tarapynyň ýarty 

uzynlygyna deň. 

Eger tegeleniş koeffisintleriň ýanyndaky gulpuň şekiline eýe bolan düwmejik 

basylsa, onda tegeleniş koeffisientleriň biriniň üýtgedilmegi beýlekilere täsir 

etmez. 

 Ellipsler 

CorelDRAW bilen işlenende ellipsleri öz diametri boýunça süýndürilen 

tegelek hökmünde hasaplamak bolýar.  

Edil göniburçluk ýaly «ellips» obýektler topary öz içinde ellip bolman duran 

obýektleri hem alýar, ýagny ellipslerden emele gelýän ellipsleriň sektorlary we 

halkalary.  

Geometriýada ellipsleriň ölçegleri onuň ýarym oklarynyň ölçegleri bilen 

kesgitlenýär, CorelDRAW-da — gabara göniburçlugyň ölçegleri bilen (belleýiş 

çägi bilen gabat gelýän). Ellips belleýiş çägi taraplaryň 4 sany orta markerleri 

ýerleşýän ýerinde degýär. Ýaňy çyzylan ellipsde diňe bir düwün bar. 

  
Ellipsleriň, halkalaryň we sektorlaryň çyzylmagy we modifikasiýa 

Sahypany grafika bilen doldurmazlyk üçin CorelDRAW resminamasyna 

täze sahypany goşmaly. Munuň üçin Layout > Insert Page (Макет > Добавить 

страницу) buýrugyndan peýdalanmaly we açylan gepleşik penjiresinde ОК 

Ellipse guralynyň 

görkeziji 

Ellipsiň düwüni 
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düwmejigine basmaly ýa-da penjiräniň aşagynda sahypanyň adyna syçanjygyň sag 

düwmejigine basyp kontekst menýuda meňzeş atly menýuny çagyrmaly.  

Ellips çyzmak üçin, gurallar toplumynda Ellipse (Эллипс) guraly saýlamaly 

we guralyň görkezijisini çyzyljak ellipsiň gabara çäginiň diagonaly boýunça 

süýşürmeli. Syçanjygyň düwmejigi goýberilenden soň, ekranda ellips çyzylar.  

Klawişa-modifikatorlar Ellipse (Эллипс) guraly bilen edil Rectangle 

(Прямоугольник) guraly bilen işleýşi ýaly işleýär. Ctrl klawişasyny basyp saklap 

ellipsi dälde, dogry tegelegi çyzmak bolýar, Shift klawişasy ellipsi burçdan 

çekmände, gabara göniburçlugyň ortasyndan çekip çyzmagy mümkin edýär. 

Klawişa-modifikatorlary syçanjygyň düwmejikler goýberilenden soň goýbermeli.  

Gurulan ellipsiň düwünini tapmaly we onuň üstüne syçanjygyň düwmejigini 

getirmeli. Ellipse (Эллипс) guralyň görkezijisi Shape (Форма) guralyň görkezijisi 

bilen çalşyrylmaly. Syçanjygyň düwmejigine basmaly we düwüni gabara 

göniburçlugyň ortasyna tarap süýşürmeli, soňra bolsa ellipsiň araçäginden daşyna 

çykman sagat oky boýunça. Syçanjygyň düwmejigi goýberilenden soň ellips 

sektora öwrüler. Şonda ýagdaý setirinde we atributlar panelinde sektoryň merkezi 

burçy we ony çäklendirýän radiuslaryň ugurlary görkeziler. 

 
Ýene bir ellipsi çyzyp onuň düwünini içinden dälde daşyna çekip 

süýşürmeli. Netijede sektor dälde, ellipsiň halkasy çyzylar.  

Ellipsiň düwüni süýşürilende Ctrl klawişasy basylyp durulsa halkanyň ýa-da 

sektoryň merkezi burçy 15° bökme bilen üýtgäp durar.  

Ellips toparaynyň obýektleri üçin atributlar paneline seredeliň)  

 

 
 

 Ellipse (Эллипс). Bu düwmejik ellips bolup durýan obýekt bellenilen bolsa 

basylýar. Sektor ýa-da halka saýlanylan mahaly bu düwmejige basylsa olar 

ýapyk ellipse öwrülerler.  

 Pie (Сектор). Bu düwmejik sektor bolup durýan obýekt bellenilen bolsa 

basylýar. Onuň basylmagy ellipsleri we halkalary sektora öwürýär.  

 Arc (Дуга). Bu düwmejik halka bolup durýan obýekt bellenilen bolsa 

basylýar. Onuň basylmagy ellipsleri we sektorlary halka öwürýär.  

Halkanyň ugry 

Halkanyň başy we soňy 

Halka 

Sektor 

Ellips 
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 Starting and Ending Angles (Начало и конец дуги). Bu iki hasaplaýjyda 

sektoryň ýa-da halkanyň merkezini degişlilikde halkanyň başlangyç we 

ahyrky nokady bilen birleşdirýän radiuslaryň ugrukdyryş burçlarynyň 

bahalary saklanylýar. Ugrukdyryş burçlar sektory ýa-da halkany döredýän 

ellips bilen bagly bolan koordinat ulgamynda bellenilýär, başlangyç şöhle 

bolsa (0°) merkezi we ellips çyzylanda beýlekilerden has çepde ýerleşen 

nokady birleşdirýär.  

 Clockwise/Counterclockwise (Направление дуги). Bu düwmejik iki 

şöhleden olaryň haýsy ugur boýunça sagat ugry ýa-da oňa garşy gitjekdigini 

kesgitleýär.  

Köpburçluklar we ýyldyzlar  

 «Köpburçluk» toparyna CorelDRAW-da hemme geometriki köpburçluklar degişli 

– diňe dogrylar degişli: çykyp duranlar we ýyldyzlaýynlar (olary köplenç которые 

чаще называют просто звездами). 

 Edil ellipsler we göniburçluklar ýaly köpburçluklar modifisirlenip we öz 

öňki şekilini tanamazça üýtgedip bilýärler. 

  
Köpburçluklary gurmak üçin ýörite gural göz öňünde tutulan. Onuň 

düwmejigi Polygon (Многоугольник) guralyň panelinde beýleki iki guralyň 

düwmejikleri bilen bilelikde ýerleşdirilen.  

 
 

Beýleki primitiwleri gurmakdan tapawutlylykda köpburçluklar bilen 

işlenende atributlar paneli bilen çyzmakdan soň dälde öň işlemek gerek bolýar. 

Meselem:  

 Number of Points of Polygon (Количество узлов базового 

многоугольника). Bu hasaplaýjynyň bahasy ellipsiň bazasynda gurulýan 

köpburçlugyň ellipsde näçe düwüni guruljakdygyny kesgitleýär, şeýlelik 

bilen ol köpburçlugyň taraplarynyň sanyny belleýär.  

Bu hasaplaýjynyň maksimal bahasy 500, minimaly — 3 deň.  

Tor 

Halkaç 

Köpburçluk 
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 Star/Polygon (Звезда/Многоугольник). Bu düwmejikler ýyldyz 

köpburçlugyň çyzma düzgüni işledýärler we öçürýärler.  

Ýylzdyzyň çyzylmagyny tarapynyň sany 5-den az bolmadyk köpburçluk üçin 

ulanmak mümkin.  

 Sharpness of Polygon (Заострение углов многоугольника). Bu dolandyryş 

elementi (polzinokly utgaşan meýdan) diňe taraplarynyň sany azyndan 7 

bolan ýyldyz köpburçluklar bilen işlenende elýeterli. Bu parametriň bahasy 

näçe uly bolsa, şonça hem ýyldyzyň şöhleleri ýiti bolaýr.  

Köpburçluk gurulandan soň, baza köpburçlugynyň depelerinde ýerleşen 

düwünlerinden başga, onda köpburçlugyň her bir tarapynyň ortasynda ýerleşen 

goşmaça düwünler görkezilýär. Köpburçlugyň formasynyň Polygon 

(Многоугольник) guraly arkaly modifikasiýasy şol düwünleri süýşürmekden 

ybarat. 

Köpburçluklaryň gurulmagy we modifisirlenmesi 

Çyzylan köpburçlugyň düwünlerine üns bereliň. Polygon (Многоугольник) 

guralyň görkezijisini köpburçlugyň taraplarynyň ortasynda ýerleşen islendik 

düwüniň üstüne getireliň — şonda görkezijiniň formasy üýtgemeli, bu bolsa Shape 

(Форма) guralyň wagtlaýyn işlenendigi barada habar berýär. Ctrl klawişasyny 

basyp saklap, şol düwüni radius boýunça merkeze çenli ýarym aralyga süýşürmeli. 

„Alynan“ düwün bilen bilelikde köpburçlugyň tarapynyň ortasynda ýerleşen 

hemme beýleki goşmaça düwünler hem süýşer. Netijede ninzalaryň zyňýan ýaragy 

bolan sýurikene meňzeş figura emele geler.  

Köpburçlugyň 

burçunyň ýiteldilmegi 

Baza köpburçlugyň 

düwünleriniň mukdary 

Ýyldyz/Köpburçluk 

Rectangle guralynyň 

görkezijisi 

Baza köpburçlugyň görkezijisi 

görkezijisi 

Köpburçlugyň tarapynyň 

ortasyndaky düwün 
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Ctrl klawişasynyň basylmagy köpburçlugyň düwünleri süýşürilende olaryň 

baza ellipsiň radiuslary boýunça hereket bilen olaryň süýşmeginiň erkinligini 

çäklendirýär.  

Indi guralyň görkezijisini köpburçlugyň depesinde ýerleşen esasy düwüniň 

üstüne getiriň we ony radius dälde merkeziň daşyndan sagat ugry boýunça 

süýşüriň. Netijede sýurikeniň şöhleleri mundan güýçli hem ýiti bolar, we figura 

oklaýyn simmetriýany ýitirip, diňe merkezi simmetriýany saklap galar.  

Indi bolsa, ýene bir köpburçluk guralyň, emma ol indi tegelegiň içine dälde, 

bir kese çekilen ellipsiň içine salnan ýaly bolsun (aşaky surat, çepden). Polygon 

(Многоугольник) guralyň görkezijisini belleniş çäginiň orta markeriniň üstüne 

getirmeli (mundan soň ol dört başly strelka öwrülmeli) we köpburçlugy saga 

süýşüreliň. Syçanjygyň çep düwmejigini goýbermezdn öň, onuň sag düwmejigine 

basmaly (dört başly strelkanyň ýanynda «plýus» nyşany emele gelmeli). Netijede 

sahypada öň gurulan köpburçlugyň süýşürilen nusgasy emele geler. Bu amaly ýene 

iki gezek gaýtalamaly we 4 sany onburçluklardan ybarat bolan hatar emele geler.  

Göçürmegiň bu usuly örän peýdalydyr we ony ýatda saklamak gerek  

 
Birinji nusgany Polygon (Многоугольник) guralyň görkezijisi bilen basyp 

bellemeli we köpburçlugyň hem-de ýyldyzyň düzgünlerini işlediş düwmejigine 

basmaly. Çykyp duran köpburçluk ýyldyza öwrüler, köpburçluklaryň ýiteldiş 

meýdanynda bolsa 1 baha emele geler. 

Beýleki nusgalarda ýiteldiş meýdanyndaky bahany artdyrmak bilen emele 

gelen ýyldyzyň burçlaryny ýitileşdirmegi görüp bolar. 

Halkaçlar  

Halkaçlar şekiliň düzüm bölekleri hökmünde örän seýrek ulanylýar, ýöne 

olaryň ukrukdyryjylar we traýektoriýalar hökmünde ulanylmagy örän gyzykly 

grafiki effektleri gazanmagy mümkin edýär.  

CorelDRAW-da halkaçlaryň iki görnüşi bar: simmetriki we logarifmik. 

Birinjiler üçin iki sany goňşy burumlaryň arasyndaky aralyk (onuň merkezinden 

geçirilen radiusyň ugry boýunça ölçenilen) tutuş halkaç üçin deň. Logarifmik 

halkaçda bu aralyk deňölçegli belli bir konstanta – halkajyň giňeliş koeffisientine 

proporsional bolup artýar.  

Bu koeffisient göterimde ölçenilýär. Bu koeffisientiň 0.333 deň bolan 

bahasy, soňraky goňşy burumlaryň arasyndaky aralyk, ondan öňkileriňkiden üçden 

bir esse ulydygyny aňladýar.  

Aşakdaky suratda birinji spiral simmetriki, ikinji spiralda koeffient = 0,5-e, 

üçünjide koeffisient – 1-e deň 

Hakykatdan aýdylanda halkaçlar 

CorelDRAW-yň primitiwleri hökmünde 

bolmaýarlar. Şol sebäpli programmada 
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“halkaç” diýip obýektler topary ýok. Olar egriler toparynyň düzümine girýärler. 

Halkaçyň dolandyryş elementleriniň hemme bahalary halkaç gurulmazdan öň 

goýulmaly. Halkaç bellenilen bolanda onuň dolandyryş elementleriniň bahalarynyň 

atributlar panelinde üýtgedilmegi oňa hiç hili täsir etmeýär.  

Halkaçlar Spiral (Спираль) guraly arkaly çyzylýar, onuň düwmejigi 

Polygon (Многоугольник) guralyň panelinde ýerleşýär.  

 
Torlar  

Torlar hem edil halkaçlar ýaly aýry obýektler toparyny düzmeýär. Graph Paper 

(Диаграммная сетка) gural arkaly gurulýan şekiliň fragmentleri özi bilen deň 

göniburçluklaryň tertipleşdirilen toparlary bolup durýar. Bu fragmentleri Rectangle 

(Прямоугольник) guraly arkaly gurmaklyk örän ýadadýar. Bu guralyň düwmejigi 

Polygon (Многоугольник) guralyň anelinde ýerleşdirilen.  

 

Logarifmik halkaç Burumlaryň  

sany 
Giňeliş koeffisienti 

Simmetriki halkaç 

Spiral guralyň 

görkezijisi 

Graph Paper guralyň görkezijisi 

Toruň 

setiriniň   

sany 

Toruň 

sütüniniň 

sany 
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Tor şeýle yzygiderlilikde gurulýar: gurallar toplumynda Graph Paper 

(Диаграммная сетка) gural saýlanylýar, soňra atributlar panelinde setirleriň we 

sütünleriň sany görkezilýär, soňra guralyň görkezijisi göniburçluk töweregiň 

diagonaly boýunça süýşürilýär. Tor elmydama deň inli sütünler we deň beýiklikli 

setrler bilen gurulýar. 

Ýumuş nusgaly plakat döretmek 

 
Täze sahypany dörediň, ony atlandyryň we içinde setirler öwrenilen 

gurallara laýyk gelýän, öýjüklerinde bolsa obýektleriň nusgalary ýerleşen jetwel 

görnüşinde plakaty çyzmaly.  

Standart figuralar  

Bu toparyň primitiwleri tejribede köp duş gelýän grafiki fragmentleri 

çyzmak üçin ulanylýar. Topar 5 bölege bölünen: baza figuralar(basic shapes), 

strelka (arrow shapes), blok-shemalaryň elementleri (flowchart shapes), ýyldyzlar 

(star shapes), çykaryjylary (callout shapes). Aşaky suratda toparyň bölünýän 

bölekleriň düwmejikleri we olara degişli standart figuralaryň palitrasy görkezilen. 

Palitralar bölege degişli bolan guralyň atributlar panelindäki düwmejik arkaly 

açylýar.  

 
Standart figuralaryň çyzylmagy ikä bölünýär: çyzma we formany sazlama. 

Figurany çyzmak üçin şulary ýerine ýetirmeli.  
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1. Perfect Shapes (Стандартные фигуры) guralyň düwmejigine basmaly.  

2. Syçanjygyň görkezijisini çyzyljak standart figuranyň diagonaly boýunça 

süýşürmeli.  

Sahypada saýlanylan standart figura emele geler, ol belleniş markerler bilen 

gurşalar. Mundan başga standart figuralaryň köpüsinde bellenilende kiçi romb 

görnüşindäki reňkli marker— marker- modifikator emele gelýär (aşaky surat, 

sagda). Syçanjyk arkaly marker-modifikatory süýşürip, standart figuranyň daşky 

keşbini üýtgetmek mümkin.  

 
Çyzylan standart figurany soňra marker-modifikator arkaly gaýtadan sazlap, 

onuň gabaralaryny we ugrukdyrylmagyny atributlar paneliniň dolandyryş 

elementleri arkaly üýtgedip bolýar. Standart figuranyň formasyny marker-

modifikator arkaly üýtgetmek mümkinçiligi figuranyň üstünden alnyp barylýan 

işiň tutuş dowamynda saklanylýar we ol diňe figura egri çyzyga öwrülende ýitýär.  
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ÇYZYKLAR 

Egriniň modeli 

CorelDRAW-da kabul edilen çyzygyň modeliniň esasynda iki düşünje 

durandyr: düwün we segment. Düwün bolup şekiliň tekizliginde duran, segmentiň 

uçlarynyň biriniň ýagdaýyny belleýän nokat bolup durýar. Segment diýlip iki 

goňşy düwüni birleşdirýän çyzygyň bölegine aýdylýar. Ýapyk çyzykda düwünleriň 

sany bilen segmentleriňki gabat gelýär, açyk çyzykda düwünleriň sany 1-a artyk 

bolýar.  

Şu ýerde „çyzyk“ diýlen adalga hökmünde egrileriň (curve) toparyna degişli 

bolan obýekte düşünmeli bolar.  

Düwün ondan öňki segmentiň häsiýetini doly kesgitleýär, şol sebäpli ýapyk 

däl çyzyk üçin iki ahyrky düwünleriniň haýsysy başlangyç bolýandygyny, ýapyk 

çyzyk üçin bolsa çyzygyň ugruny (sagat ugry ýa-da oňa garşydygyny) bilmek 

zerur. Öňdäki segmentiň häsiýetleri boýunça düwünleriň üç görnüşini belleýärler: 

ýapyk däl çyzygyň başlangyç düwüni, şeýle hem göniçyzykly (line) we 

egriçyzykly (curve) düwünler. Aşaky suratda aralykdaky 1 düwün we ahyrky 

düwün — göniçyzykly, aralykdaky 2 düwün — egriçyzykly.  

Egri çyzyjk üçin ýagdaý setiriň orta böleginde obýektiň toparynyň ady 

görkezilýär — Curve on Layer 1 (Кривая на слое 1), onuň çep tarapynda bolsa— 

şol egri çyzygyň düwünleriniň sany.  

 
 Suratdan görnüşi çyzygyň düwünleri kiçiräk inedördüliň görnüşinde 

görkezilýär. Başlangyç düwün biraz ulyrak inedördül bolup görkezilýär.  

Redaktirlemede bellenilen düwünler hem ulaldylan görnüşinde görkezilýär.  

Iň bolmanda bir egriçyzykly segment bilen goňşy bolan düwünler üçin 

görnüşleriň ýene bir toparlanylyşy bar: olar döwüliş nokatlaryna (cusp) we 

düzlenen düwünlere (smooth) bölünýärler. Ýagny, düzlenen düwüniň ýagdaýy 

hökmünde simmetriki düwün bolýar (symmetrical), emma şeýle düwün bolup diňe 

iki egriçyzykly segmentiň arasyndaky düwün bolup durýar. 

Aşaky suratda görkezilen düwüniň hemme komponentleri diňe şol düwün 

Shape (Форма) gural arkaly bellenilen bolsa we şol egride başga düwün 

bellenilmedik bolsa ekrana çykarylýar.  

Aralykdaky 2 düwün 

görkezijisi 

Ahyrky düwün 

Çyzygyň göniçyzykly segmenti 

Aralykdaky 1 düwün 

görkezijisi 

Çyzygyň egriçyzykly segmenti 

Başlangyç düwün 

Çyzygyň göniçyzykly segmenti 
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Egriçyzykly segmentiň bellenilen düwünine galtaşylýan tarapdan 

ukrukdyryjy nokat görkezilýär. Ekranda ol düwün bilen ştrihleme bilen 

birleşdirilen garaldylan inedördül hökmünde görkezilýär. Bu ştrihleme çyzyk onuň 

düwüne girýän nokadynda egriçykly segmente bolan galtaşyjy bilen gabat gelýär. 

Ukrukdyryjy nokat düwünden näçe daşlaşylsa, şonça hem egriçyzykly segment 

düwünden daşlaşylýança galtaşyjydan haýal gyşarylýar. Iki egriçyzykly segmenti 

bölýän düwün bellenilse, ekranda 4 sany ugrukdyryjy nokat görkezilýär — her 

segmenitň iki uçlaryndan.  

Düwüniň görnüşi (ol ýagdaý setirinde görkezilýär) onuň ukrukdyryjy 

nokatlarynyň özara ýerleşişini kesgitleýär. 

Döwülme nokatlary 

Düwün döwülme nokady diýlip oňa ýanaşýan segmentlere düwüniň özünden 

geçirilen galtaşyjylar bir çyzykda ýerleşmän doly açylan burçdan tapawutly burçy 

döredýän ýagdaýda atlandyrylýar. Döwülme nokatlaryň mysallary aşakdaky 

suratda getirilen.  

 
а) göniçyzykly segmentleriň sepinde; b) göniçyzykly we egriçyzykly segmentleriň 

sepinde; ç) iki egriçyzykly segmentleriň sepinde 

 

 

Düzlenen burçlar 

Düwün düzlenen diýlip oňa ýanaşýan segmentlere geçirilen galtaşyjylar bir 

çyzykda ýerleşýän bolsa atlandyrylýar. Düzlenen düwünleriň mysallary aşaky 

suratda getirilen.  

Bellenilen düwün 

Bellenilen düwüniň 

ugrukdyrjy nokatlary 

a   b ç   
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a) göniçyzykly we egriçyzykly segmentleriň sepinde b) iki egriçyzykly 

segmentleriň sepinde  

Iki göniçyzykly segmentleriň sepinde ýerleşen düwün düzlenen bolup 

bilmeýär. 

Simmetrik düwünler 

Simmetrik diýlip ugrukdyryjy nokatlar özünden deň daşlaşdyrylan düzlenen 

nokada aýdylýar. Döwüliş nokatlardan we düzlenen düwünlerden tapawutlykda 

simmetrik düwünler örän seýrek ulanylýar. Simmetrik düwüniň mysaly aşakdaky 

suratda getirilen.  

 
Ýapyk, arasy açyk we birleşdiriji çyzyklar 

Ahyrky düwün diýlip diňe bir segment bilen goňşy düwüne aýdylýar. 

Ýokarda bellenilişi ýaly, öňünden gelýän segmenti bolmadyk düwün başlangyç 

diýlip atlandyrylýar.  

Başlangyç düwüne eýe bolan çyzyk ýapyk däl (open curve) diýlip 

atlandyrylýar. Ahyrky düwünleri ýok bolan çyzyga ýapyk (closed curve) diýilýär.  

Ýapyk çyzykda başlangyç we ahyrky düwüniň roluny şol bir düwün ýerine 

ýetirýär, şol sebäpli onda hem şňki we yzyndan gelýän segmentleri bar. Şeýlelik 

bilen ýapyk çyzykda başlangyç düwün ýok, ýogsam ekranda şol düwün Shape 

(Форма) gural bilen saýlanylsa edil başlangyç düwün ýaly ulaldylan inedördül 

bilen şekillendirilen hem bolsa.  

Birleşdirilen çyzyklar – bu birnäçe şahalardan (subpath) ybarat bolan 

obýektler, şol şahalaryň her biri ýapyk ýa-da ýapyk däl çyzyk bolup durýar. 

Birleşdirilen çyzyklar obýektler Combine (Соединить) buýrugy bilen birleşdirilen 

amallarynda we beýleki obýektler (meselem tekstler) egri çyzyklara özgerdilende 

emele gelýär. Birleşdirilen obýektiň esasy tapawutly häsiýeti bolup bir obýekte 

ulaldylan inedördül bilen belleinlen birnäçe düwünleriň bolmagy bolýar. 

Birleşdirilen çyzyklary aýrylaşdyryp bolaýr.  

 

 a      b  
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Suratda ýapyk (çepde), atasy açylan (ortada) we birleşdirilen (sagda) çyzyklar 

görkezilen 

CorelDRAW-da islendik grafiki obýekt egrilere öwrülip bilner. Hem-de 

tersine, köp çylşyrymly obýektler bir ýa-da birnäçe çyzyklaryň esasynda gurulýar. 

Egri çyzyklary gurmak üçin gurallaryň biri bolup Spiral çykyş edýär. Dürli 

görnüşli çyzyklary gurmagy mümkin edýän gurallar CorelDRAW-da Curve 

(Кривая) guralyň panelinde ýygnalan.  

 

  

 

 

 

 

 

 

 

Çyzyklar we Freehand guraly 

Freehand (Произвольная кривая) guraly syçanjygyň hereket ediş ýoluny 

egri çyzyga öwürýär. Şonda çyzygyň düwünleri we segmentleri guralyň 

sazlanmasyna laýyklykda awtomatiki döreýär. 

Çyzyklary el bilen çyzmak 

Curve (Кривая) gurallar panelinde Freehand (Произвольная кривая) guraly 

saýlalyň. Syçanjygyň görkezijisi saýlanylan gurala gabat gelýän görnüşe eýe bolar. 

Syçanjygyň düwmejigine basmaly we görkezijini süýşürip tegeleklenen ýapyk 

egrini çyzmaly. Syçanjygyň görkezijisi egriniň çyzylmagy başlanan nokadyna 

golaýlaşanda görkeziji öz görnüşini suratdaky ýaly üýtgeder (sagda). Eger 

syçanjygyň düwmejigi goýberilse ýapyk egri çyzylar.  

 

Superçyzyk 

Pero 

Poliçyzyk 
Bezýe egrisi 

Egri 

Üç nokat boýunça egri 

Ölçeg çyzygy 
Birleşdiriji çyzyk 

a b 
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Egri çyzylanda, çyzyk „başga ýere barsa“, syçanjygyň düwmejigini 

goýbermän Shift düwmejigine basyp saklaň. Indi görkezijini eýýam çyzylan 

çyzygyň ugry boýunça yza süýşürsek „nädogry“ bölegi pozup bolýar. Soňra 

klawişany goýberip çyzmagy dowam etmek bolýar.  

Egri çyzylandan soň Shape (Форма) guraly saýlaň we onuň bilen islendik 

düwüne basyň, soňra bolsa ýagdaý setirindäki habary okaň. Soňra, yzygiderli Tab 

düwmejigni basyp, düwünden düwüne geçip olaryň görnüşini ýagdaý setirinden 

biliň. Netijede şular gelip çykar:  

 Freehand (Произвольная кривая) gural bilen işlenende düwünler we 

segmentler awtomatiki döredilýärler;  

 Düwünleriň köpüsi döwüliş nokady bolup durýarlar;  

 Segmentleriň köpüsi— egriçyzykly.  

Syçanjygyň tizligi egri çyzylanda näçe ýokary bolsa, şonça hem gurulýan 

düwünler biri-birinden daşda ýerleşer.  

Indi ýaňky egri çyzylanda tegelenişden başlap göniçyzkly segment 

başlanmaly we gutarmaly mahaly Tab klawişasyny basyň. Göniçyzykly segmentler 

gowy çyzyldy.  

Indi bolsa bu guralyň gowy oňarýan zadyny çyzalyň – diňe göniçyzykly 

segmentleri. Guralyň görkezijisi birinji düwüniň ýerleşmeli ýerine getirilýär we 

syçanjygyň düwmejigine basmaly. Indiki syçanjygyň düwmejiklerine basylmagy 

düwünleriň ýerleşmeli ýerinde iki gezek basylmak bilen amala aşyrylýar. Soňky 

gezek başlangyç nokatda basylan ýagdaýda çyzyk ýapyk bolup galýar.  

Corel-Draw-yň soňky wersiýalarynda Freehand (Произвольная кривая) 

gurala goşmaça hökmünde Polyline (Полилиния) guraly girizilen. Onuň bilen 

birnäçe segmentlerden ybarat bolan egrileri çyzmak amatly. Başlangyç segment 

döredilenden soň syçanjygyň düwmejigine basylýar, emma ol egriniň 

çyzylmagyny tamamlamaýar. Syçanjygyň düwmejigi basylan mahaly görkezijiniň 

süýşürilmegi egri çyzygyň egriçyzykly segmentini döredýär, syçanjygyň 

düwmejigi goýberilen mahaly görkezijiniň süýşürilmegi göniçyzykly segmenti 

döredýär. Ýapyk däl egriniň çyzylmagyny tamamlamak üçin Probel klawişasyna 

basmaly. 

Çyzyklar we Bezier guraly 

Bezier (Кривая Безьс) guraly bilen işlände ulanyjy çyzyljak egriniň 

düwünleriniň ýerleşi'ini belleýär we çyzmagyň dowamynda onuň her biriniň 

ugrukdyryjy nokatlaryna täsir etmek mümkinçiligine eýe bolýar. Egriniň Bezier 

(Кривая Безье) guraly arkaly çyzylmagy egriniň her düwüni bilen işlemegiň 

siklleriniň yzygiderliliginden ybarat. Sikl görkezijiniň boljak düwüniň ýerine 

goýulmagyndan başlanýar. Soňra syçanjygyň düwmejigi basylýar we ony basyp 

saklap ulanyjy ugrukdyryjy nokatlaryň ýerleşişini takyklaýar, syçanjyk bilen ony 

süýşürip (ilkibaşda düwünden, soňra bolsa – onuň daşynda). Deslapdan simmetrik 

düwünler döredilýär, emma syçanjygyň düwmejigi goýberilen mahaly ulanyjy 

düwüniň klawişa-modifikatordan peýdalansa düzlenen düwün ýa-da döwüliş nokat 

dörediler. Syçanjygyň düwmejigi goýberilen mahaly düwüniň görnüşi we 

ukrukdyryjy nokatlaryň ýerleşişi bellenilýär, soňra indiki düwüniň kesgitleniş sikli 

başlanýar. Siklden çykmak üçin Probel klawişasyna basmaly.  
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Döwüliş nokady döredilende С klawişasyny basyp saklamaly (cusp). 

Düzlenen nokady döretmek üçin S (smooth) klawişa-modifikator ulanylýar.  

Çyzyklary Bezier guraly arkaly çyzmak 

Gurallar toplumynda Bezier (Кривая Безье) guraly saýlaň. 

Çyzygyň gurulmagyny çyzykly segmentden öň duran düwünden başlalyň. 

Görkezijini gerekli nokada goýmaly we syçanjygyň düwmejigine basmaly. 

Düwmejigi goýbermän görkezijini birneme saga geçirmeli, düwünden „çykarylan“ 

ugrukdyryjy nokatlar görüner ýaly. Indiki segmente bolan galtaşyjy berk kese bolar 

ýaly Ctrl klawişasyna basyp saklamaly. Syçanjygyň düwmejigini goýberiň soňra 

bolsa Ctrl klawişasyna — egriniň birinji düwüni gurulan. Başda ol ýeke düwün 

bolany üçin onuň üstünden iş tamalanandan soň ol awtomatiki döwüliş nokady 

bolup durýar. Bu düwünde çyzyk ýapylan ýagdaýynda onuň görnüşi üýtgär.  

 
Ikinji düwüniň gurulmagyna geçeliň. Ol birinji düwün bilen bir kese 

çyzykda ýerleşmelidigi sebäpli, guralyň görkezijisini süýşürmezden öň gaýtadan 

Ctrl klawişasyny basyp saklamaly. Ikinji düwün edil birinji düwün ýaly gurulýar, 

ýöne syçanjygyň düwmejigi goýberilenden soň ol simmetrik bolar. 3.10).  

 
Üçünji düwün gönümel ikinjiň aşagynda ýerleşmelidir, şol sebäpli ikinji 

düwün bilen işlenenden soň Ctrl klawişasyny goýbermeseň hem bolýar. Bu gezek 

düwünden ugrukdyryjy nokady Ctrl klawişasyny goýbemän saga dälde çepe 

“çykarmaly”. Tegelenme simmetriki bolar ýaly ugrukdyryjy nokatdan düwüne 

çenli aralyk edil ikinji düwüniňki ýaly bolmalydyr.  

 
 

Dördünji düwün edil üçünji ýaly gurulýar. Indi egrini ýapmak gerek. Munuň 

üçin syçanjygyň görkezijisi başlangyç nokada süýşürilýär (ýörite strelkaly nyşan 

emele gelýänçä) we syçanjygyň çep düwmejig basylýar. Ugrukdyryjy nokady Ctrl 

klawiýasy basylan ýagdaýynda saga süýşürmek galdy (tegelenme simmetrik bolar 

ýaly) we ýapyk egri çyzylar.  

 
Täze Реn (Перо) guraly egrileri edil Bezier (Кривая Безье) guralyň teklip 

edýän usullary bilen çyzmaklygy mümkin edýär. Tapawut syçanjygyň görkezijisi 

egriniň nibatdaky düwüniň ýerleşiş nokadyna süýşürilende ektanda egriniň entek 

gurulmadyk indiki segmentiň daşky görnüşi görkezilýär.  

Üýtgeýän inli çyzyklar we Artistic Media guraly 

Artistic Media (Суперлнння) guraly arkaly «superçyzyklar» (Artistic Media 

Group) toparynyň düzüm obýektleri çyzylýar. Bu obýektleriň her biri iki bölekden 

ybarat — dolandyryjy obýektiň roluny oýnaýan we tutuşlaýyn düzüm obýektiň 

b a 
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formasynyň esasy parametrlerini kesgitleýän çyzykdan hem-de şol formanyň 

detallaryny kesgitleýän tabyn obýektden. Tabyn obýektiň rolunda ýapyk egri 

çyzyk eýsem CorelDRAW-daky islendik obýekt oýnap biler, özem dolandyrjy 

obýekt hem-de tabyn obýekt superçyzyk gurulmazdan öň çyzylyp bilner, şeýle 

hem çyzmagyň dowamynda gurulyp bilner. Bu mümkinçilikleri amala aşyrmak 

üçin Artistic Media (Суперлиния) guraly birnäçe düzgünde işläp bilýär. Artistic 

Media (Суперлиния) guralyň düzgünlerini saýlamaklyk aşakda görkezilen 

atributlar paneli arkaly amala aşyrylýar 

.  

 
  

 Preset (Заготовка), Brush (Кисть), Sprayer (Распылитель), Calligraphic 

(Каллиграфия) we Pressure (С нажимом) düwmejikleri guralyň 

düzgünlerini işletmegi mümkin edýär.  

 Polzunogy bolan Freehand Smoothing (Сглаживание) meýdany düwünleriň 

döredilmeginiň ýygylygyny sazlamagy mümkin edýär, ýagny birleşdirilen 

obýektiň dolandyryjy çyzygynyň tekizligini.  

 Artistic Media Tool Width (Ширина линии) hasaplaýjysy superçyzyk 

gurulanda tabyn obýektiň maksimal inini kesgitleýän bahany saklaýar.  

 Preset (Схема заготовки) açylýan sanaw taýýarlanma düzgünde işelenende 

tabyn obýektiň ülňisini saýlamagy mümkin edýär.  

Kaliigrafiýa düzgüni 

Guralyň görkezijisi belli bir traýektoriýa boýunça süýşürilende bu 

traýektoriýa düzüm obýektiň dolandyryjy çyzygy hökmünde bellenilýär, şonda 

düzlenmegiň dolandyrjy parametriň bahasy hasaba alynýar. Emma süýşürme 

tamamlanandan soň (syçanjygyň düwmejigi goýberilenden soň) awtomatiki ýene 

bir obýekt çyzylýar — ýapyk egri çyzyk. Onuň formasy dolandyryjy çyzygyň 

formasy we kaliigrafiki peronyň häsiýetnamalary – ini we eňňitlik bilen 

kesgitlenýär.  

Berlen inli kalligrafik pero ortaky nokady bilen dolandyryjy çyzygyň 

başlangyü düwünine goýulýar, soňra onuň ugry boýunça süýşürilýär. Tabyn obýekt 

peronyň başlangyç we ahyrky ýagdaýlaryndan we onuň gyralarynyň hereket eden 

traýektoriýadan ybarat bolan ýapyk egri çyzyk bolup durýar. Aşaky suratda 

kalligrafik gural bilen çyzylan obýekt üç gezek görkezilen, Çepde ol Shape 

(Форма) guraly bilen okuna basylyp saýlanylan, ortada — Pick (Выбор) guraly 

bilen obýektiň gyrasyna syçanjyk bilan basylyp. Sagda kaligrafik peronyň eňňitlik 

bahasy 0-dan 60° çalşyrylan ýagdaýynda.  

  

Taýýarlanma

m 
Çotga 

Basyş bilen 

Düzlenme 

Pürkgüç Kalligrafiýa Çyzygyň ini Taýýarlanmanyň ülňisi 
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Taýýarlanma düzgüni 

Kalligrafiýa düzgüninden tapawutlykda taýýarlanma düzgüni dolandyryjy 

çyzygy iki usul bilen gurmagy mümkin edýär: superçyzygyň düzüm obýekti 

gurulýan mahaly ýa-da öňünden, soňra dolandyryjy obýekte özgertme bilen.  

Birinji warianta ulanyjy edil kalligrafiýa düzgüninde ýaly hereket edýär, 

ýöne kalligrafiki peronyň eňňitliginiň deregine tabyn obýektiň öň taýyn ülňisi 

ulanylýar — bu ülňileri saklaýan sanaw atributlar panelinde emele gelýär. 

Ikinji wariantda ulanyjy çyzgyny ilkibaşda Freehand (Произвольная 

кривая) ýa-da Bezier (Кривая Безье) guraly arkaly gurýar, soňra Artistic Media 

(Суперлиння) guraly saýlanylýar, taýýarlanma düzgüni işledilýär.  

Eger dolandyryjy obýekt hökmünde birleşdirilen çyzyk ulanylsa, onda 

taýýarlanma onuň her şahamçasyna aýry ulanylýar. Taýýarlanam saýlanmazdan öň 

superçyzyk bolup duran obýekt bellenilse, onuň tabyn obýekti ýok edilýär, we täze 

tabyn obýekt bellenilýärто его подчиненный объект удаляется, а по 

сохраненной управляющей линии строится новый подчиненный объект в 

соответствии с новой заготовкой.  

 
  

Çotga düzgüni 

Çotga düzgüninde tabyn obýekt dolandyryjy çyzgy boýunça gurulmaýar, ol 

diňe onuň formasy we superçyzygyň ini boýunça deformirlenýär. Deformasiýa 

üçin basşlangyç material bolup sülereýler hyzmat edýär — ýörite .стх formatda 

CorelDRAW programmasynyň ýüklenen bukjasynda ýerleşen 

\CustomMediaStrokes bukjada ýatda saklanylan şekiller. Deformasiýanyň manysy 

şekil-sülereý ini birleşdirilen obýektiň uzynlygyna, beýikligi bolsa superçyzgyň 

Guralyň görkezijisi Eňňitlik burçy 
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berlen inine deň bolar ýaly süýnýär ýa-da gysylýar, soňra bolsa dolandyryjy 

çyzygyň formasyna laýyklykda gyşarylýar.  

 CorelDRAW-yň düzümine standart sülereýleriň toplumy girýär we olaryň 

içine täzelerine goşmak hem bolýar (diňe wektorlylary dälde, eýsem nokatlylary 

hem). Şekil \CustomMediaStrokes salnan soň onuň ýönekeýleşdirilen şekili kist 

üçin atributlar panelinde sülreýleri görkezýän açylýan sanawda ýerleşdiriler.  

 

 
 

Çyzyklary kist düzgünde çyzmaklygyň usullary edil taýýarlanma düzgüniňki 

ýalydyr. 

Şekili sülereý hökmünde ýatda saklamak üçin, ony Pick (Выбор) guraly 

arkaly saýlamak gerek, soňra Artistic Media (Суперлиния) guraly saýlamaly, kist 

düzgünini işletmeli we paneldäki degişli düwmejige basmaly we açylan penjirede 

at bermeli. Sülereýleri ýok etmek üçin hem degişli düwmejik bar. 

Sülereýiň fiziki ýok edilmegi syçanjyk bilen düwmejige basylan ýagdaýda 

dälde, CorelDRAW bilen iş tamamlananda amala aşyrylýar. Şol sebäpli 

programma ýapylmaka ýok edilen sülereýi bilen işlemek mümkin.  

Superçyzyklary çyzmak 

1. Sahypada ýylanyň suratyny çekiň (aşaky surat, ýokarda). Ilkibaşda 

ýylanyň tenine we kellesine gabat gelýän ýapyk çyzygy guruň. Gözleri we burun 

deşikleri hökmünde ellipsleri çyzyň. Arkazynda zigzak hökmünde bolsa döwülen 

çyzyk gulluk etsin.  

 
2. Indi ýylanyň hemme böleklerini Pick (Выбор) guraly arkaly göniburçluga 

salyp belläliň.  

3. Artistic Media (Суперлиния) guraly saýlap kist düzgünini işledeliň. 

Soiňra disketa görnüşine eýe bolan düwmejige basyp sülereýi ýatda saklamak üçin 

faýlyň adyny girizmeli. Ok düwmejigi basylandan soň täze sülereý ulanylmaga 

taýyn. 

Sülereýleriň sanawy Sülereýleri ýok etmek 

Sülereý hökmünde ýatda saklamak  
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4. Esc basyp ýylanyň bellenilmegini aýyrmaly. Artistic Media 

(Суперлиния) gural arkaly islendik çyzyklary çyzalyň. Netijäni ýokarky suratda 

görmek bolar!  

5. Ýylany ýumak ýaly düýrlemek üçin Spiral (Спираль) guraly arkaly 2-3 

burumdan ybarat bolan logarifmik spiraly çyzalyň. Artistic Media (Суперлиния) 

guraly saýlap ýylanyň sülereýini ulanalyň. Eger ýumak gaty dykyz bolsa 

superçyzygyň inini peseldip görmeli ýa-da obýekti ýok edip spiralyň giňeliş 

koeffisientini artdyryp obýekti çyzmaly .  

6. Ýylany halka düýrlemek üçin dolandyryjy çyzyk hökmünde ellipsi 

ulanmak gerek.  

7. Original göniburçluk ramkany ýasamak üçin göniburçlugy gurmaly we 

onuň üç burçuny – ýokarky çepdekiden başgasyny tegeleklemeli. Bu superçyzygyň 

güýçli döwülmesinden azat eder. 

Pürkgüç düzgüni 

Artistic Media (Суперлиния) guralyň pürkgüç düzgüni bir tabyn obýekti 

dälde, olaryň tutuş toparyny döredýär, ol öňden kesgitlenen şekiliň nusgalaryny we 

onuň böleklerini (pürkgüjiň şablonyny) dolandyryjy çyzygyň ugry boýunça 

ýerleşdirýär. Aşakda suratda iki mysal getirilen olaryň şablony tapawutly emma 

dolandyryjy çyzyklary bir görnüşli. 

Ýöne bu düzümli obýektleri çyzyklara örän kynçylyk bilen degişli etmek 

bolýar. Pürkgüç düzgüniň funksional mümkinçilikleri örän giň. Ýagny pürkgüjiň 

şablonyna girýän şekiliň aýry böleklerini, olaryň dolandyryjy çyzykda ýerleşişini 

kesgitleýän parametrlerini, şol bölekleriň yzygiderliligini dolandyrmak mümkin. 

CorelDRAW-yň düzümindäki topluma pürkgüjiň şablonlarynyň köp mukdary 

girýär, şol şablonlaryň sanyny köpeltmegiň mümkinçiligi hem bar. Köplenç 

pürkgüç düzgüninde düzülen superçyzyklary original ramkalary we fonlary 

döretmek üçin ulanýarlar.  

 
Artistic Media ýanaşdyrylýan penjiresi  
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Superçyzyklary gurmak we üýtgetmek üçin diňe Artistic Media 

(Суперлнния) guralyň atributlary panelini ulanman, eýsem deň atly ýanaşdyrylýan 

penjiresini ulanmak bolýar. Ony ekranda görkezmek üçin Window > Dockers > 

Artistic Media (Окно > Пристыкоаываемыеокна > Суперлиния) buýrugy 

saýlamaly.  

 
Ýanaşdyrylýan penjirede superçyzyklaryň taýýarlanmasynyň, pürkgüjiň 

sülereýleriniň we şablonlarynyň şekilini saklaýan iki sanaw getirilen. Aşaky 

sanawda \CustomMediaStrokes bukjanyň düzümine gabat gelýän ülňileriň doly 

toplumy getirilen, ýokarkyda — ýakynda ulanylanlar. Sanawyň düzümini 

görkezilýän obýektleriň menýusy arkaly dolandyrmak mümkin, ol saga 

gönükdirilen üçburçlugyň şekilini göterýän düwmejik arkaly amala aşyrylýar. 

Menýuda üç sany düzgüni pürkgüjiň taýýarlanmasynyň, sülereýleriniň we 

şablonlarynyň görkezilmegini işledýär we öçürýär.  

Blokirowka düwmejigi ülňiniň saýlanylan çyzyga ulanmagyň düzgünini 

dolandyrýar. Eger düwmejik basylan ýagdaýda bolsa, onda sanawda bir ülňi 

saýlanylandan soň, derrew şol ülňi superçyzygy gurmak üçin ulanylýar. Eger 

düwmejik basylmadyk ýagdaýda bolsa, onda, ülňini ulanmak üçin Apply 

(Применить) düwmejigine goşmaça basmak gerek bolýar.  

Şu ýanaşdyrylýan penjiresiniň elementlerini ulanmaklyk superçyzyklary 

gurmagyň üç düzgünleri: taýýarlanma, çotga we pürkgüç düzgünleri bilen işlemegi 

gaty aňsatlaşdyrýar.  

Egri çyzygy superçyzygyň dolandyrjy egri çyzygyna özgertmek üçin, 

ýanaşdyrylýan penjiräniň iki sanawynyň birinde taýýarlanmanyň, sülereýiň ýa-da 

şablonyň gerek şekilini saýlamak we ony syçanjyk arkaly şol egri çyzygyň üstüne 

süýşürmek ýeterlikdir.  

Şekili pürkgüjiň sülereýi ýa-da şablony hökmünde ýatda saklamak üçin ony 

belläp syçanjyk bilen aşaky sanawa süýşürmek ýeterlikdir. Syçanjygyň düwmejigi 

goýberilenden soň görkezilen şekil pürkgüjiň sülereýi ýa-da şablony hökmünde 

Görkezilýän 

obýektler 

Ulanylan şablonlar, 

sülereýler we ülňiler 

Taýýarlanmany 

ýok etmek 

Sülereýi ýatda 

saklamak 

Blokirowka 

Ulanmak 
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ýatda saklanylýandygy görkezilýän gepleşik penjiresi açylýar, soňra bolsa faýlyň 

ady berilýär.  

Edil şol netijäni ýanaşdyrylýan penjiräniň Save (Сохранить) düwmejigi 

arkaly gazanmak mümkin. 

Basyşly surat çekiş düzgüni 

Bu düzgün ýörite enjamy talap edýär — tenzometrik grafiki planşeti, ol diňe 

peronyň üstünden hereketini bellemän, eýsem ulanyjynyň pero basýan güýjüni 

hem hasaba alýar.  

Bu düzgünde peronyň planşet boýunça süýşürilmegi superçyzygyň 

dolandyryjy egri çyzygyny döredýär, basyş bolsa onuň inini kesgitleýär (iň ýokary 

basyşly ýerlerde ol atributlar panelinde bellenilen guralyň inine deň bolar).  

Ekzotikanyň söýüjileri bu düzgüni planşetsiz hem ulanyp bilerler. Peronyň 

hereketini syçanjyk arkaly amala aşyryp basyşy bolsa kursory dolandyryjy 

klawişalar bilen (ýokary we aşak).  

Cyzgylaryň we ülňileriň elementleri  

CorelDRAW-daky käbir obýektler esasan ýörite şekiller: çyzgylar, ülňiler, 

diagrammalar, blok-ülňiler gurulanda ulanylýar. Kada bolşy ýaly, bu görnüşli 

şekiller dürli şertler bilen çyzylýar. Programma çyzgylary çyzmaklyga bolan 

standartlaryň hemmesini kanagatlandyryp bilmeýär, ýöne eger şekile önümiň 

gabara ölçeglerini goýmak, ýa-da onuň aýry böleklerini çykaryş çyzyklar bilen 

görkezmek gerek bolsa, bu işi CorelDRAW başarýar we munuň üçin onda 

ýeterlikçe güýçli gurallar bar.  

 
Olaryň köpüsi Curve (Кривая) guralyň açylýan paneline ýygnalan. 

Ölçeg çyzyklar 

Curve (Кривая) guralyň panelinde Dimension (Размерные линии) guralyň 

saýlanylmagy ölçeg ülňileriniň bir toparyny (çykaryş çyzykdan, ölçeg çyzykdan 

we ölçeg ýazgydan ybarat bolanlary) we çykaryş çyzyklary ulanmagy mümkin 

edýär:  

 Çyzykly ölçeg (Linear Dimension);  

 Burç ölçegi (Angled Dimension);  

 çykaryjy (Callout).  

Düzümli obýektiň içine dürli toparlaryň obýektleri girýär. Olary aýratyn 

üýtgetmek mümkin däl, üýtgetme tutuşlaýyn bolup geçýär we aýratyn obýektler 

boýunça ylalaşykly bolýar, meselem ölçeg ýazgysy üýtgedilende şoňa görä ölçeg 

ülňisiniň çykaryş çyzyklary ýa ulalar ýa-da kiçeler we ölçeg çyzygy süýşüp durar.  
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Ölçeg ülňisini, edil düzümli obýekti ýaly aýry böleklere bölmek mümkin. 

Munuň üçin Arrange > Break Apart (Монтаж > Разъединить) buýrugyny 

saýlamaly. Bu buýruk ýerine ýetirilenden soň düzümli obýekt birnäçe obýektlere 

we obýektler toparyna öwrülýär. Emma bu yzyna gaýtarylmaýan hereket.  

Ölçeg ülňiler we çykaryjylar bilen işlenende uly orny atributlar paneli 

oýnaýar. 

  

 
 

 Ölçeg ülňisiniň görnüşini saýlaýyş düwmejikleriniň topary.  

o Auto Dimension Tool (Авторазмер). Ölçeg ülňisiniň görnüşi ülňi 

düzülende syçanjygyň hereketi boýunça awtomatiki kesgitlenýär. 

Islendik çyzykly ölçegiň ölçeg ülňisini gurmagyň prosesi syçanjygyň 

düwmejiginiň üç gezek yzygiderli basylmagyndan ybarat: birinji 

çykaryş çyzygyň „ölçenilýän“ obýekte birleşýän ýerinde, ikinji 

çykaryş çyzygyň birleşýän ýerinde we ölçeg ýazgynyň we ölçeg 

çyzygyň ýerleşişi bellenilende.  

Obýektiň birleşiş nokat bolup, ölçeg ülňiniň elementleri, birleşiş çyzyklar we 

çykaryjylaryň başlary bagly bolup durýan nokat çykyş edýär. Guralyň görkezijisi 

meselem Dimension Line (Размерная линия) guralyňky — birleşiş nokadynyň 

üstünden baranda ol ekranda reňkli marker bilen görkezilýär. Birleşiş nokatlary 

hökmünde obýektleriň hemme düwünleri, şeýle hem belleýiş çäkleriň 

markerleriniň ýerleşiş ýeri degişli, eger olaryň ýerleşiş ýerinde obýektiň çyzygy 

bar bolsa. Meselem, göniburçlukda, hem-de ellipsde belleýiş çäginiň aşaky 

tarapynyň ortasynda birleşiş nokady bar. Emma şol çägiň burçlarynda 

göniburçlukda birleşiş nokatlary bar, ellipsde bolsa ýok. Primitiwleriň ortasynda 

birleşiş nokatlary bar.  

o Vertical Dimension Tool (Вертикальный размер). Dik ölçeg ülňisi.  

o Horizontal Dimension Tool (Горизонтальный размер). Kese ölçeg 

ülňisi.  

o Slanted Dimension Tool (Наклонным размер). Ölçeg çyzygyň eňňitli 

ugruny göz öňünde tuttýan ölçeg ülňisi.  

o Callout (Выносная линия). Ýazgyny obýektdäki birleşiş nokady 

bilen baglaşdyrylýan ýörite düzümli obýektiň saýlanylmagy.  

o Angular Dimension Tool (Угловой размер). Burçuň ölçegini 

goýmagyň ölçeg ülňisi.  

Eňňit ölçegi Çykaryş çyzyk 

Burç ölçegi 

Ölçegiň görnüşi 

Ölçeýşiň takyklygy 

Ölçeg birligi 

Tekstiň ýerleşişi Dinamiki 

baglaşdyryş 

Ölçegiň 

goşulmasy 

Ölçegiň 

prefiksi 

Ölçeg birlikleri 

görkezmek 

Awtoölçeg 

Kese ölçeg 

Dik ölçeg 
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 Dimension Style (Тип измерения). Bu açylýan sanaw ölçegiň bahasyny 

görkezmegiň formadyny dolandyrýar. Sanawa şular goşulan:  

o Decimal (Десятичный) — ölçegiň bahasy onluk drob görnüşinde 

görkezilýär, onda drobuň razrýadlaryň sany ölçeýşiň takyklygynyň 

sanawynda saýlaýyş bilen kesgitlenýär;  

o Fractional (Дробный) — ölçegiň bahasy garyşyk natural drob 

görnüşinde görkezilýär, onuň drob böleginiň maýdalawjysy ölçeýişiň 

takyklygynyň sanawynda saýlaýyş bilen kesgitlenýär;  

o US Engineering (Инженерный) we US Architecture 

(Архитектурный) — ABŞ standartlary.  

 Dimension Precision (Точность измерений). Bu sanawyň bahalary ölçegiň 

ähmiýetini ölçeg ýazgysynda takyklygyny dolandyrýar.  

 Dimension Units (Единицы измерения). Bu açylýan sanaw ölçeg birlikleri 

saýlamagy we olaryň görkezimegini saýlamagy mümkin edýär.  

 Тext Position (Положение текста). Ölçeg ýazgysynyň ýerleşişini 

kesgitleýän düwmejikleri saklaýan panel.  

 
 

 Dynamic Dimensioning (Динамическая привязка). Ölçeg ýazgyny 

döretmegiň düzgünini dolandyrýan düwmejik. Ol basylan ýagdaýda bolsa, 

obýektiň ölçegi her gezek üýtgedilse ölçeg ýazgysy täzeden döredilýär. 

Ýogsam ölçeg ýazgysy ölçeg ülňisi döredilende bir gezek döredilýär.  

 Suffix for Dimension (Суффикс размера). Ölçeg sanyň soňundan teksti 

goşmagy mümkin edýän meýdan.  

 Prefix for Dimension (Префикс размера). Ölçeg sanyň öňünden teksti 

goşmagy mümkin edýän meýdan;  

 Show Units for Dimension (Показывать единицы измерения): Ölçeg 

ýazgynyň düzümine ölçeg birlikleri goşmagy dolandyrýan düwmejik. 

Ölçegleri goýmak 

1. Sahypada dogry altyburçlugy guruň. Atributlar panelini ulanmak bilen 

onuň dik ölçegini 50 mm deň ediň.  

2. Gurallar toplumynda Dimension (Размерные линии) guraly saýlamaly 

we atributlar panelinde kese ölçegiň düwmejigine basyň. Kese ölçeg ülňiniň 

gurmagyny atributlar panelinde dolandyryjy parametrleri bermekden başlalyň. 

Ölçegiň görnüşini Decimal (Десятичный) ediň, ölçeg birlikleri hökmünde 

millimetrleri saýlaň we ölçeg ýazgysyna oalryň ýazylmagyny gadagan ediň. 

Görkezmegiň takyklygyny oturdan soň iki razrýada deň ediň. Guralyň görkezijisini 

Ölçeg çyzygyň üstünden 

Ölçeg çyzygyň üzülmesine 

Ölçeg çyzygyň aşagyndan 

Hemişe kese boýunça 

Ýazgyny merkezleşdirme 
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altyburçlugyň çepki aşaky burçuna getiriň we birleşiş nokady reňkli marker bilen 

bellenilenden soň syçanjygyň düwmejigine basyň (aşaky surat a.)  

 
3. Guralyň görkezijisini altyburçlugyň sagdaky aşaky burçuna getiriň we 

ýokarky ýaly çykaryş çyzygyň ikinji nokadyny berkidiň (ýokarky surat b.).  

4. Guralyň görkezijisini aşak süýşüriň, onuň bilen bile ölçeg çyzygy hem 

süýşer we çykaryş çyzyklar uzalar. Indi bolsa ölçeg ýazgynyň ýerleşişini 

kesgitleýän göniburçluk ortada durar ýaly görkezijini çepe süýşüriň we ýene 

syçanjygyň düwmejigine basyň. 

5. Pick (Выбор) guraly saýlaň we altyburçluga basyň. Ölçeg ülňisi 

birleşdirilenden soň obýek dolandyrylýan bolup galdy, ýagny onuň üýtgedilmegi 

oňa birleşdirilen obýektleriň awtomatiki üýtgemegine getirýär. Eger ölçeg 

ýazgysna basylsa ol aýratyn belleniler we onyölçeg ülňisiniň çäginde islendik 

ýerde goýmak bolýar, beýleki obýektler hem şoňa görä üýtgeýär. Altyburçluk oňa 

birleşdirilen hemme ölçeg ülňiler üçin dolandyryjy obýejt bolsa, ölçeg ýazgysy 

diňe özüne degişli ölçeg ülňi üçin dolandyryjy obýekt bolup durýar. 

6. Edil şolar ýaly eňňitli we dik ölçeg ülňileri çyzylýar. 

7. Burç ölçegi üçin ölçeg ülňisini çyzalyň. Birinji nokady bellemzden öň 

ölçeg ýazgyny goşulmasyny (suffiksi) girizežiň – gradusyň belgisini. Munuň üçin 

atributlar paneliniň degişli ýerine kursory goýalyň, kömekçi klawiaturany Num 

Lock klawişasy arkaly sanlaryň giriziliş ýagdaýyna geçireliň we Alt klawişasyny 

basyp ondan gradus belginiň 0176 koduny ýazalyň. Soňra ölçegiň bahasyny 

görkezmegiň takyklygyny drobly razrýadsyz edip goýalyň. Ölçeg ülňisi ondan 

öňkilere meňzeş çyzylýar, ema bir goşmaça bilen: çykaryş çyzyklaryň birleşme 

nokatlaryny kesgitlemezden öň (aşaky surat b we ç) syçanjyk bilen basmak arkaly 

burç ölçegiň merkezini bellemek gerek — çykaryş çyzyklaryň kesişýän nokadyny 

(aşaky surat а). Eger ölçeg ülňisi doly obýekt bilen baglaşdyrylan bolsa bu 

birleşme nokady bolmaly  

 
 

 Eger ölçeg ülňisi ýalňyş çyzylan bolsa we ony ýok etmeklik gerek bolsa ony 

Pick (Выбор) guraly saýlaň, munuň üçin dolandyryjy teksti saýlamaklyk hem 

a b ç d 

a b 

ç d 
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ýeterlik we Del klawişasyna basyň. Ölçenilýän obýekt ýok edilse, onuň bilen 

bilelikde ölçeg ülňisi hem ýok ediler. 

 
  

Eger ölçeg ülňisi gurulanda çykaryş çyzyklar obýektiň birleşme nokatlaryna 

birleşilmän bolsa onda obýekt üýtgedilende üýtgemez we obýekt ýok edilende ýok 

edilmeýär.  

8. Gurulan ülňilere üýtgetme giriziň. Hemme ütgetmeler Pick (Выбор) 

guraly bilen amala aşyrylýar. 

Çykaryş çyzyklar 

Çykaryş çyzyklar aýratyn topary düzýän düzümli obýekt bolup durýar. Olar 

iki segmentden ybarat, özem ikinji segmentiň ahyry çykaryjynyň ýazgysyna 

birleşdirilen. Ýazgy çykaryjylaryň toparynyň dolandyryjy obýekti bolup durýar. 

Ýazgynyň üýtgedilmegi çykaryjynyň ikinji segmentiniň uzynlygyna we 

ýerleşmegine täsir edýär, şonda birinji segment üýtgedilmän galýar. Ýazgynyň 

uzynlygynyň üýtgedilmegi çykaryjynyň segmentlerine täsir etmeýär. Obýekt 

süýşürilende hem oňa birleşdirilen çykaryjy hem bile süýşýär.  

Çykaryjyny çyzmagyň düzgüni Dimension (Размерная линия) guraly 

saýlanylandan we şol guralyň atributlar panelinde çykaryjynyň düwmejigine 

basylandan soň 4 amaldan ybarat.  

1. Birinji syçanjyk bilen basma birinji segmentiň başyny belleýär. Eger ol obýekte 

birleşme nokadynda ýerine ýetirilse çykaryjy obýekte birleşýär, ýogsam ol onuň 

bilen bagly bolmaýar.  

2. Ikinji syçanjyk bilen basma birinji segmentiň ahyryny we ikinji segmentiň 

başyny aňladýar. Eger ikinji segment gerek däl bolsa, onuň üçin nola deň bolan 

uzynlyk bellenilýär, şonuň üçin ikinji gezek syçanjyk bilen iki gezek basýarlar.  

3. Üçünji syçanjyk bilen basma ikinji segmentiň ahyryny we çykaryjynyň 

ýazgysynyň başlanýan ýerini aňladýar.  

Segmentleriň ugry kesgitlenende Ctrl klawişa-modifikatordan peýdalanmak 

amatly.  

4. Üçünji (ýa-da ikinji) syçanjyk bilen basmadan soň ýazgynyň girizme 

düzgüni işläp başlaýar.  

Ýazgynyň tekstini girizmegi tamamlamak üçin gurallar toplumynda Pick 

(Выбор) saýlamak ýeterlik.  
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Birleşdiriji çyzyklar 

Birleşdiriji çyzyklar çyzykly obýektleriň aýratyn toparyny düzýär, olar dürli 

ülňi şekilleri, aýratynlykda hem blok-shemalary çyzmak üçin örän amatly gural 

bolup durýar. Standart figuralar bilen utgaşykda Interactive Connector Tool 

(Соединительная линия) guraly olar bilen işlenende goşmaça amatlyklary 

hödürleýär.  

Birleşdiriji çyzygyň iki ujy hem obýekte birleşme nokatlarynda 

birleşmelidir. Çyzylandan soň birleşdiriji çyzygy birleşme nokatlaryny birleşdirýär. 

Birleşmegiň iki warianty bardyr: birleşdirilen obýektleriň özara ýerleşişine 

garamazdan berk kese ýa-da berk dik göniçyzykly segmentlerden ybarat bolan 

döwülen çyzyk (döwülen birleşdiriji çyzyk) we göni çyzygyň kesimi (göni 

birleşdiriji çyzyk) bilen. Wariantyň saýlanylmagy guralyň atributlar panelinde 

ýerleşen Angled connector (Ломаная соединительная линия) we Straight 

connector (Прямая соединительная линия) düwmejikleri arkaly amala aşyrylýar. 

Birleşdiriji çyzygyň gurulmagy Interactive Connector Line 

(Соединительная линия) gural saýlanylandan soň iki amal arkaly amal aşyrylýar.  

 

 
1. Iki obýektiň birine birleşdiriji çyzygyň berleşýän nokadyny syçanjyk bilen 

basmak arkaly bellemeli.  

2. Ikinji obýekte birleşdiriji çyzygyň birleşýän nokadyny syçanjyk bilen 

basma arkaly bellemeli.  

Birleşdiriji çyzyk gurulandan soň onuň aýry segmentlerini Interactive 

Connector Line (Соединительная линия) guraly arkaly süýşürmek mümkin. 

Birleşme çyzygyň birleşýän iki obýekti onuň üçin dolandyryjy bolup durýar.  

Birleşdiriji çyzyklary gurmak 

Ilkibaşda göniburçluk bilen ellipsi çyzyň soňra bolsa olary birleşdiriji 

çyzyklaryň ikisi bilen baglaşdyryň, özem olary birleşme nokatlaryň iki aýry jübüdi 

bilen birleşdiriň. Ikinji birleşdiriji çyzygy döretmezden öň birleşdiriji çyzygyň 

görnüşini üýtgetmeli. Soňra Pick (Выбор) guraly arkaly dolandyryjy obýektleriň 

birini saýlamaly we ony ikinjiň daşyndan süýşürip duruň.  

Aýry ýagdaýlarda birleşdiriji çyzyk obýekte diňe bir ujy bilen birleşdirilip 

bilner. Şonda ikinji ujy sahypa birleşdirilen diýlip hasaplanylýar. Obýekte 

birleşdirilen birleşdiriji çyzygyň ujuny soňra aýryp bolýar, aýrylany bolsa 

Düwün 

Halkajyň ahyrky 

nokady 

Halkajyň 

başy 

Birleşdiriji çyzyk 
Birleşdiriji çyzygyň düwüni 

Interactive Connector Line 

guralyň görkezijisi 
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birleşdirip bolýar. Döwülen birleşdiriji çyzygyň segmentiniň ortasynda birleşme 

nokady ýerleşýär şol sebäpli döwülen birleşdiriji çyzyga beýleki birleşdiriji çyzygy 

birleşdirmek mümkin. 
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WEKTOR GRAFİKASY WE AUTOCAD PROGRAMMASY 

 

AutoCAD ulgamynyň ilkinji wersiýalary Autodesk amerikan kompaniýasy 

tarapyndan eýýam 20-nji asyryň 80-nji ýyllaryň başlarynda çykarylyp başlandy 

hem-de başdan original çözgüdi we ulanyjy üçin amatlylyk bilen özüne ünsi çekdi. 

Ulgamyň hemişe ösmegi, webellikleriň hasaba alynmagy beýleki öňdebaryjy 

firmalaryň önümleri bilen utgaşykda bolmagy AutoCAD programmasyny dünýä 

belli etdi. 

AutoCAD programmasynyň surat çekiş serişdesi hökmünde uly 

artykmaçlygy hökmünde çyzgylaryň geljekki arhiwiniň döredilmeginiň 

mümkinçiligi bolup durýar. Şeýle döredilen suratlaryň her biri redaktirlenýär.  

 

Goranyş gurallaryň biri hökmünde parollar we elektron sanly gollar göz 

öňünde tutulan. Ekranyň merkezi bölegi – esasy iş zolagy, onda suratyň esasy 

görünýän bölegi ýerleşýär, onuň beýleki bölekleri sagda, çepde, ýokarda, aşakda, 

olara kursoryň üsti bilen çykyp bolýar. Kursor iki göni kesişýän çyzyklaryň we 

olaryň ortasynda kiçi gönüburçlyga eýe bolan görnüşe eýedir. Kesişýän çyzyklaryň 

uzynlygy CURSORSIZE üýtgeýän arklay üýtgedilip bilner.Grafiki ekranyň aşaky 

burçunda koordinatalaryň oky ýerleşýär. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 – Menýu setiri, 2- gurallar paneli, 3- Tool Palletes, 4 – koordinat okunyň 

piktogrammasy, 5 – goşmalaryň sanawyny görkezmegiň düwmejikleri, 6 – 

modeliň giňişliginiň goşulmasy, 7 – listleriň goşulmasy, 8 – koordinatalaryň 
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hasaplaýjysy bilen ýagdaý setiri, 9 – düzgünleriň düwmejikleri, Communication 

Center, 11 – buýruk setirleriň zolagy, 12 – kursor, 13 – geçiriş çyzgyçlar, 14- 

resminamanyň penjirelerini dolandyrýan düwmejikler. 

 

Ekranyň ýokarky bölegini - File (Файл), Edit (Правка), View (Вид), Insert 

(Вставка), Format (Формат), Tools (Сервис), Draw (Рисование), Dimension 

(Размеры), Modify (Редакт), Express (Экспресс), Window (Окно), Help 

(Справка) ýazgylardan durany – menýu setiri diýip atlandyrarys. 

Grafiki ekrany aşakdan Model , Layout1, Layout2 goşulmalaryň 

düwmejikleri çäklendirýär. Goşulmalar modeliň we listleriň arasynda geçirilişde 

ulanylýar. Deslapdan aktiw bolup model goşulmasy durýar. 

Ekranyň aşaky böleginde Command ýazgy bilen çagyryş bar – bu ulanyjy 

bilen ulgama arasyndaky gepleşik geçirilýän töwerek, bu ýerde ulanyjy tarapyndan 

girizilýän buýruklar we jogaplar görkezilýär. Bu bölek buýruk setirleriň zolagy 

diýlip atlandyrylýar. Command ýazgyny saklaýan soňky ýazgy buýruk setiri diýlip 

atlandyrylýar. 

Buýruk setirleriň zolagynyň aşagynda ýagdaý setiri ýerleşen, onda koordinat 

hasaplaýjysy we düzgünleriň düwmejikleri SNAP (ШАГ), GRID (СЕТКА), 

ORTHO (OPTO), POLAR (OTC-ПОЛЯР), OSNAP (ПРИВЯЗКА), OTRACK 

(ОТС-ПРИВ), LWT (ВЕС), MODEL (МОДЕЛЬ) ýerleşdirilen. Koordinat 

hasaplaýjysy çyzgynyň meýdanynda ugrukdyrmak üçin gulluk edýär – ol öz 

koordinata ölçegini  syçanjyk grafiki ekranda hereket edende üýtgedýär. 

Hasaplaýjy F6 funksional düwmejigi arkaly ýa-da syçanjygyň çep düwmejigine 

kursory şonuň setirine getirip öçürip we ýakyp bolýar. 

Communication Center düwmejigi  Internet bilen baglanyşyk bolanda 

AutoCAD programmanyň üýtgetmeleri ýa-da täzelenmeleri barada habar berýär. 

6 sany panel bellenilen ýagdaýda ýerleşen. Gereke bolanda olaryň 

ýagdaýlaryny üýtgdip bolýar we grafiki ekranyň içine geçirilende olar “ýüzýän” 

oruna eýe bolarlar. Ýüzýän ýagdaýda olar dürli görnüşe eýe bolup biler. Paneli 

geçirmek üçin syçanjyk bilen onuň gök reňkli töweregine basyp geçirmeli. 

Menýu setiriniň aşagynda 4 sany panel görünýär: Standard (Стандартная) 

(ýokardan birinji setirde), Layers (Слои) и Styles (Стили) (ýokardan ikinji setirde) 

и Properties (Свойства) (ýokardan üçünji setirde). Bu panelleri elllemek, geçirmek 

we aýyrmak gerek däl, sebäbi olar hemişe işde gerek bolýar. Dikligine ýerleşen iki 

panel degişlikde Draw (Рисование) и Modify (Редактирование) diýlip 

atlandyrylýar. 

Panelleri çykarmak we aýyrmak üçin ýörite serişdeler bar. Kursory View 

(Вид) menýu getiriň we syçanyň sag düwmejigine basyň. Soňra Toolbars 

(Панели) setiri  saýlaň. Açylan Customize (Адаптация) dialog penjiresinde 

dikligine hemme bar bolan panelleriň sanawy görkezilýär. Şolaryň gapdalynda 

baýdagy barlar grafiki ekranda görünýär. 

Eger ekrana diňe bir paneli çykarmaly ýa-da aýyrmaly bolsa, onda kontekst 

menýudan peýdalanmaly. Kontekst menýu syçanjygyň sag düwmejigi bilen 

çagyrylýar. Syçanyň görkezijisini haýsy-da bolsa bir gurallar paneliň ýanyna 
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getiriň we syçanjygyň sag düwmejigini basyň. Şol ýerde paneller bilen işleýän 

kontekst menýusy emele geler. 

AutoCAD ulgamynda ulanyjy interfeýsiň täze parçasy bolup Tool Palettes 

(Палитры инструментов) gurallar palitrasynyň paneli bolup durýar. Bu paneliň 

çykarylmagy we aýrylmagy Ctrl + 3 düwmejikleriň basylmagy arkaly bolýar. 

Dolandyrmagyň ýene bir gyzykly elementleriniň biri bolup View (Вид) 

menýuda Clean Screen bendi bolup durýar. Ol Ctrl + 0 düwmejigi arkaly ýa-da 

Command: setirinde CLEANSCREENON we CLEANSCREENOFF buýruklar 

bilen goýulýar ýa-da aýrylýar. Ol grafiki ekrany wagtlaýynça panelleri, penjiräniň 

adyny we b. aýyrmak arkaly ulaldýar. 

AutoCAD ulgamy ulanyjy bilen interaktiw işlemek üçin döredilen. 

Ulanyjynyň ulgam bilen gepleşigi buýruklaryň dilinde alnyp barylýar. Buýruklary 

girizmegiň iň aňsat usuly olary  buýruk setirinde girizmeklikdir. 

LINE (ОТРЕЗОК) buýrugy aşakda görkezilen islendik görnüşinde 

klawiatura arkaly girizilip bilner. 

 LINE 

 Line  

 line 

 liNE 

Buýruk ýazylandan soň Enter düwmejigi basmagy ýatdan çykarmaly däl, sebäbi ol 

AutoCAD ulgamy üçin şol buýrugy işläp başlamaklyk boýunça görkezme bolup 

durýar. Enter düwmejigi basylmaka Siz buýruk setirinde ýazylan ýazgyny 

Delete, BackSpace düwmejikleri bilen üýtgedip bilersiňiz. 

Buýruklary girizmegiň beýleki usuly hökmünde menýunyň degişli bentlerini 

we panelleriň düwmejiklerini saýlamak bolup durýar.  

Commanda: setirde boş Enter basaňyzda AutoCAD ondan öňki buýrugy 

ýerine ýetirer. 

Öz işini başlan islendik buýrugyň işini bes etmek üçin ESC düwmejigini 

basmaly. 

AutoCAD ulgamynyň çyzgylary (suratlary) dwg giňişligi bolan faýllarda (şu 

faýllarda grafiki maglumat ýazylýan formada DWG-format diýilýär). saklanylýar. 

Faýllaryň atlary rus we latin harplaryny, sanlary, (@, #, $, &, _, -) ýörite belgileri, 

şeýle hem probelleri saklap bilýär. Beýleki simwollara (nokatlar, oturlar we ş.m.), 

kada bolşy ýaly, ýol berilmeýär, sebäbi olar gulluk simwollary bolup durýar we 

Windows operasion ulgamy tarapyndan nädogry interpretasiýa edilip bilner. 

«Файл» menýusy 

 New (Новый) 

 Open (Открыть) 

 Close (Закрыть) 

 Partial Load (Частичная загрузка) 

 Save (Сохранить) 

 Save As (Сохранить как) 

 eTransmit (Сформировать комплект) 

 Publish to Web (Публикация в Интернете) 

 Export (Экспорт) 
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 Page Setup (Параметры листа) 

 Plotter Manager (Диспетчер плоттеров) 

 Plot Style Manager (Диспетчер стилей печати) 

 Plot Preview (Предварительный просмотр) 

 Plot (Печать) 

 Publish (Публикация) 

 Drawing Utilities (Утилиты) 

 Send (Переслать) 

 Drawing Properties (Свойства рисунка) 

 Exit (Выход) 

 

«Open» podmenýusy 

Open (redaktirlemegiň doly mümkinçiligi bilen açmaklyk);  

Open Read-Only (Diňe okamak düzgünde açmaklyk);  

Partial Open (Bölekleýin açmaklyk); 

Partial Open Read-Only (Diňe okamak düzgünde bölekleýin açmaklyk). 

Bölekleýin açyş düzgüni  tutuş suraty açman , eýsem diňe onuň bölegini 

açmagy mümkin edýär. Bu uly ölçegli faýllar bolanda amatly. Eger bu düzgüni 

saýlan bolsaňyz Select File (Выбор файла) penjiresinde Size Partial Open 

(Частичное открытие) dialog penjiresi hödürlener. Saýlanyş gatlaklar boýunça (в 

Layer geometry to load (Загрузка объектов по слоям) töwereginiň sanawynda) 

we görnüşler (View geometry to load (Загрузка объектов по видам) töweregiň 

sanawynda) amala aşyrylyp bilner. Bölekleýin açyş şeýle hem PARTIALOPEN 

(ОТКРЧАСТЬ) buýrugy arkaly hem ýerine ýetirilip bilner. 

Ulgam bilen bilelikde ulgamyň gurnalan ýeriniň Sample bukjasynyň içinde 

(X:/AutoCAD2004/Sample) gyzykly mysallar getirilen. 

AutoCad 2004 köp resminama düzgüni goldaýar, şol sebäpli bir işiň 

dowamynda birnäçe surat açylyp bilner. 

Window düşüp açylýan menýusy 

 Close (Закрыть); 

 Close All (Закрыть все); 

 Cascade (Каскадом); 

 Tile Horizontally (Слева направо); 

 Tile Vertically (Сверху вниз); 

 Arrange Icons (Упорядочить значки). 

Menýunyň birinji bendi aktiw suraty ýapýar, ikinjisi – hemme suratlary 

ýapýar. Bu bentlere CLOSE (ЗАКРЫТЬ) и CLOSEALL (ЗАКРЫТЬВСЕ) 

buýruklar degişli. 

File (Файл) düşüp açylýan menýunyň Save (Сохранить) bendi we oňa 

laýyk gelýän QSAVE (БСОХРАНИТЬ)) şol bir atly suraty tiz ýatda saklamaga 

mümkinçilik berýär. Eger ony başga faýla ýazgy etjek bolsaňyz onda Save As 

(Сохранить как) bendi ýa-da SAVEAS (СОХРАНИТЬКАК) buýrugy ulanmak 

gerek. 

Files of type (Тип файла) açylýan sanaw arkaly suraty AutoCAD 2004 

DWG-formatynda, ýa-da AutoCAD 2000 DWG-formatynda, ýa-da ulgamyň 
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şablonlary tarapyndan ulanylýan DWT-formatda, şeýle hem standartlaryň 

faýllarynda ulanylýan DWS formatda, ýa-da awtomatlaşdyrylan taslamaklygyň 

dürli ulgamlaryň arasynda grafiki faýllary geçirilende ulanylýan DXF-formatda 

ýatda saklamak mümkinçiligi bar. 

Täze suratlar döredilende AutoCAD ulgamy olara: Drawingl, Drawing2 we 

b. şertli atlary berýär. Ulanyjy geljekde olary üýtgedip öz atlaryny berip biler. 

Export (Экспорт) bendi we EXPORT (ЭКСПОРТ) buýrugy AutoCAD 

suratynyň garfiki maglumatyny beýleki grafiki toplumlaryň ýörite formatlaryny 

özgerdip bilýär. 

Biziň seredilýän wersiýamyzda şu formatlara eksport edip bolar: WMF, 

SAT, STL, EPS, DXX, BMP, 3DS. 

eTransmit (Сформировать комплект) bendi suratlaryň toparyny we olar 

bilen bagly kömekçi faýllary (şriftleri, çyzyklaryň kysymyny we ş.m.) beýleki 

guramalar we firmalara bermek üçin niýetlenen, Publish to Web (Публикация в 

Интернете) bendi bolsa — olary saýtlaryň sahypasynda ýerleşdirmek üçin. 

Elketron poçtasy ulanylanda goşulma hökmünde suraty bermek üçin Send 

(Переслать) bendinden peýdalanmak bolar. 

Page Setup (Настройка страницы), Plotter Manager (Диспетчер 

плоттеров), Plot Style Manager (Диспетчер стилей печати), Plot Preview 

(Просмотр) и Plot (Печать) bentleri sazlamaýyşy geçirmek, şeýle hem çap etmek 

üçin niýetlenen. 

Publish (Публикация) bendi suratlary ýene bir formada — DWF formada 

ýerleşdimegi mümkin edýär, ol Autodesk tarapyndan düzülen we Internetde 

ýerleşdirmek üçin gönükdirilen. 

Eger grafiki ekranda bolup klawiaturada F2 düwmejige bassaňyz, ekranda 

AutoCAD Text Window (Текстовое окно AutoCAD) penjiresi emele geler, ony 

aýyrmak üçin ýene F2 düwmejigi basmaly. 

 

Primitiwler blen işlemek 
 

Kesimler, ýarym halkalar, tegelekler we beýleki grafiki obýektler islendik 

çyzgy faýly döredýän elementler bolup durýar. AutoCAD ulgamynda olar 

primitiwler adyny göterýärler.  

Primitiwler ýönekeý we çylşyrymly bolup durýar. Ýönekeý primitiwlere 

nokat, kesim, tegelek, ýarym halka, göni çyzyk, şöhle, ellips, splaýn, bir setirli 

tekst. Çylşyrymly primitiwlere poli çyzyk, multi çyzyk, multi tekst (köp setirli 

tekst), ölçeg, wynoska, ygtyýar, ştrihleme, bloguň ýa-da daşky salgylanmanyň 

girmegi, atribut, rastr şekili girýär. Mundan başga hem giňişlik primitiwler bar. 

Primitiwleri gurmak amallarynyň köpüsi Draw (Рисование) guralla 

paneliniň düwmejikleri arkaly ýerine ýetirilip bilner. 

Kesim 

Buýruk setirinde Line diýip ýazalyň we Enter düwmejigini basalyň. Bu 

buýrugy şeýle hem Draw (Рисование) menýusynda Line (Отрезок) bendi ýa-da 

Draw (Рисование) gurallar paneli bilen çagyryp bolýar. 

Ilkinji sorag: 
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Specify first point: (Первая точка:) 

Eger buýrugy ýerine ýetirmejek bolsaňyz onda ESC düwmejigi basyň, 

programmada islendik buýruk ýa-da amal şu düwmejik bilen kesilýär. 

Kesimiň birinji nokadyny bellemegiň iň ýönekeý usulu – syçanjyk bilen 

ekranda bellemek we onuň çep düwmejigini basmak. Mundan başga hem onuň 

koordinat ulgamyna (0,0) baglylykda onuň koordinatalaryny (x,y) girizmek. 

Birinji nokat görkezilenden soň AutoCAD выводитnobatdaky sorag berýär:  

Specify next point or [Undo]: (Следующая точка или [Отменить]:) 

Soragyň bir bölegi inedördül ýaýyň içine girizilen. Bu soňky nokady 

görkezmegi ýa-da başga bir opsiýany ulanmagy aňladýar. Opsiýa hökmünde 

AutoCAD Undo (Отменить) hödürleýär. Ol oň girizilen başlangyç nokady 

goýmak buýrugy ýatyrýar. Opsiýany ulanmak üçin onuň adyny doly ýa-da uly 

harpyny ýazmaly we Enter basmaly. 

Eger Siz ekranda syçanjyk bilen nobatdaky nokady görkezseňiz ekranda 

kesim emele geler. LINE (ОТРЕЗОК) buýrugy şunuň bilen tamamlanmaz we şu 

sorag beriler:  

Specify next point or [Undo]: (Следующая точка или [Отменить}:)  

Ýagny bir buýruk bilen nobat boýunça birnäçe kesimleri gurup bolýar, netijede 

ekranda döwülen çyzygy emele getirip bolýar. Ekranda 3-nji nokady görkeziň, 

netije nobatdaky sorag şular ýaly bolar:  

Specify next point or [Close/Undo]: (Следующая точка или 

[Замкнуть/Отменить]:)  

Bu ýerde Close (Замкнуть) opsiýasy emele geldi.. Eger birnäçe opsiýadan 

saýlama bolsa, olar "/" simwol bilen aýry edilýärler. Klawiatura bilen С ýazsaňyz 

we Enter bassaňyz AutoCAD öňki kesimiň ikinji nokadyndan başlanýan we soňy 

birinji kesimiň başyna barýan kesimi çyzar. Eger kesimleriň ýapylmagy gerek däl 

bolsa, onda Enter düwmejigine basyň. 

Başga bir usul bu syçanjygy grafiki ekranyň içine salyp sag düwmejigini 

basyp kontekst menýuny çagyrmaklyk. Bu ýerde hem buýruk setirindäki opsiýalar 

görkezilen. 

Eger Enter ikinji nokat görkezilmän basylsa, onda kesim çyzylman galar. 

Eger Enter birinji nokat görkezilmän basylsa, onda kesim öň iň soňky çyzylan 

çyzygyň, ýarym halkanyň ýa-da poli çyzgyň soňky nokadyndan çyzylyp başlanar. 

Eger buýruk setirinde buýruk bolmazdan Enter boş basylsa, onda öň ýerine 

ýetirilen buýruk ýerine ýetiriler. 

Islendik çyzylan kesim boýunça buýruk setirinde LIST buýrugy goýberilip 

maglumat alyp bolar. 

Geliň indi koordinatlary girizmegiň usullary bilen tanyşalyň. 

Birinji usul syçanjyk bilen bellemek. 

Ikinji (x, y) koordinatalary buýruk setirinde otur bilen aýry edip ýazmak, 

meselem 50.34, 56. 

Üçünji usul @ belgini ulanyp ýazmaklyk. Bu belgi häzirki nokady ondan 

öňküsinden x koordinata boýunça 50 mm we y koordinatasy boýunça 25mm 

süýşürilip çyzylar. 
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Dördünji usul bu öňki nokada görä belli bir burç bilen kesgitli aralykda 

gurnamakluk, meselem @33.5<45. Bu öňki nokatdan 33mm aralyk bilen 450 burç 

boýunça gurulan nokady çyzýar. 

Bäşinji usul bu obýekt baglaşdyrma funksiýalaryny görkezemek arkaly. Bu 

funksiýalara Object Snap (Объектная привязка) panel arkaly ýa-da şol bir 

wagtda Shift düwmejigini basyp syjanjygyň sag düwmejigine basmak bilen 

kontekst menýuny çykarmak arkaly çykmak mümkin. 

 
 

Object Snap paneli 

 — aralykdaky nokady ulanmak bilen yzarlaýyş;  

 — başga (kömekçi) nokatdan süýşme;  

 — ahyrky nokat;  

 — ortalyk nokat;  

 — iki obýektiň ýa-da olaryň dowamlylygynyň kesişme nokady;  

 — iki obýektiň ýa-da olaryň dowamlygynyň hyýaly kesişmesiniň nokady 

(ýagny obýektleriň tekizlige bolan proýeksiýalary kesişýär);  

 — domam nokady;  

 — ýarym halkaň, tegelegiň ýa-da ellipsiň merkezi;  

 — ýarym halkaň, tegelegiň ýa-da ellipsiň kwadrantlaryň nokady (0°, 90°, 

180° we 270° ýerleşen nokatlar);  

 — galtaşma nokady;  

 — obýekte perpendikulýar ýagdaýda;  

 — obýekte parallel ýagdaýda;  

 — teksti, blogy, daşky salgylanmagy goýmagyň nokady;  

 — düwün nokady;  

 — obýekte iň golaý nokady;  

 — obýekt baglaşdyrmagy ulanmazdan;  

 — baglaşdyrmagyň hemişelik düzgünlerini sazlamak. 

Düzgünler 
 

Buýruk setiriň zolagynyň aşagynda göniburç düzgünli düwmejikler bar: 

SNAP (ПРИВ), GRID (СЕТКА), ORTHO (OPTO), POLAR (ПОЛЯРНЫЙ), 

OSNAP (О-КАДР), OTRACK, LWT (ВЕС), MODEL (МОДЕЛЬ). Eger 

syçanjyk bilen şol düwmejigiň üstünden geçilse onda gysgaça düşündiriş 

görkeziler: Snap Mode (Шаговая привязка), Grid Display (Отображение 

сетки), Ortho Mode (Режим "Орто"), Polar Tracking (Полярное 
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отслеживание), Object Snap (Объектная привязка), Object Snap Tracking 

(Объектное отслеживание), Show/Hide Lineweight (Отображение линий в 

соответствии с весами), Model or Paper Space (Пространство модели или 

листа). 

SNAP (ПРИВ) kesgitlenen sazlanylýan ädim bilen toruň nokatlaryna bolan 

baglaşdyryş düzgüni işledýär we aýyrýar (hereketlendiriş berlen ädim bilen amala 

aşyrylýar ýa-da burç baglaşdyrma (kesgitlenen burçlaryň ýanynda hereketlendiriş 

segmentler boýunça berlen ädim bilen amala aşyrylýar). SNAP (ПРИВ) 

düwmejigiň roluny <F9> klawiaturanyň F9 düwmejigi ýerine ýetirýär. 

GRID (СЕТКА) düwmejigi sazlanylýan ädimli görkezilýän tory goýmagy 

we aýyrmagy amala aşyrýar. Bu tor SNAP (ПРИВ) düzgüninde ulanylýan tordan 

tapawutly bolup biler. Analogy hökmünde F7 düwmejigi bolup durýar. 

 ORTHO (ОРТО) düwmejigi ortogonallyk düzgüni işledýär ýa-da aýyrýar 

Bu düzgün işlände kesimleriň göni çyzyklaryny göni keselik ýa-da diklik boýunça 

gurulýar. Işletmek üçin şeýle hem F8 düwmejigi ulanmak bolar. 

POLAR (ПОЛЯРНЫЙ) düwmejigi ORTHO (ОРТО) düzgüniň belli bir 

sazlanylýan ädim bilen burçlara bolan giňelmesi hökmünde çykyş edýär. 

Düwmejik polýar yzarlamanyň düzgünini işledýär ýa-da öçürýär. Düwmejigiň 

analogy bolup F10 düwmejigi bolup durýar. POLAR düzgüni işledilende 

ORTHO awtomatiki öçürilýär, eger öň işledilen bolsa we tersine. 

OSNAP (О-КАДР) düwmejigi obýekt baglaşdyrmagyň funksiýalarynyň 

hemişelik işleýş düzgünini işletmegi we aýyrmagy amala aşyrýar. Düwmejigi 

analogy hökmünde F3 klawişasy bolup durýar. 

OTRACK düwmejigi bilen obýekt yzarlaýyşyň düzgüni işledilende 

AutoCAD ulgamy obýekt baglaşdyrmagy ulanmak arkaly aralyk nokatdan polýar 

yzarlamagy ulanmagy mümkin edýär Düwmejigiň analogy hökmünde F11 

klawişasy bolup durýar. 

LWT (ВЕС) düwmejigi çyzgynyň elementleriniň galyňlygyny 

görkezilmegini ýa-da görkezilmezligini belleýär. 

MODEL (МОДЕЛЬ) düwmejigi modeliň ýa-da listiň giňişligiň arasynda 

geçmegi amala aşyrýar. 

Düzgünleriň sazlanmagy DSETTINGS (РЕЖИМРИС) buýruk bilen amala 

aşyrylyp bilner, ol Drafting Settings (Режимы рисования) gepleşik penjiresini 

açýar. Buýruk Tools (Сервис) menýusynyň Drafting Settings (Режимы 

рисования) bendi bilen hem, şeýle hem syçanjyk bilen ORTHO (OPTO), LWT 

(ВЕС), MODEL (МОДЕЛЬ)) düzgünleriň düwmejiklerinden başga düzgün 

düwmejikleriň üstünde getirilip sag düwmejigi basyp çagyrylýan kontekst 

menýunyň Settings (Настройка) bendi bilen ýerine ýetirilip bilner. 

 

Nokat 

 

Nokat gurmak üçin POINT (ТОЧКА) buýrugy ulanylýar, mundan başga 

hem ol Draw (Рисование) panelinden çagyrylyp bilner  düwmejigi arkaly ýa-

da из падающего меню, если применить команду Draw | Point | Single Point 

(Рисование | Точка Одиночная) gepleşik penjireden. 
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POINT (ТОЧКА) buýrugy Draw (Рисование) panelinden çagyrylanda 

gaýtalanyş bilen işleýär, we şu soragy berýär: 

Current point modes: PDMODE = 0 PDSIZE = 0.0000 Specify a point: 

(Текущиережимы точек: PDMODE = 0 PDSIZE = 0.0000 Укажите точку:)  

 Syçanjyk arkaly ýa-da kursor bilen nokadyň koordinatlaryny giriziň. 

Görkezilen ýerde nokat emele gelýär. Mundan beýläk programma ýene ýokarky 

soragy berýär, eger buýrugy kesmeli bolsa Esc düwmejigi basmaly. Eger ulgam 

üýtgeýänler PDMODE = 0 we PDSIZE = 0 bolsa, onda nokat bir piksel bilen 

görkezilýär. Format (Формат) menýunyň Point Style (Отображение точек) 

bendi bilen Point Style (Отображение точек) gepleşik penjiresini çagyryp, 

nokadyň zerur şekilini saýlamaly, köplenç "х" görnüşde ündelýär. Şol penjirede 

hem nokadyň ölçeglerini belläp bolýar (Point Size (Размер точки) meýdany), 

sazlamalary geçirip penjiräni ýapyň, AutoCAD ulgamy awtomatiki hemme öň 

çyzylan nokatlary täze görnüşe getirer. Nokatlar Node (Узел) obýekt 

baglaşdyrmanyň funksiýasy üçin ulanylyo bilner, eger bu funksiýasy işldilen bolsa. 

Meselem kesim çyzamyzda onuň ilkinji nokady hökmünde eýýam bar bolan 

nokady syçanjyk bilen ýanyna eltsek, şol nokadyň üstünde saryja belgi emele 

geler, eger syçanjygyq çep düwmejigine bassak, onda şol nokat kesimiň ilkinji 

nokady hökmünde alynar, edil şeýle ýagdaý ikinji nokat we b. bilen   

Ekrandaky obýektleri belläp almagyň iki usuly bar. Birinji usul Buýruk 

setirinde eger Command: (Команда:) çagyryşy bar bolsa, syçanjygyň 

görkezijisini sag aşaky burçda goýalyň we onuň çep düwmejigine basyp  we 

goýberiň ulgam buýruk setirinde şeýle sorag berer Specify opposite corner: 

(Противоположный угол:). Syçanjyk bilen ikinji burçy görkeziň. Mundan soňra 

hemme obýektlerde tutawaçlar (kiçiräk gök reňkli inedördüller) emele geler. 

Obýektleri gönümel syçanjyk bilen olaryň üsti basylsa hem saýlap bolýar. 

Belleýiş çägi çepden saga (ýönekeý diýlip atlandyrylýar) we sagdan çepe 

(kesiş diýlip atlandyrylýar) eltip bolýar. Birinji ýagdaýda çägiň içine diňe doly 

giren obýektler saýlanar, ikinji ýagdaýda bolsa şol çägiň araçäkleri degen obýektler 

saýlanar. Ýönekeý çäk tutuş, kesiş çägi bolsa punktir çyzyk bilen görkezilýär. 

удалены.  

Bellenilen obýektleri aýyrmak üçin Del düwmejigi basyň, eger belleýişi 

aýyrmak üçin bolsa Esc düwmejigi basyň. 

Nokady gurýan ýene bir iki sany gyzykly buýruk bar. 

DIVIDE (РАЗДЕЛИТЬ), ol keseimi ýa-da başga obýekti deň böleklere 

bölýär. Buýruk klawiaturadan ýa-da Draw | Point | Divide (Рисование | Точка | 

Разделить) menýudan girizilip bilner. Kesimi çyzyň we DIVIDE buýrugyny 

giriziň. Birinji sorag: 

Select object to divide: (Выберите объект для деления:)  

Çyzylan kesimi belläň. Indiki sorag: 

Enter the number of segments or [Block]: (Число сегментов или 

[Блок]:)  
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meselem, biz 8 girizýäris. Netijede kesim 8 sany deň bölege bölüner, we 

bölünýän ýerde 7 sany düwün nokatlary goýular.  

MEASURE (Размер). Ol hem klawiaturadan başga Draw | Point | Measure 

(Рисование | Точка Размер) menýu ýoly bilen ýerine ýetirilip bilner. Birinji sorag: 

Select object to measure: (Выберите объект для разметки:)  

Obýekti belleýäris. ikinji sorag: 

Specify length of segment or [Block]: (Длина сегмента или [Блок]:)  

San girizilenden soň AutoCAD ulgamy bellenilen ýer haýsy uja golaý bolsa şol 

ýerden başlap bellenilen aralyk bilen nokatlary goýuşdyryp çykýar.  

 

Şöhleler 
 

Şöhle — bir tarapa üznüksiz bolan we belli bir nokatdan başlanýan primitiw. 

Ony gurmak üçin RAY (ЛУЧ) buýrugy gulluk edýär. Buýruk klawiaturadan ýa-da 

Draw (Рисование) menýusyndan Ray (Луч) bendi arkaly çagyrylyp bilner. Birinji 

sorag: 

Specify start point: (Начальная точка:)  

Birinji nokatdan soň AutoCAD gaýtalanyş ýagdaýda beýleki nokatlary soraýar we 

birinji nokatdan geçýän şöhleleri gurýar: 

Specify through point: (Через точку:) Buýrugyň tamamlanmagy - Enter 

или ýa-da syçanjygyň sag düwmejiginiň basylmagy. 

 

Göni çyzyk 
 

Göni çyzyklar kesimlerden we şöhlelerden tapawutlylykda iki taraplaýyn 

üznüksiz çyzyklar. Olary gurmak üçin XLINE (ПРЯМАЯ) buýrugy ulanylýar, ol 

klawiaturadan, Draw (Рисование) menýusynyň Construction Line (Прямая) 

bendi ýa-da Draw (Рисование) gurallar paneliniň  düwmejigi bilen ýerine 

ýetirilip bilner. Birinji sorag: 

Specify a point or [Hor/Ver/Ang/Bisect/Offset]: (Укажите точку или 

[Гор/Вер/Угол/Биссект/Смещение]:) Eger bu ýagdaýda nokat görkezilse (syçan 

bilen ýa-da seredilen başga usul bilen), onda AutoCAD birinji nokatdan geçýän 

göni çyzyklaryň toplumyny çyzyp başlar. Göni çyzygy tekizlikde gurnamak üçin 

iki nokat ýeterlik, şol sebäpli ikinji sorag: 

Specify through point: (Через точку:). Göni çyzygyň toplumy geşjek 

birnäçe nokatlary bermek mümkin. 

Beýleki bäş opsiýalar buýrugy başynda elýeterli we şu ýagdaýlarda çyzmagy 

mümkin edýär  kese (Ноr (Гор)); dik (Ver (Вер)); belli bir burç bilen (Ang 

(Угол)); depesini we taraplaryny görkezilmeli belli bir burçuň bissektrisasyny 

gurmak üçin (Bisect (Биссект)); beýleki çyzykly obýekte parallel bolanlary 

(Offset (Смещение)). 

Ноr (Гор) opsiýasy şu soragy berýär: Specify through point: (Через 

точку:). 

Kese çyzyklaryň geçmeli nokatlary görkezmek gerek. Edil şu ýagdaýda Ver 

(Вер) opsiýasy işleýär. 
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Ang (Угол) opsiýasy ulanylanda şu sorag berilýär: 

Enter angle ofxline (0) or [Reference]: (Угол прямой (0) или [Базовая 

линия]:) 

Bu ýagdaýda gorizontala (X okunyň položitel ugruna) görä ölçenilýän egiliş 

burçy ýazmaly. Eger Enter düwmejigi basylsa egiliş burçy nola deň bolar. Burçy 

san bilen berip bolýar (gradusda) ýa-da syçanjyk arkaly bir nokady görkezip 

Ulgam sorag berer: 

Specify second point: (Вторая точка:) 

Muňa beýleki nokady görkezmeli. 

Eger Reference (Базовая линия) opsiýasy ulanylsa, onda AutoCAD beýleki 

soragy berer: 

Select a line object: (Выберите линейный объект:) 

Göräleýin egiliş burçy alynjak bir çyzkly obýekti görkezmeli (kesim, şöhle 

ýa-da göni çyzygy). Burç berilenden soňra sorag berilýär: 

Specify through point: (Через точку:), we berlen egiliş burçy bilen göni 

çyzyklaryň geşjek nokatlary (nokady) görkezmeli bolar. 

Bisect (Биссект) opsiýasy depesi, birinji tarapyň nokady we ikinji tarapyň 

nokady görkezilmeli belli bir burçuň bissektrisasy bolup durýan göni çyzygy 

gurýar. Birinji sorag: 

Specify angle vertex point: (Укажите вершину угла:) 

Ikinji sorag burçuň birinji tarapynyň nokady barada:  

Specify angle start point: (Точка на первом луче угла:) 

Soňra ikinji tarapyň nokady baradaky gaýtalanýan sorag berilýär:  

Specify angle end point: (Точка на втором луче угла:) 

Eger birnäçe nokat berilse we Enter basylsa, onda depesi we birinji tarapyň 

nokady gabat gelýän ikinji tarapyň nokady bolsa üýtgeýän burçlaryň 

bissektrisalary çyzylar. 

Offset (Смещение) opsiýasy kesimlere, şöhlelere we beýleki göni çyzyklara 

parallel göni çyzyklary gurýar. Birinji sorag: 

Specify offset distance or [Through] <Through>: (Величина смещения 

или [Точка] < Точка >:) 

Bu ýerde parallel çyzykly obýektleriň arasyndaky aralyk bolup durjak sany 

girizmeli, ýa-da Enter düwmejigi basmaly - eger  Through (Точка) (ýa-da san 

berilen bolsa süýşüş ullulygyň ölçegi) tarapyndan hödürleýän ölçegler bilen razy 

bolunsa, ýa-da T harpyny girizmeli. 

Eger süýşüş ululygy girizilse, onda indiki sorag şeýle:  

Select a line object: (Выберите линейный объект:) 

Çyzykly obýekti görkezmeli. Soňra: 

Specify side to offset: (Укажите сторону смещения:) 

Tekizlikde çyzykly obýekte her tarapyndan parallel çyzyklar çyzylyp bilner, 

şol sebäpli, baza elemente görä ýerleşjek guruljak parallel çyzygyň tarapynda 

islendik nokady görkezmeli. 

Offset (Смещение) opsiýasynda Specify offset distance or [Through]: 

(Величина смещения или [Точка]:) soragyna Т (Т) jogaby saýlanylsa, onda 

AutoCAD soraýar: 
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Select a line object: (Выберите линейный объект:), soňra parallel 

çyzygyň geşjek nokadyny soraýar: 

Specify through point: (Через точку:). 

 

Tegelekler 

 

Tegeleklerıň çyzylmagy CIRCLE (КРУГ) buýrugy bılen ýerıne ýetırılýär. 

Buýrugy Draw (Рисование) panelınden  düwmejıgı ýa-da Draw (Рисование) 

menýunyň Circle (Круг) kömekçı menýusynyň alty bendı bılen ýerıne ýetırılýär. 

CIRCLE (КРУГ) buýrugy çagyrylanda AutoCAD sorag berýär:   

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: (Центр круга 

или [3T/2T/KKP (кос кос радиус)]:) 

Eger nokat görkezılse, onda ol boljak tegelegıň merkezı bolar we şeyle sorag 

beriler: 

Specify radius of circle or [Diameter]: (Радиус круга или [Диаметр]:) 

Bu yagdayda tegelegiň radiusynyň ululygy bolup durjak sany girizmek 

bolyar. Eger D (Д) simwoly girizilse, onda Diameter (Диаметр) saylanylar. Onda 

diametriň ululygyny girizmek boyunça sorag berler: 

Specify diameter of circle: (Диаметр круга:) 

Eger tegelegiň merkeziniň deregine ЗР (ЗТ) opsiyasy saylanylsa, onda 

AutoCAD tegelegi tekizligiň 3 nokady boyunça gurar. Nobatlayyn 1,2 we3=nji 

nokatlar berilyär, yöne olar bir çyzykda ýerleşmeli däldir.  

Eger 2Р (2Т) opsiýasy saýlanylsa, onda diňe 2 nokat berler, ýöne iki nokat boljak 

tegelegiň diametrine degişli diýlip hasaplanylyar. Olaryň arasyndaky aralyk 

diametr bolup durýar. AutoCAD şeýle soraglary berýär:  

Specify first end point of circle's diameter: (Первая конечная точка диаметра 

круга:) we Specify second end point of circle's diameter: (Вторая конечная 

точка диаметра круга:) 

Ttr (KKP) opsiýasy gyzykly, ol beýleki iki obýekte galtaşýan we berlen 

radiusa eýe bolan tegelegi gurýar. Birinji sorag: 

Specify point on object for first tangent of circle: (Укажите точку на 

объекте, задающую первую касательную:) 

Saýlanan obýekte syçanjygyň görkezijisi getirilende AutoCAD ony 

tapandygyny düşündirme bilen görkezýär Deferred Tangent (Отложенная 

касательная). Bu obýekte bolan galtaşyş nokady soňra hasaplanjakdygyny 

aňladýar (ol entek belli bolmadyk ikinji obýekte bagly bolup durýar). 

Ikinji sorag: Specify point on object for second tangent of circle: 

(Укажите точку на объекте, задающую вторую касательную:) 

Üçünji sorag: Specify radius of circle: (Радиус круга:)  

Radiusy san bilen ýa-da iki nokat bilen belläp bolar. Eger berlem maglumatlar 

bilen çyzuw mümkin däl bolsa onda ulgam bu barada habar berer. 

Mundan başga hem Draw (Рисование) menýunyň Circle (Круг)kömekçi 

menýusynda Tan, Tan, Tan (3 точки касания) bendi bar. Emma ol özbaşdak 

funksiýa dälde ЗР (ЗТ) opsiýanyň bir bölegi, ol arkaly, obýekt baglaşdyrmagyň 
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Tangent (Касательная) funksiýasy bilen üç galtaşma nokady arkaly tegelek 

gurulýar. 

Tegelegiň merkezinden başga ýe-ne de 4 nokady bar olara kwadrant 

diýilýär. Şol sebäpli tegelege degişlikde 3 sany obýekt baglaşdyrmagyň funksiýasy 

degişlidir - Tangent (Касательная), Center (Центр), Quadrant (Квадрант). 

 

Halka 

 

 Halka — bu tegelegiň bir bölegi bolup durýan bir primitiw. Ony gurmak 

üçin ARC (ДУГА). Buýruk klawiaturadan, Draw (Рисование) gural panelinden 

 düwmejigi arkaly ýa-da Draw (Рисование) menýusynyň Arc (Дуга) kömekçi 

menýudan çagyrylyp. 

Iň umumy warianta seredeliň. Birinji sorag:  

Specify start point of arc or [CEnter]: (Начальная точка дуги или [Центр]:)  

Jogap hökmünde başlangyç nokady ýa-da merkezi görkezip bolar. 

Eger ýöne Enter düwmejigi basylsa onda başlangyç hökmünde iň soňky 

obýektiň soňky nokady alynar (ýöne diňe kesimleriň we halkalaryň arasyndaky) 

we AutoCAD şol obýekte bolan halkany, galtaşyş çyzygy gurar. Ahyrky nokat 

soralýar (merkez we radius ahyrky nokat we obýekte bolan galtaşmagyň şerti 

boýunça kesgitlenýär: 

Specify end point of arc: (Конечная точка дуги:)  

Nokat görkezilenden soň oň obýektiň dowamy bolup duran halka gurulýar.  

Specify start point of arc or [Center]: (Начальная точка дуги или 

[Центр]:) soraga başlangyç nokat girizilse AutoCAD soraýar: 

Specify second point of arc or [Center/End]: (Вторая точка дуги или 

[Центр/Конец]:)  

Eger ikinji nokat görkezilse onda ulgam soňra soraýar:  

Specify end point of arc: (Конечная точка дуги:) 

Netijede üç nokat boýunça gurulan halka gurulýar. Ikinji nokadyň deregine 

Center (Центр) opsiýasyny saýlamak bolar, AutoCAD sorar: 

Specify center point of arc: (Центр дуги:) 

Merkeziň nokady görkezilen soň: 

Specify end point of arc or [Angle/chord Length]: (Конечная точка дуги 

или [Угол/Длина хорды]:) 

Eger ahyrky nokady görkezilse, AutoCAD halkanyň radiusyny birnji nokat 

we merkez boýunça hasaplap ony dogurlaýar.  

Soňky ýagdaýda halkany gurmagy tamamlanmagyň ýene iki warianty bar: 

Angle (Угол) we chord Length (Длина хорды). Angle (Угол) opsiýasy 

saýlanylanda belli birç girizilmeli we şol burç boýunça halka çyzylýar. Eger chord 

Length (Длина хорды) opsiýasy saýlanylsa onda halka birinji nokatdan hordanyň 

uzynlygy boýunça çyzylar. 

 

Poliçyzyk 
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 Poliçyzyk — ol bir ýa-da birnäçe biri-biri bilen özara baglanan göniçyzykly 

ýa-da halkalaýyn segmentlerden düzülen çylşyrymly primitiw. Poliçyzyk bir bitewi 

obýekt bolup işlenilýär. 

Poluiçyzygy çyzmak üçin PLINE (ПЛИНИЯ) buýrugy gulluk edýär, ol 

klawiaturadan başga, Draw (Рисование) paneliň  düwmejigi arkaly панели ýa-

da Draw (Рисование) menýusynyň Polyline (Полилиния) bendi arkaly çagyrylyp 

bilner. 

Birinji sorag: 

Specify start point: (Начальная точка:)  

Poliçyzygyň başlangyç nokadyny görkezmeli. Ikinji sorag: 

Current line-width is 0.0000 Specify next point or 

[Arc/Halfividth/Length/Undo/Width]: (Текущая ширина полилинии равна 

0.0000 Следующая точка или [Дуга/Полуширина/длИна/Отменить/'Ширина]:) 

Poliçyzyk — nol däl ine eýe bolup bilýän obýektleriň az sanyna girýär Öňki 

poliçyzyk üçin berlen ini ýa-da saklanylýar we indiki poliçyzyk üçin deslapdan 

hödürlenýär. Şol sebäpli AutoCAD Current line-width is (Текущая ширина 

полилинии ) habar bilen poliçyzygyň haýsy ini bilen çyzyljakdygy barada 

duýdurýar. Eger şu halatda nokat görkezilse öňki soragy gaýtalaýar ýöne oňa 

Close (Замкнуть) opsiýasy goşulýar: 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 

(Следующая точка или [Дуга/Замкнутъ/Полуширина/длИна/Отменить/ 

Ширина]:) 

 Arc (Дуга) — poliçyzygyň halka segmentleri çyzmagyň düzgünine 

geçmeklik;  

  Close (Замкнуть) — poliçyzygy ýapyk goýýan goniçyzykly parçanyň 

goşulmagy (şol bir wagtda PLINE (ПЛИНИЯ) buýrugy tamalnaýar);  

  Halfwidth (Полуширина) — ini görkezmeklik, ýöne ýarym iniň 

adalgasynda (ýagny zerur doly in 10 bolsa, ony almak üçin ýarym ini 5-e 

deň edip goýmaly);  

  Length (длИна) — öňki parçanyň dowamy bolup durýan segmentiň berlen 

in bilen çyzylmagy, şonda ini san bilen ýa-da nokat bilen görkezip bolar;  

  Undo (Отменить) —PLINE (ПЛИНИЯ) buýrugynda soňky amalyň 

ýatyrylmagy;  

  Width (Ширина) — indiki parça üçin ini görkezmeklik (poliçyzygyň her 

segmentinde öz ini bolup biler, we ol parçanyň başynda onuň soňundakysy 

bilen gabat gelmän hem biler; in poliçyzygyň okunyň her tarapyna deň 

paýlanýar.  

Halka çyzmagyň düzgünine geçilen ýagdaýda (опция Arc (Дуга)) 

AutoCAD  şeýle saýlamagy hödürleýär: 

Specify endpoint of arc or [Angle/CEnter/CLose/Direction/Halfwidth/ 

Llne/Radius/Secondpt/Undo/Width]: (Конечная точка дуги или 

[Угол/Центр/Замкнуть/Направление/Полуширина/Линейный/Радиус/Вторая/

Отменить/Ширина]:) 
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Bu halatda halkanyň ahyrky nokady görkezilenden soň AutoCAD 

poliçyzygyň öňki parçasyna galtaşýan halka segmenti çyzýar. Beýleki opsiýalar:  

 Angle (Угол) — Halka segmenti üçin merkezi burçuň ululygyny 

görkezmek;   

 CEnter (Центр) — halka segmenti üçin merkezi görkezmek;   

 CLose (Замкнуть) — poliçyzygy halka segmenti bilen ýapmak;  

 Direction (Направление) — halka segmenti gurmak üçin galtaşyş çyzygyň 

ugruny görkezmeklik;  

 Halfwidth (Полуширина) — indiki segment üçin ýarym ini görkezmeklik;  

 Line (Линейный) — göniçyzyk segmentleri çyzmagyň düzgünine 

geçmeklik;  

 Radius (Радиус) — halka segmenti üçin radiusy görkezmeklik;  

 Second pt (Вторая) — halka segmenti üç nokat boýunça gurmak üçin ikinji 

nokady görkezmeklik;  

 Undo (Отменить) —PLINE (ПЛИНИЯ) buýrugyň içinde iň soňky amaly 

ýatyrmaklyk;  

 Width (Ширина) — indiki segment üçin ini görkezmeklik. 

Halka segmentleri gurmagyň usullary halkalary gurmagyň ARC (ДУГА) 

buýrugyna meňzeş. 

Poliçyzyk çylşyrymly bolup durýar. Modify (Редактирование) panelindäki 

 düwmejik ýa-da Modify (Редакт) menýusynyň Explode (Взорвать) bendi 

bilen çagyrylýan EXPLODE (ВЗОРВАТЬ) buýrugy bilen ony kesimlere we 

halkalara bölüp bolýar. Şunda olaryň ini baradaky maglumat ýitýär.  

Ulgamda öň çyzylan we yzygiderli baglaşan kesimleriň we halkalaryň 

poliçyzyga birleşmegi mümkinüiligi bar. 

Munuň üçin PEDIT (ПОЛРЕД) buýrugy ulanylýar, Modify II 

(Редактирование-2) paneliň  düwmejigi we Modify | Object | Polyline 

(Редакт | Объект | Полилиния) menýu ýoly gabat gelýär. Ilkibaşda buýruk 

poliçyzygy bellemek barada sorag berýär, biz kesimi ýa-da halkany bellämizde 

ulgam olaryň poliçyzyk däldigi barada habar berýär we olary bir obýekte barada 

birleşdirmek boýunça sorag berýär, Enter basylandan soň şu sorag emele geler:  

Enter an option [Close/Join/Width/Edit vertex/ 'Fit/'Spline/'Decurve/Ltype 

gen/Undo]:(Задайте опцию 

Замкнуть/Добавить/Ширина/Вершина/С'Гладить/С'Плайн/Убрать 

сглаживание/Типлин/Отменить]:) 

Join opsiýasy saýlanylýar we gerekli yzygiderli obýektleri belleýärsiňiz. 

Netijede bir bitewi poliçyzyk emele geler. 

 

Ýörite görnüşli poliçyzyklar 

 

AutoCAD ulgamynda gönibrçluklar, dogry köp burçluklar, halkalar we 

düzediş çyzyklar ýaly obýektleri çyzmagyň birnäçe buýruklary bar. 

Göniburçluklaryň çyzylmagy RECTANG (ПРЯМО-УГ) buýrugy bilen 

amalaaşyrylýar. Buýruk klawiaturadan,  Draw (Рисование) panelindäki 
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düwmejik arkaly ýa-da Draw (Рисование) menýunyň Rectangle 

(Прямоугольник) bendi bilen çagyrylyp bilner. Başlangyç sorag:  

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]: (Первый угол или 

[Фаска/Уровень/Сопряжение/Высота/Ширина]:) 

Eger nokat görkezilse ol göniburçlugyň ilkinji burçy bolar, AutoCAD 

garşyky burçy sorar ýa-da ölçegleri:  

Specify other corner point or [Dimensions]: (Другой угол или [Размеры]:) 

Eger ikinji nokat görkezilse onda girizilen iki nokat hem göniburçlugyň 

diagonallarynyň biri bolup durýar. Dimensions (Размеры), opsiýasy saýlanylsa 

ona göniburçlugyň iki ölçeginiň ähmiýetleri soralar: 

Specify length for rectangles <0.0000>: (Длина прямоугольников 

<0.0000>:) we Specify width for rectangles <0.0000>: (Ширина 

прямоугольников <0.0000>:) – uzynlygy we ini.  

Ölçegler girizilenden soňra AutoCAD ýene-de ikinji nokady soraýar, ýöne ol 

görkezilse ol diňe göniburçlugyň ugrukdyrylmagyny kesgitlär. RECTANG 

(ПРЯМОУГ) buýrugyň mümkin bolan opsiýalar:   

  Chamfer (Фаска) — gönüburçlugyň her burçunda alynýan faskalaryň 

uzynlygyny görkezmeklik;  

  Fillet (Сопряжение) — gönüburçlugyň baglaşdyrmagyňradiusyny 

görkezmeklik;  

  Elevation (Уровень) — üçölçegli giňişligiň Z oky boýunça 

süýşengöniburçlugy gurmak üçin derejäni görkezmeklik;  

  Thickness (Высота) — üçölçegli giňişligiň Z okuň ugry boýunça 

galdyrylýan göniburçlugyň beýikligini görkezmeklik;  

  Width (Ширина) — göniburçluk bolup durýan poliçyzygyňinini 

görkezmeklik.  

 

POLYGON (МН-УГОЛ) buýrugy dogry köpburçlugy ýabir tarapyň 

ahyrky nokady, ýa-da merkeziň nokady we radius boýunça çyzýar çyzýar. Buýruk 

Draw (Рисование) paneliniň  düwmejigi ýa-da Draw (Рисование) menýunyň 

Polygon (Многоугольник) bendi boýunça çagyrylyp bilner. Birinji sorag: 

Enter number of sides <4>: (Число сторон <4>:) 

Bu ýerde köp burçlugyň taraplarynyňsanyny girizmeli, ýaýyň içinde öňki 

gezek ulanylan taraplaryňsany görkezilen. Indiki sorag:  

Specify center of polygon or [Edge]: Укажите центр многоугольника или 

[Сторона]:  

Eger Е (С) opsiýasy saýlanylsa, onda AutoCAD tarapyň iki ahyrky nokady 

soraýar we olar boýunça göniburçlugy gurýar. Eger opsiýanyň deregine nokat 

saýlanylsa, onda ulgam göniburçlugyňölçegi nähili görkeziljekdigini soraýar: 

Enter an option [Inscribed in circle/Circumscribed about circle] </>; 
(Задайте опцию размещения [Вписанный в окружность/Описанный вокруг 

окружности] <В>:) 
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I (В) jogapberilende göniburçluk belli bir tegelegiň içine salynyp çyzylýar, 

С (О) jogapda — tegelegiň daşyndan çyzylýar. Diňe tegelegiň radiusy barada 

sorag galýar: 

Specify radius of circle: (Радиус окружности:)  

 

Halka DONUT (КОЛЬЦО) buýrugy bilen çyzylýar we içki we daşky 

diametr bilen saýlanylan poliçyzyk bilen çyzylýar. Buýruk klawiaturadan başga, 

Draw (Рисование) menýusynyň Donut (Кольцо) bendi arkaly çagyrylyp bilner. 

Birinji sorag: 

Specify inside diameter of donut <0.5000>: (Внутренний диаметр 

кольца <0.5000>:) 

Içki (hem-de daşky) diametr san bilen ýa-da iki nokat bilen görkezilip bilner. 

Ikinji sorag: 

Specify outside diameter of donut <1.0000>: (Внешний диаметр кольца 

< 1.0000>:) 

Iki diametr berilen soňra halkanyňölçegleri hasaplanylýar we AutoCAD 

gaýtalamak bilen bir ölçegli halkalaryň merkeziniňnokadyny ýerleşdirmekboýunça 

sorag berýär: 

Specify center of donut or <exit>: (Центр кольца или <выход>:) 

Buýrugy Enter ýa-da syçanjygyň sag düwmejigi bilen tamamlap bolýar.  

 

REVCLOUD  

Bu buýruga Draw (Рисование) paneliň  düwmejigi we Draw 

(Рисование) menýunyň Revision Cloud (Облако правки) gabat gelýär. Buýruk 

sorag berýär: 

Minimum arc length: 15 Maximum arc length: 15 Specify start point or 

[Arc length/Object] <Object>: (Минимальная длина дуги: 15 Максимальная 

длина дуги: 15 Начальная тонка или [Длина дуги/Объект] <0бъект>:) 

Soragyňbirinji setirinde buýrugyň goýlan sazlamalary görkezilýär 

(halkalaryň iň kiçi we uly uzynlygy). Arc length (Длина дуги) opsiýasy bilen 

olary üýtgetmek mümkin. Object (Объект) opsiýasy bar bolan obýekte bulut 

formasyny bermegi mümkin edýär. 

Nokatlar görkezilende döwülen çyzyk çyzylýar. Ol başdan bulut şekiline eýe 

bolýar. Ony syçanjygy basyp çyzmak zerur däl. Syçanjygy gerek bolan ugur 

boýunça geçirmek ýeterli. 

Object (Объект) opsiýasy saýlanylan bolsa ulgam obýekti soraýar. Obýekt 

görkezilenden soň halkalaryň ugruny çalyşmak barada sorag berilýär:  

Reverse direction [Yes/No] <No>: (Изменить направление [Да/Нет] <Нет>:). 

 

Multiçyzyklar 

 

Multiçyzyk — bu biri birine parallel, döwülen çyzyklaryň toplumyndan 

ybarat bolan obýekt. Multiçyzyga girýän çyzyklaryň sany 2-den 16-a çenli. 

Multiçyzyk goşmaça häsiýetlere eýedir, olara şular degişli: aralykdaky sepler, 

gyraňlar, tegelenen ýerler we reňk berme. 
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Multiçyzyklar MLINE (МЛИНИЯ) buýrugy bilen ýerine ýetirilýär. Buýruk 

klawiaturadan ýa-da Draw (Рисование) menýunyň Multiline (Мультилиния) 

bendi arkaly çagyrylyp bilner. 

Häzirki sazalmalary görkezilip birinji sorag berilýär:  

Specify start point or [Justification/Scale/STyle]: (Начальная точка или 

[Расположение/'Масштаб/Стиль]:) 

Eger birinji nokat görkezilse onda indiki nokat boýunça sorag berilýär we 

m.b. Üçünji soragda Undo (Отменить) opsiýasy, dördünji nokatda Close 

(Замкнуть) opsiýasy emele gelýär.  

Birinji nokady görkezmezden öň opsiýalaryň ähmiýetlerini goýmak 

mümkin. Justification (Расположение) opsıýasy Тор (Верх), Bottom (Низ) и 

Zero (Центр) ähmiýetleri alyp bilýär. 

 

Ýazgylar 

 

Ýazgylar TEXT (ТЕКСТ) ýa-da МТЕХТ (МТЕКСТ) buýruklar arkaly 

döredilip bilner. Birinji ýagdaýda bir setirli tekst, ikinji ýagdaýda – multitekst (köp 

setirli tekst) döredilýär. Bu buýruk klawiaturadan başga Text (Текст) paneliniň  

düwmejigi ýa-da Draw (Рисование) menýusynyň Text (Текст) kömekçi 

menýusynyň Single Line Text (Однострочный) bendi arkaly çagyrmak mümkin. 

Buýruk goýberilenden soňra häzirki stil barada habar berilýär we : Current 

text style: "Standard" Text height: 2.5000 (Текущий текстовый стиль: 

"Standard" Высота текста: 2.5000). Stiliň düşünjesi öz içine şriftiň adyny we ony 

ulanmagyň käbir aýratynlyklaryny öz içine alýar (harplaryň eňňitligini we b.). 

Mundan başga hem AutoCAD öňki ýazgynyň beýikligini ýatda saklaýar (biziň 

mysalymyzda bu 2.5 mm). Ýazgynyň gurulmagy şu soragdan başlanýar: Specify 

start point of text or [Justify/Style]: (Начальная точка текста или 

[Выравнивание/Стиль]:)  

Tekstiň başlangyç nokadyny gşrkezmek mümkin ýa-da Justify 

(Выравнивание) we Style (Стиль) opsiýalarynyň birini saýlamak mümkin. Soňky 

opsiýa häzirki stiliň adyny üýtgetmegi mümkin edýär. Justify (Выравнивание) 

opsiýasy tekstiň haýsy ýagdaýda deňlenmegini saýlaamagy mümkin edýär. Nokat 

görkezilen ýagdaýda ol baza çyzygyň başlangyjy bolup durýar. Indiki sorag: 

Specify height <2.5000>: (Высота <2.5000>.)  

Tekstiň beýikligini girizmeli (Başlanýanýan harplara degişlikde) ýa-da ony 

ikinji nokat bilen görkezmeli. Soňra şeýle sorag emele gelýär:  

Specify rotation angle of text <0>: (Угол поворота текста <0>:)  

Ýazgynyň aşaky esasynyň X okunyň položitel ugruna görä öwrüliş burçy 

belleýän sany giriziň (kese ýagdaýda ol 0). Öwrüliş burçy ikinji nokat bilen 

görkezip bolar. Ahyrky sorag:  

Enter text: (Введите текст:)  

Ýazgynyň başyny bellän ýeriňizde I harpyň şekilinde kursor emele geler. 

Klawiaturada islendik teksti ýazyň we Enter basyň. Ekranda ýazgy emele geler we 

AutoCAD gaýtadan sorar Enter text: (Введите текст:). Buýrugy tamamlamak 

üçin Enter ýa-da Esc düwmejigi basyň. 
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Eger ýazga ýörite belgileri (meselem, diametr) ýa-da aşagy we üsti çyzylan 

simwollary ýazmak zerur bolsa, onda göterim belgiden başlanýan aşakdaky 

dolandyryjy simwollary  ulanmaly:  

  %%nnn — Windows üçin grafiki priloženiýelerde ulanylýan kodirlemegiň 

häzirki tablisasynda nnn belgili simwoly goýmak (nnn üç sany çalşyrýar), 

(meselem, %%193 —bu 193 belgili simwol, ýagny "Б");  

  %%о — üstünden çyzmagy goýmak/aýyrmak;  

  %%u — aşakdan çyzmagy goýmak/aýyrmak;  

  %%d — gradusyň "°" simwolyny goýmak;  

  %%р — goşmak-aýyrmak "±" simwoly goýmak;  

  %%с — dimaetriň simwolyny goýmak;  

  %%% — göterimiň simwolyny goýmak "%".  

Deňlemegiň opsiýasy gyzyklydyr, olar başlangyç nokadyň deregine Justify 

(Выравнивание) opsiýasy saýlanylsa elýeterli bolýar: 

Enter an option [Align/Fit/Center/Middle/ 

Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: (Задайте опцию 

[впИсанный/Поширине/Центр/сЕредина/впРаво/ВЛ/ВЦ/ВП/СЛ/СЦ/СП/НЛ/Н

Ц/НП]:). 

Align (впИсанный) we Fit (По ширине) opsiýalar gyzykly, olar harplaryň 

ölçeglerini anyk bir ýerleşiş boýunça gabat getirýärler. Align (впИсанный) 

opsiýasy ulanylanda AutoCAD baza çyzygyň ahyrky nokatlary hökmünde boljak 

iki nokady soraýar — olar ýazgynyň eňňitliginiň burçuny kesgitleýärž we tekstiň 

ini boýunça ölçegini kesgitleýärž harplaryň beýiklik boýunça ölçegleri bolsa 

harplaryň inine proporsional edilip hasaplanylýar. Fit (По ширине) opsiýasynyň 

ýagdaýynda baza çyzygyň ýerleşişini we uzynlygyny kesgitleýän iki nokady 

görkezmeli, emma AutoCAD harpyň beýikligini hem soraýarž mundan soň tekst 

ýa giňeýär ýa-da gysylýar. 



 154 

 

МТЕХТ (МТЕКСТ) buýrugy çyzga ýeterlikçe uzyn tekstiň tutuş abzaslary 

girizmegi mümkin edýär (şunda emele gelýän primitiwe multitekst diýilýär), onda 

deňleşdiriş we redaktirleýiş Microsoft Word ýaly tekst redaktorlaryň 

mümkinüiligine golaýlaşýar. Buýruga Draw (Рисование) we Text (Текст) 

panelindäki  düwmejigi, şeýle hem Draw | Text | Multiline Text (Рисование | 

Текст | Многострочный) menýunyň bendi gabat gelýär. 

  МТЕХТ (МТЕКСТ) buýrugy başda hereket edýän tekst stili barada habar 

berýär we multitekstiň ini boýunça zolagyň çäklerini kesgitleýän nokatlaryň birini 

girizmegi soraýar. Beýiklik boýunça aşaky çäk şundan bellenilmeýär we 

awtomatiki tekstiň girizilmeginiň dowamynda süýşýär. Şeýlelik bilen, başda: 

Current text style: "Standard" Text height: 2.5 Specify first corner: 

(Текущий текстовый стиль: "Standard". Высота текста: 2.5 Первый угол:) 

Затем: Specify opposite corner or [Height/Justify/Line 

spacing/Rotation/Style/Width]: (Противоположный угол или 

[ВЫСота/ВЫРавнивание/ Межстрочный интервал/Поворот/Стиль/Ширина]:) 
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Nokatlar görkezilenden soň multitekstiň redaktorynyň penjiresi açylýar. 

Multitekstiň penjiresiniň ýokarsynda Text Formatting (Форматирование текста) 

ýörite paneli çykarylýar, ol redaktoryň penjiresini dolandyrmagyň gurallaryny. 

Tekst ýazylandan soň Text Formatting (Форматирование текста) 

paneliniň  düwmejigine basmaly ýa-da Ctrl+Enter düwmejikleriň utgaşmagyny 

basmaly, mundane soň AutoCAD grafiki ekranda bitewi çylşyrymly primitiw 

bolup duran multiteksti döreder. 

 düwmejigi droblary we indeksleri ýazmaklygy dolandyrýar. Sanawjy we 

maýdalawjy ýa kese çyzyk bilen aýry edilip bilner ýa-da hiç zat bilen, ýa-da eňňitli 

çyzyk bilen aýry edilip bilner. Droblaryň düwmejigini ulanmazdan öň syçanjyk 

arkaly emele geljek sanawjynyň we maýdalawjynyň şu simwollaryň biri bilen aýry 

edilen meýdanyny bellemek gerek: /, ^ или #. Soňra şol düwmejige basmaly. 

 

 
 

 düwmejigiň eýýam drobyň gşrnüşine eýe bolan tekstiň bellenilen 

meýdanyna ulanylmagy ony öňki görnüşine getirýär. 

Kursor multitekstiň redaktorynyň içinde bolanda syçanjygyň sag 

düwmejigiň basylmagy kontekst menýuny çagyrýar.  

Kontekst menýu şu elementlere eýe:  

 Undo (Отменить) — redaktoryň penjiresinde siňky amaly ýatyrýar;  

 Redo (Повторить) — soňky ýatyrmagyň hereketini ýok edýär;  

 Cut (Вырезать) — tekstiň bellenilen bölegini kesip alýar we alyş-çalyş 

buferine girizýär;  

  Сору (Копировать) — tekstiň bellenilen bölegini alyş-çalyş buferine 

göçürip alýar;  

  Paste (Вставить) — alyş-çalyş buferinden teksti goýýar;  
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  Indents and Tabs (Отступы и позиции табуляции) —şol atly gepleşik 

penjiresini çagyrýar;  

  Justification (Выравнивание) — deňleşdiriş amallaryň kömekçu 

menýusyna geçmek;  

  Find and Replace (Найти и заменить) — teksti gşzlemek we ony 

çalşyrmak üçin Замена (Replace) gepleşik penjiresini çagyrmak;  

  Select All (Выбрать все) — redaktoryň penjiresindäki tutuş teksti belläp 

alýar;  

  Change Case (Изменить регистр) — bellenilen tekstiň meýdanynda 

ýökarky (UPPERCASE) ýa-da aşaky (lowercase) registre geçmeklik;  

  AutoCAPS (Авто-CAPS) — täze teksti ýokarky registre geçirýär;  

  Remove Formatting (Убрать форматирование) — tekstiň bellenilen 

meýdanynyň goşmaça formatirlenmesini aýyrýar (kursiw, galyňlyk, aşagy 

çyzmagy);  

  Combine Paragraphs (Объединить абзацы) — abzaslary bir abzasa 

birleşdirýär;   

  Symbol (Символ) — ýörite simwollaryň goýulmagynyň menýusyna 

geçmeklik;  

  Import Text (Импорт текста) —txt и rtf giňişlikli faýllardan teksti alýar. 

 

Multitekstiň häsiýetlerini umuman sazlamak üçin МТЕХТ (МТЕКСТ) 

buýrugyň başynda çykýan opsiýalary ulanmak zerur:  

  Rotation (Поворот) — multitekstiň X okuna görä goşmaça öwrülmegini 

belleýär;  

  Line spacing (Межстрочный интервал) — setir ara interwaly 

dolandyrýar.  

Opsiýalaryň soňkusy saýlanylanda ulgam soraýar: 

Enter line spacing type [At least/Exactly] <At least>: (Межстрочный 

интервал [Минимум/Точно] <Минимум>:) 

At least (Минимум) opsiýasy programmanyň interwaly setirleriň 

arasyndaky iň pes aralygy saklap özi hasaplaýan ýagdaýyny belleýär. Exactly 

(Точно) opsiýasy saýlanylanda setirleriň arasyndaky aralyk tekstiň 

aýratynlyklaryna garamazdan bellenilýär. Indiki sorag запрос: 

Enter line spacing factor or distance <1x>: (Значение межстрочного 

интервала <1х>:) 

Bu ýagdaýda х harpy tekstiň harplarynyň 1,66 köpeldilmegi arkaly 

bellenilýärž şol sebäpli setirara aralygy 1,5 esse ulaltmak üçin 1,5х girizmeli. 

Ähmiýetler 0,25 we 4х aralykda bolmalydyr. 

 

Ölçegler 

 

Ölçegleri, ýazgy çygaryş çyzgylary goýma amallary Dimension (Размеры) 

menýusynyň buýruklary we Dimension (Размеры) paneliniň düwmejikleri arkaly 

ýerine ýetirilýär. 
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AutoCAD programmasy goýlan ölçegleri obýektlere assosiatiw edip goýýar, 

ýagny obýektler üýtgände olar hem şoňa görä üýtgeýär. 

Birinji buýruk — DIMLINEAR (РЗМЛИНЕЙНЫЙ) — çyzykly ölçegleri 

goýmak üçin niýetlenen.. Oňa Dimension (Размеры) paneliniň  düwmejigi we 

Dimension (Размеры) menýunyň Linear (Линейный) bendi gabat gelýär. 

Gönüburçlugyň ölçegini goýalyň. Soragyň birinji buýrugy:  

Specify first extension line origin or <select object>: (Начало первой 

выносной линии или <выбрать объект>.) 

Işi ýerine ýetirmegiň iki görnüşi bar. Birinji — wagtlaýyn ýa-da hemişelik 

obýekt baglaşdyrma arkaly göniburçlugyň ýokarky çep burçunyň nokadyny 

görkezeliň we AutoCAD ulgamynyň şeýle soragyna:  

Specify second extension line origin: (Начало второй выносной линии:) 

ýokarky sag nokady görkezeliň. Öz gezegine AutoCAD ölçeg çyzygy nirä 

goýmalygyny soraýar:  

Specify dimension line location or 

[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: Положение размерной 

линии или [Мтекст/Текст/Угол/ Горизонтальный /Вертикальный 

/Повёрнутый]:) 

Obýektde görkezilen nokatlar boýunça AutoCAD ölçegiň haýsy görnüşiniň 

(kese, dik) gurulmagy gerekdigini kesgitleýär. Ylalaşylandan soň diňe syçanjyk 

arkaly ölçegiň durjak derejesini görkezmek galýar. Gurlan ölçeg bir bitewi 

primitiw bolup durýar. Syçanjyk bilen bellenilende ol tutuşlaýyn saýlanylýar. 

Zerur bolanda ony EXPLODE (РАСЧЛЕНИТЬ) buýrugy arkaly has ýönekeý 

düzüm böleklere bölmek bolýar. 

Buýruk ýerine ýetirilende aşaky opsiýalardan peýdalanmak mümkin:  

  Mtext (Мтекст) — multitekstiň mümkinçiliklerini ulanýan has çyşyrymly 

ölçeg tekstini girizmek;  

  Text (Текст) — deslapdan hödürleýän tekstden tapawutly ölçeg teksti 

girizmek;  

  Angle (Угол) — ölçeg çyzyga görä ölçeg tekstiniň burçuny görkezmek;  

  Horizontal (Горизонтальный) — kese ölçegi goýmak;  

  Vertical (Вертикальный) — dik ölçegi goýmak;  

  Rotated (Повернутый) — öwrülen (eňňitli) ölçegigoýmak; AutoCAD 

sorar: Specify angle of dimension line: (Угол поворота размерной 

линии:).  

Iki nokady görkezmegiň deregine <select object> (<выбрать объект>) 

opsiýasyny ulanmak mümkin, ol birinji çykaryş çyzygyň deregine Enter basylsa 

güýje girýär:  

Select object to dimension: (Выберите объект для нанесения размера:) 

Kesimi ýa-da poliçyzygyň göniçyzykly bölegini görkezmek gerek. 
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Ölçegi käbir parametrleri amatly bolmasa, Buýruk setirinde DIMSCALE 

ýazyp we Enter basyp olary üýtgetmek mümkin, ýagny tekstiň ululygyny.  

DIMALIGNED (РЗМПАРАЛ) buýrugy, oňa Dimension (Размеры) 

paneliniň  düwmejigi ýa-da Dimension (Размеры) menýunyň Aligned 

(Параллельный) bendi gabat gelýär, ol saýlanan kesime ýa-da iki görkezilen 

nokada ölçegi parallel goýmagy mümkin edýär. 

DIMORDINATE (РЗМОРДИHATА) buýrugy görkezilen nokadyň 

abssisasyny ýa-da ordinatasynyň ähmiýetini görkezmek üçin ulanylýar. Bu 

buýruga Dimension (Размеры) paneliniň  düwmejigi we Dimension (Размеры) 

menýunyň Ordinate (Ординатный) bendi gabat gelýär. Birinji sorag:  

Specify feature location: (Укажите положение элемента:). Kooordinatasy 

çykarylyp görkeziljek nokady görkezmek gerek. Indiki sorag: 

Specify leader endpoint or fXdatum/Ydatum/Mtext/Text/AngleJ: 
(Конечная тонка выноски или [Хзначение/Узначение/Мтекст/Текст/Угол]:)  

Çykaryş çyzygy gutarjak nokady görkezmeli. Şonda ulgamyň özi haýsy 

koordinatany görkezmegi özi kesgitlejek bolýar. 

Buýrugyň beýleki opsiýalary:  

  Xdatum (Хзначение) — abssisanyň çykarylmagyny görkezmek;  

  Ydatum (Узначение) — ordinatanyň çykarylmagyny görkezmek;  

  Mtext (Мтекст) — multitekstiň mümkinçiliklerini ulanýan has çyşyrymly 

ölçeg tekstini girizmek;  

  Text (Текст) — täze teksti girizmek;  

  Angle (Угол) — çykaryş ýazgynyň eňňitlik burçuny görkezmek.  

 

DIMRADIUS (РЗМРАДИУС) buýrugyna Dimension (Размеры) paneliniň 

 düwmejigi we Dimension (Размеры) menýunyň Radius (Радиус) bendi gabat 

gelýär. Buýruk radiusyň ölçegini goýmak üçin niýetlenen we başda şu soragy 

berýär:  

Select arc or circle: (Выберите дугу или круг:) Soňra: Specify dimension 

line location or [Mtext/Text/Angle]: (Положение размерной линии или 

[Мтекст/Текст/Угол]:) Ölçeg çyzygyň ýerleşiş nokady ölçegiň daşynda ýa-da 

içinden goýuljakdygyny çözýär.  

DIMDIAMETER (РЗМДИАМЕТР) buýrugy dimateri goýmak üçin 

niýetlenen. Oňa Dimension (Размеры) paneliniň  düwmejigi we Dimension 

(Размеры) menýunyň Diameter (Диаметр) bendi gabat gelýär.  

DIMANGULAR (РЗМУГЛОВОЙ) buýrugy kesimleriň arasynda we 

halkanyň (ýa-da tegeliň böleginiň) burç ölçeglerini goýmak üçin niýetlenen. Oňa  

Dimension (Размеры) paneliniň  düwmejigi we Dimension (Размеры) 

menýunyň Angular (Угловой) bendi gabat gelýär. Buýruk soraýar: 

Select arc, circle, line, or <specify vertex>: (Выберите дугу, круг, 

отрезок или <указать вершину >:) Munuň üçin halkany, ýa-da tegelegi (onda iki 

görkezilen nokatlaryň arasyndaky halkanyň ölçegi görkezilýär), ýa-da kesimi 

(soňra ýene bir kesim soralýar we olaryň arasynda burç ölçenilýär). Eger Enter 
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basylsa, onda AutoCAD запросит üç nokady sorar — burçuň depesini birinji we 

ikinji ahyrky nokatlary. 

QDIM (БРАЗМЕР) buýrugy birgörnüşli ölçegleriň we ölçeg zynjyrlaryň 

toparlarynyň tiz döredilmegi üçin niýetlenen. Buýruga Dimension (Размеры) 

paneliniň  düwmejigi we Dimension (Размеры) menýunyň Quick Dimension 

(Быстрый размер) bendi gabat gelýär. Buýrugyň birinji soragy:  

Associative dimension priority = Endpoint Select geometry to 

dimension: (Приоритет ассоциативного размера = Конточка Выберите 

объекты для нанесения размеров:) Bir görnüşli ölçeglerini goýmak zerur bolan 

obýektleri görkezmeli. Soňra:  

Specify dimension line position, or 

[Continuom/Staggered/Baseline/Ordinate/Radius/Dlameter/datumPoint/Edit/ 

seTtings] <Continuous>: (Положение размерной линии или 

/Цепь/Ступенчатый/Ъазовый/Ординатный/ Радиус/Диаметр/Точка/Изменить/ 

Установки] <Цепь>:). Ölçeg çyzygyň ýerleşiş ýerini görkezmekden başga şu 

opsiýalardan peýdalanmak mümkin:  

 Continuous (Цепь) — ölçeg zynjyry bellemek;  

 Staggered (Ступенчатый) — basgançaklaýyn ölçegleri bellemek;  

 Baseline (Базовый) — baza ölçegleri bellemek;  

 Ordinate (Ординатный) — ordinata ölçegleri bellemek;  

 Radius (Радиус) — radiuslary goýmaklyk;  

 Diameter (Диаметр) — diametrleri goýmaklyk;  

 Datum Point (Точка) — baza ýa-da ordinata ölçegleri üçin täze baza 

nokadynyň saýlaylmagy;  

 Edit (Изменить) — birnäçe ölçegleriň üýtgedilmegi (AutoCAD bar bolan 

ölçegleriň nokatlaryny goşmagy ýa-da aýyrmagy soraýar;  

 seTtings (Установки) — ileri tutuljak obýekt baglaşdyrmagyň beýleki 

funksiýasynyň saýlanylmagy.  

DIMBASELINE (РЗМБАЗОВЫЙ) buýrugy şol bir baza nokadyndan 

birnäçe çyzyk ölçegleri gurmaga mümkinçilik berýär. DIMBASELINE 

(РЗМБАЗОВЫЙ) buýrugy, klawiaturadan başga, Dimension (Размеры) paneliniň 

 düwmejigi ýa-da Dimension (Размеры) menýunyň Baseline (Базовый) bendi 

arkaly çagyrylyp bilner. Buýruk birinji çyzygyň ýerleşişini soramaýar hem-de 

ikinjini sorap başlaýar:  

Specify a second extension line origin or [Undo/Select] < Select >: 

(Начало второй выносной линии или [Отменить/Выбрать] <Выбрать>:) Baza 

ölçegleriň toparyň bazasy hökmünde adatça öňündä çyzyk ölçegi gulluk edýär we 

onuň birinji nokady indiki çyzyk (baza) ölçegler üçin birinji nokat bolup durýar. 

Ikinji nokat saýlanandan soň, gaýtalanyş bilen indiki nokatlary hem görkezmek 

bolýar  we olaryň saýlanmagyny Esc düwmejigi bilen tamamlap bolar. Eger ulgam 

soňky ölçegi kesgitläp bilmese onda goşmaça sorýar:  

Select base dimension: Linear, Ordinate, or Angular Associative 

Dimension Required (Выберите исходный размер: Выбрать линейный, 

ординатный или угловой размер) Undo (Отменить) DIMBASELINE 
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(РЗМБАЗОВЫЙ) buýrugyň soňky ädimini ýatyrýar, Select (Выбрать) opsiýasy 

bolsa baza hökmünde beýleki ölçegi saýlamagy mümkin edýär.  

DIMCONTINUE (РЗМЦЕПЪ) buýrugy biri birine dowam bolup durýan 

birnäçe çyzyk ölçegleri gurmagy mümkin edýär. DIMCONTINUE (РЗМЦЕПЬ) 

buýrugy Dimension (Размеры) paneliniň  düwmejigi ýa-da Dimension 

(Размеры) menýunyň Continue (Цепь) bendi arkaly çagyrylyp bilner. 

 

Ştrihleme we reňk berme 

 

Suratyň ýapyk töwereklerini ştrihlemek üçin ВНАТСН (КШТРИХ) 

buýrugy gulluk edýär, ol Draw (Рисование) paneliniň  düwmejigi ýa-da Draw 

(Рисование) menýunyň Hatch (Штриховка) bendi arkaly çagyrylýar. ВНАТСН 

(КШТРИХ) buýrugy ýapyk çyzyk bilen çäklendirilen töwerekleriň ştrihlemesini 

we reňk bilen doldurylmagyny hem-ä suduryň içinde nokatlary görkezmek arkaly, 

hem-de obýektleri saýlamak arkaly amala aşyrýar. Bu buýruk awtomatiki sudury 

kesgitleýär we oňa degişli bolmadyk primitiwlere degmeýär. Boundary Hatch 

and Fill (Штриховка и заливка по контуру) dialog penjiresini çagyrýar. 

  

Dialog penjiresi biri birini çalşyrýan üç goşmaça eýe. Hatch (Штриховка) 

ştrihlemegiň parametrini belleýär. Ştrihleme bilen doldurylýan töwerek bu 

penjiräniň sag tarapyndaky parametrler bilen bellenilýär. Туре (Тип) sanawy 

ştrihlemegiň aşaky nusgalaryny hödürleýär:  

  Predefined (Стандартный);   

  User defined (Из линий);   
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  Custom (Пользовательский).  

AutoCAD ulgamy standart ştrihlemekligiň uly sanawyny hödürleýär. 

Ştrihlemegiň saýlanylmagy Pattern (Образец) sanawy arkaly amala aşyrylýar ýa-

da wizual taýdan köp nokatly şekilli düwmejige basyp. 

Standart nusgalaryň sanawynda SOLID atly ştrihleme bar,  ol ştrihleme 

bolman reňk doldurmagy amala aşyrýar. 

 

Ellips 

 

Ellips — bu nokatlaryň geometriki ýerleşişi, şonda şol nokatlardan iki 

bellenilen nokada (fokus) çenli iki aralygyň jemi deň. Ellipsleriň we eliptik 

halkalaryň gurulmagy ELLIPSE (ЭЛЛИПС) buýrugy arkaly amala aşyrylýar, ol 

Draw (Рисование) paneliniň  düwmejigi ýa-da Draw (Рисование) Draw | 

Ellipse | Axis, End (Рисование | Эллипс Ось, Конец) menýu arkaly çagyrylyp 

bilner. Birinji sorag:  

Specify axis endpoint of ellipse or [Arc/Center]: (Конечная точка оси 

эллипса или [Дуга/Центр]:) Eger birinji nokat görkezilen bolsa indiki sorag şeýle 

bolar:  

Specify other endpoint of axis: (Вторая конечная точка оси:) Bu soraga 

ellipsiň okunyň ikinji ahyrky nokadyny görkezmeli. AutoCAD ulgamy ilkinji 

nokatlar boýunça ellipsiň merkezini hasaplaýar (birinji we ikinji nokadyň 

arasyndaky kesimiň ortasy). Soňra 

: Specify distance to other axis or fRotation]: (Длина другой оси или 

(Поворот/:) Şol wagt ellipsiň ikinji okunyň uzynlygy boljak sany girizmek 

mümkin. Eger üçünji nokat görkezilse, onda ulgam merkezden şol nokada çenli 

bolan aralygy ölçär we ony ikinji okuň daýnasy hökmünde alar we bu maglumatlar 

boýunça ellipsi gurar. Eger soňky ýagdaýda daýnanyň deregine Rotation 

(Поворот) opsiýasy saýlanylsa onda ellips XY tekizligine göräleýin görkezilen  

burça öwrülen tegelegiň proýeksiýasy hökmünde gurular (has takyklaýyn, baş 

okuna göräleýin). Eger burç nola deň bolsa, onda adaty tegelek emele geler. Eger 

birinji soraga jogap hökmünde Center (Центр) opsiýasy saýlanylsa — indiki 

habar şeýle bolar:  

Specify center of ellipse: (Центр эллипса:) Ellipsiň merkezi görkezilenden 

soň şu soralar: Specify endpoint of axis: (Конечная точка оси:) Mundan soň öň 

görkezilen ýaly ahyrky sorag berilýär (Specify distance to other axis or 

[Rotation]: (Длина другой оси или [Поворот/:)).  

Elliptik halkasyny gurmak üçin ELLIPSE (ЭЛЛИПС) buýrugynda в ответ 

birinji soraga jogap hökmünde Arc (Дуга) opsiýasyny saýlamaly. Edil şeýle işi 

Draw (Рисование) paneliniň  düwmejigi we Draw | Ellipse Arc (Рисование | 

Эллипс Дуга) bendi ýerine ýetirýär. AutoCAD ulgamynyň indiki soragy:  

Specify axis endpoint of elliptical arc or [Center]: (Конечная точка оси 

эллиптической дуги или [Центр]:) Soňra: Specify other endpoint of axis: 

(Вторая конечная точка оси:) Indiki sorag: Specify distance to other axis or 
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[Rotation]: (Д/шна другой оси или [Поворот]:) Indi halkany ellipsiň bölegi 

hökmünde bellelem boýunça sorag berilýär:   

Specify start angle or [Parameter]: (Начальный угол или /Параметр]:) 

Başlangyç burç san ýa-da syçanjyk bilen birinji oka görä görkezilýär (sanama sagat 

ugruna garşy okuň birinji nokadyndan alnyp barylýar). Soňra:  

Specify end angle or [Parameter/Included angle]: (Конечный угол или 

[Параметр/Внутренний угол]:) Ahyrky burçy görkezmek bolar ýa-da Included 

angle (Внутренний угол) opsiýasyny saýlap halkanyň içerki (merkezi) burçuny. 

SPLINE (СПЛАЙН) buýrugy — berlen nokatlardan takyk geçýän ýa-da 

elýeterligiň çäginde olardan gyşarýan başlangyç, ahyrky we iki nokatda 

galtaşmagyň şertine gabat gelýän ýylmanak çyzygy – splaýny çyzmak üçin 

niýetlenen. Buýruk klawiaturadan başga Draw (Рисование) paneliniň  

düwmejigi ýa-da Draw (Рисование) menýunyň Spline (Сплайн) bendi arkaly 

çagyrylyp. Buýrugyň başlangyç soragy:  

Specify first point or [Object]: (Первая точка или [Объект]:) Eger nokat 

görkezilse, onda şu sorag beriler: Specify next point: (Следующая точка:) Ikinji 

nokat girizilenden soňra indiki nokatlaryň görkezilmegi ýa-da Close (Замкнуть) 

opsiýasy arkaly ýapylma mümkin:  

Specify next point or [Close/Fit tolerance] <start tangent >: (Следующая 

тонка или [Замкнуть/Допуск] <касательная в начале>:) Enter basylsa 

galtaşmagyň başlangyç burçy görkeziler:  

Specify start tangent: (Касательная в начальной точке:) Eger ýapylan 

splaýn gurulsa, onda galtaşma bolan sorag biraz üýtgär: Specify tangent: 

(Направление касательной:) Burç san ýa-da syçanjyk arkaly görkezilip bilner. 

Eger Enter basylsa, onda başlangyç nokatda çyzygy gurmak üçin araçäk şerti 

ulanylmaýar. Eger splaýn ýapyk däl bolsa, onda başlangyç galtaşma çyzyk 

soralynandan soň soňky nokatda galtaşmagyň ugry barada sorag berilýär: Specify 

end tangent: (Касательная в конечной точке:)  

Eger birinji nokadyň deregine Object (Объект) opsiýasy saýlanylsa, 

AutoCAD ulgamy öň gurulan we Spline (Сплайн) opsiýasy bilen ýylmanan iki 

ölçegli we üç ölçegli poliçyzyklaryň splaýnlara özgermesine başlar  we şu soragy 

berer: Select objects to convert to splines... Select objects: 'Выберите объекты 

для преобразования в сплайны... Выберите объекты:). 

 

Seýrek primitiwlere zolaklar we figuralar degişli bolup biler. TRACE 

(ПОЛОСА) buýrugy diňe klawiaturadan girizilýär we hemişelik inli döwülen 

çyzyklary – zolaklary çyzmak üçin niýetlenen. Birinji sorag: 

Specify trace width <1.0000>: (Ширина полосы <1.0000>:) Ini san bilen 

ýa-da iki nokat bilen görkeziň. Indiki sorag: Specify start point: (Начальная 

точка:) Zolagyň oklaýyn çyzygyň başlangyç nokadyny görkezmeli. Soňra:  

Specify next point: (Следующая точка:) Gaýtalanyşda nobatdaky 

nokatlary görkeziň we gurmagy Enter düwmejigi bilen tamamlamaly. Segmentler 

bir bitewi obýekti emele getirmeýär.  
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SOLID (ФИГУРА) buýrugy — yzygiderli ýerleşen reňklenen dört 

burçluklary ýa-da üç burçluklary gurýar. Dörtburçlugyň depeleri aşaky nokatlar 

bilen gurulýar:  

Specify first point: (Первая точка:) soňra: Specify second point: {Вторая 

тонка:) Mundan beýläk: Specify third point: (Третья точка:) Dörtburçlugyň 

üçünji nokady hökmünde diagonal boýunça ikinji nokadyň garşynda ýerleşen 

nokady görkezmeli (ýogsam figura towlanan bolar). Soňra dördünji nokat soralýar. 

Eger dördünji nokadyň deregine Enter basylsa, onda üçburçly figura gurulýar. 

Specify fourth point or <exit>: (Четвертая точка или <выход>:) Soňra 

ýene üçünji nokat soralýar, sebäbi nobatdaky dörtburçlugyň birinji we ikinji  

nokady bolup ondan öňki dörtburçlugyň üçünji we dördünji nokat bolup biler. 

Üçünji nokadyň deregine Enter basylsa buýruk tamamlanar. 

SOLID (ФИГУРА) buýrugy bilen gurulan figuralar bir bitewi obýekti 

gurmaýarlar. 

 

Işiň dowamynda örän peýdaly bolup maglumat buýruklary bolýar. Olary 

Inquiry (Справки) panelinde çagyryp bolýar:  

  Distance (Расстояние);  

  Area (Площадь);  

  Region/Mass Properties (Область/Масса);  

  List (Список);  

  Locate Point (Координаты). 

  

 
 

Bu amalla şeýle hem Tools (Сервис) menýunyň Inquiry (Сведения) kömekçi 

menýusy arkaly çykyp bolýar: 

  DIST(ДИСТ);  

  AREA (ПЛОЩАДЬ);  

  MASSPROP (МАСС-ХАР);  

  LIST (СПИСОК);  

 ID (КООРД). 

 

Tejribe işleri 

 

1) 20x35 ölçegde göniburçlugy gurmaly 

2) Radiusy R=50 bolan tegelegi gurmaly 

3) Uzynlygy 45 bolan we x okuna 560 gradus bilen duran kesimi gurmaly 

4) Dogry üçburçlugy gurmaly 

5) Daşyndan aýlanan tegelegiň radiusy R=36 bolan dogry altyburçlugy 

gurmaly 

6) Içinden aýlanan tegelegiň radiusy R=18 bolan dogry sekizburçlugy 

gurmaly 



 164 

7) 6 göni çyzykdan we 7 sany egri çyzykdan ybarat bolan poliçyzygy 

gurmaly 

8) 20x35 ölçegde göniburçlugyň hemme tarapynyň ölçeglerini goýmaly 

9) Radiusy R=50 bolan tegelegiň ölçeglerini 

10) 3 mysalda görkezilen çyzygyň burçunyň ölçegini goýmaly 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

GEOMETRIÝANY REDAKTIRLEMEK 

 

 Geometriýany redaktirlemek aşakdaky usullar arkaly mümkin:  

 eljagazlar arkaly primitiwleri redaktirlemegiň amallary;  

 umumy redaktirlemegiň buýrujlary - göçürme, ýerini üýtgetme, uzynlatma 

we ş.m.;  
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 çylşyrymly primitiwleri redaktirlemegiň ýörite buýruklary.  

 

Eger buýruk setirinde Command: (Команда:) çagyryşy bar bolsa, onda 

ekranda görünýän obýektleri belläp bolýar we olarda eljagazlar – obýektleriň 

mahsus nokatlarynda gök inedördüller emele geler.  

LINE (отрезок) primitiwi üçin mahsus nokatlar bolup ahyrky we ortaky 

nokat bolýar. Öň gurlan kesim boýunça syçanjyk bilen basyň. Ahyrky we ortaky 

nokatlar reňk bilen bellenilýär. 

Adatça saýlanan obýektleriň eljagazlary gök reňke eýe bolup durýar. Emma, 

eger kursor haýsy-da bolsa nikadyň üstünde geçirilen mahaly ol ýaşyl reňke eýe 

bolar. Eger syçanjyk bilen nokada çep düwmejigi bilen bilen basylsa on ol gyzyl 

reňke eýe bolar AutoCAD şeýle habar berýär:  

** STRETCH ** Specify stretch point or [Base point/Copy/Undo/eXit]: 

(** РАСТЯНУТЬ ** Точка растягивания или [Базовая 

точка/Копировать/Отменить/выХод]:) Eger klawiaturada 90,240 ýazylsa we 

Enter basylsa – kesim derrew üýtgär: onuň bellenilen nokady X = 90, Y = 240 

koordinatalara eýe bolar. Nokadyň ýerini şeýle hem hem syçanjyk bilen goýup 

bolýar. 

Eger eljagaz saýlanylandan soňra Enter ýa-da Space (<Пробел>) klawişalar 

basylsa, onda AutoCAD meňzeş ýöne MOVE (ПЕРЕНЕСТИ) buýrugyna degişli 

bolan soragy hödürleýär. Yzygiderli Enter basylsa onda ROTATE 

(ПОВЕРНУТЬ), soňra SCALE (МАСШТАБ), mundan soň bolsa - MIRROR 

(ЗЕРКАЛО), soňra bolsa ýene STRETCH (РАСТЯНУТЬ) buýrugyň soraglary 

emele gelýär. 

Eger syçanjyk bilen ahyrky eljagaz dälde, ortakysy saýlanylsa, onda 

AutoCAD oňki soragyň edil şol opsiýalary bilen teksti hödürleýär. Syçanjyk bilen 

ortaky nokady görkeziň. Kesim täze ýere geçer.  

XLINE (прямая) primitiwde baza nokady we ondan uly bolmadyk aralykda 

iki nokat bellenilýär. Eger baza nokady bilen geçirilse, onda tutuş göni çyzyk 

geçirilýär, eger beýleki nokatlar bilen geçirilse, onda baza nokady öňki ýerde 

galýar, göni çyzygyň bolsa eňňitligi üýtgeýär. 

Edil şol ýaly şöhlelery redaktirlemek üçin eljagazlaryň ulanylmagy 

(primitiwiň ady — RAY). Şöhlede iki eljagaz bellenilýär: baza nokadyndaky we 

ugry kesgitleýän nokatda. Baza nokady geçirilse tutuş şöhle geçirilýär, ikinji nokat 

geçirilse şöhläniň eňňitligi üýtgeýär.  

Tegelekde (CIRCLE) 5 nokat bellenilýär: merkezde we kwadrantlarda. 

Merkezdäki eljagaz geçirilende tegelek täze ýere geçirilýär, beýleki galan nokatlar 

boýunça üýtgedilende tegelek giňelýär ýa-da gysylýar. 

ARC (дуга) primitiwde üç eljagaz bellenilýär: ahyrlarynda we merkezinde. 

Eljagazyň islendiginiň süýşürilmegi üç nokadyň esasynda täze halkanyň 

gurulmagyna getirer. 

Poliçyzyk LIST (СПИСОК) buýrugyň maglumat sahypasynda iki at bilen 

görkezilip bilner: LWPOLYLINE, ýagny kompakt poliçyzyk, we POLYLINE, 

ýagny doly poliçyzyk. Kompakt poliçyzygy käwagt ýeňil diýip atlandyrýarlar. 

Eljagazlar poliçyzykda segmentleriň ahyrynda we halka segmentleriň ortaky 
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nokatlarynda bellenilýär. Saýlanan eljagaz täze ýere geçirilende göniçyzykly 

segmentler edil kesimleriň ahyrky nokatlary çekilende üýtgeýşi ýaly üýtgeýär, 

halka segmentler bolsa  edil halkalaryň üýtgeýşi ýaly. 

MLINE (мультилиния) primitiw eljagazlar arkaly edil poliçyzyklar ýaly 

üýtgeýär.  

TEXT (текст) we МТЕХТ (мультитекст) primitiwler tekstiň ýerleşişini we 

deňlemesini häsiýetlendirýän nokatlarda eljagazlara eýe bolýarlar. Eljagazyň 

islendigi teksti täze ýere süýşürmek üçin ulanylyp bilner. Deňlemegiň käbir 

usullarynda (Fit (По ширине), Aligned (впИсанный)) bir nokadyň hereketi şeýle 

hem tekstiň eňňitligini üýtgedip bilýär. Dimension (Размеры) menýusynyň 

buýruklary DIMENSION (размер), LEADER (выноска) we TOLERANCE 

(допуск) primitiwleri döredýär. Primitiwleriň üýtgedilmegi islendik eljagaz 

boýunça amala aşyrylyp bilner, ol bolsa olaryň s.ýş.rilmegine we görnüşiniň 

üýtgedilmegine getirer. 

Emma ölçeg eljagaz bilen redaktirlenende eljagazlary diňe ölçegli 

primitiwde bellemänž eýsem obýektiň özünde hem bellemek gerek. Eger ölçegiň  

çykaryş çyzygy berkidilen eljagazy syçanjyk bilen hereketlendirilse, onda  diňe 

esasy obýektiň üýtgedilmegi bolman, onuň ölçeg primitiwiň hem üýtgedilmegi 

bolup geçýär. 

DIMENSION primitiwi diňe baza nokatlarynda eljagazlara eýe bolman, 

eýsem çykaryş çyzyklarda we ölçeg tekstinde hem olara eýe bolup durýar. Bu 

eljagazlar çykaryş çyzygyň we ölçeg tekstiň ýerleşişini üýtgetmäge kömek berýär. 

HATCH (штриховка или заливка) primitiwiň eljagazlar arkaly 

redaktirlenmesi netijeli däl, sebäbi ştrihleme agyrlyk merkezinde bolan diňe bir 

eljagaza eýe we onuň bilen ştrihlemegi diňe täze ýere geçirip bolýar. Öol bir 

wagtad hem ştrihlemegiň assosiatiwlilik häsiýetini ýada salmak gerek. Şol boýunça 

suduryň redaktirlenmesi oňa bagly edilen ştrihlemegiň üýtgedilmegine getirer.  

Ellipsiň we elliptik halkanyň eljagazlary dürli ýerlerde bellenilýär. Doly 

ellipsde olaryň ýerleşişi tegelegiň eljagazlarynyň ýerleöiöine meňzeş. Merkezi 

eljagaz hereketlendirilende tutuö ellip hereketlenýär. Eger elliptik halkanyň 

merkezi nokady süýşürilse bolsa, bu halkanyň üýtgedilmegine getirer, sebäbi 

AutoCAD halkanyň ahyrky nokatlaryny öňki ýerinde saklajak bolýar. 

SPLINE (сплайн) primitiwiň eljagazlar arkaly redaktirlenmesi poliçyzygyň 

redaktirlenmesine meňzeş, emma bir eljagazyň herketlenmesi splaýnyň beýleki 

böleklerine täsir edýär.  

Eger eljagazlar arkaly TRACE (полоса) primitiwi redaktirlesek, onda то ol 

figura öwrülýär. Edil şeýle SOLID (фигура) primitiwi redaktirlenýär. 

Eljagazlar bilen redaktirlemede amatly gural bolup kontekst menýusy çykyş 

edýär. Eger redaktirlenem üçin eljagaz saýlanan bolsa hem-de syçanjygyň sag 

düwmejigi basylsa onda aşakdaky kontekst menýu çykar. 
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 Enter — Enter düwmejigiň basylmagy (umumy redaktirleme buýruklaryň 

gaýtalanyş ýagdaýda saýlanmagy);  

 Move (Перенести) — obýektleri geçirmek (MOVE (ПЕРЕНЕСТИ) buýrugy);  

 Mirror (Зеркало) — obýektleri simmetriýalamak (MIRROR (ЗЕРКАЛО) 

buýrugy);  

 Rotate (Повернуть) — obýektleri öwürmek (ROTATE (ПОВЕРНУТЬ) 

buýrugy);  

 Scale (Масштаб) — baza nokadyna göräleýin obýektleri masştablamak (команда 

SCALE (МАСШТАБ) buýrugy);  

 Stretch (Растянуть) — obýektleri süýndürmek (STRETCH (РАСТЯНУТЬ) 

buýrugy);  

 Base Point (Базовая точка) — STRETCH (РАСТЯНУТЬ) buýrugy ýerine 

ýetirmek üçin başga baza nokady görkezmek;  

 Сору (Копировать) — obýektleri göçürip almak (COPY (КОПИРОВАТЬ) 

buýrugy);  

 Reference (Ссылка) — ROTATE (ПОВЕРНУТЬ) buýrugy üçin Reference 

(Опорный угол) opsiýasyny ýa-da SCALE (МАСШТАБ) buýrugy üçin 

Reference (Опорный отрезок) opsiýasyny saýlamak;  

 Undo (Отменить) — soňky buýrugyň hereketini ýatyrmak (U (О) buýrugy 

 Properties (Свойства) — obýektleriň häsiýetlerini dolandyrmak (PROPERTIES 

(OKHOCB) buýrugy);  

 Exit (Выход) — eljagazlar bilen redaktirlemek düzgüninden çykmaklyk. 

 

Eger belli bir nokat saýlanmadyk bolsa we syçanjygyň sag düwmejigine 

basylsa başga kontekst menýu çagyrylar.  
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Bu menýunyň düzümi ondan öňki kontekst menýunyňka meňzeşdir, emma 

onda  Erase (Стереть) diýen we obýektleri ýok edýän bent emele geldi. 

Ilkinji bolup kontekst menýusyna soňky buýrugyň gaýtalanyşy 

ýerleşdirilýär. Eger poliçyzyk saýlanylsa, onda bu menýuda goşmaça ikinji bent 

emele gelýär — Polyline Edit (Редактировать полилинию). Onuň emele gelmegi 

obýektiň görnüşi bilen bagly, sebäbi çyžşyrymly obýektleriň redaktirlemegiň 

aýratyn buýruklary bar. 

Properties (Свойства) bendi PROPERTIES (ОКНОСВ) buýruga gabat 

gelýär we häsiýetleriň üýtgeme penjiresini çagyrýar. 

Deselect All (Отменить выбор) bendi eljagazlaryň görkezilmegini aýyryp 

bilýär. 

Beýleki bentler adatça aktiw buýruklar ýok mahaly syçanjygyň sag 

düwmejigi basylanda çykýan kontekst menýunyň düzümine girýär.  

Quick Select (Быстрый выбор) bendi QSELECT (БВЫБОР) buýrugyna gabat 

gelýär we Quick Select (Быстрый выбор) gepleşik penjiresini çagyrýar, ol bolsa 

has takyk ýagdaýda (reňk, çyzygyň görnüşi, gatlak boýunça we ş.m.) täze ýa-da 

häzirki toplanyşa girizmek ýa-da aýyrmak üçin obýektleri saýlap almagy 

tizleşdirýär. 
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Quick Select (Быстрый выбор) penjiresiniň düzümi obýektleri saýlamagyň 

deňlemesini düzmegi mümkin edýär meselem, = Equals (= Равно), <> Not Equal 

(<> Не равно), > Greater than (> Больше), < Less than (< Меньше), Select All 

(Выбрать все). Gerek bolan amal Operator (Оператор) sanawynda goýulýar. 

Mundan başga hem aşaky meýdanlar ulanylýar:  

  Apply to (Применить) — amaly nämä ulanmagy görkezýär (Entire 

drawing (К целому рисунку), Current selection (К текущему набору));  

  Object type (Тип объектов) — obýektleriň görnüşiniň sanawyny saklaýar 

(Line (Отрезок), Polyline (Полилиния) we ş.m.) tutuş suratyň ýa-da 

häzirki toplanyşyň; Multiple (Несколько) primitiwleriň birnäçe 

görnüşleriniň bellenilendigini görkezýär;  

  Properties (Свойства) — saýlamagy amala aşyrmak mümkin bolan 

häsiýetleriň sanawyny saklaýar (Color (Цвет), Layer (Слой). Linetype 

(Тип линии), Linetype scale (Масштаб типа линии), Plot style (Стиль 

печати), Lineweight (Вес линии), Hyperlink (Гиперссылка)); eger 

häzirki toplanyşda obýektler bar bolsa, onda sanaw anyk görnüşli 

obýektleriň häsiýetlerini saklap biler (Area (Площадь), Closed (Замкнуто), 

Thickness (Высота), Global width (Глобальная ширина) we ş.m.);  

  Value (Значение) — obýekteriň saýlanylmaly ähmiýetler; ähmiýetleriň 

sanawy saýlanylan häsiýetiň görnüşine bagly (meselem, Color (Цвет) 

häsiýeti üçin bu reňkleriň sanawy).  
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How to apply (Отобранные объекты) töweregi Include in new selection 

set (Включить в новый набор) we Exclude from new selection set (Исключить 

из нового набора) pereklýuçateller arkaly şol deňleme bilen saýlanan obýektleri 

täze toplanyşa ýa goşmagy, ýa-da şol berlen ölçüt boýunça toplanyşdan aýyrmagy 

mümkin edýär. Döredilýän toplanyşyň primitiwlerini häzirki toplanyşa Append to 

current selection set (Добавить к текущему набору) baýdajygy gurnap goşmak 

mümkin.  

Kontekst menýunyň indiki bendi Find (Найти) FIND (НАЙТИ) buýrugyna 

gabat gelýär we Find and Replace (Найти и заменить) gepleşik penjiresini 

çagyrýar, ol bolsa tekst primitiwlerinde setiri tapmagy (gerek bolsa çalşyrmagy) 

amala aşyrýar. 

 

Eger Command: (Команда:) buýrugyň soragyna obýektleri bellesek, onda 

bu SELECT (ВЫБРАТЬ) buýrugyň ýerine ýetirilmegine getirer. Buýrugyň özi 

klawiaturadan hem girizilip bilner: 

Select objects: (Выберите объекты:), eger klawiaturada "?" belgisini ýazyp 

soňra Enter basylsa aşakdaky ýazylar: 

Expects a point or Window/Last/Crossing/BOX/ALL/ 

Fence/WPolygon/CPolygon/Group/Add/Remove/Multiple/Previous/Undo 

/Auto/SingleSelect objects: (Требуется точка или Рамка/'Последний /Секрамка 

/БОКС/Все/Линия/РМн-угол/СМн-угол/Труппа/Добавить/'Исключить 

/Несколько/Текущий/Отменить/Авто/Единственный Выберите объекты:) 

Opsiýalar:  

 Window (Рамка) — soňra görkeziljek iki nokady ýerleşişine garamazdan 

adaty çägiň burçlary hökmünde hasaplamagy mümkin edýär;  

 Last (Последний) — ekranda görünýänlerden iň soňky çyzylan obýekti 

saýlamagy mümkin edýär;  

 Crossing (Секрамка) — soňra görkeziljek iki nokady ýerleşişine 

garamazdan kesiş çägiň burçlary hökmünde hasaplamagy mümkin edýär;  

 BOX (БОКС) — çägiň burçlaryna baglylykda çägi adaty ýa-da kesiş 

görnüşine getirýän görkeziş düzgüne geçirýär;  

 ALL (Все) — suratyň hemme doňdurylmadyk obýektlerini saýlaýar,  

 Fence (Линия) — açyk poliçyzygy gurmagy mümkin edýär we toplanyşa 

şol çyzygyň kesişip geçen obýektler goşulýar;  

 WPolygon (РМн-угол) — köp burçlugyň görnüşinde çägi gurýar we onuň 

içine düşen obýektler saýlanylýar;  

 CPolygon (СМн-угол) — kesiş çägine meňzeş emma köp burçluk 

görnüşinde;  

 Group (Группа) — topary saýlaýar (öň GROUP (ГРУППА) buýrugy bilen 

düzülen obýektleriň toplanyşyny);  

 Add (Добавить) —  toplanyşa obýekytleri goşmak düzgüne geçmekligi 

mümkin edýär;  

 Remove (Исключить) — obýektleri toplanyşdan aýyrmaklyk düzügüne 

geçmekligi mümkin edýär;  
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 Multiple (Несколько) — obýektleri reňk bilen bellemeýär we munuň bilen 

işi tizleşdirýär;  

 Previous (Текущий) — toplanyş hökmünde AutoCAD tarapyndan öň 

düzülen toplanyşy almagy mümkin edýär;  

 Undo (Отменить) — obýekti toplanyşa goşmagyň ýa-da aýyrmagyň soňky 

amalyny ýatyrýar;  

 AUto (Авто) — awtomatiki saýlamagyň düzgüne geçirýär. Munda görkeziş 

nokatda obýekt görkezgije düşse onda ol saýlanýar, başga ýagdaýda bolsa 

girizilen nokat adaty ýa-da kesiş çägiň birinji nokady bolup durýar;  

 Single (Единственный) — diňe bir obýekti saýlaýyş düzgüne geçirýär, 

obýekt saýlanylsa amal tamamlanýar. 
 

GROUP (ГРУППА) buýrugy Object Grouping (Группы объектов) 

gepleşik penjiresini açýar. 

 

 

Umumy redaktirlemegiň buýruklary 

 

Obýektleri redaktirlemegiň buýruklarynyň düwmejikleri (göçürme, geçirme, 

uzaltma we ş.m.) Modify (Редактирование) panelinde ýerleşdirilen.  

 
 

Bu buýruklaryň her birini, klawiaturadan ady boýunça girizip bolýar, şeýle 

hem Modify |Редакт) menýusyndan çagyryp bolýar. Bu toparyň köp buýruklary 
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öňünden saýlanan obýektleriň toplanylyşy bilen işleýär ýa-da, eger şol toplanyş 

ýok bolanda Select objects (Выберите объекты) soragy berýärler. Galan 

buýruklar redaktirlenýän obýektleri degişli halatda soraýarlar. 

ERASE (СТЕРЕТЬ) buýrugyna gabat gelýän  düwmejigi, ekrandan 

saýlanan obýektleri aýyrýar we olary suratdan ýok edýär. 

Bu buýrugyň hereketiniň netijesi, edil beýleki buýrugyňky ýaly Standard 

(Стандартная) paneliniň   düwmejigi ýa-da U (О) we UNDO (ОТМЕНИТЬ) 

buýruklar arkaly ýatyrylyp bilner.  

COPY (КОПИРОВАТЬ) buýrugyň  düwmejigi saýlanan obýektleri 

ilkinji we ahyrky nokatlar bilen kesgitlenýän wektora parallel edilip göçürýär. Eger 

buýruk goýberilende saýlanan obýektler ýok bolsa, onda obýektleri saýlamak 

barada sorag berilýär. Obýektler saýlanan soňra saýlawy Enter, ýa-da syçanjygyň 

sag düwmejigi arkaly bes etmeli. Obýektler saýlanan soňra birinji sorag: 

 Specify base point or displacement, or [Multiple]: (Базовая точка или 

перемещение, или {Несколько!:) Birinji nokady görkeziň. Indiki sorag:  

Specify second point of displacement or <use first point as displacement: 
(Вторая точка перемещения или <считатъ перемещением первую точку>:)  

Ikinji nokady görkeziň. Netijede saýlanan obýektleriň göçürmesi emele geler, ol 

nusgasyndan berlen wektora süýşürilen bolar. 

Eger ikinji nokadyň deregine Enter düwmejigi basylsa, onda birinji girizilen 

nokadyň koordinatlary hereketlendirişiň koordinatlary bolup durýar. Meselem, 

eger haýsy-da bolsa bir obýekti göçürmeli bolsa we göçürme nusga görä X oky 

boýunça 145 mm-e we У oky boýunça -3,75mm-e süýşürilmeli bolsa, onda birinji 

nokady girizmek boýunça soraga 145,-3.75 girizmeli. Soňra ikinji nokada bolan 

soraga Enter düwmejigi basyň. 

Multiple (Несколько) opsiýasy saýlanan obýektleri köp gezek göçürmek 

üçin niýetlenen. Buýrugyň tamamlanmagy Enter düwmejigiň we syçanjygyň sag 

düwmejiginiň basylmagy. 

MIRROR (ЗЕРКАЛО) buýrugynyň  düwmejigi saýlanan obýektleri iki 

nokat bilen kesgitlenýän oka görä simmetriýaly göçürmek üçin niýetlenen.  

Obýektler saýlanandan soň AutoCAD soraýar: 

 Specify first point of mirror line: (Первая точка оси отражения:)  

Soňra jogapdan soň, ikinji nokat soralýar: 

Specify second point of mirror line: (Вторая точка оси отражения:)   

Ikinji nokady görkeziň. 

Mundan soň başlangyç obýektleri ýok etmeli ýa saklamaly barada sorag 

berler: 

Delete source objects? [Yes/No] <N>: (Удалить исходные 

объекты?[Да/Нет] <Н>:) 

Bellik. Simmetriýalanýan obýektleriň arasynda tekstler bar bolsa, olar hem oka 

görä simmetriýalanylýar we käwagt okalmaýan ýagdaýa gelýärler. Tekstler 

öwrülmez ýaly MIRRTEXT ulgam üýtgeýäni üçin 0 ähmiýeti goýmaly. 
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 düwmejigi OFFSET (ПОДОБИЕ) buýrugyna gabat gelýär. Şeýle hem 

buýrugy Modify (Редакт) menýusyndan Offset (Подобие) bendi arkaly çagyryp 

bolýar. 

Bu buýruk çyzykly obýektlere (kesimlere, şöhlelere, göni çyzyklara, 

poliçyzyklara, halkalara, tegeleklere, ellipslere we splaýnlara) meňzeş (parallel) 

çyzyklary çyzmak üçin niýetlenen. Parallel çyzygy çyzmagyň iki görnüşi bar: 

nusgadan belli bir aralyk we berlen nokatdan. Buýrugyň birinji soragy: 

Specify offset distance or [Through] <Through>: (Величина смещения 

или [Точка] < Точка >:)  

Burçly ýaýyň içinde deslapdan bolan ähmiýet durandyr (öňki ýerine ýetirilen 

buýrukdan galan, ol položitel san ýa-da Through (Точка) opsiýanyň ady bolup 

biler. 

Eger aralyk san bilen girizilende şeýle sorag berilýär:  

Select object to offset or <exit>: (Выберите объект для создания подобных 

или <выход>:) 

Bir obýekti görkeziň. Soňra AutoCAD obýektden haýsy tarapa parallel 

çyzygy gurmagy soraýar: 

Specify point on side to offset: (Укажите точку, определяющую сторону 

смещения:) 

Ekranda obýektden parallel çyzyk bilen bir tarapda ýerleşen islendik nokady 

görkezmeklik ýeterlik. 

OFFSET (ПОДОБИЕ) buýruk bilen işiň başynda Specify offset distance or 

[Through]: (Величина смещения или [Точка]:) soraga Т (Т) opsiýa saýlanylan 

bolsa, onda AutoCAD ilkibaşda soraýar: 

Select object to offset or <exit>: (Выберите объект для создания 

подобных или <выход>:) we obýekt görkezilenden soň nokat soralýar: Specify 

through point: (Через точку:). Saýlanylan obýekte parallel çyzyk geşjek nokady 

görkezmeli. 

ARRAY (МАССИВ) buýrugyň  düwmejigi şol bir obýektleriň 

göçürmeleriniň toparyny döretmek üçin niýetlenen, özem göçürmeler belli bir 

tertip boýunça göniburçly we tegelekli massiwiň öýjüklerinde ýerleşen. Buýrugy 

mundan başga hem, Modify (Pe-дакт) menýusyndan Array (Массив) bendi 

arkaly çagyryp bolýar. Islendik ýagdaýda buýruk aşakdaky penjiräni çagyrýar. 

Penjiräniň düzümi iki sany pereklýuçateliň ýagdaýyna bagly: Rectangular Array 

(Прямоугольный массив) we Polar Array (Круговой массив). 

Birinji ýagdaýda obýektleriň massiwiniň näçe setirden (Rows) we sütünden 

(Columns) durjakdygyny, obýektleri saýlamagy (Select objects), setirleriň 

arasyndaky (Rows offset), sütünleriň arasyndaky (Columns offset), massiwdäki 

elementleriň arasyndaky burçy (Angle of array) gurnamak bolýar. 

Ikinji ýagdaýda massiwiň tegeleginiň merkezi nokadynyň koordinatlaryny 

(Center point: X we Y), obýektleriň sanyny (Total number of items), obýektleri 

saýlamagy (Select objects), tegelegiň burç boýunça uzynlygyna obýektleriň 

ýerleşişini (Angle to fill), obýektleriň tegelegiň ugry boýunça öwrülmegini 

(Rotated items as copied) we b. gurnamak bolýar. 
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 düwmejigi MOVE (ПЕРЕНЕСТИ) buýruga gabat gelýär, ol saýlanan 

obýektleri iki nokat bilen berlen wektora parallael edip geçirmegi mümkin edýär. 

Buýrugy şeýle hem, Modify (Pe-дакт) menýusyndan Move (Перенести) bendi 

arkaly çagyryp bolýar. Зbu buýrugyň soraglary we amallary COPY 
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(КОПИРОВАТЬ) buýrugyňka meňzeşdir. Obýektler saýlanylandan soň birinji 

sorag: 

Specify base point or displacement: (Базовая точка или перемещение:)  

Birinji nokady görkeziň. Indiki sorag: 

Specify second point of displacement or <use first point as 

displacement: (Вторая точка перемещения или < считатъ перемещением 

первую точку >:) 

Hereketlendiriş wektoryň ikinji nokadyny görkeziň. Eger munuň deregine 

Enter basylsa, onda birinji nokadyň koordinatlary hereketlendiriş koordinatlary 

hökmünde seredilýär. 

ROTATE (ПОВЕРНУТЬ) buýrugyň  düwmejigi saýlanan obýektleri 

baza nokadyna görä berlen burça öwürmegi mümkin edýär. Buýrugy şeýle hem, 

Modify (Редакт) menýusyndan Rotate (Повернуть) bendi arkaly çagyryp bolýar.  

Ilkibaşda buýruk burçlary ölçemegiň düzgünleri barada habar berýär:  

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0  
(Текущие установки отсчета углов в ПСК: ANGDIR=против ч/с 

ANGBASE=0) 

Obýektler saýlanylandan soň birinji sorag: 

Specify base point: (Базовая точка:) Öwrüliş ýerine ýetiriljek baza nokady 

görkeziň. Soňra: Specify rotation angle or [Reference]: (Угол поворота или 

{Опорный угол]:). Burçy klawiaturadan girizip ýa-da syçanjyk arkaly görkeziň 

Burçy girizmegiň deregine burçy Reference (Опорный угол) opsiýasy 

arkaly mümkin. Meselem, içinde kesim bolan üçburçlygy 1 nokada göräleýin 

üçburçlugyň 1 we 2 nokat bilen belgilenen sag tarapykese bolar ýaly öwürmeklik 

gerek. 

Select objects: (Выберите объекты:) soraga syçanjyk arkaly üçburçlygy we 

kesimi belläp saýlaň we Enter basyň. Base point: (Базовая точка:) soraga obýekt 

baglaşdyrma arkaly 1 nokady belläň. Specify rotation angle or [Reference]: 

(Угол поворота или [Опорный угол]:) soraga jogap hökmünde R (О) opsiýasyny 

saýlaň. Şu sorag berler: 

Specify the reference angle <0>: (Опорный угол <0>:) Burçy iki nokat 

arkaly görkezmek usuly saýlalyň. 1 nokady görkeziň we Specify the second 

point: (Вторая точка:) soraga 2 nokady görkeziň. Başlangyç burç şeýleleik bilen 

kesgitlenen bolup durýar. Soňra AutoCAD soraýar:  

Specify the new angle: (Новый угол:). Täze burç hökmünde klawiaturadan 0 

girizmeli. Üçburçlyk keselik ýagdaýyna çenli öwrüler.  
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SCALE (МАСШТАБ) buýrugyna gabat gelýän  düwmejigi saýlanan 

obýektleri baza nokadyna göräleýin masştablamagy (ýagny ulaltmagy ýa-da 

kiçeltmegi) mümkin edýär. Şeýle hem buýrugy Modify (Редакт) menýusyndan 

Scale (Масштаб) bendi arkaly çagyryp bolýar. 

SCALE (МАСШТАБ) buýrugy oýektler saýlanylandan soň soraýar: Specify 

base point: (Базовая точка:) Baza nokadyny görkeziň.  Soňra: 

Specify scale factor or [Reference]: (Масштаб или /Опорный отрезок]:)  

Obýektleri ulaltmak üçin 1-den uly sany girizmeli, kiçeltmek üçin — 1-den kiçi 

bolan položitel sany girizmeli. Eger masştanlamagy drob esse ýerine ýetirmeli 

bolsa (meselem, 3/7), onda Reference (Опорный отрезок) opsiýasyndan 

peýdalanmaly. Bu opsiýanyň saýlanmagyna AutoCAD şu soragy berýär:  

Specify reference length <1>: (Длина опорного отрезка <!>:) 

7-lik sany giriziň. Specify new length: (Новая длина:)  

3 giriziň, we ulgam gerek bolan özgermäni ýerine ýetirer (özgeriş koeffisienti 

ikinji uzynlygyň birinjä bölünmegi hökmünde hasaplanylar). 
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STRETCH (РАСТЯНУТЬ) buýrugy, Modify (Редактирование) paneliniň 

 düwmejigi gabat gelýär, obýektiň formasyny süýndüriş arkaly üýtgetmäge 

niýetlenen. Buýrugy şeýle hem Modify (Редакт) menýusyndan Stretch 

(Растянуть) bendi arkaly çagyryp bolýar. 

Buýruk adatça poliçyzygyň üstünden ýerine ýetirilýär (emma welin ol 

halkalary, elliptik halkalary, splaýnlary we beýleki çyzykly primitiwleri süýndürip 

bilýär, onuň käbir depelerini iki nokat bilen berilýän wektora parallel edip 

süýşürip, obýektiň geometriýasyny üýtgedip bolýar. Buýrugyň birinji soragy: 

Select objects to stretch by crossing-window or crossing-polygon... 

Select objects: (Выберите растягиваемые объекты секущей рамкой или 

секущим многоугольником...Выберите объекты:) 

Aşaky suratda göniburçluk şekilindäki poliçyzyk görkezilen, onuň iki çep 

depesini süýşürmek gerek. 

 

Göniburçlugy kesiş çäg bilen saýlaň, emma çägiň içinde göniburçlugyň diňe 

çep depeleri düşer ýaly bellemeli, soňra Enter basyň. Soňra birinji nokat barada 

sorag berilýär: 

Specify base point or displacement: (Базовая точка или перемещение:) 

Birinji nokady görkeziň: Specify second point of displacement or <use first 

point as displacement>: (Вторая точка перемещения или <считать 
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перемещением первую точку >:) Hereketlendiriş wektoryň ikinji nokadyny 

görkeziň. 

 

Buýrugyň ýerine ýetirilişiniň netijesinde poliçyzygyň çägiň içine düşmedik 

depeleri öňki ýerlerinde galdy, kesiş çägi bilen bellebilen depeler bolsa görkezilen 

wektora parallel süýşýärler. 

 

LENGTHEN (УВЕЛИЧИТЬ) buýrugy, Modify (Редакт) menýusynyň 

Lengthen (Увеличить) bendi gabat gelýär, ol kesimleri, halkalary we poliçyzgyň 

ahyrky segmentlerini berlen ululyga ulaldýar (uzynlygyň ýa-da burç birliginde. 

Buýrugyň birinji soragy: Select an object or 

[DElta/Percent/Total/DYnamic]: (Выберите объект или 

/ДЕлыпа/проЦент/Всего/ДИнамика]:) 

Eger şu ýagdaýda obýekti saýlasak, onda AutoCAD onuň öol wagtky 

parametrlerini görkezýär, (kesim ýa-da poliçyzygyň segmenti üçin — uzynlygy, 

halka üçin bolsa — uzynlygy ýa-da merkezi burçy). Buýrugyň opsiýasy:  

 DElta (ДЕльта) — uzaltmagyň ululygy görkezilýär (san arkaly);  

 Percent (проЦент) — öňki uzynlykdan göterimde täze uzynlyk görkezilýär:  

 Total (Всего) — täze doly uzynlyk çyzykly we we burç birliklerde 

görkezilýär;  
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 DYnamic (ДИнамика) — uzaltmagyň ululygy dinamiki ýagdaýda 

görkezilýär, ýagny bir nokady syçanjyk arkaly görkezmek arkaly, indiki 

görkezilen nokada çenli aralyk bolsa uzaltmagyň ululygy bolup durýar.  

DElta (ДЕльта) opsiýasy ýagdaýynda AutoCAD soraýar:   

Enter delta length or [Angle] <0.0000>: Приращение длины или [Угол/ 

<0.0000>:) 

Muňa Siz goşmaça uzaltmagyň ululygyny millimetrde  görkezýärsiňiz 

(položitel san bilen eger uzynlyk uzaldylanda we otrisatel eger kiçeldilende, 

AutoCAD ulgamy indiki soragy berýär: 

Select an object to change or [Undo]: Выберите объект для изменения 

или [Отменить]:) 

Eger obýekt görkezilse, ol üýtgeýär (uzalýar ýa-da kiçelýär), özem obýekt 

görkezilende bellenilen nokada golaý bolan uçdan başlanýar.  

Eger uzynlygyň goşmaça uzaldylmagyna Angle (Угол) opsiýasy saýlanylsa, onda 

ulgam burçuň goşmaça uzaldylmagyny sorar: 

Enter delta angle: Введите приращение угла:)  

Goşmaça ulaltmagyň ululygyny giriziň (ol otrisatel hem bolup biler), we indiki 

soraga jogap hökmünde üýtgedilýän obýekti saýlaň.  

LENGTHEN (УВЕЛИЧИТЬ) buýrugyň beýleki opsiýalary hem meňzeşräk 

işleýärler. 

 

 düwmejigi TRIM (ОБРЕЗАТЬ) buýrugyna gabat gelýär, bu buýruk ony 

kesip geçýän beýleki obýektler arkaly kesip aýyrmagy we ony gerekli obýekte 

çenli uzaltmagy mümkin edýär. Buýrugy şeýle hem Modify (Редакт) menýusynyň 

Trim (Обрезать) bendi arkaly çagyryp bolýar. Birinji sorag: 

Current settings: Projection = UCS Edge = None Select cutting edges ... 

Select objects: (Текущие установки: Проекция = ПС К Кромки = Без 

продолжения Выберите режущие кромки ... Выберите объекты:) 

Bu habaryň birinji setirinde buýrugyň öol wagtky parametrleri görkezilen, 

olar gerek bolan halatda üýtgedilip bilner. 

Obýektleri görkezmegiň tertibi bu ýagdaýda örän wajyp. Ilkibaşda "kesiji 

erňekleri" görkezmeli — biziň mysalymyzda bu bir kesime deň. Kesiji obýektleriň 

saýlanylmagynyň soňy — bu Enter düwmejiginiň basylmagy. Indiki sorag: Select 

object to trim or shift-select to extend or [Project/Edge/Undo]: (Выберите 

обрезаемый объект или с клавишей <Shift> выберите удлиняемый объект или 

[Проекция/Кромка/Отменить]:) 

Bu soraga jogap hökmünde kesilmeli obýektleri görkeziň (bu mysalda — 

agzalan kesim arkaly), emma şonda obýektleri edil aýrylmagy böleginde 

görkezmeli. Kesilýän obýektleri görkezmegiň deregine görkezmeleri üýtgetmek 

ýa-da öňki hereketi ýatyrmak mümkin. Project (Проекция) opsiýasy saýlanylsa 

AutoCAD teklip edýär: 

Enter a projection option [None/Ucs/View] <Ucs>: (Задайте опцию 

проецирования [Нет/Пск/Вид] <Пск>:) Saýlamak üçin hödürlenýän opsiýalar, 

kesmeklik diňe kesiji erňekler arkaly amala aşyrylman, eýsem olaryň 

proýeksiýalary arkaly amala aşyrylyp bilner, proýesirlemegiň usuly bolsa ýa 
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koordinatlaryň häzirki ulgamynda (Ucs (Пек) opsiýasy), ýa-da häzirki görnüş 

boýunça (View (Вид) opsiýasy). None (Нет) opsiýasy proýeksiýasynda 

kesmekligiň mümkinligini aýyrýar (ýagny kesiji we kesilýän obýektler bir 

tekizlikde ýerleşmeli bolýar. 

Edge (Кромка) opsiýasy saýlanylsa şu sorag berler:  

Enter an implied edge extension mode [Extend/No extend] <No extend >:  
(Режим продолжения кромки до воображаемого пересечения [С 

продолжением/ Без продолжения] <Без продолжения>:) 

Bu ýerde kesiji erňekleriň dowamlyklary amalda çykyş edýänligi 

kesgitlenýär. Extend (С продолжением) düzgüni saýlanylsa kesmeklik diňe 

saýlanylan kesiji erňekler arkaly dälde, eýsem olaryň dowamlyklary arkaly amala 

aşyrylýar. 

 

EXTEND (УДЛИНИТЬ) buýrugy, muňa  düwmejigi gabat gelýär 

"araçäkli erňekleriň" toplanylşyny saýlamagy mümkin edýär, soňra bolsa öol 

erňeklere çenli uzalýan obýektleri görkezýär. Buýrugy şeýle hem Modify (Редакт) 

menýusyndan Extend (Удлинить) bendi arkaly çagyrmak mümkin. Obýektleriň 

görkezilmeginiň yzygiderligi örän wajyp, sebäbi ulgam araçäkli we uzaldylýan 

obýektleri tapawutlandyrmalydyr. 

Birinji habar hereket edýän düzgünler barada (düzgünler TRIM 

(ОБРЕЗАТЬ)) buýrugy bilen umumylaşdyrylan we özlerine çenli uzaltmaklyk 

amalyny ýerine ýetirmeli araçäkli erňekleri görkezmeli:  

Current settings: Projection = UCS Edge = None Select boundary edges... 

Select objects: (Текущие установки: Проекция = ПСК Кромки = Без 

продолжения Выберите граничные кромки... Выберите объекты:)   

Araçäkli erňekleriň toplanylşyny düzmeli obýektleri saýlamaly we olaryň 

saýlanylmagyny Enter düwmejigi arkaly tamamlaň. Soňra: 

Select object to extend or shift-select to trim or [Project/Edge/Undo]:  
(Выберите удлиняемый объект или с клавишей <Shift> выберите обрезаемый 

объект или [Проекция/Кромка/Отменить]:) 

Şol araçäkli erňekleriň toplanylşyna çenli uzadylmaly obýektleri görkeziň, 

özem her bir uzaldylýan obýektiň görkeziş nokady uzadylmagy amala aşyryljak 

tarapyň ahyryna golaý bolan bolmalydyr. 

 

BREAK (РАЗОРВАТЬ) buýrugy iki görkezilen nokatda obýekti üzmek üçin 

niýetlenen. Buýrugy şeýle hem Modify (Редакт) menýusyndan Break (Разорвать) 

bendi arkaly çagyrmak mümkin. Mundan başga hem, oňa Modify 

(Редактирование) panelinde iki düwmejik gabat gelýär.  düwmejigi BREAK 

(РАЗОРВАТЬ) buýrugy iň umumy ýagdaýynda çagyrýar. 

Buýrugyň birinji soragy: Select object: (Выберите объект:)  

Obýekti görkeziň, deslapdan obýekti görkezen nokadyňyzy üzülmegiň birinji 

nokady bolar. Soňra: 

Specify second break point or [First point]: (Вторая тонка разрыва или 

{Первая точка]:) Eger obýekti görkezen nokadyňyz birinji nokat bolmaly däl 
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bolsa, onda degişli opsiýany saýlap gaýtadan birinji nokady görkeziň. Soňra Enter 

basyp ikinji nokady görkezeliň. 

 

Modify (Редактирование) paneliniň  Break at Point (Разорвать в 

точке) düwmejigi birinji we ikinji üzme nokatlaryň gabat gelýän ýagdaýyny 

mümkin edýär, emma obýekti görkeziş nokady üzme nokady bolup bilmeýär.  

 

 düwmejigi CHAMFER (ФАСКА) buýrugy amala aşyrýar, ol iki sany 

kesişýän göniburçly segmentleri (kesimleri, şöhleleri, göni çyzyklary) olaryň 

kesişýän nokadyndan belli bir aralykda kesme amalyny (faska almagy) ýerine 

ýetirýär, şonda ol kesilýän ýerleriň nokatlaryny birikdirýän kesimi çyzýar. 

Buýrugy mundan başga hem Modify (Редакт) menýusyndan Chamfer (Фаска) 

bendi arkaly çagyryp bolýar. Buýruk hem kesişýän, hem-de kesişmeýän emma 

parallel däl kesimleriň üstünden ýerine ýetirilýär (şonda kesimler ilkibaöda 

kesişýänçä uzaldylýar). 
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CHAMFER (ФАСКА) buýrugy ilkibaşda düzgünleriň häzirki ýagdaýyny  

habar berýär, soňra bolsa obýekti saýlamak barada sorag berýär:  

(TRIMmode) Current chamfer DistJ = 0.0000, Dist2 = 0.0000 Select first line 

or [Polyline/Distance/Angle/Trim/Method/mUltiple]: 
((Режим С ОБРЕЗКОЙ) Параметры фаски: Длина! = 0.0000, Длина2 = 0.0000 

Выберите первый отрезок или /полИлиния/Длина/Угол/Обрезка/Метод/ 

мНого]:) 

Eger faskanyň hereket edýän parametrlerini üýtgetmeklik gerek däl bolsa, 

onda gönümel birinji obýekti görkezmeklige geçmek bolýar. Emma köplenç 

faskalaryň zerur bolan uzynlygyny goýmak gerek bolýar. Ol Distance (Длина) 

opsiýasy arkaly amala aşyrylýar, ol öz soragyny berýär:  

Specify first chamfer distance <0.0000>: (Первая длина фаски <0.0000>:)  

Birinji uzynlygy görkezeliň — meselem, 75 mm. Soňra:  

Specify second chamfer distance <75.0000>: (Вторая длина фаски <75.0000>:)  

Ikinji uzynlygy giriziň — meselem, ýene bir gezek 75 mm. Soňra:  

Select first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]:  
(Выберите первый отрезок или { полИлиния/Длина/Угол/Ойрезка/Метод/ 

мНого]:) Birinji kesimi bellemek gerek. AutoCAD şonda soraýar: Select second 

line: (Выберите второй отрезок:) Ikinji kesilýän obýekti görkeziň. Eger ilkibaşda 

multiple (мНого) opsiýasy ulanylsa, birinji faska gurulandan soň CHAMFER 

(ФАСКА) öz işini tamamlamaýar, gaýtalanyş bilen redaktirlenýän obýektleriň 

nobatdaky taýyny. 
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Trim (Обрезка) opsiýasy sorag berýär: Enter Trim mode option 

[Trim/No trim] <Trim>: (Режим обрезки [С обрезкой/Без обрезки] <С 

обрезкой>:) Bu halatda iki düzgüniň birini saýlamaly. Adaty düzgün — Trim (С 

обрезкой). No trim (Без обрезки) düzgüni saýlanylsa goşmaça kesim gurulyp, 

başlangyç segmentler ýok edilmeýär. 

Düzgüni goýmaklyk indiki FILLET (СОПРЯЖЕНИЕ) buýrugyna hem 

degişli bolýar. Buýrugyň beýleki opsiýasy Method (Метод). Bu ýagdaýda şu 

sorag berilýär: Enter trim method [Distance/Angle] <Distance>: (Метод 

построения [Длина/Угол/ <ДлинаУ:) 

Buýruk faskanyň iki usul arkaly alyp bilýär. Birinji —Distance (Длина) 

opsiýasy berilende, onda kesimlerden alynýan iki uzynlyk görkezilýär. Ikinji —  

Angle (Угол) opsiýasy ulanylanda, şonda uzynlyk we burç görkezilýär, onuň 

aşagynda faskanyň goşmaça kesimi birinji segmente göräleýin gurulýar. Iki usulyň 

görkezmelerini AutoCAD CHAMFERA, CHAMFERB (Distance (Длина) usuly) 

we CHAMFERC, CHAMFERD (Angle (Угол) usuly) ulgam üýtgeýänlerde 

saklaýar. 

 

FILLET (СОПРЯЖЕНИЕ) buýrugy obýektleri berlen radiusly halka arkaly 

baglaşdyrýar (meselem, kesimleri, halkalary we tegelekleri). Oňa Modify 

(Редактирование) paneliniň  düwmejigi we Modify (Редакт) menýusynyň 

Fillet (Сопряжение) bendi gabat gelýär. Buýruk düzgünleri boýunça CHAMFER 

(ФАСКА) buýrugyna meňzeş. 

Buýruk tarapyndan berilýän birinji habar şol wagtky sazlamalar barada 

maglumaty we aşakdaky soragy saklaýar: 

Current settings: Mode = TRIM, Radius = 0.0000 Select first object or 

[Polyline/Radius/Trim/mUltiple]: (Текущие настройки: Режим = С 

ОБРЕЗКОЙ, Радиус сопряжения = 0.0000 Выберите первый объект или 

[полИлиния/раДиус/Обрезка/мНого]:) 

Radius (раДиус) opsiýasy degişli sorag berilenden soň baglaşdyrmagy/ şol 

wagtky ähmiýetini üýtgetmegi mümkin edýär: 

Specify fillet radius < 0.0000 >: (Радиус сопряжения <0.0000>:)  

Radiusyň ululugy goýulandan soň gaýtadan şu sorag berilýär: Select first object 

or [Polyline/Radius/Trim/mUltiple]: (Выберите первый объект или 

[полИлиния/раДиус/Обрезка/мНого]:).  

Eger şol wagtky sazlamalar Sizi kanagatlandyrýan bolsa, birinji obýekti 

baglaşdyrmak üçin belläň. Soňra: Select second object: (Выберите второй 

объект:)  

Ikinji obýekt görkezilende, AutoCAD ýa gerek bolan halkany gurar ýa-da 

berlen radius bilen baglaşdyrmagyň mümkin däldigi barada habar berýär. 

Baglaşdyrýan obýektler hökmünde poliçyzygyň goňşy bölekleri bolup durýan ýa-

da bir segment bilen aýry edilen iki bölegi hem çykyş edip bilýär.  

Multiple (мНого) opsiýasy obýektleriň gaýtalanyş ýagdaýda baglaşdyrmagyny 

amala aşyrýar. Polyline (полИлиния) opsiýasy berlen radius arkaly bir 

poliçyzygyň hemme depesini tegelemegi mümkin edýär. 
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Modify (Редактирование) paneliniň iň soňky  düwmejigi EXPLODE 

(РАСЧЛЕНИТЬ) buýrugyna gabat gelýär, bu buýruk öňki mowzukda seredilipdi 

ol has ýönekeý obýektlere poliçyzyklary, bloklaryň girişlerini, ölçegleri we beýleki 

çylşyrymly obýektleri bölýärler. 

 

Poliçyzyklary redaktirlemek  

Iki ölçegli poliçyzyklaryň ýörite redaktirlenmesi PEDIT (ПОЛРЕД) 

buýrugy arkaly ýerine ýetirilýär, oňa Modify II (Редактирование-2) paneliniň  

düwmejigi we Modify | Object | Polyline (Редакт Объекты | Полилиния) 

menýusy gabat gelýär.  

 
 

Şu soraga poliçyzyk saýlanylandan soňra Select polyline or [Multiple]: 

(Укажите полилинию или [Несколько]:) AutoCAD aöakdaky opsiýalaryň 

sanawyny berýär  

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype 

gen/Undo]:(Задайте опцию [Замкнуть /Добавить /Ширина /Вершина 
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/Сгладить /Сплайн /Убрать сглаживание/Типлин/Отменить]:)  

Buýrugyň opsiýalary: 

  

 Close (Замкнуть) — ýapylmadyk (açyk) poliçyzygy ýapýar; eger ýapyk 

poliçyzyk bellenilen bolsa, onuň deregine Open (Разомкнуть) opsiýasy 

emele geler;  

 Join (Добавить) — poliçyzyga täze segmentleri goşýar;  

 Width (Ширина) — poliçyzygyň hemme segmentleriniň inini täze 

ähmiýete üýtgedýär;  

 Edit vertex (Вершина) — poliçyzygyň depelerini redaktirlemek düzgünine  

geçýär (depeleriň ýerini üýtgetme, depeleri şok etme, depeleri goşmak, aýry 

segmentleriň inini üýtgetmek we ş.m.);  

 Fit (СГладить) — halka segmentler arkaly poliçyzygy düzleýär;  

 Spline (СПлайн) — ýörite deňleme boýunça poliçyzygyň başlangyç we 

ahyrky nokadyndan splaýny geçirýär;  

 Decurve (Убрать сглаживание) — Fit (СГладить) we Spline (СПлайн) 

opsiýalar bilen ýerine ýetirilen tekizlenmegi aýyrýar;  

 Ltype gen (Типлин) — çyzygyň görnüşini gurmagy dolandyrýar 

(segmentler üçin aýratynlykda ýa-da tutuş poliçyzyk boýunça);  

 Undo (Отменить) — soňky amaly ýatyrýar.  

 

Mundan başga hem Enter düwmejigiň basylmagy (opsiýa saýlamaklygyň 

deregine) PEDIT (ПОЛРЕД) buýrugyny tamamlaýar. 

 

Iň çylşyrymly opsiýa — Edit vertex (Вершина), ol poliçyzygyň depeleri 

bilen işlemek düzgüni çagyrýar, bu bolsa depeleriň ýerleşişini üýtgetmegi, olary 

ýok etmegi, goşmagy, şeýle hem belli bir segmentiň inini üýtgetmegi we 

poliçyzygy böleklere bölmegi amala aşyrýar. Bu opsiýa saýlanylandan soň 

AutoCAD sorag berýär: 

Enter a vertex editing option [Next/Previous/Break/ 

lnsert/Move/Regen/Straighten/Tangent/Width/eXit] <N>: Задайте опцию 

редактирования вершины След/Пред/РАзорвать/ВСтавитъ/ПЕренести/ 

РЕген/ВЫпрямитъ/Касателъная/ Шкрина/выХод] <С>:) Şonda poliçyzygyň 

birinji depesinde х belgisi emele gelýär, bu bolsa şol wagtky ulanylýan depäniň 

belgisini aňladýar. Depeleriň yzygiderliginiň tertibi poliçyzyg çyzylanda olaryň 

döreýiş yzygiderligine gabat gelýär. 

Bu düzgünde şu opsiýalar elýeterli:  

 Next (След) — indiki depä geçmeklik;  

 Previous (Пред) — ondan öňki depä geçmeklik;  

 Break (РАзорвать) — şol wagtky ulanylýan depeden başlap poliçyzygy 

üzmeli;  

 Insert (ВСтавить) — şol wagtky ulanylýanyndan soň täze depäni 

goşmaklyk;  

 Move (ПЕренести) — şol wagtky ulanylýan depäni täze ýere geçirmek;  
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 Regen (РЕген) — şol wagtky görkezmeler bilen poliçyzygy regenerirlemek 

(gaýtadan çyzmak);  

 Straighten (ВЫпрямить) — şol wagtky depeden başlap meýdançada 

poliçyzygy göneltmek (goňşy depeleri ýok etmeklik);  

 Tangent (Касательная) — şol wagtky ulanylýan depä galtaşyş çyzygyň 

ugruny geljekde ýerine ýetiriljek Fit (СГладить) opresiýasy üçin bellemek; 

 Width (Ширина) — şol wagtky ulanylýan depede başlanýan meýdançada 

poliçyzygyň inini bellemek;  

 eXit (выХод) — depeleri redaktirleme düzgüninden çykmak we gaýtadan 

ilkinji soraga gaýtmaklyk: Enter an option [Close/Join/Width/Edil 

vertex/Fit/Spline/Decurve/Ltype gen/Undo]: (Задайте опцию 

[Замкнуть/Добавить/Ширина/Вершина/СГладить/СПлайн/ Убрать 

сглаживание/Типлин/Отменить]:). 

 

Break (РАзорвать) opsiýasy saýlanylanda, üzülmegiň birinji nokady 

hökmünde şol wagtky ulanylýan depe hasaplanylýar, üzülmegiň soňuny bolsa şu 

soraga jogap hökmünde görkezmeli: 

Enter an option [Next/Previous/Go/eXit] <N>: (Задайте опцию 

[След/Пред/Выполнить/выХод] <С>:) 

Eger üzmegi şol wagtky depede amala aşyrmak gerek bolsa (mundan soň 

poliçyzyk üzüliş ýerine umumy nokada eýe bolan iki sany poliçyzyga eýe bolýar), 

onda Go (Выполнить) opsiýasyny ulanmaly. 

Eger üzmegi şol wagtky ulanylýan depede başlap başgasynda gutarmaly 

bolsa (we şonuň bilen olaryň arasyndaky meýdançalary ýok etmeklik üçin), onda 

Break (Разорвать) düzgüninde Next (След) we Previous (Пред) opsiýalary 

arkaly ikinji depä geçmegi amala aşyrmaly we ondan soň Go (Выполнить) 

opsiýasyny ulanmaly. Redaktirlenme düzgüni gerek bolmasa eXit (выХод) 

opsiýasyny ulanmaly. 

Poliçyzyga täze depäni goşmak üçin Insert (ВСтавить) opsiýasyny 

peýdalanmaly. Bu opsiýa geçmezden öň yzyndan täze depe goşulmaly depä 

geçmeli. Soňra Insert (ВСтавить) opsiýasyny ulanmaly. AutoCAD soraýar: 

Specify location for new vertex: (Положение новой вершины:)  

Bu ýerde täze depäniň ýerleşmeli ýerini görkezmeli. 

Bu opsiýa arkaly poliçyzygyň depesiniň öňünden depäni goşmaklyk 

mümkin däl. 

Move (ПЕренести) opsiýasy şol wagtky ulanylýan depäni täze ýere 

geçirmeklik zerur bolanda ulnaylýar. Opsiýa ulanylanda sorag berilýär: Specify 

new location for marked vertex: (Новое положение помеченной вершины:) 

Şol depäni ýerleşmeli ýerini görkezmeli. 

Regen (РЕген) opsiýasy PEDIT (ПОЛРЕД) buýrugyndan çykman, şol 

wagtky üýtgetmeler bilen poliçyzygy täzeden çyzmaklygy amala aşyrýar.  

Eger poliçyzykdan käbir depeleri ýok etmek gerek bolsa, onda Straighten 

(ВЫпрямить) opsiýasyny ulanmaly. Bu opsiýa tarapyndan berilýän sorag Break 

(РАзорвать) opsiýasynyň berýän soragyna meňzeş: Enter an option 
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[Next/Previous/Go/eXit] <N>: (Задайте опцию [След /Пред /Выполнить 

/выХод] <С>:). 

Bu opsiýa arkaly şol wagtky ulanylýan depeden başlanýan hem-de Next 

(След) we Previous (Пред) opsiýalary bilen geçip bolýan depe bilen tamamlanýan 

meýdançany göneldip bolýar. Go (Выполнить) opsiýasy göneltme amalyny 

tamamlaýar. 

Tangent (Касательная) opsiýasy geljekde ýerine ýetirilip biljek Fit 

(СГладить) amaly üçin poliçyzygyň depelerinde galtaşma çyzgyň ugruny 

bellemegi mümkin edýär, bu bolsa tekizlenmeden soň alynýan çyzygyň görnüşine 

täsir etmegi mümkin edýär. Tangent (Касательная) opsiýasy saýlanylandan soň 

sorag berilýär: 

Specify direction of vertex tangent: (Направление касательной в 

вершине:) Ugur burç bilen ýa-da nokat bilen berilýär. Berilenden so/ şol wagtky 

ulanylýan depede görkezilen ugur bilen strelka emele gelýär. Ugur Fit (СГладить) 

opsiýasy peýdalanylanda ulanylar. 

Width (Ширина) opsiýasy şol wagtky ulanylýan depeden başlanýan  

meýdançada poliçyzygyň inini dolandyrýar. Birinji sorag:  

Specify starting width for next segment: (Начальная ширина следующего 

сегмента:) 

Başlangyç ini bellemeli (adatça klawiatura arkaly). Eger bu ýagdaýda 

syçanjyk bilen nokat görkezilse, onda AutoCAD ikinji nokady sorar. Soňra:  

Specify ending width for next segment <0.0000>: (Конечная ширина 

следующего сегмента <0.0000>:) 

Burç ýaýynda deslapdan segmentiň başlangyç ini hökmünde alynan şhmiýet 

ýerleşdirilen. Ikinji in girizilenden soň poliçyzygyň şol wagtky ulanylýan segmenti 

täze in bilen çyzylýar. 

Multiple (Несколько) opsiýasy poliçyzygy saýlamak barad berilýän iň 

ilkinji soragda elýeterli bolup durýar we üstlerinden bir kysymly amallary 

(meselem, ýapmak ýa-da global ini üýtgetmek) ýerine ýetirmek üçin bir wagtda 

birnäçe poliçyzygy saýlamaga mümkinçilik berýär. Bu opsiýa saýlanylanda Edit 

vertex (Вершина) opsiýasyny el ýeterli däldigini göz öňünde tutmak gerek. 

 

Multiçyzyklary redaktirlemek  

 

Multiçyzyk — çylşyrymly obýekt we ony redaktirlemek üçin MLEDIT 

(МЛРЕД) ýörite buýrugy bar, oňa Modify | Object | Multiline (Редакт Объект 

Мультилиния) menýunyň bendi laýyk gelýär. 

MLEDIT (МЛРЕД) buýrugy Multiline Edit Tools (Редактирование 

мультилиний) penjiräni çagyrýar. Bu penjiräni çagyrmaklygyň ýene bir usuly — 

multiçyzyk boýunça syçanjygyň çep düwmejigi bilen iki gezek basmaly (şonda 

suratda başga obýektler bellenilmeli däl). 

Bu penjirede 12 amalyň düwmejikleri bar. Penjiräniň birinji sütüninde iki 

multiçyzygyň kesişmesini işläp bejermegiň düwmejikleri, ikinjisinde – bir 

multiçyzygyň beýlekisiniň ýanynda tamamlanmagyny gurnamagyň düwmejikleri, 

üçünjide — iki multiçyzygyň burç bilen kesişmesini ýa-da bir multiçyzygyň burç 
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bilen işläp bejermegiň (şeýle hem depeler bilen amallaryň) düwmejikleri we 

dördünjide — üzmeleriň amallary ýerleşen. Bu amallary her sütünde ýokardan 

aşak seredeliň. 

 

 
 

Closed Cross (Закрытый крест) amaly (degişli düwme ) soraýar: 

Select first mline: (Выберите первую мультилинию:)  

Eger suratda iki sany kesişýän multiçyzyk bar bolsa, onda beýleki çyzyk bilen üsti 

ýapyljak multiçyzygy ilkinji görkezmeli syçanjygyň nyşany saýlanylan 

multiçyzygyň bir çyzygyna düşmelidir. Indiki sorag:  

Select second mline: (Выберите вторую мультилинию:)  

Ýokarky boljak ikinji multiçyzygy görkeziň. Amalyň ýerine ýetirilmeginiň 

netijesinde birinji multiçyzyk ikinji bilen kesişýän ýerinde ýapylar.  

Soňra şu sorag beriler: Select first mline or [Undo]: (Выберите первую 

мультилинию или /Отменить]:) 

Indiki multiçyzygy görkezmek bolar ýa-da buýrukdan çykmak üçin Enter 

düwmejigi basyň. 

Open Cross (Открытый крест) amaly (  düwmejigi) ondan öňküsine 

meňzeş işleýär, kesişýän zolakda hemme daşky erňekleri we birinji görkezilen içki 

çyzyklary ýok edýär. 

Merged Cross (Сплошной крест) amaly (  düwmejigi) ondan 

öňküsine meňzeş işleýär, emma kesişýän zolakda diňe daşky erňekleri ýok edýär.  

Операции Closed Tee (Закрытое Т) (  düwmejigi), Open Tee 

(Открытое Т) ( düwmejigi) we Merged Tee (Сплошное Т) (  

düwmejigi) birinji görkezilen multiçyzygy ikinji multiçyzyk bilen kesişýän 

ýerinden kesmegi amala aşyrýar. Bu amallaryň ýerine ýetirýän işi olaryň 

piktogrammalarynda görkezilen. 
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Corner Joint (Угловой стык) amaly (  düwmejigi) iki multiçyzygyň 

ahyrky segmentleriniň burçlaýyn kesişmesini gurnaýar ýa-da bir multiçyzgyňkyny, 

hemme zerur bolan kesişmeleri hasaplaýar. 

Add Vertex (Добавить вершину) amaly (  düwmejigi) multiçyzygyň 

göni çyzykly segmentiniň içinde depäni goşmaklygy mümkin edýär. Munuň üçin 

multiçyzygy görkezmek baradaky soraga jogap hökmünde multiçyzyga girýän 

çyzygyň birinde sepiň (täze depäniň) ýerini görkezmeli. 

Delete Vertex (Удалить вершину) amaly (  düwmejigi) multiçyzygyň 

depesini ýok etmegi mümkin edýär we şonuň bilen degişli segmenti göneldýär. 

Ýök etmeklik üçin multiçyzygy görkezmek baradaky soraga jogap hökmünde ýok 

edilmeli depäniň golaýyndaky çyzygyň birini bellemeli. Netijede AutoCAD 

multiçyzygy şol depesiz gaýtadan çyzar. 

Cut Single (Обрезать один) amaly (  düwmejigi) multiçyzyga girýän 

çyzyklaryň birini üzýär. Edil BREAK (РАЗОРВАТЬ) buýrugyndaky ýaly, 

üzülmeli multiçyzyk görkezilýän nokat üzmegiň birinji nokady bolup durýar. Ikinji 

nokat görkezilenden soň AutoCAD üzmegi amala aşyrar. 

Cut All (Обрезать все) amaly (  düwmejigi) multiçyzyga girýän 

hemme çyzyklary üzýär. 

Üzülişleri aýyrmak üçin Weld All (Соединить все) amaly (  

düwmejigi) gulluk edýär. 

 

Ýazgylary redaktirlemek 

 

Tekstleri redaktirlemegiň amallary Text (Текст) gurallar panelinde 

ýygnalan. Ýazgylary redaktirlemek üçin Text (Текст) paneliniň  düwmejigi göz 

öňünde tutulan we Modify | Object | Text | Edit (Редакт | Объект Текст | 

Редактировать) menýunyň buýrugy. Olar DDEDIT (ДИАЛРЕД) buýrugy 

çagyrýar. Bu buýrugy çagyrmagyň has ýönekeý usuly — bir setirli tekste syçanjyk 

bilen iki gezek basmaly. 

DDEDIT (ДИАЛРЕД) buýrugy diňe ýazgyny redaktirlemek üçin niýetelnen 

dälde, eýsem ölçeg ýazgyny, dopusklary we atributlary kesgitlemek üçin 

niýetlenen. 

Buýruk soraýar: 

Select an annotation object or [Undo]: (Выберите текст или 

/Отменить]:) Eger bir setirli ýazgy görkezilse, onda Edit Text (Редактирование 

текста) dialog penjiresi emeke geler. 

Text (Текст) bellenilen meýdanda zerur üýtgetmeleri girizmeli soňra ОК 

düwmejigine basmaly. Ýazgynyň beýleki parametrleri (beýikligi, deňeşdirme 

görnüşi, baglaşdyrma nokady we ş.m.) bu buýrukda üýtgetmek mümkin däl.  
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 Eger DDEDIT (ДИАЛРЕД) buýrukda redaktirlenýän ýazgynyň deregine 

multitekst saýlanylan bolsa, onda multitekstiň redaktorynyň penjiresi çagyrylýar.  

 
 

 

 
 

 

Text (Текст) paneliniň  düwmejigi FIND (НАЙТИ) buýrugy çagyrýar, ol 

bolsa tutuş çyzgynyň tekst primitiwinde ýa-da bellenilen meýdançada gözlemegiň 

we çalşyrmagyň işini ýerine ýetirýär. 

 düwmejigi STYLE (СТИЛЬ) buýruga gabat gelýär, ol tekstleriň stillerini 

döredýär. 

 düwmejigi SCALETEXT (МАСШТЕКСТ) buýrugy çagyrýar, ol teksti 

masştablamagy mümkin edýär. Buýrugy şeýle hem Modify | Object | Text | Scale 

(Редакт Объект | Текст Масштаб) menýudan çagyryp bolýar. Buýrugyň birinji 

soragy: 

Select an annotation object or [Undo]: (Выберите текстовый объект или 

[Отменить]:) Bir setirli ýa-da köp setirli teksti görkezmek gerek. Mundan soň 

obýektleri saýlamak. Saýlamagy Enter düwmejigine basyp  gutarmaly. Soňra:  

Enter a base point option for scaling [Existing/Left/Center/Middle/Right/TL 

/TC/TR/ML/MC/MR/BL/BC/BR] <Existing>: (Задайте опцию базовой точки 

для масштабирования [Существующая/вЛево/Центр/сЕредина/впРаво/ 

ВЛ/ВЦ /ВП/СЛ/СЦ/СП/НЛ /НЦ /НП] < Существующая >:)  

JUSTIFYTEXT (ВЫРТЕКСТ) buýrugy, oňa  düwmejigi gabat gelýär, ol 

ýazgynyň daşky görnüşini üýtgetmän onuň deňeşdirmesini üýtgetmegi mümkin 

edýär (meselem, ýazgy aşaky sag nokadyna baglaşdyrylan. Buýrugy şeýle hem 

Modify | Object | Text | Justify (Редакт | Объекты Текст Выравнивание) 

menýudan çagyrmak mümkin. 

Buýrugyň başlangyç soragy: Select objects: (Выберите объекты:). 

Saýlamadan soň spesifiki sorag berilýär:  

Enter a justification option [Left/Align/Fit/Center/Middle/ 

Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]<Left>:  

(Задайте опцию выравнивания [вЛево/впИсанный/Поширине/Центр 

/сЕредина/впРаво/ВЛ/ВЦ/ВП/СЛ/СЦ/СП/НЛ/НЦ/НП] <вЛево>:) 

Opsiýa arkaly deňlemegiň täze opsiýasyny saýlamaly bolýar. 
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Text (Текст) paneliniň soňky  düwmejigi SPACETRANS (ЕДПРОСТ) 

buýrugyna gabat gelýär, ol modeliň we listiň giňişlikleriniň arasyndaky 

uzynlyklary gaýtadan hasaplamak üçin niýetlenen 

Bir setirli tekstleri redaktirlemek üçin amatly serişde bolup CHANGE 

(ИЗМЕНИТЬ) buýrugy çykyş edýär. Ol ýazgynyň islendik parametrlerini 

üýtgetmegi mümkin edýär. 

Buýrugyň birinji soragy: Select objects: (Выберите объекты:). Bir setirli 

teksti görkezmeli we Enter basmaly. Soňra:  

Specify change point or [Properties]: (Точка изменения или [Свойства]:) 

Properties (Свойства) opsiýasy häsiýetleriň redaktirlenmesine eltýär. Täze 

nokady görkeziň. Ýazgy süýşüriler. Eger Enter klawişasyna basylsa, onda goşmaça 

sorag berler: 

Specify new text insertion point <no change>: (Новая точка вставки 

текста <не изменять"?:) 

Täze nokady görkeziň ýa-da teksti süýşürmek gerek däl bolsa onda Enter 

basmaly. Soňra: 

Enter new text style <Standard>: (Новый текстовый спишь 

<Standard>:) Eger başga stil alynmajak bolsa onda Enter basmaly. Eger stilde 

harplaryň beýikligi bellenilmedik bolsa aşaky sorag berilýär (başga ýagdaýda 

berilmeýär): 

Specify new height <33.5000>: (Новая высота <33.5000>:)  

Täze beýikigi giriziň. Eger beýiklik üýtgedilmeli däl bolsa Enter basmaly. Soňra:  

Specify new rotation angle <30>: (Новый угол поворота <30>:) Burçly ýaýyň 

içinde aşaky esasyň öwrülmeginiň şol wagtky ulanylýan burçy görkezilen 

(meselem — 30). Burçy görkeziň ýa-da Enter basyň. Indiki sorag: 

Enter new text <... >: (Новый текст <...>:) Täze teksti girizmeli ýa-da öňki 

tyekst bilen ylalaşylsa Enter basmaly. 

CHANGE (ИЗМЕНИТЬ) buýrugy köp setirli tekstleri redaktirlemek üçin 

ulanylmaýar. 

 

Ölçegleri redaktirlemek 

 

Dimension (Размеры) panelinde öň döredilen ölçeg primitiwleri 

redaktirlemek üçin ýene-de birnäçe düwmejikler bar. Olara gabat gelýän buýruklar 

Dimension (Размеры) menýuda hem bar. 

 DIMEDIT (РЗМРЕ7П) oňa  düwmejigi gabat gelýär, ölçeg teksti we 

onuň ýerleşýän ýerini üýtgetmegi, şeýle hem çykaryş çyzyklary egmek bolýar. Bu 

buýruga bölekleýin (bir opsiýanyň çäginde) Dimension (Размеры) menýunyň 

Oblique (Наклонить) buýrugy gabat gelýär. 

Buýrugyň birinji soragy: Enter type of dimension editing 

[Home/New/Rotate/Oblique] <Home>: (Операция редактирования размеров 

[Вернуть/Новый/Повернуть/нАклонить] <Вернутъ>:) 
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Jogabyň 4 görnüşi elýeterli. New (Новый) opsiýasy teksti Multiline Text 

Editor (Редактор многострочного текста) penjiresi arkaly üýtgetmegi mümkin 

edýär. Bu buýrug amaly boýunça DDEDIT (ДИАЛРЕД) buýrugyna gabat gelýär. 

Hemme üýtgetmeler edilen soň penjire ýapylandan soňra diňe, teksti 

ütgedilmeli ölçeg primitiwleri görkezmeklik galýar. 

Rotate (Повернуть) opsiýasy ölçeg teksti ölçeg çyzygyna görä öwürýär.  

Ноmе (Вернуть) opsiýasy Rotate (Повернуть) opsiýasy bilen girizilen 

üýtgetmeleri ýok edýär. 

Oblique (нАклонить) opsiýasy (bu opsiýa Dimension (Размеры) 

menýusynyň Oblique (Наклонить) bendi gabat gelýär) çykaryş çyzyklaryň  kese 

okuna görä egilme burçuny görkezmegi mümkin edýär. Ol ilkibaşda obýektleri 

soraýar soňra bolsa burçy: 

Enter oblique angle (press ENTER for none): (Угол наклона (или 

ENTER, если без наклона):) 

Aşaky suratda çykaryş çyzyklaryň 60° çenli egilmegi görkezilen. 

 

 DIMTEDIT (РЗМРЕДТЕКСТ) buýrugy oňa  düwmejigi we Dimension 

(Размеры) menýunyň Align Text (Размерный текст) kömekçi menýusynyň 

bendleri gabat gelýär, ol ölçeg tekstiň we ölçeg çyzygyň ýerleşişini üýtgetmegi 

mümkin edýär. 

Buýruk ilkibaşda redaktirlenýän ölçegi saýlamagy soraýar, soňra bolsa onuň 

täze ýerini soraýar: Specify new location for dimension text or 

[Left/Right/Center/Home/Angle]: (Новое положение размерного текста или 

[вЛево/вПраво/Центр/Вернуть/ Угол]:). 

Left (вЛево), Right (вПраво), Center (Центр) opsiýalary ölçegi bar bolan 

ölçeg çyzygyň ugry boýunça süýşürýärler. Angle (Угол) opsiýasy ölçeg çyzygyna 

görä ölçeg teksti öwürmegi mümkin edýär. Ноmе (Вернуть) opsiýasy bu buýruk 

arkaly ýerine ýetirilen ölçeg tekstiň öwrülmegini we süýşürilmeginiň ýok edýär. 

DIMSTYLE (РЗМСТИЛЬ) buýrugyna  düwmejigi gabat gelýär ol hem 

Dimension (Размеры), hem-de Styles (Стили) paneline girýär. Bu buýruga 

Dimension (Размеры) menýunyň Style (Стиль) bendi we Format (Формат) 

menýunyň Dimension Style (Размерные стили) bendi gabat gelýär. Buýruk ölçeg 

stilleri redaktirlemegi mümkin edýär. Ölçeg stili — ölçeg primitiwleriň görnüşini 

teswirleýän görkezmeleriň jemi. 

Emma  düwmejigi ölçeg stilini redaktirlemän we täzesini döretmän 

ölçegleri taýýarlamagyna aýry üýtgetmeleri girizmeklik üçin ulanmak amatly. 

Dimension Style Manager gepleşik penjiresine has ünsli seredeliň. 



 193 

 

Ölçegleri taýýarlamagyň hemme görkezmeleri ölçeg üýtgeýänlere ýazylýar, 

olar bolsa surat bilen ýatda saklanylýar. Olaryň hereket edýän ähmiýetlerini 

görmek üçin Compare (Сравнить) düwmejigine basmaly. 

 
 

Sanawy görüp DIMSCALE (в русской версии — РЗММАСШТ) üýtgeýäni 

üçin (Description (Описание) sütünde Overall scale (Общий масштаб) 

parametri) 1.0000. bahasyna eýe bolup durýar. 

Eger ölçeg goýulyp we ol örän ownuk bolsa onda ölçegleri taýýarlamagyň 

hemme elementlerini proporsional ulaltmak mümkin – meselem iki esse. Munuň 

üçin Compare Dimension Styles (Сравнение размерных стилей) penjiresini 

ýapalyň we Dimension Style Manager (Диспетчер размерных стилей) 
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penjiresinde Override (Переопределить) düwmejigine basalyň. Mundan soň 

indiki penjire açylar — Override Current Style (Переопределение текущего 

стиля) ol 6 sany goşmaça eýe: Lines and Arrows (Линии и стрелки), Text 

(Текст), Fit (Размещение). Primary Units (Основные единицы), Alternate 

Units (Альтернативные единицы) we Tolerances (Допуски).  

Hemme görkezilen goşmaçalar ölçeg üýtgeýänleriň bahalaryny we oalry 

üýtgetmek üçin düwmejikleri saklaýarlar. Syçanjyk arkaly Fit (Размещение) 

goşmaça geçip Scale for Dimension Features (Масштаб размерных элементов) 

meýdany tapalyň. 

 

Bu meýdanda Use overall scale of (Глобальный масштаб) pereklýuçatel 

işledilen. Bu bahany 2 ediň. 

Öň goýlan ölçegleri ulaltmak üçin Dimension (Размеры) panelinde 

 düwmejigi bar, Dimension (Размеры) menýuda bolsa — Update 

(Обновить) bendi bar. 

Bu düwmejik basylanda obýektleri saýlamak barada sorag berler. Zerur 

ölçeg primitiwler bellenilenden soň olar täze görkezmeler bilen gaýtadan çyzylar. 

Команда DIMDISASSOCIATE (РЗМОТКРЕПИТЬ) ölçeg primitiwlerden 

assosiatiwlik häziýetini ýok edýär. 
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Assosiatiwligi dikeltmeklik ýa-da üýtgetmeklik üçin DIMREASSOCIATE 

(РЗМПРИКРЕПИТЬ) buýrugy peýdalanmaly ýa-da oňa gabat gelýän Dimension 

(Размеры) menýunyň Reassociate Dimensions (Прикрепить размеры) 

bendinden peýdalanmaly. Buýruk ölçeg obýektleri soraýar: 

Select dimensions to reassociate Select objects: (Выберите 

прикрепляемые размеры Выберите объекты:) 

Obýektler saýlanylandan soň ulgam birinji çykaryş çyzygyň başynyň nokady 

assosiirlenen nokady soraýar: 

Specify first extension line origin or [Select object] <next>: (Начало 

первой выносной линии или [Выбрать объект] <далее>:) 

Şonda çykaryş çyzygyň başynyň hereket edýän kesgitleýji nokady şu iki 

marker bilen belgilenýär:  — eger ol assosiatiwlik häsiýetine eýe 

bolsa we  — eger şol häsiýete eýe bolmadyk bolsa. Ölçeg ýa doly, ýa-

da bşlekleýin berkidilip bilner.  

 

Ştrihlemeleri we reňk bilen doldurylanlary redaktirlemek 

Ştrihlemeleri we reňk bilen doldurylanlary redaktirlemek üçin Modify II 

(Редактирование-2) panelinde  düwmejigi bar, ol HATCHEDIT 

(РЕДШТРИХ) buýrugyna gabat gelýär. Buýrugy çagyrmagyň başga usuly —

Modify | Object | Hatch (Редакт | Объект Штриховка) menýunyň bendleri.  

Buýruk soraýar: Select associative hatch object: (Выберите объект — 

ассоциативную штриховку:) Ştrihleme görkezilenden soň Hatch Edit 

(Редактирование штриховки) gepleşik penjiresi açylýar, onda Hatch 

(Штриховка) goşmaçasy aktiw bolar. (рис. 3.70). Eger reňk doldurylma 

görkezilse onda şol penjire Gradient (Градиентные) goşmaçasynda açylar.  
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Bu penjire Boundary Hatch and Fill (Штриховка и заливка по контуру) 

penjiresine laýyk gelýän hem bolsa, emma onda sudury saýlamak boýunça hemme 

amallar ýapylan. Bu ýerde ştrihlemegiň nusgasyny, egilmegiň burçuny we 

masştabyny üýtgetmek mümkin. Zerur bolan görkezmeler saýlanylandan soň 

AutoCAD şrihlemegi täze görnüşde regenerirleýär. Hatch Edit (Редактирование 

штриховки) gepleşik penjiresini şeýle hem ştrihlemä iki gezek basmak arkaly 

çagyrmak mümkin. Şonda ştrihlemeden başga hiç obýekt belenilmedik bolmaly. 

 

Splaýnlary redaktirlemek 

Splaýnlary redaktirlemek SPLINEDIT (РЕДСПЛАЙН) buýrugy arkaly 

amala aşyrylýar, oňa Modify II (Редактирование-2) paneliniň  düwmejigi we 

Modify | Object | Spline (Редакт Объекты Сплайн) menýusy gabat gelýär.  

Birinji sorag: Select spline: (Выберите сплайн:)  

Syçanjyk arkaly splaýn görkeziň. PEDIT (ПОЛРЕД) buýrugynyň Spline 

(СПлайн) opsiýasy bilen tekizlenen poliçyzygy hem saýlamak bolýar. Şonda 

POLYLINE primitiwi awtomatiki SPLINE primitiwine özgerdiler. Система 

AutoCAD redaktirlemegiň opsiýalarynyň sanawyny berer:  

Enter an option [Fit data/Close/Move vertex/Refine/rEverse/Undo]: (Задайте 

опцию [Определяющие/Замкнуть/Перенести/Исправить/ОБратно/Отменить 

/выХод]:) 

Şol bir wagtda AutoCAD dolandyryjy nokatlary ýagtyladýar, olar splaýnyň 

özünde dälde şol görnüşli splaýny almak üçin tekizlenmeli karkas poliçyzykda 

ýerleşen. Kesgitleýji nokatlar (ulanyjy tarapyndan splaýn döredilenden girizilen 

nokatlar) şonda ýagtylanmaýar. 

 Fit data (Определяющие) — splaýnyň kesgitleýji nokatlaryny 

redaktirleýär;  

 Close (Замкнуть) — splaýny ýapýar;  

 Move vertex (Перенести) — dolandyryjy nokatlaryň ýerleşişini üýtgedýär  

(we kesgitleýji nokatlary ýok edýär);  

 Refine (Исправить) — splaýnyň çyzygynyň tekizligini üýtgedýär;  

 rEverse (ОБратно) — splaýnyň ugruny üýtgedýär (nokatlary ters 

yzygiderlikde goýýar);  

 Undo (Отменить) — splaýny redaktirlemegiň iň soňky amalyny ýatyrýar.  

Mundan başga hem Enter düwmejigine basylsa buýrugyň işi tamamlaýar.  

Eger splaýn ýapyk bolsa, Close (Замкнуть) opsiýasynyň deregine Open 

(Разомкнуть) opsiýasy görkezilýär. Fit data (Определяющие) opasiýasy 

saýlanylanda buýruk kesgitleýji nokatlary görkezýärwe olary redaktirlemegiň 

düzgünine geçýär. 
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Sorag berilýär запрос: Enter a fit data option 

[Add/'Close/'Delete/'Move/'Purge/Tangents/toLerance /eXit] <eXit>: (Задайте 

опцию [Добавить/Замкнуть/Удалить/Перенести/Очистить/Касательные 

/ДОПуск/выХод] <выХод>:) 

Opsiýalar:  

 Add (Добавить) — splaýna täze kesgitleýji nokady goşýar;  

 Close (Замкнуть) — splaýny ýapýar;  

 Delete (Удалить) — käbir kesgiteleýji nokatlary ýok edýär we splaýny 

galan kesgitleýji nokatlar boýunça hasaplap täzeden çyzýar;  

 Move (Перенести) — kesgitleýji nokatlaryň ýerini üýtgedýär;  

 Purge (Очистить) — kesgitleýji nokatlar baradaky maglumaty ýok edýär, 

şondan soň olar elýeterli däl bolýarlar;  

 Tangents (Касательные) — splaýnyň başlangyç we ahyrky araçäk şertini 

üýtgedýär;  

 toLerance (ДОПуск) — splaýnyň kesgitleýji nokatlaryndan bolan 

gyşarmasyny görkezýän dopusky üýtgedýär;  

 eXit (выХод) — kesgitleýji nokatlary redaktirleme düzgüninden çykýar. 

Splaýny redaktirlemegiň bu opsiýalary köp halatda poliçyzygy 

redaktirlemegiň meňzeş opsiýalaryna gabat gelýär. 

 

Tejribe işleri 

 

 

1) 20x35 ölçegde göniburçlugyň göçürmesini almaly 

2) Radiusy R=50 bolan tegelegiň radiusyny 3,5 esse artdyrmaly 

3) Uzynlygy 45 bolan we x okuna 560 gradus bilen duran kesimiň burçuny 350 

etmeli we uzynlygyny 65 edip artdyrmaly 

4) Dogry üçburçlugyň gurmaly aýnalyk şekilini almaly 

5) Öň ýazylan teksti üýtgetmek onuň şriftini Times New Roman 16 ölçegde 

etmeli 

6) Içinden aýlanan tegelegiň radiusy R=18 bolan dogry sekizburçlugyň bir 

tarapyny ýok etmeli 

7) 6 göni çyzykdan we 7 sany egri çyzykdan ybarat bolan poliçyzygyň egri 

böleklerini ýok etmeli 

8) Setirde 8 we sütünde 6 sany 20x35 ölçegde göniburçlukdan ybarat bolan 

köplügi döretmeli 

9) 9 sany aýry kesimleri bir poliçyzyga öwürmeli 

10) 3 sany çyzykdan ybarat bolan multiçyzygy çyzmaly 
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HÄSIÝETLER, STILLER WE STANDARTLAR. 

Häsiýetler 

Her bir primitiwiň öz reňki, gatlagy we çyzygynyň tipi, çyzygynyň tipiniň 

masştaby, çap edilmeginiň stili, çyzygyň agramy, giperssylka we beýikligi все это 

bularyň hemmesi häsiýetlere degişli edilen. Obýektleriň şol wagtky häsiýetlerini 

LIST (СПИСОК) buýrugy arkaly kesgitlemek mümkin. Häsiýetler bilen işlemek 

üçin esasy panel bolup Properties (Свойства) çykyş edýär.  

 
Bu panelde 4 sany açylýan sanaw bar:  

 Color Control (Цвета);  

 Linetype Control (Типы линий);  

 Lineweight Control (Веса линий);   

 Plot Style Control (Стили печати).  

Ýene bir panel - Layers (Слои).  

 
Panelde üç düwmejik bar:  

 Layers Properties Manager (Диспетчер свойств слоев);  

 Make Object's Layer Current (Сделать слой объекта текущим);  

 Layer Previous (Предыдущий слой).  

Mundan başga hem Layers (Слои) paneline gatlaklaryň sanawy girýär, ol 

sanaw häzirki gatlagyň adyny we esasy häsiýetnamalaryny görkezýär.  

Format (Формат) menýunyň ilkinji 4 sany bendi häsiýetleriň şol wagtky 

ähmiýetlerini dolandyrýar. 

Reňkler 

Properties (Свойства) paneliniň birinji sanawy Color Control (Цвета). Ol 

reňkiň häzirki ähmiýetini goýýar. Deslapdan reňkiň ähmiýeti ByLayer (Послою), 

ýagny reňk häzirki ulanylýan gatlakdan alynýar. Şol sebäpli ilkibaşdaky çyzylan 

obýektler reňki degişli bolan gatlakdan alýarlar, emma olara başga reňk hem 

bellemek bolýar  
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Color Control (Цвета) açylýan sanawy bar bolan obýektiň reňkini 

üýtgetmek üçin ulanylyp bilner. Obýekt bellenilen ýagdaýynda onuň reňki şol 

sanawda görkeziler, eger birnäçe obýekt bellenilse we olaryň reňki meňzeş bolsa 

onda şol reňki görkezilerž eger deň däl bolsa ol sanawyň setiri boş bolar. 

Eger has inçe öwüşginler gerek bolsa Select Color (Выбор цвета) setiri 

ulanyp bilner ol Select Color (Выбор цвета) gepleşik penjiresini çagyrýar, onda 

elýeterli bolan reňkleriň palitrasy getirilen. 

Reňki şu goşmaçalaryň — Index Color (Цвет по номеру), True Color 

(Точный цвет) we Color Books (Цветовые книги) üçüsinden hem saýlap bolýar. 

AutoCAD ulgamynda esasy reňkleri hökmünde 1-den 7-dä çenli reňkler 

bolup durýar:  

 1 — Red (Красный);   

 2 — Yellow (Желтый);  

 3 — Green (Зеленый);  

 4 — Cyan (Голубой);  

 5 — Blue (Синий);  

 6 — Magenta (Фиолетовый);  

 7 — White (Белый), hakykatda ak ýa-da gara bolup biler – grafiki ekranyň 

fonunyň reňkine baglylykda.  

Format (Формат) menýusynyň Color (Цвета) bendi hem reňk saýlama 

gepleşik penjiresini çagyrýar. Mundan başga hem ony klawiaturadan  girizilýän 

COLOR (ЦВЕТ) buýrugy hem çagyryp biler. 

Çyzygyň tipi we masştaby 

Çyzygyň tipi we onuň masştaby — çyzykly obýektleriň ýene-bir iki sany möhüm 

häsiýetleri. Linetype Control (Типы линий) açylýan sanaw Properties 

(Свойства) panelinden çepden ikinji bolup durýar.  

 

 
 

Onda ByLayer (Послою) we ByBlock (По-блоку) gulluk ähmiýetlerden 

başga, diňe Continuous tipi bar, ol adaty inçe tutuş çyzygyň adyny belgilemek 
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üçin ulanylýar. Çyzyklaryň beýleki tiplerini ýüklemek üçin Other (Другой) 

setirine basyň. Linetype Manager (Диспетчер типов линий) gepleşik penjiresini 

açyň. 

Bu penjire arkaly bar bolan çyzygyň tipini ulanylýan edip bolýar, ony ýok 

edip bolýar we täze görnüşini ýükläp bolýar. Penjiräniň merkezi böleginde siziň 

suratyňyzyň faýlyna eýýam ýäklenilen tipler görkezilen. Täze tipleri ýüklemek 

üçin Load (Загрузить) düwmejigine basyň. Mundan soň ekranda Load or Reload 

Linetypes (Загрузка или перезагрузка типов линий) gepleşik penjiresi emele 

geler.  
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Penjiräniň ýokarky böleginde tipleriň ýüklenilýän (acadiso.lin) faýlyň ady 

görkezilen. Tejribeli ulanyjylar çyzyklaryň täze tiplerini döredip olary öz 

faýllarynda ýatda saklap bilerler. 

Eger bir tipi saýlap ОК düwmejigine basylsa onda ol Linetype Manager 

(Диспетчер типов линий) gepleöik penjiresiniň içindäki tipleriň hataryna girer. 

Çyzyklaryň tipleriniň hemme görnüşlerini ýäklemek üçin, Load or Reload 

Linetypes (Загрузка или перезагрузка типов линий) gepleşik penjiresinde 

kursory tipleriň ady sanalyp geçilýän töwerekde goýup kontekst menýuny 

syçanjygyň sag düwmejigi bilen çagyryo we Select All bendi saýlamak gerek. 

Bar bolan obýektleriň çyzyklarynyň tipini üýtgetmeklik hem reňk saýlanyş 

ýaly bolup geçýär. 

Linetype Manager (Диспетчер типов линий) gepleşik penjiresiniň 

çagyrylmagy şeýle hem Format (Формат) menýunyň Linetype (Типы линий) 

bendi ýa-da klawiaturadan girizilýän LINETYPE (ТИПЛИН) buýrugy bilen amala 

aşyrylyp bilner. 

Primitiwiň ýe-ne bir häsiýeti — çyzygyň tipiniň masştaby. Eger bir obýekte 

çyzygyň tipi bellenilen bolsa we ony düzýän elementleriň (ştrihleriň, nokatlaryň, 

ştrihleriň arasyndaky probelleriň we b. ) ölçeglerini üýtgetmek üçin şol obýekt üçin 

çyzygyň tipiniň masştabyny üýtgedip bolar. Deslapdan masştab 1 deň. Aşakdaky 

suratda çyzygyň tipleri deň bolan emma çyzygynyň tipiniň masştaby tapawutly 

bolan çyzyklar görkezilen. 

 

Obýektiň çyzygynyň tipiniň masştabynyň ähmiýeti iki masştabyň: global we 

öz masştablarynyň köpeldilmegi hökmünde alynýar. Global masştaby çyzgynyň 

hemme obýektlerine degişli bolýar, öz masştaby bolsa hususan obýektde degişli 

edilýär. Iki masştabyň hereket edýän ähmiýetlerini üýtgetmek üçin (Global scale 

factor (Глобальный масштаб) we Current object scale (Текущий собственный 

масштаб)) Linetype Manager (Диспетчер типов линий) penjiräniň Show 

details (С подробностями) düwmejigi basmaly, ol penjiräniň aşaky böleginde 

goşmaça maglumaty görkezýär. 

Global masştabyň üýtgedilmegi çyzgynyň hemme elementlerine täsir eder. 

Klawiaturadaky LTSCALE (ЛМАСШТАБ) buýrugy çyzyklaryň tipleriniň global 
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masştabyny üýtgetmegi mümkin edýär. Onuň ähmiýeti LTSCALE ulgamlaýyn 

üýtgeýände saklanylýar. Häzirki öz masştabyň ähmiýeti CELTSCALE ulgamlaýyn 

üýtgeýäne girizilýär. 

 
Gatlaklar 

Çylşyrymly suratlar döredilende aýry obýektlere ýa-da obýektleriň 

toparlaryna atlary bermek zerurlygy ýüze çykýar. Bu maksatlar üçin primitiwleriň 

ýe-ne bir häsiýeti gulluk edýär — слой. Mundan başga hem gatlak öçürilme 

häsiýetine eýe bolup durýar, bu esasan käbir obýektleri ýok etmän, wagtlaýyn 

ekrandan aýyrmak üçin ulanylýar. 

Gatlaklar bilen işlemek boýunça esasy buýruk bolup LAYER (СЛОЙ) çykyş 

edýär, oňa  Layers (Слои) paneliniň  düwmejigi Format (Формат) menýunyň 

Layer (Слои) bendi gabat gelýär. 

LAYER (СЛОЙ) buýruk Layer Properties Manager (Диспетчер свойств 

слоев) gepleşik penjiresini çagyrýar. 
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Birnäçe gatlak bar bolanda olaryň biri ulanylýan bolup durýar (aktiw). Onuň 

ady: Current Layer: 0 (Текущий слой: 0) meýdanynda görkezilýär 

Häzirki ulanylýan gatlak — täze obýektleriň dörediljek gatlagy.  

Ýokarky sag burçunda şeýle düwmejikler görünýär:  

 New (Новый) — täze düwmejigi döredýär:  

 Delete (Удалить) — suratdan gatlagy ýok edýär (bu diňe gatlak 

ulanylmaýan bolsa amala aşyrylýar);  

 Current (Текущий) — başga gatlagy häzirki ulanylýan edip goýýar onuň 

ady CLAYER ulgamlaýyn üýtgeýäne ýazylýar ;  

 Show details (С подробностями) — penjiräniň aşaky böleginde saýlanylan  

gatlagyň häsiýetlerini görkezýär;  

 Save state (Сохранить состояние) — gatlaklaryň häzirki görkezmelerini 

las giňişlikli konfigurasiýa faýlynda olary soňra dikeltmek üçin ýatda 

saklaýar;  

 State Manager (Диспетчер конфигураций слоев) — las giňişlikli ýatda 

saklanylýan gatlaklaryň görkezmeleriniň dikeldilmegini saýlamak mümkin 

bolan gepleşik penjiresini çagyrýar.  

Gatlaklaryň şeýle häsiýetnamalary bar:  

 Name (Имя) — gatlagyň ady simwollaryň sany 1-den 255-e çenli bolup 

bilýär;  

 On (Вкл) — gatlagyň işledilmeginiň ýagdaýy (işledilen ýa-da öçürilen);  

 Freeze in all VP (Hemme görülýän ekranlarda doňdurylan) — hemme 

görülýän ekranlara görä doňdurlmagyň ýagdaýy (doňdurylan ýa-da 

doňdurylmadyk); 

 Lock (Блокированный) — blokirlenmeginiň ýagday (blokirlenen we 

blokirlenmedik);  

 Color (Цвет) — reňk hökmünde By Layer (Послою) ähmiýeti berlen 

gatlagyň obýektleri üçin reňki belleýär;  
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 Linetype (Тип линии) — çyzygyň tipi hökmünde By Layer (Послою) 

ähmiýeti berlen gatlagyň obýektleri üçin çyzygyň tipini belleýär;  

 Lineweight (Вес линии) — çyzygyň agramy hökmünde By Layer 

(Послою) ähmiýeti berlen gatlagyň çyzygyň agramyny belleýär;  

 Plot Style (Стиль печати) — gatlaga ulanylýan çapy etmegiň stili;  

 Plot (Печать) — daşky gurala çykarmak üçin gatlagyň obýektleriniň 

ýagdaýy (çap etmeli ýa-da däl).  

Gatlak döredilende onuň ady berilýär we ОК düwmejigine basylsa täze 

gatlak edil 0 gatlagyň häsiýetnamalary bilen dörediler. 

Gatlagyň beýleki häsiýetnamasy — On (Вкл). Eger gatlagyň bu sütüninde 

(sary çyrajyk) duran bolsa, gatlak işledilen diýlip hasaplanylýar, eger (синяя gök 

çyrajyk) — onda öçürilen diýlip hasaplanylýar. 

Öçürilen gatlakda ýerleşen obýektler ol işledilýänçä wagtlaýynça ekrandan 

ýitýärler, emma ýok edilmeýär. Islendik gatlak, eýsem häzirki hem öçürilip bilner. 

Indiki häsiýetnama — Freeze in all VP . Eger gatlgyň bu sütüninde (sary 

gün) belgisi duran bolsa, onda gatlak doňdurylmadyk diýlip hasaplanylýar, eger 

(gök buzjagaz) belgisi bolsa — onda doňdurylan diýlip hasaplanylýar.  

Doňdurylýan gatlakda ýerleşen obýektler wagtlaýyn görünmeýän bolýar. 

Häzirkiden başga islendik gatlak doňdurylyp bilner. 

Gatlagyň indiki häsiýetnamasy — Lock (Блокированный). Eger-de 

gatlagyň bu sütüninde (açyk gulp) belgisi duran bolsa, onda ol blokirlenmedik 

bolup durýar, eger (ýapyk gulp) belgisi duran bolsa — blokirlenen diýlip 

hasaplanylýar. Blokirlenen gatlakda täze obýektleri döretmek mümkin, emma bar 

bolanlary ýok etmek we redaktirlemek mümkin däl. 

Color (Цвет) häsiýetnamasy reňk hökmünde ByLayer (Послою) ähmiýeti 

berlen gatlagyň obýektleriniň hakyky reňkini görkezýär. 

Indiki häsiýetnama — Linetype (Тип линии). Ol çyzygyň tipi hökmünde 

By Layer (Послою) ähmiýeti berlen gatlagyň obýektlerini çyzmak üçin çyzygyň 

tipini belleýär. 

Indiki häsiýetnama — Lineweight (Вес линии). Ol çyzygyň agramy 

hökmünde By Layer (Послою) ähmiýeti berlen gatlagyň obýektlerini çyzmak üçin 

çyzygyň agramyny belleýär. 
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Plot Style (Стиль печати) häsiýetnamasy diňe çapyň stilini teswirleýär. 

Plot (Печать) häsiýetnamasy gatlagyň obýektleri çapa çykarylarmy ýa-da 

ýok meselesini kesgitleýär. (çyzylmadyk printer) belgisi obýektleriň çap 

ediljekdigini,  (çyzylan printer) belgisi çap edilmejekdigini görkezýär. 

Layers (Слои) panelindäki  düwmejigi AI_MOLC buýrugyna gabat 

gelýär, ol häzirki ulanylýan edip gatlagy belleýär. 

Buýrugyň soragy: Select object whose layer will become current: 

(Выберите объект, слой которого должен стать текущим:)  

Obýekt görkezilenden soň ol häzirki ulanylýan etmeli.  düwmejigi LAYERP 

(СЛОЙП) buýrugyna gabat gelýär, ol gatlaklaryň öňki ýagdaýyna gelmegi 

mümkin edýär emma aşakdakylar gaýdyp gelmeýär:  

 Ady üýtgedilen gatlaklaryň ady dikeldilmeýär;   

 Ýok edilen gatlaklar dikeldilmeýär;   

 Täze gatlaklar ýok edilmeýär.  

Bellik LAYERP (СЛОЙП) buýrugyň işini başga buýruk dolandyrýar — 

LAYERPMODE (СЛОЙПРЕЖИМ), ol LAYERP (СЛОЙП) buýrugyň işine rugsat 

ýa berýär ýa-da bermeýär. 

 Çyzygyň agramy — bu obýektiň çapa çykaryljak galyňlygy. Obýektleri inçe 

çyzyk emma nola deň bolmadyk agramy berseňiz onda çapda olar goýy çyzyklar 

bilen çykarylar. 

Eger LWT düzgün düwmejigi basylan bolsa, onda grafiki ekranda çyzyklar 

agramsyz görkezilýär. 
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Agram galyňlygyň beýleki görnüşleri bellenilen obýektlere täsir etmeýär: 

poliçyzygyň nol däl inli meýdançalaryna, zolaklara, figuralara, reňk 

doldurylmalara, True Type şrifli ýazgylara, rastr şekillere. 

Täze obýektler agramyň häzirki ähmiýeti Properties (Свойства) paneliniň 

Lineweight Control (Веса) açylýan sanawy arkaly bellenilýär.  

 
 

 

Agramyň häzirki ähmiýeti mundan başga hem LWEIGHT (ВЕСНИН) 

buýrugy we oňa gabat gelýän Format (Формат) menýunyň Lineweight (Вес 

линий) agramy bilen bellenilýär. LWEIGHT (ВЕС-ЛИН) buýrugy Lineweight 

Settings (Параметры весов линий) gepleşik penjiresini çagyrýar. 
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Bu gepleşik penjiresinde çyzyklaryň agramyny ýol berilýän ähmiýetleriň 

sanyndan kabul edip bolýar (от 0-dan 2,П-e mm çenli). Display Lineweight 

(Отображать линии в соответствии с весами) baýdajygyň goýulmagy LWT 

(ВЕС) düwmejigiň basylmagyna deň täsir berýär. Adjust Display Scale 

(Масштаб экранного отображения) şkalnyň polzunogy grafiki ekranda 

görkezilende agramlaryň masştablaryny dolandyrýar (bu sazlama çapda ulanylýan 

agramlaryň ululyklaryna täsir etmeýär). 

Default (По умолчанию) açylýan sanaw DEFAULT (ОБЫЧНЫЙ) aýratyn 

ähmiýet üçin agramy belleýär. DEFAULT (ОБЫЧНЫЙ) atly agram adatça 0,25 

mm (0,01 dýýma) deň edilip kabul edilýär. Bu ähmiýet çyzgynyň esasy 

elementleriniň toplumy üçin ulanylýar. 

 

Giperssylka 

Giperssylka — bu grafiki obýektiň beýleki surata, resminama, elektron 

jetwele we islendik beýleki faýla salgylanma häsiýeti.  

Giperssylkalaryň goýulmagy we redaktirlenmegi HYPERLINK 

(ГИПЕРССЫЛКА) buýrugy arklay ýerine ýetirilýär, oňa Insert (Вставка) 

menýusynyň Hyperlink (Гиперссылка) bendi gabat gelýär.  

Buýruk obýektleri soraýar we eger giperssylkasy bolmadyk obýektler saýlanylsa 

onda Insert Hyperlink (Вставка гиперссылки) gepleşik penjiresi çagyrylýar. 
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Text to display (Выводимый текст) meýdanynda kursor obýektiň 

üçstünden geçirilende görkeziljek teksti girizilmeli. Suradyň primitiwi bilen 

baglaşdyrylýan obýektiň tipi Insert Hyperlink (Вставка гиперссылки) gepleşik 

penjiresiniň Link to (Связать с) çep sütünden alynyp bilner, bu ýerde üç 

düwmejigiň ady bar:  

  Existing File or Web Page (Имеющийся файл или Web-страница); 

  View of This Drawing (Вид из этого рисунка); 

  E-mail Address (Адрес электронной почты). 

 

Häsiýetleri redaktirlemek 

Primitiwleriň beýleki häsiýetleri — beýiklik we dereje. Beýiklik — ölçegli 

çyzuwlarda ulanylýan primitiwleriň häsiýetleri. Ol Z okuň ugry boýunüa gysylyp 

çykarmagyň ululygyny belleýär, bu ok X we Y oklaryn aperpendikulýar bolýar. 

Mese lem tegelegi silindre öwürmek üçin ony nol däl ululyga gysyp çykarmaly. 

Dereje — obýektiň döredilen tekizligiň XY tekizligine görä süýşmegi. 

Esasy häsiýetnamalary (gatlak, reňk, çyzygyň tipi, çyzygyň agramy) 

eljagazlar we Properties (Свойства) paneliniň Layer Control (Слой), Color 

Control (Цвета), Linetype Control (Типы линий), Lineweight Control (Веса 

линий) açylýan sanawlar arkaly redaktirlemek mümkin. 

PROPERTIES (OKHOCB) uniwersal buýrugy obýektleriň islendik 

häsiýetlerini, şeýle hem geometriýany redaktirlemegiň mümkinçiligini berýär. 
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Buýruga Standard (Стандартная) paneliniň  düwmejigi we Tools (Сервис) 

menýunyň Properties (Свойства) bendi gabat gelýär. Buýrugy çagyrmagyň ýene-

de bir usuly — klawiaturada <CtrI>+<!> klawişalaryny girizmeklik. 

PROPERTIES (OKHOCB) buýrugy PROPERTIES (СВОЙСТВА) penjiresini 

açýar. 

Bu penjiräni ýeşle hem obýekte iki gezek syçanjyk bilen abasmak arkaly 

çagyryp bolýar. 

PROPERTIES (СВОЙСТВА) penjiresiniň düzümi haýsy obýektleriň 

saýlanandygyna örän bagly bolup durýar. 

 

Eger birnäçe obýekt saýlanylsa we haýsy-da bir häsiýet bu obýektlerde dürli 

ähmiýetlere eýe bolan bolsa, onda (meselem, reňk), onda häsiýetiň meýdanyna 

*VARIES* ähmiýeti girizilýär. Açylýan sanawyň çep tarapynda üç düwmejik bar:  

 Juck Select (Быстрый выбор) — suratda filtrler arkaly obýektleri tiz 

saýlamak;  

 Select Objects (Выбор объектов) — obýektleri gaýtadan saýlamak 

üçin;  

 Toggle value of PICKADD Sysvar (Изменить значение системной 

переменной PICKADD) — PICKADD ulgam üýtgeýäniň ähmiýetini 1-den 0-a 

üýtgedýär; eger onuň ähmiýeti 1 deň bolsa, onda PROPERTIES (СВОЙСТВА) 

şol wagt saýlanylan obýektler üçin umumy häsiýetleri görkezýär, eger 0 bolsa — 

onda diňe soňkyňkyny we seredilýän düwmejik -  şekile eýe bolar. 

PROPERTIES (СВОЙСТВА) penjiresiniň merkezi bölegi goömaçalara 

eýe bolan jetwel hökmünde taýýarlanan. Goşmaçalaryň sanawy saýlanylan obýekte 

bagly bolup durýar. Eger saýlanylan obýekt bolmasa, onda goşmaçalar hökmünde  

General (Общие), Plot Style (Стиль печати), View (Вид) we Misc (Разное) 

goşmaçalar çykarylar. Eger grafiki ekranynda saýlanylan obýekt bar bolsa, onda 
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General (Общие) goşmaçasy çykarylar, oňa obýektleriň tipine baglylykda 

Geometry (Геометрия) goşmaçasy ýa-da beýleki goşmaçalar goşulýar. 

Gerekli häsiýeti saýlap onuň ähmiýetini üýtgedip bolýar. 

CHPROP (СВОЙСТВА) buýrugy obýektiň häsiýetini buýruk setirinden. 

Obýektleri sýlamak üçin soragdan soň şeýle sorag berilýär:  

Enter property to change [Color/LAyer/LType/ltScale/LWeight/Thickness]:  
(Укажите изменяемое свойство [Цвет/Слой/Тип линии/Лмасштаб/ вЕс 

линии/Высота]:). 

CHANGE (ИЗМЕНИТЬ) buýrugy — buýruk setirden üýtgetmeleri 

girizmegiň ýene bir usuly. Ol obýektleri soraýar. Saýlanan obýektler ulanyjynyň 

koordinatlar ulgamynyň tekizligine parallel bolmalydyr. Bu şert beýikligi nola deň 

däl bolan kesimlere degişli däl. Soňra sorag berilýär:  

Specify change point or [Properties]: (Точка изменения или [Свойства]:)  

Eger nokat görkezilse ol saýlanylan obýektiň üýtgedilýän nokady bolup durýar 

(meselem, kesimiň ahyrky nokatlarynyň biri täzesine geçirilýär. Properties 

(Свойства) opsiýasynyň ýagdaýynda şu sorag berilýär:  

Enter property to change [Color/Elev/LAyer/LType/ltScale/L 

Weight/Thickness]: (Укажите изменяемое свойство /Цвет/Уровень/Слой/Тип 

линии/Лмасштаб/ в Ее линии/Высота!:)  

Bu ýerde — Elev (Уровень) opsiýasy bar. Bu opsiýa obýektden XY 

koordinat ulgamynyň tekizligine çenli aralygy berýär. 

AutoCAD ulgamynda bir obýektiň häsiýetlerini başga obýekte geçirmegiň 

buýrugy bar - MATCHPROP (КОПИРОВАТЬСВ) buýrugy. Buýruga gabat 

gelýän  düwmejigi Standard (Стандартная) panelinde ýerleşýär. Buýrugy 

şeýle hem Modify (Редакт) menýusynyň Match Properties (Копирование 

свойств) bendi arklay çagyryp bolýar. 

Buýrugyň birinji soragy: Select source object: (Выберите исходный 

объект:) Obýekt saýlanylandan soň КОПИРОВАТЬСВ (MATCHPROP) 

buýrugyň şol wagtky sazlamalar barada habar berilýär: 

Текущие активные настройки: (Current active settings:)  

Habar buýrugyň beýleki obýekte geçirjek bolýan häsiýetleriň sanalmagy bilen 

bolup geçýär. Bu häsiýetleriň maksimal toplumy aşakdaky suratda görkezilen. 
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 Soňra şu sorag berilýär: Select destination object(s) or [Settings]: 

(Выберите целевой объект(ы) или [Настройки]:) 

  

Stiller we standartlar 

AutoCAD ulgamynda — Styles (Стили) paneli tekst we ölçeg stillerine tiz 

elýeterliligi üpjün edýär.  

 
Tekst stilleri örän wajyp bolup durýarlar we bir setirli tekstlerde ulanylyp 

köp beýleki obýektlere (ölçeg stillerine, atributlaryň kesgitlenilşi) täsir edýär. 

Häzirki ulanylýan stiliň ady Styles (Стили) gurallara paneliniň birinji açylýan 

sanawynda görkezilýär. Tekst stilleri suratyň içinde saklanylýar.  

Tekst stiller bilen işlemeklik STYLE (СТИЛЬ) buýrugy arkaly amala aşyrylýar, 

oňa Format (Формат) menýunyň Text Style (Текстовые стили) bendi hem-de 

Text (Текст) we Styles (Стили) panelleriň  düwmejigi gabat gelýär. STYLE 

(СТИЛЬ) buýrugy Text Style (Текстовые стили) gepleşik penjiresini çagyrýar.  

 
Penjiräniň orta böleginde şriftiň parametrleri kesgitlenýär: şriftiň ady, 

kursiwligi ýa-da ýok harplaryň beýikligi. Penjiräniň aşaky böleginde dürli effektler 

bellenilýär (agdarylmasy, süýnmesi we ş.m.). Apply (Применить) düwmejikler 

arkaly edilen üýtgetmeleri ýatda saklamak mümkin.  

New (Новый) düwmejigine basylsa täze stili döretmek mümkin. 
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Täze stil hemme öz ilkibaşdaky häsiýetnamalaryny häzirki stilden alar. 

Gepleşik penjiresinde olary Siz öz islegiňiz boýunça üýtgedip bilersiňiz.  

Text Style (Текстовые стили) gepleşik penjiresinde Font Name (Имя шрифта) 

açylýan sanawynda — AutoCAD ulgamynda elýeterli şriftleri saýlamaly. 

Çepinde  belgisi bolan — bu adaty AutoCAD ulgamynyň SHX-şriftler, 

olar AutoCAD ulgamynyň programma üpjünçiliginiň Fonts bukjasynda shx 

giňişligi bilen ýatda saklanylýar. Çepinde  belgisi bolan — bular Windows 

ulgamynda ýäklenen True Type şriftleri. txt.shx şriftine esaslanýan we täze 

suratda deslapdan ulanylýan Standard stili ýok edilip we ady üýtgedilip hem 

bilenok hem ady. Bu stili diňe dürli ölçeglerini redaktirlemek bilen üýtgetmek 

mümkin. 

Penjiräniň Height (Высота) meýdany şol stiliň hemme ýazfylary üçin şriftiň 

şol bir beýikligini goýmak üçin ulanylýar. Nola deň bolmadyk beýiklik bolanda 

TEXT (ТЕКСТ) buýrugy harplaryň beýikligi barada sorag bermeýär. 

Eger şrift hökmünde SHX-şriftleriň biri ulanylan bolsa onda Use Big Font 

(Использовать большой шрифт) baýdajygy elýeterli bolýar. 

Параметр Width Factor (Степень растяжения) şriftleri gysmagy ýa-da 

süýndirmegi amala aşyrýar. 1-den uly bahalar şriftiň simwolalryny süýndürýärler, 

1-den kiçi bahalar — gysýarlar. Oblique Angle (Угол наклона) parametri diklige 

görä harplaryň eňňitliginiň burçuny belleýär (tutuş ýazgynyň eňňitligine täsir 

etmän!). Ýol bererli ähmiýetler -85° we +85° bahalaryň arasynda. 

Ölçeg stilleri 

Ölçeg stiller bilen işlemeklik DIMSTYLE (РЗМСТИЛЬ) buýrugy arkaly 

amala aşyrylýar, oňa Styles (Стили) we Dimension (Размеры) panelleriň  

düwmejigi, şeýle hem Dimension (Размеры) menýusynyň Style (Стиль) bendi we 

Format (Формат) menýusynyň Dimension Style (Размерные стили) bendi gabat 

gelýär. 

Hemme ölçeg stilleriň atlary bar. Häzirki suratda bar bolan stilleriň sanawy 

Dimension (Размеры) panelinde saklanylýar, şeýle hem Styles (Стили) panelinde. 

Eger bu paneller dik ýagdaýynda fiksirlenen bolsa onda sanaw görkezilmeýär.  

Täze suratda azyndan bir stil — ISO-25 stili bar. 

DIMSTYLE (РЗМСТИЛЬ) buýrugy Dimension Style Manager 

(Диспетчер размерных стилей) gepleşik penjiresini açýar.  
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 Gepleşik penjiresini merkezi böleginde Preview of (Образец стиля) 

serediliş meýdanynda şol wagtky ulanylýan stil bilen döredilen ölçegleriň görnüşi 

görkezilen. Aşakda, Description (Описание) meýdanynda hereket edýän stile 

bolan düşündirme getirilen. 

Penjiräniň sag böleginde şu düwmejikler ýerleşen:  

  Set Current (Установить) – stilleriň sanawynda bir stili häzirki ulanylýan 

edip goýýar;  

  New (Новый) – täze stili döretmek üçin;  

  Modify (Изменить);  

  Override (Переопределить);  

  Compare (Сравнить).  

Eger suratda bar bolanlardan täze häzirki ulanylýan stil gerek bolsa, ony 

Styles (Стили) sanawyndan saýlaň we Set Current (Установить) düwmejigine 

basmaly. 

Täze stili döretmek üçin, New (Новый) düwmejigine basmaly. Bu ýagdaýda 

Create New Dimension Style (Создание нового размерного стиля) penjiresi 

emele geler.  

 
Täze stil özbaşdak we hakykatdan täze bolup diňe Use for (Размеры) snawynda 

All dimensions (Все размеры) opsiýasy saýlanylan bolsa bolýar. Eger başga 

opsiýalar saýlanylsa: Linear dimensions (Линейные размеры), Angular 
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dimensions (Угловые размеры), Radius dimensions (Радиусы), Diameter 

dimensions (Диаметры), Ordinate dimensions (Ординатные размеры) ýa-da 

Leaders and Tolerances (Выноски и допуски), onda bu ýagdaýda täze stil 

döredilmän şol wagtky ulanylýan stiliň käbir parametrini gaýtadan kesgitllenmegi 

bolup geçer. Bu ýagdaýda täze stiliň adyny görkezýän meýdan elýeterli bolmaz. 

Create New Dimension Style (Создание нового размерного стиля) 

gepleşik penjiresinde hemme gerekli görkezmeler goýulandan soň Continue 

(Далее) düwmejigine basmaly. Mundan soň New Dimension Style (Новый 

размерный стиль) penjiresi emele geler, ol 6 sany goşmaça eýe bolar. Adatça 

ilkibaşda Lines and Arrows (Линии и стрелки) goşmaçasy aktiwizirlener. 

 

Область Dimension Lines (Размерные линии) töweregi ölçeg çyzyklary 

çyzmagyň şeýle görkezmelerine eýe:  

 Color (Цвет) - reňk;  

 Lineweight (Вес линии) – çyzygyň agramy;  

 Extend beyond ticks (Удлинение за выносные) çykaryş çyzyklaryň daşyna 

uzalma;  

 Baseline spacing (Шаг в базовых размерах);  

 Suppress Dim Line 1 (2) (Подавить 1-ю (2-ю) размерную) – 1-nji ýa-da 

ikinji ölçeg çyzygyň ujuny ýok etmek 

Parametrleriň niýetlenilişi olaryň atlaryna gabat gelýär. 

Extension Lines (Выносные линии) meňzeş görkezmeleri saklaýar emma 

çykaryş çyzyklary üçin: 

 Color (Цвет) - reňk;  

 Lineweight (Вес линии) - çyzygyň agramy;  

 Extend beyond dim lines (Удлинение за размерные) ölçeg çyzyklaryň 

daşyna uzalma;  
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 Offset from origin (Отступ от объекта) – birinji obýektden süýşme;  

 Suppress Ext Line 1 (2) (Подавить 1-ю (2-ю) выносную) – 1-nji ýa-da 2-

nji çykaryş çyzygy ýok etmek.  

Arrowheads (Стрелки) töweregi ölçeg çyzyklaryň we çykaryşlaryň 

strelkalarynyň görnüşleriniň ýol bererli ähmiýetleriniň degişli açylýan sanawlaryny 

saklaýar, şeýle hem sterlkalaryň ululygyny kesgitleýän meýdanyny:  

 1st (1-я);   

 2nd (2-я);   

 Leader (Выноска);   

 Arrow size (Величина).  

Center Marks for Circles (Маркеры центра для кругов) töweregi 

tegelegiň we halkalaryň merkeziniň we oklaýyn çyzyklarynyň markeriniň tipini, 

şeýle hem markeriň we tegelegiň daşyna oklaýyn çyzyklaryň çykýanlygynyň 

ölçegini kesgitleýär:  

 Туре (Тип) — markeriň görnüşiniň 3 ähmiýeti bilen sanaw - (None (Нет), 

Mark (Только маркер), Line (С линиями));  

 Size (Размер) — markeriň ölçegi bilen sanawjynyň meýdany.  

 

New Dimension Style (Новый размерный стиль) gepleşik penjiresiniň 

Text (Текст) goşmaçasy ölçeg tekstiniň görkezmelerini teswirleýär.  

Text Appearance (Свойства текста) töweregi şeýle görkezmeleri belleýär:  

 Text style (Текстовый стиль) — ölçeg tekstiniň stiliniň ady;  

 Text color (Цвет текста) — ölçeg tekstiniň reňkini;  

 Text height (Высота текста) — simwollaryň beýikligini;  

 Fraction height scale (Масштаб дробей) — droblaryň simwollarynyň 

masştabyny. 

Mundan başga hem Draw frame around text (Текст в рамке) baýdajygyň 

goýulmagy ölçeg tekstiň töwereginde çägi belleýär.  
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Text Placement (Выравнивание текста) töweregi ölçeg tekstiň ölçeg 

çyzygyna görä ýerleşişini kesgitleýär: Vertical (По вертикали) — ýol bererli 

ähmiýetler Centered (По центру), Above (Над линией), Outside (Снаружи), 

JIS (Стандарт JIS)) hem-de Horizontal (По горизонтали) — ýol bererli 

ähmiýetler Centered (По центру), At Ext Line 1 (У 1-й выносной). At Ext Line 

2 (У 2-й выносной), Over Ext Line 1 (Над 1-й выносной), Over Ext Line 2 

(Над 2-й выносной)), şeýle hem tekst üçin ölçeg çyzykdan süýşmegi Offset from 

dim line (Отступ от размерной) sanawjy arkaly belleýär. 

Text Alignment (Ориентация текста) töweregi ölçeg tekstiniň 

oriýentasiýasyny görnüşlerini belleýän üç pereklýuçateli saklaýar: Horizontal 

(Горизонтально), Aligned with dimension line (Вдоль размерной линии) we 

ISO Standard (Согласно ISO). 

 

Gepleşik penjiresiniň Fit (Размещение) goşmaçasy ölçegleri goýmagyň 

görnüşlerini tekst we strelkalar çykaryş çyzyklaryň arasynda sygmaýan 

ýagdaýynda kesgitleýär. 

Fit Options (Опции размещения) opsiýasy "If there isn't enough room to 

place both text and arrows inside extension lines, the first thing to move 

outside the extension line is:" ("Если текст и стрелки одновременно не могут 

быть размещены между выносными линиями, размещать их за пределами:") 

ýazgyny saklaýar we degişli pereklýuçatelleri saklaýar:  

  Either the text or the arrows, whichever fits best (Либо текст, либо 

стрелки (оптимальное размещение));  

  Arrows (Стрелки);  

  Text (Текст);  

  Both text and arrows (Текст и стрелки);  

  Always keep text between ext lines (Текст всегда между выносными).  

Bu töwerekde mundan başga hem Suppress arrows if they don't fit inside 

the extension lines (Подавить стрелки, если они не помещаются между 

выносными) baýdajygy bar. 

Text Placement (Размещение текста) töweregi "When text is not in the 

default position, place it" ("При перемещении текста с позиции по 

умолчанию") ýazgyny we aşaky üç pereklýuçatel arkaly saýlamagyň görnüşlerini 

saklaýar:  

 Beside the dimension line (Перемещать размерную линию);  

 Over the dimension line, with a leader (Строить выноску);  

 Over the dimension line, without a leader (He строить выноску).  

Scale for Dimension Features (Масштаб размерных элементов) töweregi 

iki sany pereklýuçateli saklaýar: Use overall scale of (Глобальный масштаб), 

ölçegleri goýmagyň hemme elementlerine täsir edýär, we üsti bilen masştab 

berilýän  degişli sanawjy, alternatiwa hökmünde — listiň giňişligine görä ölçegleri 

masştablaýan Scale dimensions to layout (paperspace) (Масштаб относительно 

листа) pereklýuçateli. 

Fit (Размещение) goşmaçasynyň iň soňky töweregi Fine Tuning 

(Подгонка элементов) iki baýdajyga eýe: Place text manually when 
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dimensioning (Размещение размерного текста вручную) we Always draw dim 

line between extlines (Размерная линия всегда между выносными).  

Primary Units (Основные единицы) goşmaçasy ölçeg sanlaryň birliklerini 

sazlamagyň parametrlerini kesgitleýär.  

 

 

Linear Dimensions (Линейные размеры) töweregi häsiýetnamalaryň şeýle 

meýdanlary öz içine alýar: 

 Unit format (Формат единиц); 

 Precision (Точность); 

 Fraction format (Формат дробей); 

 Decimal separator (Десятичный разделитель); 

 Round off (Округление); 

 Prefix (Префикс); 

 Suffix (Суффикс). 

Mundan başga hem, Linear Dimensions (Линейные размеры) töweregiň 

içinde ýene iki içki töwerek bar. Birinji töwerek Measurement Scale (Масштаб 

измерений) Scale factor (Масштаб) masştab köpeldijini saklaýar, oňa hemme 

çyzykly ölçegler köpeldilýär. Bu köpeldiji diňe listiň giňişligine ulanylýar - eger 

Apply to layout dimensions only (Только для размеров на листе) degişli 

baýdajyk gurnalan bolsa. 

Beýleki içki Zero Suppression (Подавление нулей) töweregi degişli 

baýdajyklar goýulandan soň başdaky we soňdaky nollary aýyrmagy mümkin 

edýär:  

  Leading (Ведущие);  

  Trailing (Хвостовые);  

  0 Feet (0 футов);  
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  0 Inches (0 дюймов).  

Angular Dimensions (Угловые размеры) töweregi burç ölçegleriň 

formadyny we takyklygyny sazlamagy mümkin edýär. Mundan başga hem bu 

ýerde başdaky we soňdaky nollary ýok etmegiň mümkinçiligi bar.  

Indiki goşmaça Alternate Units (Альтернативные единицы) diýlip 

atlandyrylýar.  

 
Ol ölçegler bie wagtda esasy we alternatiw birliklerde goýlan ölçegler üçin 

görkezmeleri saklaýar — meselem, millimetrlerden başga düýmler gerek bolanda. 

Bu goşmaçanyň elementleri Display alternate units (Разрешить альтернативные 

единицы) baýdajyk goýlan wagtynda elýeterli bolýar. 

Alternate Units (Альтернативные единицы) töweregi formady we 

takyklygy, gaýtadan sanamagyň koeffisientini, çyzykly ölçegleriň tegelenmegini, 

alternatiw birlikleriň prefikdlerini we suffikslerini dolandyrýar. Ol sazlamagyň 

degişli meýdanlaryny saklaýar:  

  Unit format (Формат единиц);  

  Precision (Точность);  

  Multiplier for alt units (Коэффициент пересчета);  

  Round distances to (Округление);  

  Prefix (Префикс);  

  Suffix (Суффикс).  

Zero Suppression (Подавление нулей) töweregi Primary Units 

(Основные единицы) gomaça üçin bolan şol meýdança meňzeş. Placement 

(Размещение) töweregi iki pereklýuçatel arkaly  alternatiw ölçeg birligi 

pereklýuçatelleriň atlaryna degişlikde ýerleşdirmegi mümkin edýär, ýagny After 

primary value (За основным значением) ýa-da Below primary value (Под 

основным значением). 
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Tolerances (Допуски) goşmaçasy ölçeglerde dopusklaryň goýulmagyny 

kesgitleýär.  

 
Hemme görkezmeler goýulandan soň hemme goşmaçalary ОК düwmejigine 

basyp ýapmaly, Dimension Style Manager (Диспетчер размерных стилей) 

gepleşik penjiresini bolsa — Close (Закрыть) düwmejigine basmak gerek. 

Dimension Style Manager (Диспетчер размерных стилей) penjiresiniň 

Modify (Изменить) düwmejigi bar bolan ölçeg stiline üýtgetmeleri girizmegi we 

ýatda saklamagy mümkin edýär. Ol Modify Dimension Style (Изменение 

размерного стиля) gepleşik penjiresini çagyrýar ol dolulykda New Dimension 

Style (Новый размерный стиль) penjiresine gabat gelýär we 6 goşmaça eýe. 

Modify (Изменить) düwmejigine meňzeşlikde Override (Переопределить) 

düwmejigi işleýär ol Override Current Style (Переопределение текущего 

стиля) gepleşik penjiresini açýar. 

Dimension Style Manager (Диспетчер размерных стилей) penjiresiniň 

Compare (Сравнить) düwmejigi degişlikde Compare Dimension Styles 

(Сравнение размерных стилей) gepleşik penjiresini çagyrýar. 

Bu penjirä  Compare (Сравнить) we With (Co стилем) sanawynda stilleriň 

tapawutly atlary görkezilen bolsa ölçeg üýtgeýänleriň tapawutly ähmiýeteleri 

çykarylýar. Eger iki sanwda hem atlar gabat gelýän bolsa ýa-da olaryň birinde 

<none> (<нет>) opsiýasy saýlanylan bolsa, onda üýtgeýänleriň doly sanawy we 

ähmiýetleri çykarylýar. 
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Ölçegleriň goýulmagyny sazlamak üçin iň tis usuly — bu degişli 

ulgamlaýyn üýtgeýäni üýtgetmekli. Meselem, eger Siz olçegleri goýmagyň global 

masştabyny üýtgetmegi isleseňiz, Command: (Команда:) setirde DIMSCALE 

girizmeliž we muňa jogap hökmünde ululygyň duran bahasy görkezilip, täze 

bahany girizmek üçin sorag berler: 

Enter new value for DIMSCALE <1.0000>: (Новое значение 

DIMSCALE <1.0000>:). 

Multiçyklaryň stilleri 

Täze stiliň döredilmegi MLSTYLE (МЛСТИЛЬ) buýrugy arkaly amala 

aşyrylýar, oňa Format (Формат) menýunyň Multiline Style (Стили 

мультилиний) bendi gabat gelýär. MLSTYLE (МЛСТИЛЬ) buýrugy Multiline 

Styles (Стили мультилиний) penjiresini çagyrýar. 
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Penjiräniň Multiline Style (Стиль мультилиний) töweregi açylýan sanawy 

we iki meýdany saklaýar. Current (Текущий) açylýan sanaw häzirki stiliň adyny 

görkezýär. Bu sanaw suratyň multiçyzyklaryň stilleriniň hemme sanawyny 

görmegi, şeýle hem beýleki stili goýmagy mümkin edýär. Name (Имя) meýdany 

täze stili döretmekde ýa-da bar bolanyň adyny üýtgetmekde at bermek üçin 

ulanylýar. Description (Пояснение) meýdany her stile uzynlygy 255 simwola 

çenli bolan belligi ýazmagy mümkin edýär. 

Mundan başga hem Multiline Style (Стиль мультилинии) töwereginde 4 

düwmejik bar:  

  Load (Загрузить);   

  Save (Сохранить);   

  Add (Добавить);   

  Rename (Новое имя).  

Load (Загрузить) düwmejigi Load Multiline Styles (Загрузка стилей 

мультилинии) gepleşik penjiresini çagyrýar.  

 
Multiçyzyklaryň stillerini giňişligi mln bolan faýllarda ýatda saklamak 

mümkin hem-de şol faýllardan ýüklemek mümkin. Ýüklemek we ýatda saklamak 

üçin standart faýl bolup acad.mln çykyş edýär. 

Element Properties (Свойства элемента) we Multiline Properties 

(Свойства мультилинии) düwmejikleri häzirki ulanylýan we entek hiç hili 

multiçyzygy çyzmakda ulanylmadyk stiliň häsiýetnamalaryny üýtgetmek üçin 

ulanylýar. Multiline Styles (Стили мультилинии) gepleşik penjiresiniň 

merkezinde häzirki stiliň häsiýetleri görkezilýär. 

Multiçyzygyň täze görnüşini döredeliň. Özi bilen iki sany döwük 

çyzyklardan ybarat bolan STANDART stilden başga ýene bir stil döredeliň we 

onuň adyny latin harplary bilen ýazmak gerekName (Имя) meýdanynda 

STANDARD ady üýtgedip täze at, meselem Triple bermeli.  

Description (Пояснение) meýdanynda öz belligiňizi girizmeli— meselem, üç 

çyzyk. Soňra Add (Добавить) düwmejigine basmaly. 

Mundan soň multiçyzygyň stilleriniň sanawynda iki at görkeziler 

(STANDARD и TRIPLE), we TRIPLE ady häzirki ulanylýan stiliň ady bolar.  



 222 

 
 

Stiliň iki çyzygyna ýe-ne birini goşalyň. Element Properties (Свойства 

элемента) düwmejigine basmaly. Element Properties (Свойства элемента) 

gepleşik penjiresi açylar. 

 
 

 

Penjiräniň ýokarky böleginde Elements (Элементы) sanawy ýerleşdirilen, 

onda häzirki stile girýän çyzyklar we onuň häsiýetleri görkezilen. Häsiýetlere şular 

degişlidir: Offset (Смещение), Color (Цвет), Ltype (Тигашнии). TRIPLE 

stilinde ilkibaşda STANDARD stilinde hem bar bolan diňe iki çyzyk bar. Çyzyklar 

0.5 we -0.5 süýşmeler eýe, ýagny multiçyzygyň okuna görä iki tarapa ýarym 

millimetre süýşürilen. Süýşmeleri üýtgetmek üçin syçanjyk bilen çyzygy bellemeli 

we Offset meýdanynda baha girizmeli.  

Multiçyzygyň iki elementine hem täze reňk bereliň. Munuň üçin Color (Цвет) 

düwmejigine basmaly we açylan gepleşik penjiresinde reňk saýlamaly. 

Multiçyzygyň iki elementiniň ýanynna üçünjini goşalyň.  

Munuň Add (Добавить) düwmejigine basmaly. Basylandan soň elementleriň 
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sanawynda üçünjisi emele geler.  Bu çyzygyň hem häsiýetlerini üýtgetmek 

mümkin. Islendik elementiň çyzygyň tipini üçýtgetmek mümkin munuň üçin 

Linetype (Тип линии) düwmejigine basmaly. Eýýam tanyş, çyzygyň tipini almak 

üçin gepleşik penjiresi açylar. Onda çyzygyň täze tipini ýüklemeli. Bu amallardan 

soň Multiline Styles (Стили мультилинии) gepleşik penjiresine gaýdyp gelmeli.  

Stiliň beýleki häsiýetnamalaryny  Multiline Properties (Свойства мультилинии) 

düwmejigine basyp redaktirlemeli. Multiline Properties (Свойства 

мультилинии) penjiresi açylar. 

 
 

Bu penjirede multiçyzyklar üçin Вşeýle parametrleri goýmak mümkin: 

 Display joints (Показать стыки);   

 Caps (Торцы);   

 Fill (Заливка).  

Display joints (Показать стыки) baýdajyklar goýulsa, multiçyzyklaryň 

döwülýän ýerlerinde sepler kesimler bilen görkeziler.  

Caps (Торцы) töweregi uçlary (gyraňlary) çyzmagy amala aşyrýar. Gyraňlaryň 

islendiginde daşky erňekleriň kesimler bilen (флажок Line (Отрезок)), şeýle hem 

halkalar bilen (флажок Outer arc (Внешняя дуга)) birikdirilmeginiň bellenilmegi 

mümkin. Inner arcs (Внутренние дуги) baýdajygy elementleriň sany dört ýa-da 

köp bolsa taýlaýyn içki elementleri halkalaýyn birleşdirýär. Multiçyzygyň gyraňy  

kesýän burç Angle (Угол) meýdanynda berilýär. Fill (Заливка) töweregi 

multiçyzygyň içindäki doldurmagyň reňkini kesgitleýär, şeýle hem ol On (Вкл) 

baýdajygy arkaly doldurmagyň özüni işledip ýa-da öçürip bilýär. 

Hemme parametrler goýulandan soň Multiline Styles (Стили 

мультилинии) gepleşik penjiresini ýapmaly. 
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Dolandyryş merkezi 

Bu ýörite penjire  ADCENTER (ЦУВКЛ) buýrugy bilen çagyrylýar, oňa 

Standard (Стандартная) gurallar paneliniň  düwmejigi we Tools 

(Сервис) menýunyň DesignCenter (Центр управления) bendi gabat gelýär. 

Dolandyryş merkezini <Ctrl>+<2> klawişalar arkaly çagyrmak mümkin.  

 
 

 

Netijede DESIGNCENTER (ЦEHTP УПРАВЛЕНИЯ) penjiresi açylýar. 

Bu penjiräniň düzümi aşakdaky 4 sany goşmaçanyň açylmagyna bagly bolup 

durýar:  

 Folders (Папки) — faýla saýlamak ýa-da we onuň elementlerini görmek 

üçin kompýuteriň  disklerini we bukjalaryny görkezýär;  

 Open Drawings (Открытые рисунки) — penjiräniň çep tarapynda  grafiki 

elementleri, sag tarapynda bolsa şol elementleriň atlaryny görkezýär; 
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 History (Журнал) — Dolandyryş merkezindäki soňky amallaryň žurnalyny 

görkezýär;  

 DC Online (ЦУ Online) — Autodesk saýtynda standart elementleriň  

bibliotekalaryna gönümel  düzgündäki Internede bolan elýeterlilik; şonda 

AutoCAD ulgamynyň ekzemplýary barada maglumat berilýär. 

Goşmacalaryň aşagynda Dolandyryş merkezi bilen işlemegi aňsatlaşdyrýan 

düwmejikler ýerleşen:  

  - Load (Загрузить), bellenilen surady ýükleýär;  

  — Back (Назад), öňki ýüklenen elemente geçýär (surat);  

  — Forward (Вперед), indiki ýüklenen elemente (surada) geçýär;  

  — Up (Вверх), agaç düzümde bir dereje ýokary geçýär;  

  — Search (Поиск), bellenilen häsiýetler (gatlaklar, bloklar we b.) 

boýunça faýly gözleýär;  

  — Favorites (Избранное), AutoCAD Favorites (Избранное) bukjanyň 

içinde döreden Autodesk  bukjanyň düzümini görkezýär; 

  — Home (Домой), показывает содержимое папки DesignCenter, 

расположенной внутри папки AutoCAD ulgamynyň programma 

üpjünçiliginiň Sample bukjasynyň içinde ýerleşen DesignCenter 

bukjasynyň düzümini görkezýär; 

  — Tree View Toggle (Зона структуры), penjiräniň çep böleginde gerek 

bolýan tipiň düzümini görkezýär ýa-da aýyrýar (tip goşmaça bilen 

kesgitlenýär);  

  — Preview (Образцы), penjiräniň sag böleginde grafiki däl nusgalaryny 

görmegiň zolagyny goşýar ýa-da aýyrýar;  

  — Description (Описания), penjiräniň sag böleginde bellenilen 

elementler üçin (meselem bloklar üçin) tekst bellikleri görmegiň zolagyny 

goşýar ýa-da aýyrýar;  

  — Views (Вид), elementleri ekrana çykarmak üçin penjiräniň 

görnüşini belleýär (Large icons (Крупные значки), Small icons (Мелкие 

значки), List (Список) ýa-da Details (Таблица)). 

 düwmejigi işledilende AutoCAD DESIGNCENTER (ЦЕНТР 

УПРАВЛЕНИЯ) penjiräni diklik boýunça iki bölege bölýär we çep böleginde ýa 

iş stolunyň, ýa-da saýlanylan surat faýlynyň, işiň žurnalynyň agaç görnüşli 

düzümini gurýar (düzümi saýlanylan goşmaça bagly). 

DESIGNCENTER (ЦЕНТР УПРАВЛЕНИЯ) penjiräniň sag bölegi bir, iki 

ýa-da üç bölege bölünip bilner, şeýle hem  saýlanylan elementiň nusgasyny we 

teswirlenmesini görkezip ýa-da görkezmän bilýär, bu bolsa  we  

düwmejikleri arkaly dolandyrýar. Open Drawings (Открытые рисунки) 

goömaçasynda DESIGNCENTER (ЦЕНТР УПРАВЛЕНИЯ) penjiräniň çep 

boleginde suratyň nyşanynyň çep tarapynda ýerleşen plýusly nyşana syçanjyk bilen 

basylsa grafiki däl elementleriň düzümi görkeziler, olara şular degişli: 

 Blocks (блоки); 
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 Dimstyles (размерные стили); 

 Layers (слои); 

 Layouts (листы); 

 Linetypes (типы линий); 

 Textstyles (текстовые стили); 

 Xrefs (внешние ссылки). 

DESIGNCENTER (ЦЕНТР УПРАВЛЕНИЯ) penjiresinde görkezilen 

islendik elementler şol wagt açylan surada ýönekeý syçanjyk bilen geçirilme bilen 

geçirilip bilner. 

 

Tejribe işler 

 

1) Içi gyzyl reňk bilen doldurylan inedördüli çyzmaly 

2) Iki kesişýän göniburçluklaryň kesişýän töweregini reňklemeli 

3) Iki kesişýän göniburçluklaryň kesişmeýän töweregini reňklemeli 

4) Orta çyzygynda Gas diýen ýazgyly multiçyzygy döretmeli 

5) Iki gatlakdan ybarat bolan çyzgy gurmaly 

6) Üç gatlakdan ybarat bolan çyzgy gurmaly 

7) Bölekleri çap edilmeýän çyzgy gurmaly 

8) Bölekleri redaktirlenmeýän çyzgy gurmaly 

9) Çyzyklarynyň galyňlygy dürli bolan çyzgy gurmaly 

10) Çyzyklarynyň reňki dürli bolan çyzgy gurmaly 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ÇAP, BLOKLAR WE DAŞKY SALGYLANMALAR 
Çap  

Plotter ulgamda gurnalandan soň çykyşy sazlamaga başlamak bolar. Munuň 

üçin Standard (Стандартная) paneliniň düwmejigi we File (Файл) menýunyň 

Plot (Печать) bendi niýetlenen. Olar PLOT (ПЕЧАТЬ) buýruga gabat gelýärler.  

PLOT (ПЕЧАТЬ) buýrugy çagyrylanda aşkdaky Plot (Печать) gepleşik penjiresi 

emele geler.  
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Penjire diklik boýunça üç bölege bölünýär, özem ortaky bölegi iki goşmaça 

eýe bolup durýar - Plot Device (Устройство печати) we Plot Settings 

(Параметры печати).  

Gepleşik penjiräniň ýokarky çep böleginde ýerleşen Layout name (Имя 

вкладки) töweregi AutoCAD grafiki ekranynyň goşmaçasyny adyny saklaýar: ol 

Model (Модель), Layout 1 (Лист!) we Layout2 (Лист2), ýa-da ulanyjy 

tarapyndan bellnilen baha eýe bolup biler. Goşmaçanyň adynyň ýanynda Save 

changes to layout (Сохранить установленные параметры) baýdajygy goýmak 

mümkin, ol şol penjirede bellenilen parametrleri indiki çap üçin ýatda saklamagy 

mümkin edýär. 

Page setup name (Набор параметров листа) töweregi listiň 

parametrleriniň toparyny at bilen ýatda saklamagy we olary soň atlary boýunça 

çagyrmagy mümkin edýär. 

Page setups (Наборы параметров листа) sanawynda şol suratyň listiniň 

parametrleriniň toplumy sanalyp geçilýär. 

Plot (Печать) gepleşik penjiresiniň birinji Plot Device (Устройство 

печати) goşmaçasy çykyş gurluşyň sazlaýyş parametrlerini saklaýar. Şol 

goşmaçanyň Plotter configuration (Конфигурация плоттера) töweregi bar 

bolanlaryň arasyndan zerur konfigurasiýasyny saýlamagy mümkin edýär 

(meselem, HP DeskJet 400 (Monochrome)). Properties (Свойства) düwmejigi 

Plotter Configuration Editor (Редактор параметров плоттера) penjiresini 

çagyrýar, onda plotteriň konfigurasiýasynyň faýlyny ýatda saklamak mümkin (рсЗ 

giňişlikli). 

Plot style table (pen assignments) (Таблица стилей печати (присвоения 

перьев)) töweregi Name (Имя) açylýan sanaw arkaly bar bolanlaryň arasyndan 

stilleriň jetwelini saýlamagy mümkin edýär. 



 228 

Number of copies (Количество экземпляров) hasaplaýjysy çap edilýän 

çyzgynyň göçürmeleriniň sanyny dolandyrýar. 

Plot to file (Печать в файл) töweregi Plot to file (Печать в файл) baýdajyk 

goýlan bolanda çapy gönümel plottere dälde, pit giňişlikli faýla amala aşyrýar, ol 

bolsa soň AutoCad ulgamyndan daşary plottere çykarylyp bilner. 

Plot (Печать) gepleşik penjiresiniň ikinji Plot Settings (Параметры 

печати) goşmaçasy listiň we çyzgynyň parametrlerini saklaýar. Paper size and 

paper units (Формат листа и единицы) töweregi iki parametri saklaýar – açylýan 

sanawy we iki sany pereklýuçateli. Plot device (Устройство печати) parametri 

birinji goşmaçada saýlanylan plotteriň adyny saklaýar. Paper size (Формат листа) 

açylýan sanawda saýlanylan plotter üçin el-ýeterli bolan formatlardan listiň 

formadyny saýlamak gerek. Printable area (Доступная область) parametri berlen 

listiň formady üçin hakyky çap edilýän töwereginiň ölçeglerini görkezýär.  

 
 

 

Drawing orientation (Ориентация чертежа) töweregi çyzgynyň kagyzyň 

listinde ýerleşmegini dolandyrýar: Portrait (Книжная) ýa-da Landscape 

(Альбомная). Ikinji pereklýuçatel işledilende çykarylýan şekil birinji ýerleşmä 

görä 90° öwrülýär. Şekili 180° öwürip bolýar - Plot upside-down (Перевернуть) 

baýdajygy goýmaly. 

Plot area (Печатаемая область) töweregi örän 

möhüm, onuň görkezmeleri çyzgynyň dolulykda ýa-da 

onuň böleklerini çap etmegi mümkin edýär.  

 Model (Модель) goşmaçasy çap edilende Plot area 

(Печатаемая область) töwereginde aşakdaky 

pereklýuçatellere bar:  

 Limits (Лимиты) — limitleriň zolagu çykarylýar;  
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 Extents (Границы) — araçäkleriň zolagy çykarylýar, ýagny çyzgynyň 

hemme elementleri tutýan iň kiçi göniburçluk zolak (doly şekili almagyň iň 

tygşytly wariant;  

 Display (Экран) — diňe şol mahal grafiki ekranda görünýän zat çykarylýar;  

 View (Вид) — saýlanylan atlandyrylan görnüş çykarylýar;  

 Window (Рамка) — diagonal boýunça iki nokat bilen kesgitlenýän 

göniburçluk zolak çykarylýar.  

Plot scale (Масштаб печати) töweregi çyzgynyň plottere çykarylmagynyň 

masştabyny belleýär. Bu töweregiň açylýan sanaw standart masştablaryny 

saklaýar: Scaled to Fit (Вписать), 1:1, 1:2, 1:4, 1:8, 1:10, 1:16, 1:20, 1:30, 1:40, 

1:50, 1:100, 2:1, 4:1, 8:1, 10:1, 100:1 we b. Scaled to Fit (Вписать) bahasy 

çyzgynyň gönümel kagyzyň formadynda doly ýerleşdirýär. Eger çyzgynyň 

çykarylmagyny standart däl formatda amala aşyrmak gerek bolsa 1:27.5, onda çep 

meýdanda 1 (mm (мм)), sagda bolsa — 27.5 (units (единиц рисунка)) girizmeli.  

Plot scale (Масштаб печати) töwereginiň Scale lineweights (Масштабировать 

веса линий) baýdajygy çapda diňe obýektleriň ölçeglerini dälde, eýsem olaryň 

agramlaryny jem masştablamagy mümkin edýär. Eger baýdajygy aýrylan bolsa, 

çyzyk berlen agram bilen çyzylýar. 

Plot offset (Смешение от начала) töweregi Center the plot 

(Центрировать) baýdajyk aýrylan ýagdaýynda listde çapyň el-ýeterli töwereginiň 

çep aşaky burçundan goşmaça süýşmegi belleýär (süýşmegiň mm-däki ähmiýetini 

X we Y meýdanlaryna ýazmaly). Center the plot (Центрировать) goýlan bolsa 

çyzgy takyk listiň merkezinde ýerleşdirilýär. X we Y meýdanlaryň bahalary 

položitel bolsa süýşürilme kagyzyň listiniň içine amala aşyrylýar. 

Shade plot (Раскраска чертежа) açylýan sanawda aşakdaky opsiýalar bar:  

  As Displayed (Как есть);  

  Wireframe (Каркас);  

  Hidden (Co скрытием невидимых линий);  

  Rendered (Тонированная).  

Bu opsiýalar görnüş ekrany onuň suratda haýsy ýagdaýda ýerleşendigine 

garaşsyz (adaty, reňklenen, görünmeýän çyzyklary ýok etme bilen ýa-da tonirlenen 

ýagdaýda). 

Quality (Качество) açylýan sanaw tonirlenen we reňklenen görnüşleriň 

hilini dolandyrýar. Sanawa şeýle elementler girýär:  

  Draft (Черновое) — reňkleme we tonirleme inkär edilýär, çap karkas 

görnüşinde amala aşyrylýar;  

  Preview (Предварительное) — 150 dpi  rugsat;   

  Normal (Обычное) — 300 dpi  rugsat;  

  Presentation (Высокое) — 600 dpi  rugsat;  

  Maximum (Максимальное) — şol printer üçin mümkin bolan iň ýokary 

rugsat;  

  Custom (Пользовательское) — rugsady ulanyjy belleýär.  

Plot options (Опции печати) töweregi aşakdaky baýdajyklara eýe:  
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 Plot object lineweights (Учитывать веса линий объектов) — çyzyklaryň 

agramlaryny hasaba alýar; bu baýdajyk diňe Plot with plot styles 

(Учитывать стили печати) baýdajygy aýrylandan el-ýeterli bolup durýar;  

 Plot with plot styles (Учитывать стили печати) — çapyň stilleri ulanylýar;  

 Plot paperspace last (Объекты листа последними) — ilkibaşda list 

giňişliginiň obýektlerini ýa-da model giňişliginiň obýektlerini çap etmeli;  

 Hide paperspace objects (Скрывать объекты) — görünmeýän çyzyklary 

bukýar.  

Plot Device (Устройство 

печати) we Plot Settings 

(Параметры печати), 

goşmaçalaryň hemme parametrleri 

goýulandan soň çapyň görnüşine 

seretmeli, munuň üçin Plot 

(Печать) gepleşik penjiresiniň 

aşagynda ýerleşen düwmejikleri 

ulanmaly. Olaryň birinjisi Partial 

Preview (Контурный просмотр) 

düwmejigi Partial Plot Preview 

(Контурный просмотр чертежа) 

penjiresinde çap edilýän töweregiň 

ýerleşişini görkezýär.  

Partial Preview (Контурный 

просмотр) düwmejigi ulanylandan 

soň Full Preview (Полный просмотр) düwmejigine basmaklyk ündelýär, ol 

boljak çapyň netijesini kagyzyň listinde görkezýär.  

Çapyň dogry çykjakdygyna doly göz ýetirip Plot (Печать) gepleşik 

penjiresinde ОК düwmejige basmaly we çyzgyny plottere ibermeli. 

Plot stamp (Штемпель) töwereginde baýdajygyň On (Вкл) ýagdaýynda 

çyzga çykarylýan ştempeliň deslapky düzülmegi PLOTSTAMP (ШТЕМПЕЛЬ) 

buýrugy bilen ýerine ýetirilýär. Bu buýruk Plot Stamp (Штемпель) gepleşik 

penjiresini açýar.  
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Bu penjirede Preview (Просмотр) töweregi şertli görnüşinde döredilýän 

ştempeliň nirede ýerleşjekdigini görkezýär. 

Ştempeliň düzümi tekst setiri bolup durýar, onuň elementleri çykarylanda 

oturlar bilen aýrybaşgalanýarlar. Şeýle elementler 9-a çenli bolup durýar. Esasy 

elementler (7-ä çenli):  

  Drawing name (Имя рисунка);  

  Layout name (Имя вкладки);  

  Date and Time (Дата и время);  

  Login name (Пользователь);  

  Device name (Устройство);  

  Paper size (Формат листа);  

  Plot scale (Масштаб чертежа).  

Ştempele ikiden köp bolmadyk ulanyjynyň elementlerini goşmak mümkin, olar 

User defined fields (Дополнительная информация) töwerekde ýerleşen açylýan 

sanawlaryndan alynýar. 

 

Bloklar we salgylanmalar 

Çyzgylary we modelleri taýýarlamagyň möhüm guraly bolup bloklaryň we 

daşky salgylanmalaryň ulanylmagy durýar. Blok— bu çylşyrymly atlandyrylan 

obýekt, onuň üçin teswirleme döredilýär, ol teswirleme öz içine şol wagt ulanylýan 

suratyň primitiwleriň islendik sanyny alýar. Blok baza nokadyna eýe bolýar; ol 

çyzgynyň islendik ýerine goýmaklyk üçin ulanylyp bilner. Blok atributlara eýe 

bolup biler— ulanyjy tarapyndan bellenilýän ýazgy üýtgeýänleri. Bloguň 

goýulmagynyň netijesinde emele gelýän primitiw bloguň girmegi diýlip 

atlandyrylýar. 
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Daşky salgylanma — şol wagtky ulanylýan elementleri bilen daşky faýlyň 

şekili, özem salgylanýan faýlyňyz esasy surata ýazylmaýar. Netijede şol wagtky 

ulanylýan surat täze obýektleriň daşky şekilleriniň köp sany bolen doldurylyp 

bilner, emma şol faýlyň ölçegi kän ýokarlanmaýar. Daşky salgylanmany goýma 

amalyndan emele gelýän primitiw daşky salgylanmanyň girmegi ýa-da ýöne daşky 

salgylanma diýlip atlandyrylýar. 

Bloklar arkaly bir görnüşli obýektleri gurup bolýar we diňe olaryň birini 

teswirlemek arkaly galanlaryny bolsa blogy goýmak bilen alyp bolýar. Daşky 

salgylanmalar öň döredilen standart grafiki elementlerini ulanmaga mümkinçilik 

berýär. 

Bloklar 

Blogy ulanmaklyk üçin birinji ädim— oinuň teswirlenmesini döretmek. 

Munuň üçin blok haýsy primitiwlerden durýandygyny we baza nokadyň nirede 

bolmalygyny kesgitlemeli. 

Bloguň teswirlenmesini döretmek üçin BLOCK (БЛОК) buýrugy saýlamaly. 

Buýruga Draw (Рисование) gurallar paneliniň  düwmejigi Draw | Block | 

Make (Рисование | Блок Создать) menýunyň bendi gabat gelýär. 

BLOCK (БЛОК) buýrugy Block Definition (Описание блока) gepleşik 

penjiresini çagyrýar. 

Bu penjire arkaly bloguň adyny, baza 

nokadyň koordinatlaryny, bloga girjek 

obýektleri we b. bellemek mümkin. 

Blogy goýma amaly üçin INSERT 

(ВСТАВИТЬ) buýrugy ulanylýar, oňa 

Draw (Рисование) paneliniň  topar 

düwmejiginiň  düwmejigi we Insert 

(Вставка) menýusynyň Block (Блок) bendi 

gabat gelýär. Mundan başga hem bu 

buýruga Insert (Вставка) paneliniň 

düwmejigi gabat gelýär.  

 
 

 

 

 

 

INSERT (ВСТАВИТЬ) buýrugy işlände Insert (Вставка блока) gepleşik 

penjiresi açylýar. Bu penjire şol wagt ulanylýan surata onda kesgitlenen bloklary 

goýmagy mümkin edýär (eýsem beýleki suratlardan bolan faýllary). Bu penjire 

içinde görkezilen bloklary atlary boýunça saýlamagy we goýulmagy amala 

aşyrýar. Baza nokadyň suratda ýerleşmegini, bloguň goýulanda masştabyny we 

haýsy burç bilen goýulmagy belli bir baýdajyklar işledilende ýa gönümel penjirede 

ýa-da surata goýlan wagta amala aşyrmak mümkin. 
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Şeýle hem bu penjirede Explode (Расчленить) baýdajygy goýmak bilen 

blogy goýlan mahaly bölmek mümkin. 

Tool Palettes paneli 

 Bu paneli iň köp ulanylýan bloklary, 

ştrihlemeleri we reňk doldurmalary (beýleki 

suratlardan) goýmagy amala aşyrýar. 

Deslapdan TOOL PALETTES (ПАЛИТРЫ 

ИНСТРУМЕНТОВ) panelinde  üç palitra bar, olaryň 

her biri goşmaça hökmünde ýerine ýetirilen: ISO 

Hatches (Штриховки ISO), Sample office project 

(Примерный офисный проект), Imperial Hatches 

(Английские штриховки). 

Palitranyň elementine syçanjygy sag düwmejigi bilen 

basylsa 5 elementden ybarat bolan kontekst menýu 

emele geler:  

 
Şol menýudan Properties (Свойства) bendine basylsa elementiň 

häsiýetnamalaryň penjiresi emele geler. 

Bu penjire reňk doldurmalar we ştrihlemeler üçin meňzeş gelýär. Meselem 

aşaky suratda Office trim carpet elementi üçin penjiräniň düzümi getirilen. 

Pattern (Образец) parametrler toparynda spesifiki häsiýetler getirilen, General 

(Общие) parametrler toparynda — standart häsiýetler (reňk, we ş.m.). 

Bloklar üçin şol penjiräniň düzümi birneme tapawutly bolýar. Sanawda 

Pattern (Образец) parametrler toparynyň deregine Insert (Вставка) topary bar. 
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Bloklary eksport etmek 

Teswirlemesinde bloga goşulan obýektler goýulan blokda hem öz esasy 

häsiýetlerini saklaýarlar (gatlak, reňk, çyzygyň tipi, agramy). BYBLOCK 

(ПОБЛОКУ) ýörite ähmiýet üçin degişli däl bolup durýar, bu ähmiýet reňke, 

çyzygyň tipine we agramyna berilip bilner. 

Suratyň islendik bölegi (meselem bloguň teswirlenmesi) WBLOCK 

(ПБЛОК) buýrugy arkaly aýry faýla çykarylyp bilner. Bu buýruk Write Block 

(Запись блока на диск) gepleşik penjiresini çagyrýar.  

Bu penjiräniň Source böleginde 

eksportirlemek üçin blogy, suraty ýa-

da obýektleri saýlamaklyk mümkin 

edilen. 

Eger Object pereklýuçateli işledilse 

onda Base point we Objects 

töwerekleri el-ýeterli bolup durýar. 

Base point töweregi baza nokadynyň 

koordinatlaryny bellemegi mümkin 

edýär. Objects (Объекты) 

töwereginiň düwmejikleri çykarylýan 

primitiwleri saýlamagy mümkin 

edýär, şeýle hem saýlanylan obýektler 

bilen WBLOCK (ПБЛОК) buýrugy 

ýerine ýetirilenden soň näme 

etmelidigini görkezýär: 

 

 

 Retain (Оставить) — şol wagtky ulanylýan suratda saýlanylan görnüşde 

öňki ýagdaýynda galdyrmaly;  



 235 

 Convert to block (Сделать блоком) — şol wagtky ulanylýan suratda 

bloguň teswirlenmesini döretmek (bloguň ady hökmünde Destination 

(Размещение) töwereginden faýlyň adyny almaly), saýlanylan obýektleri 

şol bloguň girmesine çalşyrmaly;  

 Delete from drawing (Удалить из рисунка) — saýlanylan primitiwleri şol 

suratdan ýok etmeli. 

Bloguň atributlary 

Köplenç blok bilen bilelikde ol goýlan mahaly öz ähmiýetlerini üýtgedip 

bilýän ýazgylary saklamak zerurlygy ýüze çykýar. AutoCad ulgamynda 

ATTRIBUTE DEFINITION (ОПИСАНИЕ АТРИБУТА) primitiwi bar, ol bloguň 

teswirlenmesine goşulyp bilýär we şol blok goýulanda onuň bahasy soralyp bloguň 

düzümine girýän atribut (tekst setiri) dörediler. 

Atributlary döretmek üçin ATTDEF (АТОПР) buýrugy döredilýär, Draw | 

Block | Define Attributes (Рисование | Блок | Задание атрибутов) bendi gabat 

gelýär. ATTDEF (АТОПР) buýrugy Attribute Definition (Описание атрибута) 

penjiresini çagyrýar.  

Bu penjiräniň parametrlerini aşaky 

mysalda seredeliň. Meselem otagda 

kompýuterleriň ýerleşişiniň ülňisini 

çyzmak gerek bolan ýagdaýda. 

Kompýuteriň şertli belgisi hökmünde iki 

göniburçlukdan ybarat bolan blogy 

ulanmaly. Göniburçluklaryň şekiliniň 

aşagynda atributlardan iki ýazgyny 

ýerleşdirmeli. Bir ýazgy prosessoryň 

tipini, ikinjisi operatiw huşuň ululygyny 

kesgitlär.  

Şol göniburçluklary çyzyp Attribute 

Definition (Описание атрибута) 

gepleşik penjiresini çagyrmaly. 

Mode (Режим) töweregi 4 baýdajyk arkaly atributyň düzgünini belleýär:  

  Invisible (Скрытый) — atribut görünmeýär (ony görkezmek üçin 

ATTDISP (АТЭКР) buýrugy ulanmaly);  

  Constant (Постоянный) —atribut hemişelik (üýtgemeýän) baha eýe bolýar 

we ol blok goýulanda soralmaýar;  

  Verify (Контролируемый) — blok goýulanda gözegçilik üçin atributyň 

bahasy iki gezek soralýar;  

  Preset (Установленный) — atribut bellenilen baha bilen goýulýar (baha 

soralmaýar).  

Attribute (Атрибут) töwerekde aşakdaky üç parametri goýmak mümkin:  

 Tag (Имя) — atributyň ady;  

 Prompt (Подсказка) — atributyň bahasy soralanda çykýan sorag;  

  Value (Значение) — atributyň deslapky bahasy. 
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Insertion Point (Точка вставки) töwereginde her atribut üçin goýulmagyň 

nokady bellenilmeli, Text Options (Параметры текста) töwereginde bir setirli 

tekst üçin parametrler bellenilýär. 

Biziň mysalymyzda PROCESSOR we RAM atly atributlary kesgitlemeli. Iki 

atribut üçin Mode (Режим) töwereginde hiç baýdajygy goýmaly däl. Kömek 

sözler hökmünde Процессор we Оперативная память ýazmaly.  Deslapky 

bahalar hökmünde Р-3 800 МГц we 256 Мб alalyň. Birinji atributyň goýulma 

nokadyny daşky göniburçlugyň aşagynda ortadan ýerleşdirmeli Justification 

(Выравнивание) parametrini bolsa — Center (Середина) edip goýmaly. Ikinji 

atribut üçin Align below previous attribute definition (Выровнять по 

предыдущему атрибуту) baýdajygy goýmaly. 

 
BLOCK (БЛОК) buýrugy arkaly bloguň teswirlenmesini döredeliň oňa 

Computer ady bermeli, oňa iki göniburçlugy we iki atribut teswirlenmesini 

goşmaly. Başlangyç obýektleri ýok etmeli. 

INSERT (ВСТАВИТЬ) buýrugy boýunça döredilen blogy goýmak mümkin. 

Blok goýlan mahaly AutoCAD ulgamy ilkibaşda birinji atributyň bahasyny 

girzmek barada sorag berer : 

Процессор <Р-3 800 МГц>:  

Soňra: ikinji atributyň bahasyny girzmek barada sorag berer  

Оперативная память <256 Мб>:  
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Goýlan bloklar üçin atributlaryň bahalaryny redaktirlemek mümkin. Munuň 

üçin EATTEDIT САТРЕЛАКТ) buýrugy ýa-da oňa gabat gelýän Modify II 

(Редактирование 2) paneliniň  düwmejigi gabat gelýär. 

 
 

Daşky salgylanma 

INSERT (ВСТАВИТЬ) buýrugy arkaly bir faýlyň beýleki surat faýlyna 

goýulmagy soňkunyň ölçegini artdyrýar, sebäbi onuň içine goýuklýan faýlyň 

primitiwleri geçirilýär. Emma şol wagtky ulanylýan surata beýleki suratyň şekilini 

goýmagyň beýleki usuly bar – faýly daşky salgylanma arkaly goýmaklyk. Şonda 

salgy goýulýan faýlyň primitiwleri gönümel geçirilmän, diňe salgylanýan faýlyň 
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ady ýatda saklanylýar. Geljekde AutoCAD suraty açanda ilkibaşda surat ýüklenip, 

soňra goşmaça faýl-salgylanmanyň düzümi ýüklenýär. Bu ýagdaýda suratyň faýly 

uly ölçege eýe däl, emma bu ýagdaýda onuň faýl-salgylanma bolan bagly bolmagy 

artdyrylýar we soňky ýok bolanda ýa-da ady üýtgedilse ýalňyşlyk ýüze çykar. 

Goşulan salgylanmalar hem mümkin, bu ýagdaýda öz içinde daşky faýla 

salgylanma eýe bolan faýla salgylanma bolýar. 

Daşky salgylanmalaryň dispetçeri 

XREF (ССЫЛКА) buýrugy suratda başga faýllara salgylanmalary 

dolandyrýar. Buýruga Insert (Вставка) paneliniň  düwmejigi ýa-da Reference 

(Ссылки) paneliniň meňzeş düwmejigi gabat gelýär, bu buýruk şeýle hem Insert 

(Вставка) menýusynyň Xref Manager (Диспетчер внешних ссылок) bendi 

arkaly çagyrylýar. Şeýle hem şeýle düwmejigi Draw (Рисование) panelinde  

düwmejikler toparynda tapmak mümkin.  

 
XREF (ССЫЛКА) buýrugy Xref Manager (Диспетчер внешних ссылок) 

gepleşik penjiresini çagyrýar. 

 
By penjire daşky salgylanmalaryň üstünde amallary ýerine ýetirmegi 

mümkin edýär (goşmak, ýok etmek, täzelenme we ş.m.). Merkezi böleginde 

suratda saklanylýan daşky salgylanmalaryň sanawy ýerleşen. Sanaw jetwel ýa-da 

agaç düzüminde ýerleşdirilip bilner. 

Jetwel we agaç görnüşleriň arasynda geçmek üçin <F3> we <F4> klawişalar 

ýa-da penjirede ýerleşen (List View (F3) (Таблица)) we (Tree View (F4) 

(Дерево)) düwmejikler arkaly mümkin. Jetwel görnşi şeýle sütünlere eýe:  

  Reference Name (Имя);  

  Status (Статус);  

  Size (Размер);  

  Туре (Тип);  

  Date (Дата);  
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  Saved Path (Сохраненный путь).  

Sütünleriň niýetlenilişi olaryň atlaryna laýyk gelýär. Olariň ikisini 

düşündirmek maksada laýyk  

Status (Статус) parametri aşakdaky ähmiýetlere eýe bolup biler:  

 Loaded (Загружена) — daşky salgylanma tapylan we surata ýüklenen;  

 Unloaded (Выгружена) — daşky salgylanma surtadan ýüklenmeden 

çykarylan;  

 Unreferenced (He используется) — daşky salgylanma goýulan emma 

soňra ýok edilen;  

 Not Found (He найдена) — daşky salgylanma hiç ýol boýunça 

tapylmadyk;  

 Unresolved (He обработана) — daşky salgylanma tapylan emma okalyp 

bilinmeýär;  

 Orphaned (Разорвана) — daşky salgylanma tapylmadyk, işlenip 

bejerilmedik ýa-da üzülen beýleki daşky salgylanma goşulan.  

Туре (Тип) parametri daşky salgylanmanyň tipini görkezýär: Attach 

(Вставленная) ýa-da Overlay (Наложенная). Goýlan diýlip öz içinde beýleki 

daşky salgylanmalaryň hemmesini görkezýän salgylanma aýdylýar. Üstünden 

goýlan diýlip öz içindäki salgylanmalary görkezmeýän salgylanma aýdylýar. 

Daşky salgylanmalaryň üstündäki amallar 

Xref Manager (Диспетчер внешних ссылок) gepleşik penjiresiniň sag 

tarapynda daşky salgylanmanyň üstündäki amallarynyň düwmejikleri ýerleşen:  

  Attach (Вставить);  

  Detach (Удалить);  

  Reload (Обновить);  

  Unload (Выгрузить);  

  Bind (Внедрить);  

  Open (Открыть). 

 

Tejribe işleri 

 

 

1) Keseligine A4 formada çap etmek üçin sazlama döretmeli 

2) Dikligine A4 formada çap etmek üçin sazlama döretmeli 

3) Keseligine A3 formada çap etmek üçin sazlama döretmeli 

4) Dikligine A2 formada çap etmek üçin sazlama döretmeli 

5) Çapda iki gezek ulaldylan sazlamany döretmeli 

6) Çapda üç gezek ulaldylan sazlamany döretmeli 

7) Çap penjiresiniň ölçegine deňeşdirilen sazlamany döretmeli 

8) Sagdan 20mm daşlaşma bilen çapyň sazlamasyny döretmeli 

9) Çyzgynyň ýartysyny çap edýän sazlamany döretmeli 

10) Çyzgynyň diňe bir figurasyny çap edýän sazlamany döretmeli 
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BEÝLEKI FORMATLARYŇ ÜSTÜNDÄKI AMALLAR 

AutoCAD ulgamy rastr şekilli faýly okap we ony öz suradyna reňkli 

göniburçluk hökmünde goýmagy amala aşyrýar (daşky salgylanma meňzeş). 

Nokatlaýyn derejede goşlan şekili AutoCAD redaktirläp bilmeýär, emma şekili 

kesip, masştablamagyny, geçirmegi we beýleki ýönekeý redaktirleme amallaryny 

ýerine ýetirip bilýär. Bir rastr şekili beşlekiň üstüne goýlanda olaryň görünmeginiň 

tertibi dolandyrmak mümkin. 

Rastr şekiller bilen işlemek üçin IMAGE (ИЗОБ) buýrugy ulanylýar, oňa 

Reference (Ссылки) we Insert (Вставка) panelleriň  düwmejigi, şeýle hem 

Insert (Вставка) menýunyň Image Manager (Диспетчер изображений).  

IMAGE (ИЗОБ) buýrugy Image Manager (Диспетчер растровых изображений) 

gepleşik penjiresini açýar. Penjire şol wagt işlenilýän surata goýlan rastr şekilleriň 

sanawyny görkezýär. 

 
Sanaw şeýle sütünlere eýe:  

 Image Name (Имя);   

 Status (Статус);   

 Size (Размер);  

 Туре (Тип);   

 Date (Дата);   

 Saved Path (Сохраненный путь).  

Status (Статус) aşakdaky bahalary kabul edip bilýär:   

 Loaded (Загружено) — şekil tapylan we surata ýüklenen;   

 Unload (Выгружено) — şekil suratdan ýüklenmeden çykarylan;   

 Reload (Перегружено) şekil gaýtadan ýüklenilen;  

 Not Found (He найдено) — şekil hiç standart ýol boýunça tapylmadyk.  

Туре (Тип) parametri şekiliň formadyny görkezýär. AutoCAD rastr 

faýllaryň şeýle formatlaryny okaýar: BMP (— bmp, rle, dib), CALS1 (rst, gp4, 

mil, cal, cg4), FLIC (flc, fli), GEOSPOT (bil), IG4 (ig4), IGS (igs), JFIF (jpg), 

PCX (pcx), PICT (pet), PNG (png), RLC (rlc), TGA (tga), TIFF (tif, tiff).  

Image Manager (Диспетчер растровых изображений) gepleşik penjiresiniň sag 

böleginde şekilleriň üstünden bolan amallaryň düwmejikleri toplanylan:  
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  Attach (Вставить);  

  Detach (Удалить);  

  Reload (Обновить);  

  Unload (Выгрузить);  

  Details (Подробнее).  

Attach (Вставить) düwmejigi Image (Растровое изображение) penjiräni 

çagyrýar, onda surata goýulýan şekiliň adyny bellemek mümkin. 

 
Bu penjirede Name (Имя) açylýan sanaw goýulýan şekiliň adyny görkezýär. 

Eger rastr şekili surata goýlan bolsa, onda ony sanawyň içinden saýlamak mümkin. 

Eger ol öň goýulmadyk bolsa, ony Browse (Обзор) düwmejigi arkaly tapyp 

goýmak bolar. Insertion point (Точка вставки), Scale (Масштаб) we Rotation 

(Угол поворота) töwerekleri bloklary we daşky salgylanmalary goýmak boýunça 

gepleýik penjireleräki ýalydyr. 

Rastr şekilleri Image Manager (Диспетчер растровых изображений) 

gepleşik penjiresini ulanman goýmak üçin IMAGEATTACH (ИЗОБВСТАВИТЬ) 

buýrugy ulanmaly, ol Reference (Ссылки) paneliniň  düwmejigi ýa-da Insert 

(Вставка) menýusynyň Raster Image (Растровое изображение) bendi arkaly 

çagyrylýar. 

Rastr şekiliniň goýulmagynyň netijesinde emele gelýän primitiwiň ady — IMAGE. 

Bu primitiwiň häsiýetleri baradaky maglumaty LIST (СПИСОК) ýa-da 

PROPERTIES (OKHOCB) buýruklary arkaly almak mümkin. 

Eger birnäçe rastr şekilleri biri-biriniň üstünden goýlan bolsa, 

DRAWORDER (ПОРЯДОК)  buýrugy arkaly ekranda rastr şekilleriň 

görkezilmegini dolandyrmak mümkin. Bu buýruga Modify II (Редактирование-2) 

paneliniň  düwmejigi gabat gelýär. DRAWORDER (ПОРЯДОК) buýrugy 

çagyralanda ol ilkibaşda obýektleri saýlamagy sorar. Aşaky şekili syçanjyk bilen 

suduryna basyp saýlamaly we saýlamagy tamamlamak üçin <Enter> klawişany 

basmaly. Soňra şeýle sorag beriler: 

Enter object ordering option [Above object/Under object/Front/Back] 

<Back>: (Задайте опцию перестановки [Перед объектом/За 

объектом/пЕредний план/зЛдний план] <зАдний>:) 
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Front (пЕредний план) opsiýasy saýlanylan şekili beýleki hemme 

obýektleriň üstünden goýar. 

 Above object (Перед объектом) — şekili başga obýektiň öňünde goýýar, 

şol başga obýekti hem soň görkezmeli bolýar;  

  Under object (За объектом) — şekili başga obýektiň yzyndan goýýar, şol 

başga obýekti hem soň görkezmeli bolýar  ;  

  Back (зАдний план) — obýekti iň yzky plana geçirýär (hemme beýleki 

obýektleriň yzyna).  

AutoCAD ulgamynda ýörite Draw Order (Порядок вывода) 

paneli bar onuň dört düwmejigi ýokarky bendlere gabat gelýär.  

IMAGECLIP (ИЗОБРЕЗ) buýrugy – oňa Reference (Ссылки) paneliniň  

düwmejigi we Modify | Clip | Image (Редакт | Подрезка | Изображение) 

menýunyň bendi gabat gelýär. Bu buýruk şekili göniburçluk ýa-da köpburçlyk 

sudur arkaly şekili kesmegi amala aşyrýar. 

Buýruk soraýar: 

Select image to clip: (Выберите изображение для подрезки:)  

Kesilmeli şekiliň araçägine syçanjygyň çep düwmejigi bilen basmaly. Indiki sorag: 

Enter image clipping option [ON/OFF/Delete/New boundary] <New>:  
(Задайте опцию подрезки [Вкл/Откл/Удалить/Новый контур] <Новый>:)  

Aşakdaky opsiýalar mümkin:  

 ON (Вкл) — kesiş sudur bellenilip öçürilen bolsa şekiliň kesilmegini 

işledýär;  

 OFF (Откл) — kesiş sudury bellenilen hem bolsa kesmegi öçürýär;   

 Delete (Удалить) — kesiş suduryny ýok edýär;  

 New boundary (Новый контур) — täze göniburçlyk ýa-da köpburçlyk 

sudury belleýär.  

New boundary (Новый контур) opsiýasy saýlanylanda AutoCAD soraýar:  

Enter clipping type [Polygonal/Rectangular] <Rectangular>:  
(Тип контура подрезки [Многоугольный/Прямоугольный] 

<Прямоугольный>:) 

Şekiliň sudury IMAGEFRAME 

(ИЗОБКОНТУР) buýrugy arkaly işledilip 

hem-de öçürilip bilinýär, ol buýruga 

Reference (Ссылки) paneliniň  düwmejigi 

we Modify | Object | Image | Frame (Редакт 

| Объекты | Изображения | Контур) bendi 

gabat gelýär. 

Buýruk soraýar: 

Enter image frame setting 

[ON/OFF]: (Контур подрезки изображения 

[Вкл/Откл]:).  

Sudury öçürilen şekil hiç bir redaktirlemäge 

degişli däl. 

IMAGEADJUST (ИЗОБРЕГУЛ), 
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buýrugy ýagtylyk, kontrastlyk we fon bilen birigiş ýaly häsiýetnamalary 

üýtgetmegi mümiin edýär oňa Reference (Ссылки) paneliniň  düwmejigi we 

Modify | Object | Image |Adjust (Редакт | Объекты | Изображения | 

Регулировка) menýunyň bendi gabat gelýär. 

Buýruk ilkibaşda şekili soraýar soňra Image Adjust (Регулировка 

изображения) gepleşik penjiresini çagyrýar. 

 
IMAGEQUALITY (ИЗОБКАЧЕСТВО) buýrugy şekili ekrana çykarmagyň 

hilini dolandyrýar. Buýruga Reference (Ссылки) paneliniň  düwmejigi we 

Modify | Object Image | Quality (Редакт | Объекты | Изображения | Качество) 

menýunyň bendi gabat gelýär. 

Buýruk soraýar: 

Enter image quality setting [High/Draft]: (Качество изображения 

[Высокое/Черновое]:) 

Rastr şekilleriň käbir tipleri açyklyk häsiýetine eýe, we ol häsiýet işledilende 

olaryň yzyndan duran obýektler görünip başlanýar. TRANSPARENCY 

(ПРОЗРАЧНОСТЬ) buýrugy şol hili dolandyrýar. Bu buýruga Reference 

(Ссылки) paneliniň  düwmejigi we Modify | Object | Image | Transparency 

(Редакт | Объекты | Изображения | Прозрачность) menýunyň bendi gabat 

gelýär.  

Buýruk ilkibaşda şekili soraýar, soňra şeýle soragy berýär:  

Enter transparency mode [ON/OFF]: (Состояние прозрачности [Вкл/Откл]:). 

AutoCAD ulgamy grafiki ekranyň şekilini rastr formatda ýatda saklap bilýär. 

Bu SAVEIMG (СОХРИЗОБ) buýrugy ýa-da oňa gabat gelýän Tools | Display 

Image | Save (Инструменты | Показать изображение | Сохранить) menýunyň 

bendi arkaly ýerine ýetirilip bilner. Bu buýruk Save Image (Сохранение 

изображения) gepleşik penjiresini çagyrýar. 

Hemme parametrler goýulandan soň we ОК düwmejige basylandan soň 

AutoCAD ulgaly Image File (Файл изображения) penjiresini çagyrýar, onda 

saýlanylan giňişlik (bmp, tga или tif) belli bir rastr formet bilen bellenilen (BMP, 

TGA или TIFF), faýlyň adyny bolsa ulanyjy bermeli. 
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WipeOut primitiwi 

Käwagt döredilen suratda käbir çyzyklary ýa-da olaryň böleklerini fon bilen 

ýapmak gerek bolýar. Munuň üçin ulgamda rastr şekilleriň bir tipi girizilen 

WIPEOUT buýrugy tarapyndan döredilýän tegmil. 

WIPEOUT primitiwi hem täze obýekti döredýär hem-de oň döredilen 

poliçyzygy üýtgedip gurýar.  

Bu buýrugy klawiaturadan WIPEOUT girizip ýa-da Draw (Рисование) 

menýusynyň Wipeout (Пятно) bendini saýlap çagyryp bolýar: 

Specify first point or [Frames/Polyline]<Polyline>: (Первая точка или 

[Границы/Полилиния] <Полилиния>:) 

Nokat görkezilen ýagdaýda ulgam gaýtalamak bilen ýapyk sudurly 

köpburçlugyň nokatlaryny sorap durar (nokatlaryň girizilmegini tamamlamak üçin 

—<Enter> klawişasyny basmaly). Polyline (Полилиния) opsiýasy saýlanylsa: 

Select a closed polyline; (Выберите замкнутую полилинию:) sorag berler. 

Obýekt görkezilenden soň ýene bir sorag berler: 

Erase polyline [Yes/No] <No>: 

Стереть полилинию [Да/Нет] <Нет >:  

Yes (Да) jogap berilse başlangyç 

poliçyzyk ýok ediler, ýogsam hem 

suratda galar.  

Poliçyzyk ýok edilse hem onuň sudury 

ekranda galar. Hemme WIPEOUT 

obýektleri üçin sudurlary öçürmek üçin 

WIPEOUT buýrugynyň Frames 

(Контуры) opsiýasyny ulanmaly we  

Enter mode [ON/OFF] <ON>: 
(Введите режим [Вкл/Откл] <Вкл >:) 

soraga OFF (Откл) jagap berilse 

hemme tegmilleriň sudury öçürilýär.  

Tegmil edil rastr şekilleriň häsiýetlerine 

eýe. 
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Beýleki formatlardan bolan import 

Insert (Вставка) menýusynda käbir beýleki formatlaryň şekillerini 

importirlemegi mümkin edýän 6 sany bendi bar:  

 3D Studio (Файл 3D Studio) —3ds max ulgamyndan faýllary import edýär 

(3DSIN (ИМПОРТЗДС) buýrugy), geometriýany we tonirleme, torlar, 

materiallar, ýagtylyk çeşmeler we kameralar baradaky maglumaty bermek 

bilen;  

 ACIS File (Файл ACIS) —ACIS formatdaky faýllaryň importyny belleýär, 

bu format giňişlik gaty jisimli obýektleriň geometriýasyny saklamak üçin 

ulanylýar (ACISIN (ИМПОРТТЕЛ) buýrugy);  

 Drawing Exchange Binary (Файл DXB) — faýlyň importyny DXB ikilik 

alyş-çalyş formatda ýerine ýetirýär (DXBIN (ИМПОРТД) buýrugy);  

 Windows Metafile (Метафайл Windows) —Windowsyň grafiki 

metafaýllarynyň importyny belleýär (WMFIN (ИМПОРТМТФ) buýrugy);  

 OLE Object (Объект OLE) — OLE tilsimatyny goldaýan programmadan, 

meselem, Microsoft Word-dan ýa-da Microsoft Excel-den baglaşan ýa-da 

gurnalan obýektiň goýulmagyny ýerine ýetirýär (INSERTOBJ 

(ВСТОБЪЕКТ) buýrugy);  

 Markup (Пометка) — RML formatly faýlda Autodesk firmasynyň Volo 

View Express moduly arkaly ýatda saklanylan bellikleriň çyzgy faýlyna 

goýmagy amala aşyrýar (RMLIN (ПОМЕТКА) buýrugy). 

Beýleki formatlara eksport etmek 

 EXPORT (ЭКСПОРТ) buýrugy we oňa gabat gelýän File (Файл) 

menýusynyň Export (Экспорт) bendi Export Data (Экспорт данных) penjiresini 

çagyrýar, onda Files of type (Тип файлов) açylýan sanawy ulanyp aşakdaky 

formatlaryň görnüşini saýlap şoňa eksport etmek mümkin:  

Metafile (Метафайл) -  wmf  WMFOUT (ЭКСПОРТМТФ);   

ACIS (ACIS) - sat  ACISOUT (ЭКСПОРТТЕЛ);  

Lithography (Литография) - stl  STLOUT (ЭКСПОРТСТЛ);   

Encapsulated PS (Encapsulated PS) - eps  PSOUT (ЭКСПОРТПС);   

DXX Extract (Файлы вывода DXX) - dxx АТТЕХТ (АТЭКСП);   

Bitmap (Растровые файлы) - bmp  BMPOUT (ЭКСПОРТНЫЙ);   

3D Studio (Файлы 3D Studio) - 3ds  3DSOUT (ЭКСПОРТЗДС);   

Block (Блок) - dwg WBLOCK (ПБЛОК). 

 

Tejribe işleri 

 

Aşakdakylary import etmeli 

1) Metafile (Метафайл) -  wmf  

2) ACIS (ACIS) - sat  

3) Lithography (Литография) - stl  

4) Encapsulated PS (Encapsulated PS) - eps  

5) DXX Extract (Файлы вывода DXX) - dxx 

6) Bitmap (Растровые файлы) - bmp  
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7) 3D Studio (Файлы 3D Studio) - 3ds  

8) Block (Блок) - dwg 

9) Iş meýdany 

10) Wideoşekiliň pursadyny 
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ÜÇ ÖLÇEGLI ÇYZMALAR. NETIJELILIGI ÝOKARLANDYRMA 

 

AutoСad ulgamy çyzmalary diňe XY tekizlikde gurman, eýsem olary üç 

ölçegli giňişligiň islendik tekizliginde hem gurup bilýär. 

Koordinatalaryň esasy ulgamynyň XY tekizligi dünýe 

koordinat ulgamy diýlip atlandyrylýar (МСК), ol grafiki ekranyň 

tekizligi bilen habat gelýär. Üçünji ok (Z) ekrana perpendikulýar 

we ekrandan ulanyja tarapyna ugrukdyrylan. Dünýä koordinat 

ulgamynyň alamaty hökmünde oklaryň piktogrammasy 

koordinatlaryň başlangyjynda göniburçliga eýe bolýar.  

Hemme beýleki koordinat ulgamlary ulanyjy koordinat  

ulgamlary diýlip atlandyrylýar. 

UCS belgini dolandyrmak 

UCS Icon (Знак ПСК) 

penjiresi View | Display | UCS 

Icon | Properties (Вид | 

Отображение | Знак ПСК | 

Свойства) menýunyň bendi 

arkaly ýa-da UCSICON 

(ЗНАКПСК) buýrugyň 

Properties (Свойства) opsiýasy 

arkaly çagyrylýar. 

Bu penjire 4 töwerege eýe. 

UCS icon style (Стиль 

пиктограммы ПСК) 

töwereginde degişli 2D we 3D 

pereklýuçateller arkaly koordinat ulgamyň piktogrammasynyň görkezilişini 

dolandyrmak mümkin. 3D stili ýokarky suratda görkezilen 2D — aşaky suratda.  

 2D stil ulanylanda W harpy WCS belgileýär.  

3D stil goýlanda Cone (Конус) baýdajygyň goýulmagy oklaryň 

ahyrlarynda ýapyk strelkany (konusy) çykarýar, baýdajyk 

aýrylanda bolsa — ýapylmadyk strelkany. Line width (Ширина 

линии) parametri oklaryň inini dolandyrýar.  

UCS icon size (Размер знака ПСК) töwereginde nyşanyň 

ekranyň ölçeginden göterimde bolan ululygy bellenilýär (5-den 95%-e çenli). UCS 

icon color (Цвет знака ПСК) töwereginde piktogrammanyň reňkini üýtgetmek 

mümkin - Model space icon color (Цвет знака в пространстве модели) и 

Layout tab icon color (Цвет знака на листах)). 

Üç ölçegli giňişlikdäki koordinatalar 

Öň seredilen buýruklaryň köpüsinde nokatlaryň üç ölçegli koordinatalaryny 

girizmegine ýol berilýär. Meselem, LINE (ОТРЕЗОК) buýrugy üçin From point: 

(От точки:) soraga: 114,47,200 girizmek mümkin — bu guruljak çyzygyň birinji 

nokady oklar boýunça: Х= 114, Y= 47 we Z= 200 koordinatalara eýedigini 

görkezýär.  Eger LINE (ОТРЕЗОК) buýrugynyň beýleki soragyna То point: (К 
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точке:): 62.81,—39.4,—4.55 jogap berilse, onda ahyrky nokady: Х= 62.81, Y= -

39.4 и 2= -4.55 koordinatalara eýe bolan nokat bolan kesim gurular. 

Dekart koordinatalarynda nokatlaryň göräleýin girizilmegi hem üç 

koordinatalaryň girizilmegini mümkin edýär, meselem: @28,0,44 — çyzylýan 

nokat öňki X okundan 28 mm-e, У oky boýunça — 0 mm, Z oky boýunça —44 

mm-e süýşürilen. 

Polýar koordinatalarynda nokady göräleýin girizilmeginiň ýazgysyna hem 

üçünji koordinata goşulyp bilner, meselem: @12.6<19.4,20.79. ol şuny aňladýar: 

öňki nokatdan ikinji görkezilen nokada çyzylan kesimiň XY tekizligine bolan 

proýeksiýasy XY tekizlikde X okunyň položitel ugry bilen 19,4° burçy emele 

getirýär we şol tekizlikde 12,6 mm uzynlyga eýe, kesimiň soňky nokadynyň Z 

koordinatasy bolsa başlangyç nokatdan Z oky boýunça 20,79 mm süýşürilen 

(silindrik koordinatalary). 

@73<35<57 ýazgy bilen koordinatalaryň girizilmegi mümkin (sfera 

koordinatalary). Muňa şeýle düşünmeli: kesim X okunyň položitel ugry bilen 35 

gardus burçy döredip ilkibaşda XY tekizlikde gurulýar, soňra kesim XY tekizligine 

göräleýin 57° egilýär we şeýleik bilen kesgitlenen şöhlede kesimiň ahyrky nokady  

başlangyç nokatdan 73 mm süýşürilýär. 

Üç ölçegli çyzgylary izometriýa görnüşlerinde analizirlemek amatly. 

Günorta-günbatar izometriýa diýlip atlandyrylýan satandart görnüşi bellemek 

mümkin. Munuň View | 3D Views | SW Isometric (Вид | ЗМ виды ЮЗ 

изометрия) menýunyň bendlerini ulanmaly. Bu ýagdaýda oklaryň proýeksiýasyny 

arasyndaky burçlar göniburç bolmazda 120° deň bolar. 

Dereje we beýiklik 

Izometriýadaky işi tegelegi çyzmakda göreliň CIRCLE (КРУГ)) buýrugy 

arkaly merkezi X = 0, Y = 0 korrdinataly nokatda bolan we radiusy 100 mm bolan 

tegelegi çyzmaly.  

Izometriýa görnüşinde tegelek ellips ýaly 

görünýär. Z oky bu ýagdaýda dik gidýär. 

Tegelegiň derejesini üýtgedeliň (munuň üçin 

tegelegiň merkeziniň Z koordinatasyny 

üýtgetmeli). Tegelege syçanjyk bilen basmaly — 

onda eljagazlar emele geler. Standard (Стандартная) paneliniň  düwmejigi 

arkaly PROPERTIES (СВОЙСТВА) penjiresini çagyrmaly. 

  Bu penjirede tegelegiň hemme 

häsiýetnamalary görkezilen Center Z (Центр Z) 

häsiýetnamanyň gapdalynda 0 bahany 250 edip 

üýtgetmeli. Вnetijede tegelek 250 mm ýokary 

süýşüriler. eger tegelegi aşak süýşürmek gerek 

bolan bolsady Z = —250 edip girizmeli bolardy. 

Şeýlelik bilen ilkibaşda çyzgy tekizligi hökmünde 

ilkibaşda esasy XY tekizlik Z= 0 derejesi bilen 

bolupdy, soňra bolsa obýekt täze tekizlige geçirildi 

(250 mm z ok boýunça ýokarda). 

Indi tegelegiň ýene-de bir häsiýetnamasyny 
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üýtgedeliň — beýikligi. AutoCAD ulgamyndabeýiklik 

hökmünde obýektiň Z oky boýunça galyňlygy 

düşünilýär. Munuň üçin PROPERTIES 

(СВОЙСТВА) penjiresinde Thickness (Высота) 

parametriň bahasyny 100 edip goýalyň. Netijede üç 

ölçegli silindr emele geler.  

 
Silindriň egri çyzkly ýerlerinde AutoCAD görkezmek 

üçin düzüjileriň birbäçe sanyny çykarýar. Mundan 

başga hem, iş düzgüninde silindriň hemme 

diwarjyklary redaktirlemek üçin el-ýeterli we açyk.  

Beýikligi üýtgetmegiň amaly başgaça iki ölçegli obýekti gysyp çykarma diýlip 

hem atlandyrylýar. Emele gelen obýekt üç ölçegli bolup durýar. Indi silindriň 

görünmeýän böleklerini bukmak üçin View (Вид) menýusyndan Hide (Скрыть) 

bendini ulanaly. Bu bende HIDE (СКРЫТЬ). Buýrugy gabat gelýär.  

Görünmeýän çyzyklary bukmagyň netijesinde emele gelen şekil işçi däl 

bolup durýar — redaktirlemegi mümkin etmek üçin View (Вид) menýunyň Regen 

(Регенерировать) ýa-da  Regen All (Регенерировать все) bendi basmaly. 

AutoCAD ulgamy çyzgylar amala aşyrylýan derejäniň ulanylýan bahasyny 

ELEVATION ulgam üýtgeýäninde saklaýar. ELEV (УРОВЕНЬ) buýrugy 

obýektler üçin ulanylýan derejeleri we beýiklikleri üýtgedýär. Buýruk soraýar 

(ýaýyň içinde ulanylýan baha bar): 

Specify new default elevation <0.0000>: (Новый уровень по умолчанию 

<0.0000>:) 

250 girizmeli bu, silindriň aşaky esasyna gabat geler. Şeýlelik bilen çyzgy 

tekizligi 250 mm derejä geçirilýär. Indiki sorag (ýaýyň içinde ulanylýan baha):  

Specify new default thickness <0.0000>: (Новая высота по умолчанию 

<0.0000>:)  

100 girizmeli – bu ýagdaýda obýektler Z okunyň otrisatel ugry boýunça 100 

mm gysylyp çykarylýar. Indi bolsa 0,0 koordinatalary noktda merkezi bolan we 

radiusy 200 mm bolan tegelegi çyzmaly. Eger nokatda Z koordinatalary ýok bolsa 

Z bahasy ulanylýan derejä deň edilip kabul edilýär (ýagny 250 mm). Netijede 

birinjiden tegelek dälde ýene bir silindr çyzylar, sebäbi nola deň däl beýiklik 
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bellenilen,  ikinjiden bolsa silindriň bir esasy birinji silindriň aşaky esasynyň 

tekizligine düşer, ikinji esasy bolsa 150 mm derejeli tekizlikde ýerleşer ( sebäbi 

ulanylýan 250 derejä gysyp çykaryş beýikligi goşulýar — 100).  

 

 

 

 

 

 

 

 

 

 

 

Koordinat ulgamlary 

МСК-nyň XY tekizligine parallel däl beýleki çyzgy tekizlikleri bellemeke 

üçin UCS (ПСК) buýrugy ulanylýar. Ulanyjy koordinat ulgamlary atlandyrylyp 

bilner. UCS (ПСК) buýrugy täze koordinat ulgamynyň başyny bellemegi we täze 

X we Y oklaryň ýerleşmegini bellemegi, täze Z okunyň ýerleşişi bolsa degişli Х 

we У oklaryň ýerleşmegine bagly we şol sebäpli awtomatiki kesgitlenýär.  

Bu buýruga iki sany gural panel gabat gelýär: UCS (ПСК) we UCS II (ПСК-2)  

 
UCS 

 
UCS II 
Görnüşler we görnüş ekranlary 

Üç ölçegli obýektiň modeli bilen işläp, görnüşleri, bellemek we üýtgetmek, 

grafiki ekrany böleklere bölmek mümkin, olaryň her birinde öz proýeksiýany we 

serediş nokady bellemek mümkin. 

Umumy görnüş 

Çylşyrymly çyzgyny ýa-da modeli görkezmegi amatly etmek üçin Aerial 

View (Общий вид) penjiräni ekrana çykarmak peýdaly. Şonda esasy ekranda bir 

görnüş, goşmaça penjirede bolsa beýleki görnüş bellenilip bilner. 

Bu penjiräniň çagyrylmagy DSVIEWER (ГЛАЗ) buýrugy ýa-da View (Вид) 

menýunyň Aerial View (Общий вид) bendi arkaly çagyrmak mümkin. Uly 

ekranyň kiçi ekran arkaly zummirlenmegi mümkin. Munuň üçin Aerial View 

(Общий вид) penjiräni içine syçanjyk bilen basmaly. Ýerine ýetirilýän 

zummirleme esasy grafiki ekranda görkezilýär. 
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Görnüş ekranlaryň konfigurasiýasy 

AutoCAD ulgamy model giňişliginde bşlekleriň islendik sanyndan 

konfigurasiýalary döretmegi amala aşyrýar (biri birini ýapmaýan ekranlary) we şol 

konfigurasiýa at berilip bolýar. VPORTS (ВЭ-КРАН) buýrugy görnüş ekranlaryň 

konfigurasiýasyny döredýär. Oňa Viewports (Порты) menýunyň  düwmejigi 

View | Viewports | New Viewports (Вид | Порты | Названные виды) menýunyň 

bendleri gabat gelýär.  

 
VPORTS (ВЭКРАН) buýrugy Viewports (Видовые экраны) gepleşik penjiresini 

açýar. 

Şol penjiräniň New name 

(Новое имя) meýdany 

dörediljek görnüş ekranlaryň 

konfigurasiýasynyň adyny 

bellemek üçin niýetlenen.  

Preview (Образец) 

töwereginde şol 

konfigurasiýanyň görnüşi 

görkezilýär. Standard 

viewports (Стандартные 

конфигурации) sanaw 

bölünmegiň wariantlary 

saýlamak mümkin. Apply 

to (Применить) açylýan 

sanawda grafiki ekranyň 
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haýsy böleginde ýerleşdirmegi görkezmegi amala aşyrýar: 

  

 Display (Ко всему 

экрану);  

 Current Viewport (К 

текущему ВЭкрану). 

Setup (Режим) açylýan 

sanawda diňe iki baha el-

ýeterli:  

 2D — ulanylýan 

görnüş (ýagny aktiw 

görnüş ekranynda 

bellenilen görnüş) 

hemme täze görnüş 

ekranyna degişli 

bolýar; 

 3D — ulanylýan 

görnüş döredilýän 

görnüş ekranlaryň 

birinde bellenilýär, 

galanlarynda bolsa 

AutoCAD ulgamy 

degişli ortogonal 

görnüşleri saýlaýar.  

Görnüş ekranlaryň biri aktiw bolup durýar. Islendik ekrany aktiw etmek üçin 

oňa syçanjyk bilen basmaly.  

Bir ekranly konfigurasiýa gaýtmak üçin galdyrylmaly ekrana basmaly we ony 

aktiw etmeli, VPORTS (ВЭКРАН) buýrugy bilen откройте Viewports (Видовые 

экраны) gepleşik penjiresini açmaly. New Viewports (Новые ВЭкраны) 

goşmaçasynyň Standard viewports (Стандартные конфигурации) sanawynda 

Single (Один) konfigurasiýasyny saýlamaly, Apply to (Применить) açylýan 

sanawda bolsa Display (Ко всему экрану) goýmaly. Bir ekrana geçmek üçin 

beýleki usul - Viewports (Видовые экраны) paneliniň  düwmejigine basmaly. 

Galtaşýan görnüş ekranlary bir ekrana birleşdirmeli. Munuň üçin View | 

Viewports | Join (Вид | Видовые экраны | Соединить) menýunyň bendinden 

peýdalanmaly. 

Görnüşler 

Görnüş ekranynda (ýa-da tutuş grafiki ekranda, eger ol bölünmedik bolsa) 

seretmegiň ugruny we görkezmegiň masştabyny belläp görnüşi gutnamak mümkin.  

 
View (Вид) gurallar panelinde aşakdaky düwmejikler ýerleşdirilen:  

 — View (Вид) gepleşik penjiresini açýar;  
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 6 sany standart ortogonal görnüşi gurnaýyş düwmejikler — (ýokarky 

görnüş), (aşakdan görnüş), (çepden görnüş), (sagdan görnüş), 

(öňünden görnüş) we (yzdan görnüş);  

 Standart izometriýa görnüşleriň 4 düwmejigi — (günorta-günbatar 

izometriýa),  (günorta-gündogar izometriýa),  (demirgazyk-günbatar 

izometriýa) we (demirgazyk-günbatar izometriýa);  

  — kameranyň nokady seretmegiň ugrunyň nokady arkaly seretmegiň 

ugruny belleýär. 

Görnüşi sazlamak  

Perspektiwanyň we kesiji tekizlikleriň bellenilmegi DVIEW (ДВИД) 

buýrugy arkaly ýerine ýetirilýär. Buýrugyň birinji soragy:  

Select objects or <use DVIEWBLOCK>: (Выберите объекты или 

Использовать DVIEWBLOCK>:) 

Soraga jogap hökmünde obýektleri görkezmek gerek. 

Ondan soň: 

Enter option [CAmera/TArget/Distance/POints/ 

PAn/Zoom/TWist/CLip/Hide/Off/Undo]:(Задайте 

опцию[Камера/Цель/Расстояние/Точки/ПАн/ПОказатъ/ВРащать/СЕчение/СК

рыть/ОТКл/ОТМенить/:)  

Buýrugyň opsiýalary:  

 САrаеrа (Камера) — seretmegiň ugruny kesgitleýän kamera-maksat 

wektory üçin başlangyç nokadynyň dinamiki görkezilmegi;  

 TArget (Цель) — seretmegiň ugruny kesgitleýän kamera-maksat wektory 

üçin ahyrky nokadynyň dinamiki görkezilmegi;  

 Distance (Расстояние) — kamera bilen maksadyň arasynda täze aralygyň 

girizilmegi; Ох-den 16х çenli şkala aralygy häzirkiden 16 esse artdyrmagy 

mümkin edýär;  

 POints (Точки) — maksadyň we kameranyň nokatlaryny koordinatalarda 

bermek;  

 РАn (ПАн) — görnüşi ulaltman hereketlendirişiň iki wektory arkaly 

süýşürmek;  

 Zoom (ПОказать) —0х-den 16х çenli ulaldyş koeffisientiň berilmegi, şeýle 

hem işledilen perspektiwada fokus aralygyň berilmegi;  

 TWist (ВРащать) — görnüşiň seretmegiň ugruna göräleýin aýlanylmagy 

we eňilmegi;  

 CLip (СЕчение) — görnüşde kesiji tekizlikleriň goýulmagy ýa-da 

aýrylmagy;  

 Hide (СКрыть) — saýlanylan obýektler üçin gizlin çyzyklaryň ýapylmagy;  

 Off (ОТКл) — perspektiw proýeksiýasyny öçürýär; ony işletmek üçin ýene 

Distance (Расстояние) opsiýasyny ýerine ýetirmeli;  

 Undo (ОТМенить) —DVIEW (ДВИД) buýrugynyň soňky amalynyň 

hereketini ýatyrýar.  



 254 

Görnüşi dolandyrmak üçin ýene bnir gyzykly mümkinçilik — 3DORBIT (3-

ОРБИТА) buýrugy, oňa 3D Orbit (3M орбита) paneliniň  düwmejigi we View 

(Вид) menýunyň 3D Orbit (3M орбита) bendi gabat gelýär. 

 
Buýruk üç ölçegli obýektleriň görnüşini görkezme gurluşy arkaly dinamiki 

üýtgetmegi mümkin edýär. Buýruk çagyrylan mahaly haýsy-da bolsa obýektler 

saýlanylan bolsa, onda görnüşi üýtgetmede diňe olar çykyş edýär. Saýlanylan 

obýektler ýok bolanda dinamiki üýtgetme suratyň hemme görünýän obýektleriň 

täze ýerleşmegini görkezýär. 

3DORBIT (3-ОРБИТА) işlän wagty ПСК nyşany reňkli üç ölçegli oklaryň 

nyşanyna öwrülýär we görnüşde orbital halka emele gelýär.  

 
Orbital halkanyň merkezi görnüşiň merkezi bilen gabat gelýär. Görkeziji orbital 

halkanyň içinde ýa-da daşynda hereketlendirilende kursor dürli nyşanlara eýe 

bolýar. Eger ol orbital halkanyň içinde ýerleşende ol iki kesişýän sferanyň 

görnüşini alýar - . E3ger kursor orbital halkanyň daşynda ýerleşen bolsa, ol ol 

daşynda tegelek-strelka bolan sfera görnüşinde bolýar . Eger kursor orbital 

halkanyň çep we sag kwadrantlaryň nokatlarynda ýerleşen tegelekleriň içinde bolsa 

ol kese ellips-strelkaly bolan sferanyň görnüşini alýar . Eger kursor orbital 

halkanyň ýokarky we aşaky kwadrantlaryň nokatlarynda ýerleşen tegelekleriň 

içinde bolsa ol dik ellips-strelkaly bolan sferanyň görnüşini alýar .  

Kursor şu görnüşlere eýe bolanda syçanjygyň çep düwmejigi basylyp orbital halka 

şol şekillere görä aýlanar we obýektleri degişli görnüşe getirerler. 3DORBIT (3-

ОРБИТА) buýrukdan çykmak üçin <Esc> we <Enter> klawişalaryna basmaly. 

 Orbital halka ekrandaka kontekst menýusy çagyryp Shading Modes 

(Раскрашивание) menýuny çagyrmak we 6 opsiýa arkaly obýektler aýlanylanda 

olary reňklemegiň wariantyny bellemek mümkin:  

 Wireframe (Каркас) — obýektler kesimleriň we çyzyklaryň (gyraňlaryň we 

jisimleriň erňekleriň) utgaşmasy görnüşinde görkezilýär, reňklenme ýok;  

 Hidden (Скрытие линий) — Wireframe (Каркас) ýaly, emma yzky 

görünmeýän gyraňlaryň çyzyklary görkezilmeýär;  
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 Flat Shaded (Плоское) — gyraňlar reňklenýär, emma reňklemegiň pes 

birsydyrgynlylyk bilen;  

 Gouraud Shaded (По Гуро) — gyraňlar reňklenýär; gyraňlaryň geçişleri 

öwüşginler bilen düzlenýär; reňklemegiň birsydyrgynlylygy öňki 

opsiýanyňkydan ýokary;  

 Flat Shaded, Edges On (Плоское, с кромками) —Wireframe (Каркас) 

we Flat Shaded (Плоское) opsiýalar utgaşdyrylýar (reňklenmede 

karkaslaryň çyzyklary yşyklanyp görünýär);  

 Gouraud Shaded, Edges On (По Гуро, с кромками) —Wireframe 

(Каркас) we Gouraud Shaded (По Гуро) opsiýalar utgaşdyrylýar.  

 
Üç ölçegli poliçyzyklar  

Aýratyn üç ölçegli obýekt bolup üç ölçegli poliçyzyk bolup durýar, ol 

baglanyşan göniçyzykly segmentlerden ybarat, emma segmentleriň depeleri üç 

ölçegli giňişligiň islkendik koordinatalaryna eýe bolup bilýär. Üç ölçegli poliçyzyk 

iki ölçegliden tapawutlykda, kada bolşy ýaly,  üç ölçegli giňişligiň ýeketäk 

tekizliginde ýerleşýär we 3DPOLY (3-ПЛИНИЯ) buýrugy arkaly gurulýar. 

Üç öplçegli çyzyklary redaktirlemek üçin şol bir PEDIT (ПОЛРЕД) 

buýrugy ulanylýar.  
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Tonirleme 

Üç ölçegli modelleri AutoCAD ulgamynda reaklistik görkezmek üçin 

birnäçe amalla rgöz öňünde tutulan. Olaryň arasynda HIDE (СКРЫТЬ) buýrugy, 

DVIEW (ДВИД) buýrukda hem görünmeýän çyzyklary ýaşyrmak opsiýasy hem 

göz öňünde tutulan. 

3DORBIT (3-ОРБИТА) buýrugy obýektleri reňklemegi mümkin edýär. 

Şeýle mümkinçilikleri hem View (Вид) menýunyň 

Shade (Раскрашивание) bendi hödürleýär. 

Reňklemegiň hemme görnüşleri düwmejik hökmünde 

Shade (Раскрашивание) panelinde getirilen. Bu 

düwmejikler SHADEMODE (РЕЖИМРАСКР) buýrugynyň opsiýasy bolup 

durýar.  

Üç ölçegleri realistik şekillerini almagyň has gyzykly mümkinçiligi bolup 

tonirleme amaly çykyş edýär. Tonirleme  ekrana perpendikulýar ugrukdyrylan 

adaty daşlaşdyrylan yşyklandyryş çeşmesinden başgalary – nokatlaýyn çeşmeleri 

we prožektorlary ulanmagy mümkin edýär. Obýektleriň üstlerine materiallaryň 

häsiýetlerini bellemek mümkin. Ýörite effektleriň arasynda dumany we fony (şol 

sanda taýyn rastr şekilinden) ulanmak mümkin. 

Tonirlemegiň hemme buýruklary View (Вид) menýunyň Render 

(Тонирование) şeýle hem 

Render (Тонирование) 

panelinde ýerleşen.  

Bu panel şeýle düwmejiklere eýe:  

 — üç ölçegli modeliň ýaşyrylan çyzyklaryny ýapmak bilen şekili (HIDE 

(СКРЫТЬ) buýrugy);  

 — üç ölçegli modeliň realistik tonirlenen şekiliniň ýerine ýetirilmegi 

(RENDER (ТОНИРОВАТЬ) buýrugy);  
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 — model giňişliginde sahnalary dolandyrmak (sahna — görnüşiň we 

yşyklandyryş çeşmeleriň topary) (SCENE (СЦЕНА) buýrugy);  

 —yşyklandyryş çeşmelerini dolandyrmak (СВЕТ (LIGHT) buýrugy);  

 — materiallar dolandyrmak (RMAT (МАТЕРИАЛ) buýrugy);  

 — materiallaryň importy we eksporty (MATLIB (БИБМАТ) buýrugy);  

 — teksturalary goýmak (materiallary üste baglaşdyrmak, SETUV 

(НАЛТЕК) buýrugy);  

 — fony bermeklik (BACKGROUND (ФОН) buýrugy);  

 — dumany dolandyrmak (FOG (ТУМАН) buýrugy);  

 — landşaftyň elementlerini goýmaklyk (çogdumlaryň, agaçlaryň, 

adamlaryň we ş.m. şekili, LSNEW (ЛАНДНОВЫЙ) buýrugy);  

 — landşaftyň elementlerini redaktirlemek (LSEDIT (ЛАНД-РЕД) 

buýrugy);  

 — landşaftyň elementleriniň bibliotekasy bilen işler ýerine ýetirmek 

(LSLIB (ЛАНДБИБ) buýrugy);  

 — tonirlemegiň düzgünlerini bellemek (RPREF (РЕЖИМТОН) 

buýrugy);  

 — tonirleme barada statistiki maglumatlaryň çykarylmagy (STATS 

(СТАТ) buýrugy).  

RENDER (ТОНИРОВАТЬ) buýrugy tonirlemegi amala aşyrmak üçin onuň 

parametrlerini bellemeki boýunça Render (Тонирование) gepleşik penjiresini 

açýar. 

Penjiräniň aşagynda ýerleşen Render (Тонирование) düwmejigi ony ýapýar 

goýlan parametrler bilen tonirlemegi gönümele ýerine ýetirýär.  
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Render (Тонирование) gepleşik penjiresiniň Rendering Type (Тип 

тонирования) açylýan sanawynda ýerine ýetirmegiň algoritmini saýlamak gerek: 

Render (Упрощенное), Photo Real (Фотореалистичное) we Photo Raytrace 

(Трассировка луча). Köplenç olaryň arasyndaky tapawut bildirmeýär. 

Scene to Render (Сцена для тонирования) sanawynda sahnanyň saýlawyny 

ady boýunça mala aşyrmak mümkin (eger olara at berlen bolsa) ýa-da şol wagtky 

sahnanyň saýlamak mümkin. Rendering Procedure (Процедура тонирования) 

töwereginde üç baýdajyk ýerleşdirilen, olar tonirlemäniýerine ýetirmegiň 

prosedurasyny kesgitleýärler:  

 Query for Selections (Выбирать объекты) — tonirlenýän obýektleriň 

gönümel görkezilmegi bellenilýär;  

 Crop Window (Задать область тонирования) — tonirleme töweregini 

bermeklik ýerine ýetirilýär (baýdajyk Destination (Вывод) töwereginde 

açylýan sanawdan Viewport (Видовой экран) bendi saýlanylan ýagdaýda 

el-ýeterli);  

 Skip Render Dialog (Без диалога) — gepleşiksiz, tutuş görnüş ekranyň 

tonirlenmegi bellenilýär. 

Light Icon Scale (Масштаб символа источника) meýdany yşyklandyryş 

çeşmesini belgilemek üçin ulanylýan bloguň masştabyny belleýär, Smoothing 

Angle (Угол сглаживания) meýdany bolsa — gyraňlaryň arasynda  burçuň 

maksimal bahasyny belleýär, şol burçda AutoCAD ulgamy olaryň gyraňlaryny 

düzleýär (deslapdan — 45°). 

Rendering Options (Параметры тонирования) töwereginde 4 baýdajyk 

ýerleşen: 

 Smooth Shade (Плавное) — köp gyraňly üstüň gyraňlaryň arasynda 

birsydyrgyn geçmegini kesgitleýär (gyraňlaryň reňklerini garmak arkaly);  

 Apply Materials (С материалами) — bellenilen materiallaryň 

ulanylmagyny amala aşyrýar; baýdajyk aýrylan ýagdaýynda *GLOBAL* 

("ГЛОБАЛЬНЫЙ*) standart materialy ulanylýar;  

 Shadows (С тенями) — tonirlemegiň iki görnüşi üçin kölegeleriň 

generasiýasyny belleýär: Photo Real (Фотореалистичное) we Photo 

Raytrace (Трассировка луча);  

 Render Cache (Кэширование) — tonirleme üçin keş-faýlyň ulanylmagyny 

görkezýär, bu bolsa tonirleme amalynyň gaýtadan ýerine ýetirilmegini 

tizleýdirýär.  

Şol töwerekde More Options (Дополнительно) düwmejigi bar, ol 

Rendering Type (Тип тонирования) sanawda saýlanylan obýektiň görnüşine 

baglylykda goşmaça sazlamalaryň penjiresini açýar: Render Options (Параметры 

упрощенного тонирования), Photo Real Render Options (Параметры 

фотореалистического тонирования) ýa-da Photo Raytrace Render Options 

(Параметры тонирования методом трассировки лучей). Bu penjire tonirleme 

düzgünlerini has takyk sazlamagy amala aşyrmagy, gyraňlary tonirlenmeginiň 

birsydyrgynlygyna täsir etmegi, kertikleri aýyrmagyň derejesini dolandyrmagy we 

ş.m. mümkin edýär. 



 259 

Destination (Вывод) töwereginde açylýan sanaw arkaly tonirlenen obýektiň 

çykarylmagyny ugurlaryny bellemegi mümkin edýär:  

  Viewport (Видовой экран) — görnüş ekranyna çykarmak;  

  Render Window (Окно) — netijäni ýörite Render penjiresine çykarmak;  

  File (Файл) — faýla ýazgy.  

Şol töweregiň More Options (Дополнительно) düwmejigi faýlyň 

parametrlerini görkezmegiň gepleşik penjiresini açýar, emma diňe opsiýalaryň 

sanawynda çykaryş gönümel faýla bellenilen. 

Sub Sampling (Проба) töweregi açylýan sanaw arkaly tonirlenmegiň 

barlanmasyny tizleşdirilen ýagdaýda kesgitleýär: 1:1-den (Best) (iň gowy hil, 

emma haýal) 8:1 çenli (Fastest) (tiz, emma hili pes). Background (Фон) 

düwmejigi fony bellemegiň penjiresiniň açmagyny ýerine ýetirýär, Fog/Depth 

Cue (Туман/Затемнение) düwmejigi bolsa — garamtylaýan effektleriň 

bellemegiň gepleşik penjiresini açmagy amala aşyrýar. 

Yşyklandyryş çeşmeler  

LIGHT (СВЕТ) buýrugy we Render (Тонирование) paneliniň  

düwmejigi surata täze yşyklandyryş çeşmeleri goşmagy mümkin edýär, ol 

çeşmeler 4 görnüşli bolup biler: dagynyk ýagtylygy, daşlaşdyrylan çeşme, 

nokatlaýyn çeşme we prožektor. Dagynyl ýagtylygy — ol fon yşyklandyryşa 

meňzeş, ony öçürmek ýa-da depginliligini üýtgetmek mümkin. 

Daşlaşdyrylan çeşme ýagtylygy diňe bir ugurda göni çyzykly ýaýradýar we 

ýagtylygyň depginliligi aralyk bilen üýtgemeýär. Daşlaşdyrylan çeşme gün 

ýagtylygyna meňzetme döretmek üçin ulanylyp bilner. 

Nokatlaýyn çeşme ýagtylygy hemme ugurlarda berýär, we onuň depginliligi 

ondan daşlaşylýan mahaly peselýär. Nokatlaýyn çeşmeler arkaly elektrik 

lamplalara gowy meňzetme döredilýär (meselem, otaglaryň modelleri 

döredilende). 

Prožektordan ýagtylyk şöhleleri berlen ugurda konusy döredip gidýär, bu 

ýagtylanýan obýektlerde ýagty yşyk tegmilleri we olaryň töwereginde 

yşyklanmagynyň peseliş zolaklaryny döredýär. Yşyk tegmiline gabat gelýän 

konusyň burçy, öz içine ýagty yşyk tegmilleri we olaryň töwereginde 

yşyklanmagynyň peseliş zolaklaryny alýan doly ýagtylyk konusyň burçundan kiçi 

bolmalydyr. Iki burç 0 we 160 gradusyň arasynda bolmalydyr. Hemme ýagtylyk 

çeşmeleri (dagynyk ýagtylykdan başga) suratda bloklaryň şekilleri bilen 

görkezilýär.  

 
LIGHT (СВЕТ) buýrugy Lights (Источники света) gepleşik penjiresini 

çagyrýar.  

Şol gepleşik penjiräniň Ambient Light (Рассеянный свет) sag bölegi 

umumy dagynyk ýagtylygyň depginliligini (Intensity (Интенсивность) şkalasy) 

we reňki (Color (Цвет) töweregi) sazlamagy mümkin edýär. 
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Çepde Lights 

(Источники) sanawy 

ýerleşen, ol hemme 

atlandyrylan çeşmeleriň 

sanawyny saklaýar. Ondan 

sagda Modify (Изменить), 

Delete (Удалить) we Select 

(Выбор) düwmejikleri bar, 

olar degişlilikde çeşmäni 

üýtgetmegi, ýok etmegi we 

syçanjyk bilen saýlamagy 

mümkin edýär. 

New (Новый) 

düwmejigi täze yşyk 

çeşmesini döretmek üçin ulanylýar. Emma oňa basmazdan öň, ondan sagdaky 

açylýan sanawda çeşmäniň görnüşini saýlamaly: Point Light (Точечный), Distant 

Light (Удаленный) ýa-da Spotlight (Прожектор). Nokatlaýyn çeşme üçin New 

(Новый) düwmejigi New Point Light (Новый точечный источник света) 

gepleşik penjiresini açýar.  

Bu penjiredäki Light Name (Имя 

источника) meýdanynda çeşmäniň 

adyny girizmeli (uzynlygy 8 

simwola çenli). Intensity 

(Интенсивность) şkalasy täze 

çeşmäniň depginliligini görkezmegi 

mümkin edýär. Position 

(Положение) töwereginde 

ýerleşdirilen Show (Показать) 

düwmejigi ekrana döredilýän 

çeşmäniň koordinatalaryny 

deslapdan çykaýar. Çeşmäniň 

gurnlyş nokadynyň hakyky 

koordinatalaryny Modify 

(Изменить) düwmejik arkaly 

mümkin, ol ýagtylyk çeşmesiniň 

ýerleşmeginiň nokadyny ulanyjy görkezer ýaly New Point Light (Новый 

точечный источник света) penjiräni wagtlaýyn ýapýar. 

Color (Цвет) töwereginde çeşme üçin reňk bellenilýär. 

Attenuation (Спад) pereklýuçateller topary aralyk bilen depginliligniň 

nähili üýtgediljekdigini kesgitleýär. Üç görnüş mümkin:  

  None (Нет) — depginliligiň peselmegi ýok, ýagny çeşme hem ýakyn hem-

de daşky obýektleri deň yşyklandyrýar;  

  Inverse Linear (Линейная инверсия) — depginligiň peselmegi çeşmeden 

bolan aralyga proporsional üýtgeýär;  
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  Inverse Square (Квадратичная инверсия) — depginligiň peselmegi 

aralygyň inedördüline proporsional.  

Shadows (Тени) töwerekde Shadow On (Включить) baýdajygy goýmak 

mümkin, ondan soň tonirleme geçirilende obýektlerden bolan kölegeler goşulýar. 

Kölegeleriň häsiýetnamalary Shadow Options (Параметры теней) düwmejik 

arkaly dolandyrylýar, ol Shadow Options (Параметры теней) gepleşik penjiresini 

açýar.  

 

 

 

 

New Point Light (Новый точечный источник света) gepleşik penjiresi 

ýapylandan soň Lights (Источники света) gepleşik penjiresine gaýdýarys. Täze 

çeşme hökmünde açylýan sanawda Distant Light (Удаленный) saýlamak 

mümkin.Şonda New (Новый) düwmejigi basylanda New Distant Light (Новый 

удаленный источник света) gepleşik penjiresi açylar.  

 
Light Name (Имя источника), Intensity (Интенсивность) meýdanlary 

hem-de Color (Цвет) we Shadows (Тени) meýdanlary öň seredilen New Point 
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Light (Новый точечный источник света) penjiredäkilere meňzeş. Sun Angle 

Calculator (Положение солнца) düwmejigi Sun Angle Calculator (Положение 

солнца) gepleşik penjiresini açýar, şol penjirede günüň anyk bir geografiki ýeriň 

belli wagtynda ýerleşmegini kesgitlemegi mümkin edýär.  

 
 

Bu penjirede Geographic Location (Географическое положение) 

düwmejigi öz gezeginde Geographic Location (Географическое положение) 

gepleşik penjiresini açmagy mümkin edýär, ol gerek bolan ýeriň giňişligini we 

uzaklygyny kartany we şäherleriň sanawyny ulanmaklyk bilen kesgitleýär. 

Hasaplanan ähmiýetler awtomatiki ondan öňki penjirä geçirilýär.  

 
 

New Distant Light (Новый удаленный источник света) penjiresiniň 

Azimuth (Азимут) we Altitude (Возвышение) meýdanlary daşlaşdyrylan 

çeşmäniň geografiki koordinatalarda ýerleşmegini belleýär. Light Source Vector 

(Направление луча) töweregi çeşmäniň wektorynyň görkezilmegini ýa-da 

girizilmegini mümkin edýär. 

Eger Lights (Источники света) penjirede täze çeşme hökmünde açylýan 

sanawda Spotlight (Прожектор) saýlanylsa, onda New (Новый) düwmejigi 

açylanda New Spotlight (Новый прожектор) gepleşik penjiresi açylýar.  
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Bu penjire öňki çeşmelere bolan penjirelere meňzeş gelýär. Täze bolup 

Hotspot (Яркое пятно) we Falloff (Полный конус) meýdanlary çykyş edýär. 

Sahnalar 

SCENE (СЦЕНА) buýrugy we Render 

(Тонирование) paneliniň düwmejigi Scenes 

(Сцены) penjiresini açýar, ol penjire ulanylýan 

suratyň atlandyrylan sahnalaryny dolandyrýar.  

Sahna düşünjesi öz içine ýagtylygyň görnüşini we 

çeşmesini alýar. Scenes (Сцены) penjiräniň çep 

böleginde atlandyrylan sahnalaryň sanawy bar. Eger 

sahnalar bellenilmedik bolsa onda Scenes (Сцены) 

sanawy diňe *NONE* (*HET*) setiri saklaýar.  

New (Новый) düwmejigi New Scene (Новая 

сцена) gepleşik penjiresini çagyrýar.  

Täze sahnany döretmek üçin Views (Виды) 

sanawynda gerek bolan görnüşiň adyny saýlamaly, 

Lights (Источники) sanawynda — hemme gerek 

bolan çeşmeleriň adyny saýlamak gerek. Eýýam 

saýlanylan çeşmelerine beýlekilere goşmak üçin 

<Ctrl> klawişany basyp durmaly. Scene Name 

(Имя сцены) täze sahna berilmeli at girizmeli. 

 

Materiallar 

Tonirlemegiň sazlamalaryny bellemegiň beýleki buýruk bolup, Render 

(Тонирование) paneliniň  düwmejigine gabat gelýän RMAT (МАТЕРИАЛ) 

buýrugy bolup durýar, ol gurlan obýektlere materiallary belleýär. Buýruk 

Materials (Материалы) penjiresini çagyrýar.  
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Penjiräniň çep böleginde Materials 

(Материалы) sanawynda ulanylýan 

sanawa ýüklenen materiallaryň sanawy 

getirilen. *GLOBAL* 

("ГЛОБАЛЬНЫЙ*) diýlip 

atlandyrylýan material hökmany suratda 

duş gelýär we üste eýe bolan hemme 

obýektlere berkidilýär. Hemme beýleki 

materiallary MATLIB (БИБМАТ) 

buýruk arkaly ýa-da Render 

(Тонирование) paneliniň  düwmejigi 

arkaly importirlemek mümkin, olar 

Materials Library (Библиотека 

материалов) penjiräni çagyrýar.  

 

 

Şol penjiräniň çep böleginde 

Current Drawing (Текущий 

рисунок) töwereginde ulanylýan 

surata importirlenen materiallaryň 

sanawy getirilendir. Bu sanawy 

Purge (Очистить) düwmejigi 

arkaly arassalamak mümkin ýa-da 

mli giňişlikli aýry faýl hökmünde 

ýatda saklamak mümkin. Ýokarky 

sag burçda Current Library 

(Текущая библиотека) töwereginiň 

açylan sanawynda ulanylýan 

bibliotekanyň ady ýerleşen, onuň 

aşagynda bolsa onuň 

materiallarynyň sanawy 

ýerleşdirilen. Deslapdan AutoCAD ulgamynyň render.mli atly standart 

bibliotekasy ulanylýar.  

Eger materiallaryň sanawynda materialy saýlap Preview (Просмотр) düwmejige 

basylsa onda şol materialyň görnüşini görmek bolar. 

Materiallaryň importy şeýle ülňi boýunça ýerine ýetirilýär. Gerekli material 

sanawda bellenilýär we soňra Import (Импорт) düwmejik arkaly ulanylýan 

suratyň materiallar sanawyna geçirilýär. 

Hemme materiallar import edilenden soň Materials Library (Библиотека 

материалов) penjiräni ýapmaly. Mundan soň Materials (Материалы) gaýtadan  

açylýar.  

Materials (Материалы) penjiresinde hem Preview (Просмотр) düwmejigi 

bar. Modify (Изменить) düwmejigi bellenilen material üçin Modify Standard 

Material (Изменение стандартного материала) penjiräni çagyrmagy we oňa 

käbir häsiýetnamalary üýtgetmegi mümkin edýär.  
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Bu penjiräniň Attributes (Параметры) töwereginde 7 pereklýuçatel bar:  

 Color/Pattern (Цвет/Текстура) — materialyň esasy reňki sazlanylýar 

(diffuz serpikme); Value (Значение) meýdany we Color (Цвет) töweregi 

bilen kesgitlenýär;  

 Ambient (Рассеяние) — üst bilen serpikýän ýagtylygyň reňki sazlanylýar; 

Value (Значение) we Color (Цвет) bilen dolandyrylýar;  

 Reflection (Отражение) — serpikýän üstde blikleriň reňki sazlanylýar; 

Value (Значение) we Color (Цвет) bilen dolandyrylýar;  

 Roughness (Шероховатость) — düz dälligiň derejesiniň sazlanmagy amala 

aşyrylýar (has düz üstde blikler az);  

 Transparency (Прозрачность) — açyklygyň sazlanmasy ýerine ýetirilýär; 

Value (Значение) bilen dolandyrylýar; File Name (Имя файла) 

meýdanynda teksturanyň faýlynyň adyny bermek mümkin;  

 Refraction (Преломление) — serpikmede şöhleleriň döwülmeginiň 

derejesi sazalnylýar.  Value (Значение) bilen dolandyrylýar;  

 Bump Map (Выдавливание) — gysyp çykarma effektine meňzetme ýerine 

ýetirilýär; teksturanyň faýlynyň ady File Name (Имя файла) meýdanynda 

bellenilýär.  

Her material 4 görnüşinden birine eýe bolup bilýär, olar New (Новый) 

düwmejiginiň aşagynda ýerleşen açylýan sanawda ýerleşýär: Standard 

(Стандартный), Granite (Гранит), Marble (Мрамор), Wood (Дерево). 

standartlydan tapawutlykda beýleki üç görnüş öz öwüşginini materiala goşýar 

(degişlikde granit, mermer ýa-da agaç). Standart bolmadyk görnüş alynanda 

Modify Standard Material (Изменение стандартного материала) gepleşik 

penjiresi öz adyny üýtgedýär (meselem, Granite (Гранит) görnüşi üçin penjire 

Modify Granite Material (Изменение материала Гранит) diýlip atlandyrylýar). 

Materials (Материалы) gepleşik penjiresiniň Select (Выбор) düwmejigi 

obýekte öň berkidilen materialy kesgitlemegi mümkin edýär. Bu düwmejige 

basylandan soň AutoCAD wagtlaýynça Materials (Материалы) ýapýar we 



 266 

suratda obýekti görkezmegi hödürleýär. Soňra gaýtadan Materials (Материалы) 

penjiresi açylýar, ýöne sanawda bellenilen material bilen. 

Materialy berkitmek üçin sanawda bellemeli, we soňra Attach (Присвоить) 

düwmejigi basmaly. AutoCAD Materials (Материалы) penjiresini ýapyp 

obýektleri sorar. Obýektler görkezilenden soň materiallar berkidilýär we Materials 

(Материалы) penjiresi işi dowam etmek üçin gaýtadan açylýar. 

Berkidilen materialy aýyrmak gerek bolsa Detach (Снять) düwmejige 

basmaly. Materialy berkitmegiň ýene iki mümkinçiligi bar: reňk we gatlak 

boýunça. By ACI (По ИЦА) düwmejigi reňkiň belgisini material bilen, By Layer 

(По слою) düwmejigi bolsa material bilen gatlagy baglaşdyrýar. 

SETUV (НАЛТЕК) buýrugy we oňa gabat gelýän Render (Тонирование) 

paneliniň  düwmejigi teksturlary üstünden goýmagy mümkin edýär. 

Fon we duman 

BACKGROUND (ФОН) buýrugy we Render (ТОнирование) paneliniň 

düwmejigi служат tonirlemede fony döretmek üçin ulanylýar we ýerine ýetirilende 

Background (Фон) gepleşik penjiresini açýarlar. 

Bu penjirede fonuň görnüşini saýlamak gerek:  

 Solid (Сплошной) — bir reňkli fony belleýär;    

 Gradient (Переход) — iki ýa-da üç reňklerden bolan birsydyrgyn geçýän 

fony kesgitleýär;  

 Image (Изображение) —rastr faýlyndan bolan fony belleýär;  

 Merge (Слияние) — fon hökmünde görnüş ekranyň düzümini kesgitleýär 

(diňe Render (Тонирование) penjiresinde Destination (Вывод) bölümiň 

açylýan sanawynda Viewport (Видовой экран) bendi saýlanylan bolsa 

mümkin); bu ýagdaýda adaty tonirlemede ýitýän obýektler görünýär.  

 
FOG (ТУМАН) buýrugy we oňa gabat gelýän Render (ТОнирование) 

paneliniň  düwmejigi dumanyň effektini gazanmagy mümkin edýär. Buýruk  

Fog/Depth Cue (Туман/Затемнение) penjiresini açýar.  

 



 267 

Bu penjirede eger duman bilen 

tonirlemeklik gerek bolsa, Enable Fog 

(Включить туман) baýdajygy goýmaly, 

ýogsam beýleki meýdanžar el-ýeterli bolmaz. 

Dumanyň reňkiniň we depginliliginiň 

sazlanylmagy penjiräniň degişli düwmejikleri 

arkaly mala aşyrylýar. 

 

 

 

 

 

 

 

 

 

 

 

Landşaftyň elementleri 

LSNEW (ЛАНДНОВЫЙ) buýrugy we oňa gabat gelýän Render 

(Тонирование) paneliniň  düwmejigi tonirlemede landşaftyň elementini 

goşmagy mümkin edýär. Buýruk Landscape New (Новый ландшафт) gepleşik 

penjiresini çagyrýar. 

Bu penjirede landşaftyň 

elementiniň adyny saýlamaly. Preview 

(Просмотр) düwmejigi saýlanylan 

elementi görmegi mümkin edýär. 

Goýmazdan öň şekiliň parametrleri 

(Geometry (Геометрия) töweregi) we 

öleçegleri (Height (Высота) meýdany) 

bellenilýär.  

Position (Положение) düwmejik 

arkaly landşaftyň elementi suratyň 

meýdanynda ýerleşdirilýär. 

Tonirlemeden daşarda goýlan elementler 

üçburluk görnüşe eýe. Tonirlemede  olar 

şekili janlandyrmak üçin fona goşulýar..  

LSEDIT (ЛАНДРЕД) buýrugy goýlan 

elementiň parametrlerini üýtgetmegi 

mümkin edýär, LSLIB (ЛАНД-БИБ) 

buýrugy bolsa — landşaftlar bibliotekasynda saklanylýan elementleri görmegi, 

üýtgetmegi we goşmagy mümkin edýär.  

Gyraňlar we torlar 

Tonirlemede obýektleriň üstleri açyk bolmaz ýaly, olar ýörite usul bilen 

döredilen bolmalydyr. Silindriň (gysylyp çykarylan tegelegiň) hemme üstleri iki 
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ölçegli karkasyň düzgüninde görünmeýän çyzyklar ýaşyrylandan açyk däl 

bolýarlar, gysylyp çykarylan göniburçluk görnüşindäki poliçyzykda bolsa diňe 

gapdal diwarlary açyk däl. Göniburçlugyň özi tutuş tekiz obýekt bolup durmaýar 

we diňe sudura eýe. 

Açyk däl üçburçluklar we dörtburçluklar üçin AutoCAD-da ýörite obýekt 

bar— gyraň. Üznüksiz ýerleşen gyraňlar "torlara" birleşdirilip bilner.  

Draw | Surfaces | 3D Surfaces (Рисование | Поверхности ЗМ 

поверхности) bendi saýlamaly. Ekranda 3D Objects (ЗМ объекты) gepleşik 

penjiresi emele geler.  

 
 

Bu penjirede 9 obýekt el-ýeterli (Box3d (ЗМ ящик), Pyramid (Пирамида), 

Wedge (Клин), Dome (Купол), Sphere (Сфера), Cone (Конус), Torus (Top), 

Dish (Чаша) we Mesh (Сеть)), olaryň parametrleri goýulandan soň suratda 

dörtburçlukly we üçburçlukly öýjükli torlar gornüşindäki üstler bilen gurularlar. 

Hemme öýjükler görünmeýän çyzyklary ýaşyrmak, reňklemek we 

tonirlemek amallary açyk däl. 

Surfaces (Поверхности) gurallar panelinde gyraňlar we torlar bilen 

işlemegik üçin hemme amallaryň düwmejikleri bar.  

 
 

Birinji  düwmejigi tekiz dörtburçluklary çyzmagyň SOLID (ФИГУРА) 

buýrugyny çagyrýar. 

Figuralar goşmaça häsiýete eýe – olar açyk däl. Figura tekiz (ikiölçegli) 

obýekt bolup durýar we XY tekizligine parallel bolan tekizlikde ýerleşýär. 

3DFACE (3-ГРАНЬ) buýrugy we oňa gabat gelýän Surfaces 

(Поверхности) paneliniň  düwmejigi hem-de Draw | Surfaces | 3D Face 

(Рисование | Поверхность ЗМ грань) bendi hem dörtburçly primitiwleri 
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gurýarlar, emma olar eýýam üçölçegli obýekt bolup durýar we oalryň depesi bir 

tekizlikde bolman hem bilýär. 

Buýrugyň birinji soragy: Specify first point or [Invisible]: (Первая точка 

или (Невидимая):)  

Invisible (Невидимая) buýrugy saýlanylsa, onda birinji nokatdan ikinjä 

barýan gyraň erňegi, görünmeýän bolar. Şol opsiýa saýlanylandan soň AutoCAD 

birinji nokadyň soragyny gaýtalar. Eger birinji nokat berilse indiki sorag berler:  

Specify second point or [Invisible]: (Вторая точка или [Невидимая]:) 

Bu ýerde Invisible (Невидимая) opsiýanyň saýlanylmagy, ikinji we üçünji 

nokatlaryň arasyndan geçýän erňek görünmeýän bolar. Ikinji nokat girizilenden 

soň: Specify third point or [Invisible] <exit>: (Третья точка или [Невидимая] 

<выход>:)  

Eger bu ýagdaýda <Enter> klawişasy basylsa, onda buýruk öz işini 

tamamlar. Soňra üçünji nokat girizilenden soň:  

Specify fourth point or [Invisible] <create three-sided face>: (Четвертая точка 

или [Невидимая! <создать треугольную грань>:) 

Bu ýagdaýda <Enter> klawişanyň basylmagy üçburçluk gyraňy döredýär 

(ýagny üçünji we dördünji nokatlar gabat gelýär). Dördünji nokat görkezilenden 

soň bolsa ýene üçünji nokat barada sorag berler. 

 
EDGE (КРОМКА) buýrugy we oňa gabat gelýän Surfaces (Поверхности) 

paneliniň  düwmejigi gyraňlaryň we torlaryň erňekleriniň görünmrgini 

üýtgetmegi mümkin edýär. Erňekleriň görünmegini üýtgetmegiň amatly guraly 

bolup Properties (Свойства) penjiresi bolup durýar. 

Torlary EXPLODE (РАСЧЛЕНИТЬ) buýrugy arkalygyraňlara bölmek 

mümkin, özem bir öýjükden bir gyraň emele geler. 

Standart görnüşli hemme torlar çyzmalaryň ulanylýan tekizligine göräleýin 

gurulýar, şol sebäpli şeýle obýekti döretmezden öň gerekli ПСК geçmek gerek. 

8 sany standart üstleriň gurulmagy diňe Surfaces (Поверхности) paneliniň 

düwmejikleri bilen dälde, eýsem 3D (ЗМ) buýruklary arkaly hem gurulyp bilner. 

Standart üstüň gurulmagyny göniburçluk parallelepipediň esasynda seredeliň: 

Select option [Box/Cone/DIsh/DOme/Mesh/ Pyramid/Sphere/Torus 

/Wedge]:(Задайте опцию [Ящик/КОнус/ЧАша/Купол/СЕть/Пирамида/Сфера 

/Тор/КЛин]:)  
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Box (Ящик) opsiýasyny saýlamaly. Indiki sorag:  

Specify comer point of box; (Угловая точка ящика:)  

Birinji burçuň nokadyny görkezmeli. Soňra:  

Specify length of box: (Длина ящика:) 

Uzynlygy san bilen ýa-da nokat bilen görkezmeli. Soňra: Specify width of box or 

[Cube]: (Ширина ящика или {Куб/:)  

Ini san bilen ýa-da nokat arkaly ýa-da Cube (Куб) opsiýasyny saýlamaly. 

Eger in berlen bolsa, ýagny gapyrjak kub bolmadyk bolsa, onda goşmaça sorag 

berler: 

Specify height of box: (Высота ящика:)  

Indi hemme ölçegler bellenilen, emma ýene gapyrjagy Z okunyň daşyndan 

aýlamak bolýar. Indiki sorag: 

Specify rotation angle of box about the Z axis or [Reference]: (Угол 

поворота ящика вокруг оси Z или /Опорный угол]:) 

 
Umumy ýagdaýda tor bu bir ugry boýunça nelli bir nokatlaryň sany (М), 

beýleki ugur boýunça bolsa nokatlaryň beýleki sany (N) bolan obýekt. Bu ugurlary 

— М-ugur we N-ugur diýlip atlandyrylýar. Degişlilikde öýjükleriň umumy sany  

(М - 1)-ň (N - 1)-a bolan köplük hasyly bolup durýar. Torlar ýapyk we 

ýapylmadyk bolup bilerler, özem ýapylmagy bir ýa-da iki ugur boýunça bolmagy 

mümkin. Belli bir ugur boýunça ýapylmadyk tor PEDIT (ПОЛРЕД) buýrugy 

arkaly ýapylyp bilner. 

3DMESH (3-СЕТЬ) buýrugy we oňa gabat gelýän Surfaces (Поверхности) 

paneliniň  düwmejigi toruň depesiniň koordinatalary boýunça ýapylmadyk 

islendik tory gurmagy mümkin edýär. 

Buýrugyň birinji soragy: Mesh M size: (Размер сети в направлении М:)  

M ugur boýunça toruň ölçegini kesgitleýän 2-den 256-e çenli bolan sany girizmeli 

Soňra: Mesh N size: (Размер сети в направлении N:)  

Edil ýokaky ýaly jogaş bermeli. Soňra toruň her depesi boýunça soraglar beriler. 

Her ugur boýunça nokatlar 0-dan М — 1-çenli  we 0-dan N — 1-e çenli 

belgilenýär. Meselem: Vertex (0, 0): (Положение вершины (0, 0):)  

Soňra nobat boýunça beýleki depeler gurulýar (0, 1), (0, 2), (0, 3), (1, 0), (1, 1), (1, 

2), (1. 3), (2, 0), (2, 1), (2, 2), (2, 3). 
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 düwmejigi we oňa gabat gelýän REVSURF (П-

ВРАЩ) buýrugy giňişlikde kesimiň daşyndan çyzyk 

aýlananda emele gelýän üsti almagy mümkin edýär.  

  — süýşmegiň üstüni döredýär, ol bir egri çyzygyü 

beýlekä görä hereketinden alynýar (TABSURF (П-

СДВИГ) buýrugy);  

 — bir çyzykdan beýlekä birsydyrgyn geçilende 

emele gelýän birleşme üsti döredýär (RULESURF (П-

СОЕД) buýrugy);  

 — ýapyk egriçyzykly dörtbuçlugy mele getirýän 

erňekleriň arasynda Kuns üsti döredýär (EDGESURF 

(П-КРОМКА) buýrugy).  

Bu dört buýrukda SURFTAB1 we SURFTAB2 

üýtgeýänler uly rol oýnaýar. 

 

 

 

 

 

 

 

Töwerekler 

 Töwerek — iki ölçegli obýekt, ol ýapyk sudur bilen çäklendirilip we içlige 

eýe. Töwerekde deşikler bolup biler. Töwerekleri goşup we aýyrmak mümkin. 

Olar açyk däl (deşik bolup durýan meýdanlardan başga). Töwerekler — 

çylşyrymly görnüşli jisimleri gurmak üçin ulanylyp bilner (gysyp çykarma ýa-da 

aýlama arkaly). 

Islendik tekiz ýapyk sudury (tegelegi, ýapyk poliçyzygy, ýapyk döwük 

görnüşindäki kesimlerr we olara meňzeş beýleki obýektleri) töwerek edip bolýar. 

Munuň üçin REGION (ОБЛАСТЬ) buýrugy ulanylýar, oňa Draw (Рисование) 

paneliniň  düwmejigi we Draw (Рисование) menýusynyň Region (Область) 

bendi gabat gelýär. 

REGION (ОБЛАСТЬ) buýrugy obýektleri soraýar we olar saýlanylandan 

soň döredilen töwerekleriň sany barada habar berýär. 

Töwerekleriň üstünden birleşdirme, aýyrma we kesişme amallary ýerine 

ýetirmek mümkin. Bu amallaryň düwmejikleri Solids Editing (Редактирование 

тел) gurallar panelinde ilkinji üç düwmejik bolup durýar, şol amallar jisimleriň 

üstünden hem mümkin.  
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Aşakdaky suratda üç töwerekleriň birine birleşmegi görkezilen. Degişli 

gurllar - UNION (ОБЪЕДИНЕНИЕ) buýrugy we Solids Editing 

(Редактирование тел) paneliniň  düwmejigi.  

 
Aşaky suratda obýektleriň aýrylmagy görkezilen. Degişli gurallar SUBTRACT 

(ВЫЧИТАНИЕ) buýrugy we Solids Editing (Редактирование тел) paneliniň 

düwmejigi.  

Aşaky suratda üç töweregiň kesişmesi görkezilen. kesişme amaly üçin  

INTERSECT (ПЕРЕСЕЧЕНИЕ) buýrugy we oňa laýyk gelýän Solids Editing 

(Редактирование тел) paneliniň  панели düwmejigi ulanylýar.  

 
 

Eger kesişmeýän töwerekler birleşdirilse onda köp baglanşykly daşky sudura 

eýe bolan töwerek emele geler. EXPLODE (РАСЧЛЕНИТЬ) buýrugy töweregi 

ýönekeý primitiwlere bölýär (kesimlere, halkalara, tegeleklere, ellipslere, 

splaýnlara). 
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Jisimler 

Üç ölçegli torlar, olar ýapyk hem bolsadylar içliksiz bolan obýektlerdiler. 

Içlige şeýle hem gysylyp çykarylan iki ölçegli obýektler hem eýe däl (meselem, 

silindr). 

 Jisimler diýlip atlandyrylýan obýektler içlige eýe we olaryň göwrümini 

birleşdirmek, aýyrmak we kesişdirmek mümkin. 

Jısımler standart jisimleri gurmagyň buýruklary ulanylanda emele gelýär 

(gapyrjaklar, konuslar, şarlar we ş.m.), şeýle hem töwerekleri aýlamagyň we gysyp 

çykarmagyň netijesi hökmünde çykyş edýärler. Jisimleri böleklere kesip bolýar we 

tekizlikler arkaly kesimlerini alyp bolýar. 

AutoCAD ulgamynda gaty jisimli modeli döretmek üçin ony pikir bilen 

ilkibaşda ýönekeý standart böleklere bölmeli. Soňra logiki amallary arkaly 

(birleşdirme, aýyrma we kesişme), şeýle hem redaktirleme amallary arkaly gerekli 

görnüşli obýekti döretmeli. 

Jisimleri gurmak 

Solids (Тела) (рис. 9.80) gurallar panelindejisimleri gurmagyň düwmejikleri 

bar. 

 
 

Bu paneliň birinji düwmejikleri standart gaty jisimli obýektleri gurmak üçin 

niýetlenen. Bu düwmejiklere degişlilikde şu buýruklar gabat gelýär: BOX 

(ЯЩИК), SPHERE (ШАР), CYLINDER (ЦИЛИНДР), CONE (КОНУС), 

WEDGE (КЛИН) we TORUS (TOP). 

BOX (ЯЩИК) buýrugy arkaly МСК-da gaty jisimli parallelepipedi guralyň. 

Arassalanan garfiki ekranda günorta-günbatara izometriýany görnüş hökmünde 

goýmaklyk ündelýär. 

BOX (ЯЩИК) buýrugyň birinji soragy: 

Specify corner of box or [CEnter]<0,0,0>: (Угол ящика или /Центр/ 

<0,0,0>:)  

<Enter> klawişasy basylsa — bu gapyrjagyň birinji burçunyň nokady 

deslapdan saýlanylan, ýagny МСК-nyň başynda ýerini alar. CEnter (Центр) 

opsiýasynyň saýlanylmagy gapyrjagy birinji burçdan dälde parallelepipediň 

merkezinden gurulyp başlamaklyga getirer. Indiki sorag: 

Specify corner or [Cube/Length]: (Угол или 

[Куб/Длина]:)  

Bu ýerde gapyrjagyň beýleki burçunyň nokadyny bermek 

mümkin. Cube (Куб) opsiýasy kubuň gurulmagyna 

getirer. Length (Длина) opsiýasyny saýlaň. Soňra 

gapyrganyň uzynlygyny görkezmeli: 

Specify length: (Длина:) 400. Soňra: 

Specify width (Ширина:) ini girizmeli 350. 

Soňra: 

Specify height: (Высота:) beýikligi bermeli 200. 



 274 

Indi gapyrjagyň ýokarky üstünde radiusy 100 mm we beýikligi 150 mm 

bolan silindri guralyň. CYLINDER (ЦИЛИНДР) buýrugy sorar:  

Current wire frame density: ISOLINES=4 Specify center point for base of 

cylinder or fEllipticalJ <0,0,0>: (Текущая плотность 

каркаса: ISOLINES=4 Центральная точка основания 

цилиндра или [Эллиптический] <0,0,0>:) 

200,175,200 nokady belläli. Soňra: 

Specify radius for base of cylinder or 

[Diameter]: (Радиус основания цилиндра или 

[Диаметр]:) 

Radiusy 100 girizeliň. 

Specify height of cylinder or [Center of other 

end]: (Высота цилиндра или [Центр другого основания]:) 

Silindriň beýikligini 150 girizeliň. 

AutoCAD silindri emele getiriji çyzyklarynynyň sanyny (dört) ISOLINES 

ulgamlaýyn üýtgeýäniň bahasyna deň edip alýar. 

Başlangyç ýagdaýda suratda olar diňe iki bolup 

görünýär. Emma obýektiň öňki tarapynyňky bilen 

yzyňkysy gabat gelýärler. Emele getiriji çyzyklaryň 

sanyny 28 çenli  artdyralyň. Munuň üçin buýruk setirinde: 

ISOLINES ýazmaly we <Enter> basmaly: 

New value for ISOLINES <4>: (Новое значение 

ISOLINES <4>:). 28 girizmeli. Ekrany regenerasiýa etmeli 

- View (Вид) menýunyň Regen (Регенерировать) bendini 

saýlamaly ýa-da REGEN (РЕГЕН) buýrugy girizmeli. 

Indi bolsa gapyrjagyň bize golaý sag gapdal 

diwarynda beýleki gapyrjagy guralyň, ol soňra 

çuňlaşdyrma bolar. Munuň üçin TÄZE ПСК-ny sag gapdal 

diwar boýunça gurnalyň. Munuň üçin UCS (ПСК) 

paneliniň  düwmejigini ulanalyň: 

Select face of solid object: (Выберите грань 

твердотельного объекта:) Syçanjyk bilen gapyrjagyň sag 

öňki diwarynyň aşaky gapyrgasyna basalyň. Sag gyraň 

yşyklanar we sorag emele geler: 

Enter an option [Next/Xflip/Yflip] <accept>: 
(Задайте опцию 1Сменить/обратитьХ/обратитьУ] 

<принять>:) 

Eger koordinat ulgamynyň piktogrammasy aşaky 

suratdaky ýaly görünýän bolsa onda ylalaşmak üçin 

<Enter> klawişasyny basmaly.  

Indi BOX (ЯЩИК) buýrugy arkaly gapyrjagy guralyň, onuň burçunyň 

nokadyny (100,0,0), ikinji burçuňkyny — (300,—170,0), beýikligi bolsa—250 mm 

edip girizeliň. Esasy gapyrjagyň içinde ikinjisi emele geler. 
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Indi bolsa  we  

düwmejikleri arkaly uly 

gapyrjagy silindr bilen 

birleşdireliň, emele gelen düzüm 

jisimden kiçi gapyrjagy aýyralyň. 

Indi bolsa öň seredilen 

CHAMFER (ФАСКА) we 

FILLET (СОПРЯЖЕНИЕ) 

jisimlere ulanalyň  

Jisimleri gysyp çykarma we aýlama usullary arkaly gurmak mümkin. Bu 

amallar Тела (Solids) paneliniň  we düwmejikleri arkaly amala aşyrylýar. 

Bu düwmejikler EXTRUDE (ВЫДАВИТЬ) we REVOLVE (ВРАЩАТЬ) 

buýruklara gabat gelýär. 

Mysal hökmünde EXTRUDE (ВЫДАВИТЬ) buýrugy arkaly turbanyň gaty 

jisimli meýdanynyň gurulmagyna seredeliň. Boş ekranda görnüş hökmünde 

günorta-günbatar izometriýany goýalyň. Merkezleri koordinat başynda bolan iki 

sany tegelegi degişlilikde 100 we 80 radius bilen çyzalyň. Olary töwereklere 

özgerdeliň. Uly töwerekden kiçini aýyryp halka 

görnüşindäki töweregi alalyň. 

Görkezilen suratda halkadan başga gysylyp 

çykarmagyň ýoly hem götkezilen. Ony gurmak üçin 

UCS (ПСК) paneliniň  düwmejigi arkaly панели 

инструментов UCS (ПСК) oklary öwüreliň (diklik 

ýagdaýa çenli). Täze koordinat ulgamynda üç 

segmentden ybarat bolan poliçyzygy guralyň: olaryň 

birinji göniçyzykly  bolup durýar we depeleri (0,0) we 

(0,500) nokatlarda, okinjisi — halkalaýyn, birinjä 

galtaşýar we (100,600) nokatda tamamlanýar, üçünjisi 

— ýene göniçyzyklyhalkalaýyn bölege galtaşýar we (1000,600) nokatda 

tamamlanýar (hemmesinde z koordinatasy 0 deň EXTRUDE (ВЫДАВИТЬ) 

buýrugy çagyralyň. Obýektleri saýlamak barada soraga 

halkany görkezmeli. Indiki sorag: Specify height of 

extrusion or [Path]: (Глубина выдавливания или 

[Траектория]:) 

Path (Траектория) opsiýany saýlamaly. Soňra 

ulgam sorar: 

Select extrusion path: (Траектория 

выдавливания:)  

Poliçyzygy görkezeliň. 

INTERFERE (ВЗАИМОД) buýrugy iki we köp jisimleriň göwrümini tutýan 

jisimi döretmegi mümkin edýär. Buýruga  düwmejigi gabat gelýär.  

Kesişler 
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SLICE (РАЗРЕЗ) buýrugy we oňa gabat gelýän Тела (Solids) paneliniň 

düwmejigi, tekizlik bilen jisimi iki jisime kesmegi mümkin edýär, we gerek 

bolanda olaryň birini ýok edýär. 

UCS (ПСК) buýrugy arkaly МСК geçeliň. Syçanjyk bilen   düwmejige 

basalyň we obýektler barada sora berilende öň çyzylan turbany görkezeliň. 

Indiki sorag: Specify first point on slicing plane by 

[Object/Zaxis/View/XY/YZ/ZX/3points] <3points>: (Первая тонка на 

режущей плоскости [Объект/2ось/Вид/Х¥/¥2/7Х/Зточки] <3точки >:) 

<Enter> klawişany basyp kesimi üç nokat arkaly ýerine ýetirmegi 

tassyklaýarys. Soňra yzygiderli soraglara jogap berip, aşakdaky nokatlary 

girizmeli: (100,-50,100), (-100,80,100) we (300,0,600). Indi ulgama haýsy 

jisimleri galdyrmak barada habar bermeli:  

Specify a point on the desired side of the plane or [keep Both sides]:  
(Укажите точку с нужной стороны от плоскости [Обе стороны]:) 

keep Both sides (Обе стороны) opsiýany saýlalyň. Turba iki jisime 

bölüner, özem bir jisimde iki sany kesişmeýän bölek bolar. Biri jisime çepe 

süýşüreliň. Netije aşakdaky suratda.  

Sag jisimi gerek bolnada iki aýratyn jisime Solids 

Editing (Редактирование тел) paneliniň  

düwmejigi arkaly bölmek mümkin. 

SECTION (СЕЧЕНИЕ) buýrugy we oňa gabat gelýän 

Solids (Тела) paneliniň  düwmejigi, jisimiň 

kesimini döredip, kesimiň çyzyklaryny saklaýan 

töweregi emele getirýär, soňkuny çykaryp çyzgyda 

ulanmak mümkin. 

Jisimleri redaktirlemek 

Jisimleriň üstünden umumy redaktirlemegiň buýruklaryny ýerine ýetirmek 

mümkin (ýok etme, süýşürme, göçürmeи we ş.m.). Modify (Редакт) menýusyna 

3D Operation (3M операции) kömekçi menýu girýär, onda şeýle peýdaly bendler 

ýygnanylan:  

  3D Array (3M массив) — üç ölçegli massiwiň döredilmegi (3DARRAY 

(3-МАССИВ) buýrugy);  

  Mirror 3D (ЗМ зеркало) — berlen tekizligine görä obýektleriň aýna 

serpikiş görnüşiniň döredilmegi (MIRROR3D (3-ЗЕРКАЛО) buýrugy);  

  Rotate 3D (ЗМ поворот) — obýektleriň giňişlikde islendik okuň daşyndan 

öwrülmegi (ROTATE3D (3-ПОВЕРНУТЬ) buýrugy);  

  Align (Выровнять) — obýektleriň beýleki nokatlar we obýektler bilen iki 

ölçegli we üç ölçegli giňişliklerde deňleşmegi (ALIGN (ВЫРОВНЯТЬ) 

buýrugy).  

Jisimleriň eljagazlaryny süýndürme, gyraňlaryň we gapyrgalaryň 

modifikasiýasy ýaly amallary ulanmak bolmaýar. Munuň üçin Solids Editing 

(Редактирование тел) gurallar paneli göz öňünde tutulan. 
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SOLIDEDIT (РЕДТЕЛ) buýrugyň opsiýalaryna gabat gelýän düwmejikler:  

 — jisimleriň gyraňlarynyň berlen çuňluga ýa-da ýol boýunça gysylyp 

çykarylmagy;  

 — jisimiň gyraňlaryny berlen aralyga geçirmek;  

 — gyraňlaryň berlen aralyga ýa-da görkezilen nokada çenli deňölçegli 

süýşürilmegi;  

 — jisimleriň gyraňlarynyň baglaşdyrmalar we fsakalar bilen ýok 

edilmegi;  

 — berlen ok boýunça gyraňlaryň öwrülmegi;  

 — berlen burç boýunça gyraňlaryň konusa özgerdilmegi;  

 — jisimiň gyraňlarynyň töwerek ýa-da gaty jisimli gabyklar görnüşindäki 

göçürmelerini döretmek;  

 — aýry gyraňlaryň reňkiniň üýtgedilmegi;  

 — jisimiň gapyrgalarynyň kesimler, halkalar, tegelekler ýa-da splaýnlar 

görnüşindäki göçürmeleriniň döredilmegi;  

 — gapyrgalaryň reňkiniň üýtgedilmegi;  

 — gyraňda tagma döretmek (beýleki obýektiň yzy bolup durýan täze 

gapyrganyň döredilmegi;  

 — artykmaç gapyrgalaryň we depeleriň ýok edilmegi;  

 — köpbaglanşykly jisimleri (giňişlikde birnäçe ýapyk göwrümleri tutýan) 

aýry jisimlere bölmek;  

 — berlen galyňlykly boş inçe diwarjykly gabygyň döredilmegi;  

 — obýektiň ýol bererli jisimdigi baradaky barlag. 

Hemme bu amallar şeýle hem Modify (Редакт) menýusynyň Solids Editing 

(Редактирование тел) kömekçi menýusy arkaly hem ýerine ýetirilip bilner. 

SOLIDEDIT (РЕДТЕЛ) buýrugy aşaky habardan öz işini başlaýar:  

Solids editing automatic checking: SOLIDCHECK=1 Enter a solids editing 

option [Face/Edge/Body/Undo/eXit] <eXit>: (Автоматическая проверка тел 

при редактировании: SOLIDCHECK=1 Задайте опцию редактирования тела 

{Грань/Ребро/Тело ACIS/Отменить/ выХод] <выХод>:) 

Birinji soragda SOLIDEDIT (РЕДТЕЛ) buýrugy dört opsiýany hödürleýär:  

 Face (Грань) — gyraňlary redaktirlemek düzgüni;   

 Edge (Ребро) — gapyrgalary redaktirlemek düzgüni;  

 Body (Тело ACIS) — jisim bilen işlemegiň ýörite düzgüni (barlag, tagma 

goýmak we ş.m.);  

 Undo (Отменить) — iň soňky amaly ýatyrmak;   

 eXit (выХод) — buýrygyň işini tamamlamak. 
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Tejribe işleri 

 

1) Radiusy R=30 bolan tegelekden beýikligi 100 bolan silindr gurmaly 

2) Deň taraply üçburçlukdan beýikligi 70 bolan piramida gurmaly 

3) Deň taraply üçburçlugy aýlamak arkaly konus gurmaly 

4) Bedräniň şekilini gurmaly 

5) Aýna penjiresini gurmaly 

6) Diwarlary bolan otagy gurmaly 

7) Gül goýulýan küýzäni gurmaly 

8) Daşky radiusy 40 we içki radiusy 30 bolan egri turbany gurmaly 

9) Basgançaklary gurmaly 

10) Ýönekeýje minarany gurmaly 
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